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GENIUS TOOLS'™"

1 Overview

GENIUS TOOLS Starter® is used to start locally installed applications using a centrally
managed configuration. All required data is synchronized from a central storage location
(Caddepot) to the local computer (Cadpool). The software offers global administration
capabilities for heterogeneous IT landscapes and user-specific adaptation options.

1.1 GENIUS TOOLS Starter philosophy

GENIUS TOOLS Starter lets you manage centrally configured operating environments.
Typically, a company uses one productive operating environment. This operating
environment can be synchronized to all user computers. An operating environment can
contain any number of Starter projects, which are configured with just a few mouse clicks
and distributed to either all or only to specific users.

GENIUS TOOLS Starter can provide for multiple operating environments, so that test
environments or environments with customer-specific configurations can be configured
with little effort. Also, GENIUS TOOLS Starter can integrate publicly available
configurations.

Using synchronization between the administration computer and a number of client
computers, you can manage large and complex installations, distribute central
configuration settings to each workstation and also distribute the required data. Changes
to the configuration are thus automatically made available to all users. Configurations can
differ between users by organizing them in units.

The following procedure applies to all programs:
1. the environment can be cleaned first and

2. GENIUS TOOLS Starter settings are made.

Supported applications
With GENIUS TOOLS Starter, users can start all programs on the user's computer.

1. Administrators can create projects with object data and predefined configuration
settings for the following CAD applications:

— AutoCAD, AutoCAD Architecture, AutoCAD LT und AutoCAD Mechanical 2021 - 2025
— Creo Elements / Direct Modeling

— Creo Parametric 2.0 - 12

- Inventor 2021 - 2025
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— SolidWorks 2020 - 2025

2. The following applications will be automatically detected if they are installed on the user
computer (autostart). The latest version will be opened.

— Creo Elements / Direct Drafting
— Creo lllustrate

— Creo Schematics

— Creo View

— Geomagic Design X

— KeyShot

— Mathcad

3. Projects without configuration settings can be created for all applications located on the
user computer.

1.2 Component modules

GENIUS TOOLS Starter provides user-friendly graphical interfaces for easily managing CAD
installations as well as any other program. It consists of four components:

— GENIUS TOOLS Environment Administrator for managing operating environments

— GENIUS TOOLS Project Configurator for configuring projects in an operating
environment

— GENIUS TOOLS Starter App for starting configured projects
— GENIUS TOOLS Config Editor for editing configuration blocks
— GENIUS TOOLS Git Utility for checking in to Git and version management

GENIUS TOOLS Environment Administrator

GENIUS TOOLS Environment Administrator provides functionality for managing operating
environments. Use GENIUS TOOLS Environment Administrator to

— create new operating environments
— change properties of an operating environment

— update GENIUS TOOLS Starter and GENIUS TOOLS for Creo in an operating
environment

— configure license servers and synchronization settings

GENIUS TOOLS Environment Administrator is a stand-alone administrative tool. The
executable file gtsa.exe is located in the Installdepot directory.
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GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator provides functionality for configuring different
projects with only a few mouse clicks. End users can thus start projects with an application
using specific configuration settings. Use GENIUS TOOLS Project Configurator to

— define adaptable configuration settings for homogeneous or heterogeneous CAD
landscapes

— define unit-specific settings
— manage different projects.

GENIUS TOOLS Project Configurator is started from the user menu of GENIUS TOOLS
Starter App, but the administrator may deny users access.

GENIUS TOOLS Starter App

The configured projects are listed in GENIUS TOOLS Starter App for the users, who can
select a project with a specific configuration. The user interface also displays additional
information, e. g., available licenses, working directory and error messages.

GENIUS TOOLS Starter App is a stand-alone tool. The executable file gts.exe is located in
the Caddepot directory under Software.

GENIUS TOOLS Config Editor

Administrators can edit configuration settings with GENIUS TOOLS Config Editor as well as
compare them in different versions for Creo Parametric.

GENIUS TOOLS Config Editor is a stand-alone tool. The executable file GTConfigEditor.exe
is located in the tools directory, which is a directory in both the installation computer as
well the user computer.

GENIUS TOOLS Config Editor also starts by clicking a config file in GENIUS TOOLS Starter
App, though administrators may deny users access.

1.3 Advantages of using GENIUS TOOLS Starter

The use GENIUS TOOLS Starter offers the following advantages:

— project-oriented workflow

— creating projects that unite the program to be launched, required licenses, specific
configuration and related data

— support for different working environments

— easy handling through graphical user interface
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— central configuration of application computers
— synchronization based on a configurable interval
— organization of users into units and subunits
— role-based permission concept
— management of configuration blocks (component files of a configuration)
— blocking access to projects
— support for multiple languages
For CAD applications, the following advantages are added:
— fastest possible startup of CAD application, as all data is stored locally
— licensing with FlexLM, fail-safe mode and license borrowing supported
— creation of project options which users can select
— easy configuration of a CAD landscape
— license management
— easy offline work using license borrowing
— Windchill integration

— database-driven management of Creo Parametric configuration settings

1.4 License-dependent features

Starting with GENIUS TOOLS Starter 6.0.1, the product functionality depends on the type
of license you are using. From the year 2020 onwards, GENIUS TOOLS Starter is only sold
with subscription licenses.

The following functions are available with a subscription license for GENIUS TOOLS Starter.

Subscription Description Release
function

Dynamic access to  Creates access to Windows user management and 6.0.1.0
Windows user enables live queries so that user assignment is always
management with  up-to-date. Users thus do not have to be created and
LDAP/Active maintained manually.

Directory = Less maintenance work

(lightweight
directory access
protocol)
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Subscription Description Release
function

Configuring units ~ Adds a group element (“unit”) that can easily reflect 6.0.1.0
complex configurations such as for company sites and
units.

= Easier configuration for companies with many sites
and/ or units

= Allows for a reduction of projects

Access to Adds a group element (“users”) that can easily reflect  6.0.1.0
directory “users” complex configurations for many users.

= Less maintenance work

Selecting Creo Provides a project with a choice from several Creo 7.0.0.0
startkey when startkeys (start command that opens Creo with a
starting a project  defined license package). Users can start a project

with a default startkey or select another one when

opening a project in GENIUS TOOLS Starter App.

= Allows the reduction of projects

Apps projects Creates projects that run on any other program. 7.0.0.0
Assigning a project directory and batch files is
possible.

= GENIUS TOOLS Starter App can be made the
central access point for users.

Operating Enables the connection of synchronization serversto ~ 7.0.1.0
satellites in a main server and their automatic synchronization.

GENIUS TOOLS
Starter Service

= Faster connection of user computers to a
synchronized satellite

= Reducing queries from network to main server

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 13
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Subscription
function

Edit and compare
configuration
blocks

Company-specific
project
collections

Selectable project
options

Reproducing
organization
structure with
units and subunits

Combined project
options

Edit config.pro
files in GENIUS
TOOLS Config
Editor

GENIUS TOOLS Starter

Description

Release-dependent config.pro editor and graphic
comparison tool

= Quick overview, comparison and editing of project-
related configuration blocks (config_*.pro files)

Start projects can be put together in defined project
groups by the administrator.

= In many projects, these can be structured
according to your own requirements.

Projects can be started with multiple, individually
defined configuration blocks, e. g.for license
extensions or additional programs.

Subordinate units (subunits) can be created to
provide additional configuration levels for project
settings.

= Better mapping for locations, subunits etc. and the
resulting complex project configurations

= Allows for further reduction of projects

Users can select a project option in GENIUS TOOLS
Starter App, which activates multiple configuration
options which are located in different directories and
configuration levels, e. g. for license extensions and
add-on applications.

= Number of projects can be minimized

Creo configuration options can be edited faster with
auto-completion and color coding.

= Easier comparison and editing of configuration
options, also in batch mode.

Release

7.0.1.0

7.0.2.0

8.0.0.0

8.0.1.0

8.0.1.0

8.0.2.0
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Subscription Description Release
function
Auto projects Settings for auto projects (e. g. Keyshot) can be 9.0.0.0

specified for the configuration levels standard, unit,
project and user.

= Company-specific configurations possible

Create and For Creo Elements/Direct Modeling projects, settings ~ 9.0.0.0
migrate Creo can be specified for the configuration levels standard,
Elements/Direct unit, project and user, and project settings and data

Modeling packages can be added or migrated.

projects = Integration of an additional CAD application

Create SolidWorks  Projects for SolidWorks can be configured in the 9.0.1.0
projects layers standard, unit, project and user. Project settings

can be specified and data packages added.

= Integration of an additional CAD application

Create Inventor Projects for Inventor can be configured in the layers 9.0.2.0
projects standard, unit, project and user. Project settings can
be specified and data packages added.

= Integration of an additional CAD application
Create AutoCAD For the applications AutoCAD, AutoCAD Architecture  9.0.2.0
projects and AutoCAD Mechanical, projects can be created for

a specific release and be assigned project and data
directories.

= Integration of an additional CAD application

Support of Projects can be created for AutoCAD LT. 10.0.1.0
AutoCAD LT
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Subscription
function

Select alternative
authentication

Unit-specific
visibility of
projects

Install Creo
projects

SSO-
Authentifizierung

Synchronization
with
GitSynchronizatio
n with Git

GENIUS TOOLS™"

Description

Users can authenticate against a system other than
Windows. Windchill user data can be imported with
GENIUS TOOLS Project Configurator. For other
systems, e. g. SAP, a self-created file can be used.

= Compatibility of Starter projects with other
authorization systems, e. g. Windchill

Access to a project can be restricted to a specific unit
(in addition to being restricted to a role).

= Use of units for project access

Synchronize Creo Parametric setups to user
computers, from which they can be started manually
or automatically.

Windchill user data can be authenticated with an
existing Windchill server with SSO (single sign-on)
setup.

= Login process in GENIUS TOOLS Starter omitted

Operating environments can be synchronized with the
version control system Git.

= Synchronization server can be accessed with URL
address

Release

10.0.1.0

11.0.0.0

11.0.0.0

11.0.1.0

11.0.1.0

Warning: If you are using mixed licenses (perpetual and subscription) and configure
functionality that is limited to subscription licenses, the projects in GENIUS TOOLS
Starter App will no longer start if there is no subscription license available.

User can see whether projects include subscription functions =] by consulting Data base

mode in the footer of GENIUS TOOLS Starter App.

For information on managing PTC license packages, please refer to Assigning Creo

licenses to projects.

GENIUS TOOLS Starter

© 2025 INNEO Solutions GmbH
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Falsely activating a subscription function

When activating a subscription function, a backup copy of the configuration database
sut.db is created. Use this backup copy, if you want to undo an activation of any of the
above functions so you can work again with permanent licenses.

Procedure:
1. On the installation computer, go to the backup directory: ..
\caddepot\ <operatingenvironmentname >\configuration\database\BackupBeforeUpgra
de

2. Copy the backup file sut.db from the BackupBeforeUpgrade folder.
3. Paste this file into the database directory.
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2 Basics

GENIUS TOOLS Starter allows users to launch projects from different applications, with
settings made centrally by the administrator.

2.1 Important terms

The administration computer is a computer on which the administrative user has full
write access to the Caddepot directory in order to manage all data on the file system
level.

The user computer is the computer on which the end user of an application opens
configured projects with GENIUS TOOLS Starter App. The required applications must be
installed.

Caddepot is a directory on the installation computer that can contain any number of
operating environments. It is the source of synchronizing the local operating
environments on user computers, that is, the source for the local Cadpool directories. The
Caddepot directory must shared to be accessible for distributed work.

An operating environment is a directory in the Caddepot that contains all the data
required for working with the desktop application. This includes configuration data,
libraries, templates and additional applications. The operating environment also contains a
database with all configured projects. An operating environment can contain an arbitrary
number of projects.

If you work across a network, the directory for the operating environment is the Caddepot
on the administration computer and the Cadpool on the application computers.

The operating environments contains the software components GENIUS TOOLS Starter,
GENIUS TOOLS Starter App and GENIUS TOOLS Project Configurator of a defined version.

A Starter project combines specifications that are made in GENIUS TOOLS Project
Configurator, namely

— the program to be started,
— the required licenses,

— the project directory and
— the associated data,

with configuration settings that can be made in the configuration levels using manually
created configuration blocks.

It can be selected by users in GENIUS TOOLS Starter App and starts with locally available
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data and the configuration settings defined centrally by the administrator.

For the configuration of a project GENIUS TOOLS Starter reads out different component
files, the so-called configuration blocks. These files can be stored together with batch
files in different configuration levels.

2.2 Workflow and synchronization

Standard workflow: Working locally with synchronization

As of version 6.0 of Startup TOOLS, Creo users work with all data locally on their
computers. This ensures the fastest possible access to the data and also allows users to
work offline.

Local data (the operating environments) are located in the Cadpool directory and are
synchronized from the central Caddepot directory at a configurable interval, i. e. the data
is copied from Caddepot to Cadpool.

Data synchronization means that local modifications to a configuration will be overwritten
in the synchronization process. Local changes that are to apply to all users —e. g. entries in
a configuration block (config_*.pro file) — must be copied manually to the Caddepot.
Synchronization must be suspended while you are making local changes. To pause
synchronization, open GENIUS TOOLS Project Configurator and select Pause
synchronization from the user menu 3,

Please note: For data synchronization to work, users need access to the Caddepot
directory. We recommended granting read access only, if you do not want users to
change settings by themselves.

The setup for working locally with synchronization is created by GENIUS TOOLS Starter by
default. If you start the GTS.exe file, it will open from the local Cadpool directory, or create
the Cadpool directory, if it does not exist yet (initial synchronization).

Network mode: Working without synchronization

You can work locally with the data in the Caddepot and without synchronization within a
computer network. To do so, the standard behavior of GENIUS TOOLS Starter has to be
changed and set to network mode, meaning that the file GTS.exe will be started in the
Caddepot directory.

To set access rights for network mode, open GENIUS TOOLS Project Configurator and set
Access rights > Function access > Select unit > Function access > Prevent switch to local
installation: Yes.
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Server

Installation directory

Share
Caddepot

Operating environment

Network mode: GTS . exe started
software —{ GTS.exe | in the Caddepot directory
via a call from the application computer
\\srvishare\OperatingEnvisoftwaregts.exe

—— Installdepot — gtsa_latest —JCTSARE]

——  Mediadepot

Uni-directional synchronization

Application computer

Cadpool

p-Operating environment

—

e _@ Standard behavior: GTS.exe started in the

Cadpool directory on the application computer

Legend [EFSASE GENIUS TOOLS Environment Administrator GENIUS TOOLS Starter App

Synchronization and network mode in GENIUS TOOLS Starter.

2.3 Operating environments

You can manage any number of operating environments with GENIUS TOOLS Starter. This
means that you can have both a test and a production environment installed and manage
environments for different clients.

Each operating environment contains a set of projects, the required data and the GENIUS
TOOLS Starter software. Each operating environment is fully independent of the others.

The directory for the operating environment contains configuration data, libraries and
templates, additional applications as well as the database for project-specific
configuration settings, see Directory structure.

Software updates of an operating environment are managed by using GENIUS TOOLS
Environment Administrator. Data in an operating environment — such as GENIUS TOOLS
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Starter software, additional applications like GENIUS TOOLS for Creo, configuration files,
or standard parts — cannot be changed by setup programs. This gives the IT administrator
better control over which data is to be changed or updated in an operating environment.

2.4 Directory structure

With GENIUS TOOLS Starter you can create projects for Creo Parametric as well as Creo
Elements/Direct Modeling, Inventor and SolidWorks. In order to be able to include data
for other CAD systems, the entire directory structure has been changed in version 9.0.0.

Warning: Due to these new features in GENIUS TOOLS Starter, the directory structure
and the software are no longer backward compatible, which means that after updating
an operating environment to version 9.0.0.0 or newer, it is no longer possible to revert
to an older version. Read the chapter Important information in the News document
before updating.
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Directories of an operating Directories of an operating
environment before version 9.0 environment from version 9.0

<operating_environment> <operating_environment>
_lmages _lmages
_Information _Information
apps application
PP app Ll directory for
gtfc ogl':t?guralion Apps projects
standard
units . .
. rojects or authentication
configuration ESGJE with Windchill
application i (from 10.0.1.)
database

. auth_provider
t isutdb uth_provi

gt_resource_folder

. i Contains data
configuration for configuring

i _Images GENIUS TOOLS Starter
database

plot ¢ isutdb contains all images
and icons for

projects help projects and units

standard parametric

units apps

users gtfc
data mpuser

<company_data>

configuration

help application

serveronly
software
tools
userdata

gt_resource_folder
ifx
mpuser
plot
standard
units
projects
users
data

<company_data> application-
specific
directories for
creo_view Starter projects
apps
configuration
standard
units
projects.
users
data

software
tools
userdata

System directories of the first level

_Images contains images (JPEG, PNG, SVG) for the operating environment as well as the
start icon (ICO). See also chapter ConfiguringConfiguring the desktop link.

_Information contains messages to the users as text files. See also Sending messages to
the users.

application directory for applications of App projects, e.g. Model Processor.

auth_provider contains the executable files Auth_Windchill.exe and
Auth_Windchill_SSO.exe for authenticating against Windchill (authentication provider).

configuration contains images and icons for units and projects, and the sut.db database
which stores the configuration settings of an operating environment.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH
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help contains the manuals and installation instructions for GENIUS TOOLS for Creo,
GENIUS TOOLS Starter and Startup TOOLS.

satelliteonly is located in the caddepot of the main server and all satellites. It can contain
data specific to satellites.

serveronly is located in the caddepot directory of the main server only. It contains
additional tools such as GENIUS TOOLS Comma-to-dot or GENIUS TOOLS Purge. The
subdirectory _ErrorLog contains log files for errors.

software contains the GENIUS TOOLS Starter software.

tools contains the software component GENIUS TOOLS Config Editor and Requirement
Check, a tool which returns a log file with a list of all available applications.

userdata contains user-defined settings, e. g. mapkeys and user images. The name of a
subfolder corresponds to the login name. See Create user with image.

In contrast to the directory in configuration/Users, this directory can be managed by the
user themselves. See chapter User-driven configuration

The following application-specific directories are created:
auto_cad AutoCAD, AutoCAD Architecture, AutoCAD LT und AutoCAD Mechanical
ced_drafting Creo Elements/Direct Drafting

creo_view Creo View

elements_direct Creo Elements/Direct Modeling
geomagic_design_x Geomagic Design X

illustrate Creo lllustrate

inventor Inventor

key_vr KeyVR

keyshot Keyshot

mathcad Mathcad

parametric contains data packages, standard projects and add-on applications for Creo
Parametric

schematics Creo Schematics
solid works SolidWorks

For some applications, only one Starter project can be created: so-called auto projects.

Please note: Empty directories are not synchronized.
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Directories of the second level for the various applications

Each of the above listed application-specific directories has three sub-directories for data,
configuration settings and add-on applications.

apps contains all additional applications.

— For Creo Parametric: the GENIUS TOOLS for Creo products Library and/or Parameter
(gtfc) and the freeware tool GENIUS TOOLS Ul File Loader (ui).

— It is represented by the variable GTS_APPS_DIR.

configuration contains configuration settings for system-wide standards, units, projects,
users as well as further directories.

— For Creo Parametric: gt_resource_folder.
— It is represented by the variable GTS_CONFIGURATION_DIR.

data contains all data packages (subdirectories) available in a project, e.g., libraries,
materials, ModelCheck configuration files etc.

— A subdirectory of data is represented by the variable GTS_DATA.

install contains all data and setup files for installing Creo Parametric on user computers.

2.9 Defining settings

The settings for an operating environment are made in different locations and are saved
as follows.

Information on synchronisation and licence server

These properties of an operating environment are specified in GENIUS TOOLS
Environment Administrator in the Modify function and when creating an operating
environment.

Information on the configuration of a CAD application
Configurations for a CAD application and configuration instructions are specified in
configuration blocks and batch files.

Storage location:
caddepot\<operatingenvironment >\ <application >\configuration\ < configurationlayer>

Changes to these files must be made in the caddepot. Any changes to files located in the
cadpool are overwritten by data synchronization. If you do want to edit files in the
cadpool you have to pause synchronization in the user menu of GENIUS TOOLS Project
Configurator and copy the files to the caddepot manually.
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Please note: If you make changes to files in an operating environment that is versioned
with Git, you must first open GENIUS TOOLS Project Configurator, see Connecting
operating environments to Git.

Information on the configuration of GENIUS TOOLS Starter App

Settings for projects, users and units are made in GENIUS TOOLS Project Configurator and
saved in the database sut.db on the installation computer, i. e. the computer which
contains the caddepot.

Storage location: \caddepot\<working environment name>\configuration\database\sut.db

A backup of the database is created in the database directory every time GENIUS TOOLS
Project Configurator is closed.

Changes made with GENIUS TOOLS Project Configurator are saved with the function Save
database [2). Before saving, changes can be discarded in the user menu {33 via Revert
changes.

In git-versioned operating environments, the Save function is replaced by the Git check-in
button £%, which checks in both the sut.db database and all changes to files in the
cadpool, e. g. configuration blocks and batch files, into Git. Detailed information can be
found in the Connecting operating environments to Git chapter.

Warning: All users who are allowed to start GENIUS TOOLS Project Configurator are
contributors and can check in changes to Git. Therefore, make sure that changes to the
operating environment are not made by several users simultaneously. This can lead to
merge conflicts during check-in.

Settings made in configuration blocks, batch files and GENIUS TOOLS Project Configurator
define the behavior of Starter projects, see next chapter.
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3 Starter projects

A Starter project combines specifications that are made in GENIUS TOOLS Project
Configurator, namely

— the program to be started,
— the required licenses,

— the project directory and
— the associated data,

with configuration settings that can be made in the configuration levels using manually
created configuration blocks.

It can be selected by users in GENIUS TOOLS Starter App and starts with locally available
data and the configuration settings defined centrally by the administrator.

An administrator can thus make GENIUS TOOLS Starter App the central starting point at
work for users.

The setup of a Starter project requires object data, which are located in the data directory,
as well as configuration blocks, which can be located in the configuration directories
standard, units, projects and users. The separation of the object data from the
configuration data and additional applications ensures that objects of an operating
environment can be used for several projects.

A Starter project can be created with the following components:
— start variables (supported by GENIUS TOOLS Starter)

— environment variables (GTS)

— configuration blocks (GTS)

— previously started programs (defined by batch files)

— Windows registry (GTS)

— settings (GENIUS TOOLS Project Configurator)
for units and individual projects:

- servers
- licenses

- language and license key (as project options)
and additionally for users:

- access rights

- visibility and presentation of projects
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caddepot\<OperatingEnvironment>\<Application>\configuration\

standard projects

configuration
layers
Project 1
GENIUS TOOLS
GENIUS TOOLS

Project Configurator

Starter App - configuration blocks
with configuration settings
oeer - batch files

| Global settings
- license servers / (Standard)
- license keys (startkeys)

selects project - language
- environment variables N Project settings
Project 1
Project 1 > - project directory -
- data directory <« |

- software version
- start behavior

project start

Structure of a Starter project set up with standard settings and project settings

Starter projects can be created for all applications. Each project can be assigned a project
directory and a data directory. The first, general steps are described in the General
procedure chapter.

The license to start a CAD application / Starter Core license is returned after 120 minutes
of runtime, unless the CAD application is closed before. After this runtime, the CAD starter
license is free again and can be used by the next user.

For CAD applications, you can additionally define startup behavior, license server and
environment variables. Accordingly, the settings for these applications are more in-depth
and are described in the respective chapters:

— AutoCAD

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 27



Starter projects G EN I US TO 0 I.S®==

— Creo Elements/Direct Modeling
— Creo Parametric
— Inventor

— SolidWorks

3.1 Data packages

The directory data is the system directory of an application, under which the files related
to an operating environment can be found. All object data are stored in the subdirectories,
the data packages:

<GTS-working-environment>\<application>\data\<data-package >

For example, for Creo Parametric: <GTS_ROOT_DIR>\parametric\data\sut_creo9.

Please note: Data packages are subdirectories in the system directory data of an
application.

A reference to a data directory from a configuration block is made with the variable
$GTS_ DATA.

Hint: If possible, always work with variables.

For Creo Parametric, object data is provided with the Startup TOOLS product package, see
Creo data packages.

3.2 Configuration blocks

Most software programs do not allow to make specific settings for different user groups,
projects and locations. To provide this possibility, GENIUS TOOLS Starter creates a specific
configuration from different configuration component files, the configuration blocks.

A configuration block

— is a text file that contains one or more configuration options, i. e. settings for the
application,

— must be given an application-specific name (see table below),

— is one of many configuration files that are read by GENIUS TOOLS Starter to create the
configuration of a Starter project,

— can contain conditions, that define whether to include them into the configuration
(Conditional configuration blocks).
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Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,
configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks and Config.pro files using
the add-on program GENIUS TOOLS Config Editor, which features color highlighting,
auto-completion as well as error messages and which allows you to compare entries of
two configuration blocks.

Configuration blocks are created manually and stored at the desired configuration layers.
This provides company-wide settings as well as setting options per department, location,
project etc.

Please note: If you make changes to files in an operating environment that is versioned
with Git, you must first open GENIUS TOOLS Project Configurator, see Connecting
operating environments to Git.

The following configuration blocks can be used for the respective applications.
Configuration block  Content Example

Creo Parametric

1 config_*.pro All settings (configuration config_sut_de_c6p_dir file.pro
(also: Config file)  options) for running the config_c5p_mapkeys.pro
application
2 config_*.sup Settings that cannot be config_design_de.sup

modified by the user

SolidWorks

3 config_*sldreg All settings, config_addin_compose.sldreg
Embedding of additional
applications (add-ins)

Inventor

4 config_*.xml General settings config_dir_file.xml

5  ui_*xml Settings for the user interface  ui_customization.xml

6  *.addin Embedding of additional AdditiveMFG.inventor.addin

applications (add-ins)
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3.3 Batch files

Batch files are used to execute configuration commands at different times.

If you want to execute additional instructions before an application is started or when
changing to another project, you can place unit or project-specific batch files in the
corresponding directories of the configuration layer. You can also use batch files to set
additional environment variables or copy additional data.

The batch files names have to start with one of the following prefixes.

Types of bhatch files

Prefix Start time Comment
prestart_ Started before the When a project is started, GENIUS TOOLS
configuration is created. Starter calls the prestart_ batch files before
the config.pro files for the project are
assembled.
poststart_ Started after the This type of batch file can be used for
application has been accessing the running Creo session with the
started. help of additional programs.
start_ Started before the When a project is started, GENIUS TOOLS
application is started. Starter assembles the config.pro files for the

project, then calls the start_ batch files.

stop_ Started after the Please note that Enable stop batches has to
application is closed. be set to Yes in the Project Configurator
under Configuration > (Select unit) > Creo
Settings > Startup Settings.

For Creo Elements/Direct Modeling, only start batch files can be executed.

Warning: What if Creo Parametric does not start? The most common cause is that a
batch file causes the Creo call to stop. If there are start issues, first check which batch
file could cause the Creo call to stop.

Batch files are subject to the same call hierarchy as configuration files. Unlike configuration
files, however, batch files cannot be located in the PDM directory.
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User or computer-specific batch files

GENIUS TOOLS Starter can call batch files depending on which user or computer starts a
project. These batch files and their call sequence do not differ from the general batch
files.

Use the following prefixes and be careful not to use special characters.

Batch file Prefix (without the Beispiel
characters <>)

User-dependent U_<WindowsUSername U_MUELLER_stop_copy workspace.bat
>—

Computer- C_<WindowsComputern C-CADL3_start map drive.bat

dependent ame> _

Please note: User and computer groups are converted into units when updating to
version 11.0.0.0 and later. Configuration blocks that were created for user or computer
groups (UG_<nameofusergroup>_config.pro or CG_<nameofcomputergroup >_config.pro),
will be migrated into a new unit directory of the same name.

3.4 PDM directories

The PDM directory will be included into the call hierarchy for files when you are working
with a PDM system, e. g. Windchill. It contains additional settings that are defined on
starting the PDM system, as well as commented-out settings for Starter projects. Settings
that are commented-out are stored in the file exclude.txt.

As soon as the PDM system is activated, the PDM directories within all configuration
directories relevant to a project will also be included into the configuration call hierarchy.
All configuration blocks located in the PDM directories will be used.

Please note: The PDM directories were named SEARCHMODE until version 9.0.1.

3.9 Configuration concept

All data for the configuration of a starter project are located in an operating environment
in the system directory configuration of the respective application. When a project is
started, all configuration and batch files from the subdirectories standard, units, projects
and users are taken into account, i. e. from the configuration layers.
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3.9.1 Configuration layers

The task of GENIUS TOOLS Starter is to perform configuration settings on different
configuration levels. These levels are:

— Standard (global settings)

— Units (departments / locations)
— Projects

— Users

All configuration blocks and batch files for an application are stored in these configuration
levels and processed according to the call sequence for files, see next chapter. If you work
with subunits, the configuration of a starter project is additionally determined by the
organizational structure.
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I— Organizational structure

Directories of the configuration layers

The following directories are available for the configuration layers. They are located in the
system directory configuration.

1. Standard directory:
<GTS-OperatingEnvironment >\ <Application >\configuration\standard

2. Unit directory / directories: subdirectory /subdirectories of units
<GTS-OperatingEnvironment >\ <Application >\configuration\units\ %
GTS_UNIT_DIR_NAME%

(The variable contains the name of the last selected unit).

3. Project directory: subdirectory of projects
<GTS-OperatingEnvironment >\ <Application>\configuration\projects\ %
GTS_UNIT_DIR_NAME%
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4. Users directory: subdirectory of users
<GTS-OperatingEnvironment >\ <Application >\configuration\users\%USERNAME %

Please note: In order to work with data for other CAD systems in the future, the entire
directory structure has been changed in version 9.0.0 of GENIUS TOOLS Starter. Consult
the comparison of the old and new directory structure. The adjustment of the paths is
done automatically during an update.

1. Standard directory
Configuration options in the directory standard always apply as long as they are not
overwritten by specifications in subordinate folders.

2. Unit directory / directories
The directory units contains the individual unit directories, e. g.
<GTS_ROOT_DIR>\parametric\configuration\units\manufacturing.

All unit directories are located on the same level, including those of subordinate units
(subunits). Subunits are created by the arrangement in the organization tree.

3. Project directory

The directory projects contains the individual project directories, i. e. subdirectories with
project-specific information, e. g. <GTS-

OperatingEnvironment >\parametric\configuration\projects\project_creo8p_de.

You can select a project-specific directory in the settings for a project. Without this
specification, the directory will be inherited from the standard or unit settings.

Please note: Unit and project directories are not generated by creating a unit or
project in GENIUS TOOLS Project Configurator, but must be created manually.

4. Users directory
The directory users contains subdirectories for all users, e.g.
<GTS_ROOT_DIR>\parametric\configuration\users\cfoster.

When synchronizing from Caddepot to Cadpool only the directory for the specific user is
copied from the Users directory.

3.9.2 Call sequence for files

Configuration blocks (config files) and batch files can be located in these configuration
directories: standard directory for global system settings, unit directories, project
directories and user directories for user-defined settings. The files are processed in the
following sequence by GENIUS TOOLS Starter. A configuration block will only be read if it
falls into the selection made by the user for a unit and/or a project.

1. standard (global directory)
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1.1. standard > PDM, if a PDM system (e. g. Windchill) is activated
2. units (individual subdirectories)
2.1. units > PDM, if a PDM system is activated
3. projects (individual subdirectories)
3.1. projects > PDM, if a PDM system is activated
4. users (individual subdirectories, named by Windows / Windchill user name)
4.1. users > PDM, if a PDM system is activated

5. userdata (configurable)

Please note: The directories units and users can only be used with a subscription license.

The directory PDM was named SEARCHMODE until version 9.0.1.0.

The following applies to all files:

— Afile is only read if it is in the selection made by the user for a unit and project.
The following applies to Batch files, IPJ files and Creo Ul files:

— The first file found is read.
The following applies to configuration blocks (Config_*.pro files):

— All files are read. The last entry of a configuration option is the valid value.

— If you work with subordinate units (subunits), the configuration blocks of a unit can be
overwritten by another unit. The sequence depends on the organization tree, see
Mapping an organization.

— The PDM directory must be activated extra, see PDM directories.

Batch files

o Y oo Yomn Pern Y mE P e |

Configuration blocks (config files)
T \
standard unit subunit 1 subunit 2 project e ) folder )
../PDM ../PDM ../PDM ../PDM ../PDM ../PDM / Rt edzly /

Call sequence of configuration blocks and batch files for a Starter project

The processing order of the files significantly influences the configuration result for a
starter project. In addition, the settings in GENIUS TOOLS Project Configurator determine
the configuration of the project, see next chapter.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 34



Starter projects G EN I US TO 0 I.S®==

Example of a project configuration: Creo Parametric

The following graphic illustrates the call hierarchy for configuration blocks and batch files,
if user C.Forest chooses the unit UK and starts Project 1. The value of the last configuration
block is the valid value.

<OperatingEnvironment>

[— parametric

configuration

& standard ———{ config_mapkey.pro

units —— UK
Q-

— Germany

— Key User

Project 1
‘& projects { Project 2
Project 3
C Forest

‘e_ users «E N Gardener
P Smith

G userdata C Forest

E N Gardener
P Smith

The following configuration blocks are used if Windchill is not used. If values are listed
multiple times in several blocks, the value in the last-mentioned file is taken over, in the

example from the file <GTS-
OperatingEnvironment >\configuration\users\CForest\config_mapkey.pro.

<GTS-OperatingEnvironment>\configuration\standard\config_mapkey.pro
<GTS-OperatingEnvironment>\configuration\standard\start_.bat
<GTS-OperatingEnvironment>\configuration\units\UK\config_unit.pro
<GTS-OperatingEnvironment>\configuration\units\UK\config_mapkey.pro
<GTS-OperatingEnvironment>\configuration\units\UK\*.bat
<GTS-OperatingEnvironment>\configuration\projects\Project1\stop_.bat

<GTS-
OperatingEnvironment>\configuration\projects\Project1\config_sut_de_c6p_dir.pro
<GTS-
OperatingEnvironment>\configuration\projects\Project1\creo_paramatric_customization
ui

<GTS-OperatingEnvironment>\configuration\users\CForest\config_mapkey.pro
<GTS-OperatingEnvironment>\configuration\users\CForest\config_customization.ui
<GTS-OperatingEnvironment>\configuration\users\CForest\start_*.bat
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<GTS-OperatingEnvironment>\userdata\CMeier\config_user.pro
<GTS-OperatingEnvironment>\userdata\CMeier\config_user.ui

For the selected project 1, the project settings made in GENIUS TOOLS Project
Configurator also apply, e. g. to the license servers, startkeys or environment variables.

3.9.3 Call sequence for settings

Settings in GENIUS TOOLS Project Configurator — e. g. for license servers, synchronization
behavior or additional environment variables — are made for the configuration layers
standard, units and projects.

As always, the last setting overwrites the settings defined in the above configuration
layers.

The following sequence for settings in GENIUS TOOLS Project Configurator applies:
1. Global settings: Standard
2. Unit

3. Subunit(s): If you work with subunits, their hierarchy depends on the organizational
structure, see Call hierarchy for subunits.

L The settings for units and subunits are made in the menu page Configuration.
4. Project

L The settings for projects are made in the menu page Projects.

Settings in GENIUS TOOLS Project Configurator

global unit settings .—. project settings
Standard Subunit 2
&.g. former groups.

Call sequence for the settings made in GENIUS TOOLS Project Configurator

Please note: The configuration logic has been changed with the introduction of Units
as of version 6.0.1.

User and computer groups have been abolished in version 11.0.0.0 and are now
available as units.
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3.6 General procedure

There are two types of starter projects, general and CAD specific. The created starter
projects are displayed to the users in GENIUS TOOLS Starter App.

To configure a general starter project, you can follow the procedure below. The additional
options that apply to CAD-specific projects are described in the respective chapters.
BASIC PROCEDURES

1. Set up operating environment
Questions: How should the operating environment be set up?

Procedure: Create operating environment with GENIUS TOOLS Environment Administrator
and define license and synchronization server(s).

2. Define organizational structure

Questions: How complex is the structure of your company? Will you be working with
subordinate business units, e. g. Construction as a subunit of Italy?

Procedure: Map the organizational structure in GENIUS TOOLS Project Configurator.
CROSS-PROJECT PROCEDURES

3. Create configuration blocks

Questions: Which configuration options should be predefined for users on a starter
project? Which configuration settings, mapkeys and project options should apply
company-wide and which should apply to a unit or specific project?

Procedure: Write application-specific configuration blocks (config files) and place them in
the appropriate directories of the configuration layers.

Hint: We recommend defining settings and configuration options in the highest
possible configuration level, i.e. as few as necessary for individual projects. For example,
individual projects may contain the version-specific settings.

4. Set environment variables
Questions: Do the various configuration layers require different environment variables?

Procedure: Environment variables can be assigned and defined in GENIUS TOOLS Project
Configurator for each configuration layer.

5. Include additional programs
Questions: Which other programs should be started with the application?

Procedure: Make specifications in batch files.
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6. Define global settings and unit settings
Questions: Which license server(s), which synchronization settings should apply? How
should projects be displayed in GENIUS TOOLS Starter App?

Procedure: Define global settings as well as settings for units in GENIUS TOOLS Project
Configurator.

7. Display project information for users
Questions: Which information about the project should be available to users?

Procedure: Information displayed in GENIUS TOOLS Starter App can be restricted, see
chapter Granting function access rights.

PROJECT SPECIFIC PROCESSES

8. Create a project
Questions: Which project and data directory should be assigned to the project?

Procedure: Define project settings in GENIUS TOOLS Project Configurator.

9. Define language or make it available for selection
Questions: Should users be able to choose the language of the application?

Procedure: Set language in GENIUS TOOLS Project Configurator or create as project
option.

10. Display project

Questions: Should the project be accessible for all or certain users?

Procedure: Restrict access for defined user groups (roles), see chapter Restricting project
access.

CAD-SPECIFIC PROCESSES
Projects of the CAD applications can furthermore be provided with:

— additional project options, e. g. for license extensions, add-ins, see chapter Making use
of project options,

— additional information in the tabs of GENIUS TOOLS Starter App, e. g. on the
configuration blocks used, see Customizing information panes,

— the possibility to borrow licenses, see chapter Displaying license information.

Creo Parametric projects can be used to assign license packages to individual workstations
or users, see chapter Assigning Creo licenses to a project.
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3.1 Conditional configuration blocks

Configuration blocks are read in different ways. There are basic and conditional
configuration blocks. Conditional configuration blocks are used to create combined
project options and to work with units without unit folders.

Basic configuration blocks: without tag ID

The configuration block (config_*.pro file) is given a meaningful name and stored in one of
the directories Standard, Unit, Project, User. If the directory is valid for the selected project,
the Config.pro module is read out.

— Control: Call hierarchy of the directories determines which configuration block is used
for the project, see Call hierarchy for configuration files.

— Notation: config_*pro, e.qg.: config_1_lic_sim_live.pro
Conditional configuration blocks: with tag ID

A tag ID is a textual identifier that is recognized by GENIUS TOOLS Starter. By adding a tag
ID to a configuration block, its validity can be linked to conditions.

— Notation: config_*TAGID.pro, e. g. config_mbd.europe.berlin.mbd.pro
GENIUS TOOLS Starter distinguishes between unit tag IDs and free tag IDs.

Unit tag ID

A unit tag ID is an additional textual marking in a configuration block that defines a unit
and limits the validity of the block to it. This means a conditional configuration blocks with
a unit tag ID is activated by the selection of a unit in GENIUS TOOLS Starter App.

Unit tag IDs can be used
— as name of the unit folder
— as name of an image file: to assign images to a unit

— in configuration blocks: to restrict configuration options to a unit, see Using unit tag IDs.

Free tag ID

A free tag ID is an additional textual marking in a configuration block that defines a
combined project option and limits the validity of the block to it, e. g. config_lic. mbd.pro.
That means users have to activate the project option — here: mbd —in GENIUS TOOLS
Starter App in order for the configuration block to be read at project start. The first
configuration block with the free tag ID creates a checkbox.
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Creo Parametric 11.0 Crec Parametric 11.0.1.0

Mew version

ﬁ p % f de ~ Default - parametric.psf - mbd QECpEC

project option

v GENIUS TOOLS for Creo |+ MP User v Keyshot 10 plugin

& Toolkit & AAX af BMX

Free tag IDs can be choosen freely, but cannot be assigned to a unit.
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4 GENIUS TOOLS Environment Administrator

GENIUS TOOLS Environment Administrator is an administrative tool for managing
operating environments. Use GENIUS TOOLS Environment Administrator to handle the
following tasks.

1. Create operating environments

2. Add components to an existing operating environment
— project directories (directories with config.pro and other project-specific files)
— data directories
— additional applications

3. Update operating environments (Software update for GENIUS TOOLS Starter App and
GENIUS TOOLS for Creo)

4. Modify settings for an operating environment for
— license servers
— synchronization servers (Caddepot, Cadpool)

The next chapters describe each function in detail.

Warning: The following applies to git-versioned operating environments: All changes
made on the user computer that have not been commited into Git are discarded when
executing a function in GENIUS TOOLS Environment Administrator.

4.1 User interface

GENIUS TOOLS Environment Administrator must be started with write access to the
caddepot directory.

If you open the software from an administration computer which does not have an
AppData directory, you must start GENIUS TOOLS Environment Administrator with the
command -gts:appdata=%TEMP%.

Warning: GENIUS TOOLS Environment Administrator can only be used with operating
environments and Startup TOOLS software that have the same or older versions.

You need administrator rights on your computer for all functions that are used after
creating an operating environment. GENIUS TOOLS Environment Administrator is
restarted after a warning.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 41



GENIUS TOOLS'™"

GENIUS TOOLS Environment Administrator

After installing the software for Startup TOOLS or GENIUS TOOLS Starter, the GTSA.exe file
is located in the install depot in the gtsa-latest directory.

GTSTARTER. » installdepot »

Mame

10.0.2.0
11.0.1.0
git_latest
gtsa-latest

gts-service-latest

The user interface contains the user menu and the following functions.

Language » Create Modify

Theme User menu

Help (F1)
Referencecard

GENIUS TOOLS Knowledge Base

About (F12)

Exit

When you select a function on the GENIUS TOOLS Environment Administrator start page,

+[
([

Add Components

a wizard with one or more dialog pages is displayed. The inline help on the right side
supports each task of the workflow.

GENIUS TOOLS Starter
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GENIUS TOOLS ENVIRONMENT ADMINISTRATOR 11.0.1.0

Edit Synchronization

1

OPERATING ENVIRONMENT HELP
Caddepot Her.e you can change the synchronization server(s) and license server(s) or alter
their setup.
DA\GTSTARTER\caddepot (]
Please note: GENIUS TOOLS Environment Administrator only modifies the
Sefectignaratinglenvionment settings of the Standard group, i.e. of the system-wide configuration. If you
CompanyName_Doku | Version 11.0.0.0 - want to change the settings of a user group or computer group, go to GENIUS
TOOLS Project Configurator.
GENIUS TOOLS LICENSE MANAGER
Operating Environment
Souice Caddepot
T766@Iocalhost Select the caddepot directory to be used.

Name of operating environment
Enter the name of the operating environment.

GENIUS TOOLS License Manager

Source

Define the server from which GENIUS TOOLS Starter App is to use the licenses, in
the notation eortéservernane (€.. 77668<11censeservernane). Separate a series of
license servers with semicolons.

Active

Yes

Active
Defines whether the license server is to be used (yes) or not (no).

&

-

Dialog for completing three tasks and integrated help

First, you always need to select the Caddepot. Then, the option list shows the operating
environments that are available for selection.

All changes in Caddepot are stored in a database that cannot be edited by multiple users
at the same time. The following hint message means that another user is working either in
GENIUS TOOLS Project Configurator or in GENIUS TOOLS Environment Administrator.

Operating environment in use

User ahelp on computer AHELP has locked database of operating
environment INNEO at 03.06.2022 10:00:00.

Notification that the selected operating
environment is currently modified by another user

User menu

To access general settings for GENIUS TOOLS Environment Administrator, click on the
gear symbol {23 in the header.

Language: user interface language

You can switch the user interface language between English, German and French at any
time. The language setting is saved and will be used the next time you start the software.
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The software first starts with a German user interface if the operating system locale is set
to German. For all other locale settings, the software first starts with an English user
interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at
any time. The theme setting is saved and will be used the next time you start the software.

Help (F1)

Opens the installation manual for GENIUS TOOLS Starter. The help corresponds to the
document GENIUS TOOLS Starter Installation.pdf in the directory help of an operating
environment.

Reference card
Opens a reference card for a quick overview of all functions.

Info (F12)
Shows the current GENIUS TOOLS Starter version.

Exit

Closes the software. Clicking on the Close button (X) in the header will minimize the
program window.

4.2 Creating an operating environment

GENIUS TOOLS Environment Administrator lets you create different operating
environments with just a few mouse clicks.

The function Create creates an empty, new operating environment. This contains the
directory structure, the GENIUS TOOLS Starter software GTS.exe and an empty database,
sut.db. All settings defined in GENIUS TOOLS Project Configurator are stored in this
database file, which is located in the <OperatingEnvironment>\configuration\database
directory.

If you have purchased the Startup TOOLS product package, the add-on application
GENIUS TOOLS for Creo is automatically installed in the
<QOperatingEnvironment>\parametric\apps directory when you create a new operating
environment. This provides you with an operating environment with standardized
templates (start object templates, project-specific libraries, drawing frames, ModelCheck
configurations), interface and function configurations for Creo (config.pro, config.sup
config.ui) and many additional functions for Creo (toolkit applications).
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You can add data packages and standard start projects at any time thereafter via the Add
Components function.

GENIUS TOOLS Environment Administrator:
Creating a new operating environment

caddepot installdepot
\\<mainserver>\CADDEPOT \\<mainserver>\GTSTARTER/installdepot
L NameOperatingEnvironment —12.0.0.0
A
—| configuration ! — git_latest
I
L database || — gts-service-latest
. I
sut.db ; — gtsa-latest
\
—| parametric '\ Create
[ S~ GENIUS TOOLS
apps ~ | Environment Administrator
[] 12.0.0.0 (GTSA.exe)
gtfc*
— software

* The additional application GENIUS TOOLS for Creo
is automatically installed when purchasing the
Startup TOOLS product package.

gts.exe

Click the Create symbol on the start page to start create a new operating environment.

_I_

Create

Step 1: Define operating environment

GENIUS TOOLS Environment Administrator will find the Caddepot and Installdepot
directories automatically if the software is started from a default installation setup.
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Verify the paths for the Caddepot (1) and
Installdepot (3) directories.

Enter a name for the operating environment
(2). The name is used to create a directory of
the same name in the Caddepot and setting
up the directory structure there.

Please note: You can change the name of
an operating environment any time by
renaming its directory.

Select a software version (4) from the
Installdepot.

Create operating environment

OPERATING ENVIRONMENT

Caddepot

\\devleipzig\caddepot o
Mame of operating environment

INNEQ e
SOFTWARE
Installdepot

\\devleipzig\ GTSTARTER\installdepot o
Select software version

11.01.0 o
Send telemetry data

o Activated e

Please note: With GENIUS TOOLS Environment Administrator 11.0.0.0 and newer,
operating environments of versions 10.0.2.0 and older cannot be created. This is due to

the migration to .NET 8.

The button Send telemetry data (5) transmits anonymized telemetry data from GENIUS
TOOLS Starter, Model Processor User and the add-on applications GENIUS TOOLS for
Creo to servers of Inneo Solutions GmbH. The data is collected for the purposes of
troubleshooting and optimizing performance as well as for product improvement and
development (user-centered development and sustainable decision-making in the
development process). See Documentation telemetry data in the help directory. The

environment variable GT_TELEMETRY is set to 1.

Click Next.

Step 2: Configuring license and synchronization server

The users need to connect to GENIUS TOOLS License Manager in order to use a full

version of GENIUS TOOLS Starter App.

Data synchronization allows you to keep all data up-to-date on the local application
computers and give users fast access to any changes.

The synchronization process is adapted to Creo in that it will not update toolkit
applications as long as Creo is running. For this, the toolkit applications, such as GENIUS
TOOLS for Creo, have to be located in the apps directory of Creo Parametric.

Please note: If you do not configure the synchronization settings, Environment
Administrator will create a local operating environment without synchronization.
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Under Source (1), enter the name of the Create operating environment
server that GENIUS TOOLS Starter App

should access to get licenses.

Under Synchronization server settings, the P

server name (2) that has been entered at s locshest [ 1)

setup is displayed. R

Enter the path to the Caddepot netshare (3) = o

of the synchronization server using UNC i — °

paths (\\GTSServer\caddepot), environment ot e o

variables (%GTS_SERVER_NAME%) or a mixed 20 (5 )

form (\\%GTS_SERVER_NAME%\caddepot).

Under Target directory (4) enter the location
where the Cadpool directory should be
located on the application computers. If the
Cadpool directory is not present yet, GENIUS
TOOLS Starter will try to create it. It will also
create a subdirectory named for the
operating environment. You can use
absolute paths or environment variables that
are available on the application computers.

Please note: GENIUS TOOLS Starter App will add the name of the current operating
environment automatically. This makes it possible to copy operating environments, for
example to quickly create test environments without having to change the settings. Also,
operating environments can be renamed without having to change the settings.

Enter the synchronization interval (5) in minutes. The synchronization interval defines how
often GENIUS TOOLS Starter App should synchronize the data from the central Caddepot.
A synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is
changed and on how many GENIUS TOOLS Starter Apps are running at the same time. If
there are many changes to the data, the interval should be shorter. If many users are
accessing the Caddepot, the interval could be longer to avoid too much network load due
to frequent synchronizations.

Click on Create.
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4.3 Adding components to an operating environment

If you want to add components, you first have to install them into the Installdepot
directory from the data setups, see Data setup. With the Add components function you
can then add the following components to an existing operating environment.

For Creo Elements/Direct Modeling:
— TSPRO environment
— SOLIDPOWERPARTS
For Creo Parametric:
— data directories (data packages)
— project directories (directories with configuration blocks and other files)

— Toolkit applications (GENIUS TOOLS for Creo, Ul)

Data packages

Data packages are subdirectories of the data directory, e. g. for Creo Parametric:
<mainserver>\GTSTARTER\installdepot\11.0.0.0\parametric\data\sut_creoT1.

If you add data packages to an operating environment, you will get an operating
environment with standardized templates (start object templates, project-related libraries,
drawing frames, ModelCheck configurations), interface and function configurations for
Creo (config.pro, config.sup, config.ui) as well as many add-on functions for Creo (toolkit
applications).
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GENIUS TOOLS Environment Administrator:
Adding components

caddepot installdepot
\<mainserver>\CADDEPOT \<mainserver>\GTSTARTER\installdepot
[ NameOperatingEnvironment 12.0.0.0
l parametric L parametric
— apps <~ apps
t gtfc N configuration]
\
ui data l
— configuration N gtsa-latest /
* N !
~ /
L projects s K
std_sut_creo12p . GENIUS TOC?L_S e
Environment Administrator
120,00 (GTSA.oxe)

— data
sut creo12

Click the Add Components symbol on the start page to start the installation assistant.

+L]

O

Add Components
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GENIUS TOOLS'™"

Step 1: Select operating environment

First select the operating environment (2)
you want to configure from the Caddepot

(1).

Then select the software version (4) to use
from the Installdepot (3). Select a software
version that has the required components
installed.

Step 2: Add CAD applications

Add Components

1

OPERATING ENVIRONMENT

Caddepot
\\devleipzighcaddepot
Select operating environment

INMEQ | Version 11.0.1.0

SOFTWARE

Installdepot
\\devleipzighGTSTARTER\installdepot

Select software version

11.0.1.0

Here, project components that have been installed in the install depot are selected.

Select the CAD application to which you wish
to add components.

For Creo Elements/Direct:
— TSPRO-Umgebung
— SOLIDPOWERPARTS
For Creo Parametric:

1. Ddata packages

2. projects (directories for standard start
projects)

3. toolkit applications (gtfc, ui)

Components for Creo Parametric

Add Components

2

CAD
CAD application

Crea Parametric

Data packages =

Projects 2

Toolkit Application e

Data packages and toolkit applications are added separately.

Projects can be added together with the data package subsequently as well is in their own.

1. Add data packages and create standard projects
All data directories for Creo Parametric from the previously selected software version in

the installdepot are displayed here, e.g. D:

\GTSTARTER\installdepot\9.0.0\parametric\data.
Select a data package. Data packages in gray are directories that have already been
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copied to the caddepot once.

Enter a target name under which it should be copied in the directory data in the
caddepot. (Caddepot\ <operatingenvironment>\parametric\data.)

The target name can be overwritten.

@ Data packages

Copy MName Target name

o sut_creo10 | INNEC ¢l

v sut_creoll | INNED <17

When selecting a data package, you can in the second step create standard projects
whose settings should be adjusted afterwards in the GENIUS TOOLS Project
Configurator. Here, the supplied standard projects — one standard project per Creo
version with and without Windchill — are copied from the project directory

(Caddepot\ < OperatingEnvironment>\parametric\configuration\projects) under a new
name (target project name).

If a project is grayed out, it means that it has already been copied once. It can be copied
again under new name.

&2 Project directories

Create Project name Target project name | Display name Target display name
v std_sut_creo8p INNEO_c& Creo Parametric 8.0 INMEQ - Crec Parametric 8.0
std_sut_wt_creo8p Creo Parametric 8.0 Windchill
hd std_sut_creo9p INMEO _¢9_2 Creo Parametric 9.0 INMEQ - Creo Parametric 9.0
! Projects that have previously been copied (gray) can be copied again under a new name. |

The target project name is the name of the folder in the project directory and at the
same time the name of the project in GENIUS TOOLS Project Configurator. The display
name is the name that appears in GENIUS TOOLS Starter App. It can be changed in
GENIUS TOOLS Project Configurator.

Projects Creo
+0®m L ®
INNEO - Creo Parametric 8.0 EGENERAL
L Productive version Project name = Project folder INNEQ_c8
- Creo Parametric 9.0 Display name INNEO - Creo Parametric 8.0
Test version o
Information Preductive versicn

’—_ INNEO - Creo Parametric 9.0

Preductive versicn

Project folder

INNEQ_c8

2. Create standard start projects
If the data packages have already been installed, standard start projects can be created
here as in the previous point.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 51



Hn
GENIUS TOOLS Environment Administrator G EN I US TO 0 I.S®. )

&3 Project directories

Create | Project name Target project name | Display name Target display name | Data directory
sut_crea® v

v std_sut_wt_creo9p  INNEQ <9 wi Creo Parametric 9.0 Windchill | Innec - Creo with Windchill sut_cread -

3. Toolkit applications

Select the toolkit application you wish to add.

— GENIUS TOOLS for Creo: Additional functions for Creo Parametric which are included
in the products GENIUS TOOLS Library, GENIUS TOOLS Parameter and GENIUS TOOLS
MBD for ISO-GPS.

— ui: Application that allows reloading multiple customization.ui files.

If it is not possible to tick an application, it means that it already exists in the

application-specific apps directory. The application cannot be created again.

Please note: The toolkit application GENIUS TOOLS for Creo will be automatically
installed to the parametric\apps directory when creating a new operating
environment, if you have purchased the Startup TOOLS product package.

i2i Toolkit Application

Copy | Display name

After clicking Add all specified components are added to the operating environment.

4. Customize data packages
When using Startup TOOLS for the first time, we recommend adapting the supplied data
directory (“data package”). All company-specific data should be adapted, such as

— Startup parts,
— material files,
— drawing frames.

Data directories should be created version-neutral.

If data files are accidentally deleted, they can be copied back from the install depot at any
time, i. e. no backup copies need to be made.

Hint: If possible, always work with variables. A reference to a data directory from a
configuration block is made via the variable scTs pata.

Once a data package has been adapted to company-specific requirements, it must be
manually adapted to newer software versions, see Updating Creo data packages and
resource folder.
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4.4 Updating software

All software setups in GENIUS TOOLS Starter unpack their data to the Installdepot
directory. You can use the Update function of GENIUS TOOLS Environment Administrator
to update the software for GENIUS TOOLS for Creo and GENIUS TOOLS Starter App in the
operating environments. This two-step process allows you to make targeted adjustments
to individual operating environments. You can upgrade or downgrade to any version that
is available in the Installdepot.

If you have configured synchronization, the configuration for the software update will be
made in the background without the users having to stop Creo or GENIUS TOOLS Starter
App. The new software version will then be used on the application computer after the
next synchronization.

If you update GENIUS TOOLS for Creo, the synchronization on the application computers
will only be run after Creo has been closed.

Warning: If you are using network mode, make sure that all users have closed GENIUS
TOOLS Starter App and Creo, as the software cannot be updated otherwise.
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GENIUS TOOLS Environment Administrator:
Updating software

caddepot installdepot
\\<mainserver=\CADDEPOT \\<mainserver=\GTSTARTERJ\installdepot
L NameOperatingEnvironment —9.0.2.0
- parametric —11.0.1.0
apps — 12.0.0.0
gtfc - parametric
- serveronly apps
- software gtfc
| tools serveronly
software
GENIUS TOOLS
Environment Administrator tools
12.0.0.0 (GTSA.exe)

— gtsa-latest

In GENIUS TOOLS Environment Administrator click the Update button to start the
installation assistant.
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Software U pdate
ﬂ OPERATING ENVIRONMENT
_D

Caddepot

\\devleipzighcaddepot o
Select operating environment
INNEC | Version 11.0.1.0 e
Software update soFTwaRe
First, select from the Caddepot (1) the 'nS:::::i:g\GTSTARTER\m”dEth e
operating environment (2) you want to Select software version
configure (1). B0 (4]
Then select from the Installdepot (3) the new U;;;LZ?SZTLZL;?:ZELD
software version (4) you want to install. @D - wiviert
. GEMIUS TOOLS Library/Parameter
Under Update settings (5) you can select the @ cvier
components to update: GENIUS TOOLS MBD for 1S0-GPS
@ Deaktiviert 9
Tools-Verzeichnis
@D ~«tiviert
Freeware-Tools
@ Deaktiviert
Telemetriedaten senden
@D «tiviert

— the software GENIUS TOOLS Starter (component of the Startup TOOLS product package)

— the software GENIUS TOOLS Parameter and GENIUS TOOLS Library (add-on application
GENIUS TOOLS for Creo, component of the Startup TOOLS product package)

Please note: An update does not update the resource folder (gt_resource_folder). This
has to be updated manually, see chapter Update process.

— the software GENIUS TOOLS MBD for ISO-GPS (add-on application GENIUS TOOLS for
Creo)

— the tools directory, which contains GENIUS TOOLS Config Editor and Requirement
Check, as well as

— several freeware products which are located in the Caddepot in the serveronly directory
under tools. (GENIUS TOOLS Comma To Dot, GENIUS TOOLS Flexnet Watcher, GENIUS
TOOLS Material Browser, GENIUS TOOLS Purge, FreeCommander, XML-Import and
others).
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The button Send telemetry data (5) transmits anonymized telemetry data from GENIUS
TOOLS Starter, Model Processor User and the add-on applications GENIUS TOOLS for
Creo to servers of Inneo Solutions GmbH. The data is collected for the purposes of
troubleshooting and optimizing performance as well as for product improvement and
development (user-centered development and sustainable decision-making in the
development process). See Documentation telemetry data in the help directory. The
environment variable GT_TELEMETRY is set to 1.

Under Migration settings (6), you can set whether access restrictions for projects are
transferred when updating to version 11.0.0.0 and newer.

Result: The update process writes a new software directory for GENIUS TOOLS Starter and
updates the database. For GENIUS TOOLS for Creo, the gtfc directory under apps is re-
written. The main.cfg file remains untouched. The directories tools and serveronly\tools are
copied from the Installdepot to the Caddepot.

4.5 Modifying settings

Some settings for operating environments can only be changed using the Modify wizard in
GENIUS TOOLS Environment Administrator. The most important one of these setting is the
Caddepot path. You can also edit synchronization and licensing settings.

Please note: GENIUS TOOLS Environment Administrator only change the standard
settings, that is, the settings for the unit Standard. If you have made individual settings
for a unit or subunit, you have to change these settings using GENIUS TOOLS Project
Configurator (Configuration > Select unit > Synchronization)

In GENIUS TOOLS Environment Administrator click the Modify button to start the
installation assistant.

S
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Step 1: Change license server settings

First, select from the Caddepot (1) the
operating environment (2) you want to
modify.

Edit Synchronization

1

OPERATING ENVIRONMENT

Then enter the license server settings (3). You
can also deactivate the license server (4).

Caddepot
YdevleipzighGTSTARTER\caddepot

An inactive license server will not be used by e

X Select operating environment
GENIUS TOOLS Starter App. This means that INNEQ | Version 110,10
you can only use home-use or educational GENIUS TOOLS LICENSE MANAGER
Creo licenses. Source

TT66@lictriad1;7766@lictriad2: 7766 @lictriad3
Active

la

Step 2: Change synchronization settings

Specify the server path (3) so that it points to
the caddepot on the synchronization server.
The server name (1) is automatically taken
from this information. 2

Edit Synchronization

You can enter a description for the server (2). | *¥NRONEATION SERVERSETTINGS

MName

When Checksum verification (2) is active, a devieipzig
checksum for each copied file is calculated T

and compared to the checksum of the file on | server parn

the server. If the checksum differs, the server Wdevieiprig\caddepot
is queried for the file again. If checksum S
verification is not active, the files will just be
copied.

No

Warning: Activating checksum verification often allows significantly shorter
synchronization times.

If you have moved your synchronization server, proceed as follows:

1. Create a new Caddepot and adapt the synchronization server settings in the new
operating environment there.

2. Test the new operating environment to make sure that the configuration settings are
correct and the synchronization works.

3. In the old operating environment, switch the synchronization server to the new
Caddepot
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a. When GENIUS TOOLS Starter App is restarted, it switches to the new Caddepot and
synchronizes the data from there.

Warning: Please be extremely careful when changing the Caddepot directory in an
operating environment that is already in use on multiple application computers. Wrong
settings can lead to the application computers not synchronizing. However, it is still
possible to change the Caddepot directory when you move a server. Create a new
Caddepot, then set the synchronization path in the old operating environment to the
new Caddepot. The application computers will switch over accordingly.

Step 3: Edit settings for the application computers

You can activate or deactivate synchronization between the central Caddepot and the
application computer Cadpool directories (1).

Warning: If you deactivate synchronization, you permanently separate the application
computers from the Caddepot. Any changes you make to the central synchronization
settings or the operating environment will not be transferred to the application
computers!

Under Target directory (2), specify the
location of the Cadpool directories on the
application computers, where the local copy

Edit Synchronization

of the operating environment is stored. If the 3
Cadpool directory cannot be found, GENIUS | cuentsermines

TOOLS Starter will try to create it. A el ot

subdirectory named after the operating Ta:et srectory o
environment will also be created. You can CAGTSTARTER\cadpool @
use absolute paths such as C: Symehronizetion Intsrval (minutse)
\GTSTARTER\Cadpool, or environment St::[inemwnh - ©
variables that are available on the application I8 (4]
computers, e. g. %GTS_SYNC_DESTINATION Send talemotry data

%, @D Activated o

Under Synchronization interval (3), specify an interval in minutes. The synchronization
interval determines how often GENIUS TOOLS Starter App will synchronize the data. A
synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is
changed and on how many GENIUS TOOLS Starter Apps are running at the same time. If
there are many changes to the data, the interval should be shorter. If many users are
accessing the Caddepot, the interval could be longer to avoid too much network load due
to frequent synchronizations.
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If Start client with Windows (4) is activated, GENIUS TOOLS Starter App will be started
automatically when the operating system is started on the application computers.

The button Send telemetry data (5) transmits anonymized telemetry data from GENIUS
TOOLS Starter, Model Processor User and the add-on applications GENIUS TOOLS for
Creo to servers of Inneo Solutions GmbH. The data is collected for the purposes of
troubleshooting and optimizing performance as well as for product improvement and
development (user-centered development and sustainable decision-making in the
development process). See Documentation telemetry data in the help directory. The
environment variable GT_TELEMETRY is set to 1.

4.6 Create Git repository

GENIUS TOOLS Environment Administrator allows you to connect an existing operating
environment to the version control system Git.

The software for the Git server is supplied with GENIUS TOOLS Starter. Other Git servers
are not supported.

Requirements

— A Git environment must be created on the installation computer, i. e. on the computer
on which the caddepot is located.

— For versioning with Git the service GENIUS TOOLS Gitea must be running. This requires
GENIUS TOOLS Environment Administrator to be started with administrator rights. A
warning message appears if this is not the case and GENIUS TOOLS Environment
Administrator restarts.

— The administrator who creates the operating environment in Git is the administrator who
checks in changes to GENIUS TOOLS Project Configurator.

— The security requirements are met, see Encryption of the Auth file.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 59



Hn
GENIUS TOOLS Environment Administrator G EN I US TO 0 |.S®. )

GENIUS TOOLS Environment Administrator:
Create Git environment

caddepot installdepot Git-Repositories
\\<mainserver>\GTSTARTER\caddepot \\<mainserver>\GTSTARTERl\installdepot http://<installationcomputer>:3000
OperatingEnvironment 1 | ‘I 12.0.0.0 | |—| OperatingEnvironment 3
OperatingEnvironment 2 | 4 git_latest |

OperatingEnvironment 3 | L

~| gts-service-latest |

.git

*l gtsa-latest |
|

GENIUS TOOLS
Environment Administrator
12.0.0.0 (GTSA.exe)

Creating Git environment

In GENIUS TOOLS Environment Administrator click the GIT button to start the installation
assistant.

®

GIT

From the caddepot (1), select the operating

environment (2) you want to connect to Git. Create Git environment

OPERATING ENVIRONMENT

Under Git server (3), the URL address of the —
computer on which GENIUS TOOLS Weviipaghcaddepot )
Environment Administrator is running is seiectopersthg enionnent
displayed. This must be the installation o
computer, see Requirements above. it server

INNEQ | Version 11.0.1.0

Results

On the installation computer

1. The service GENIUS TOOLS Gitea is set up.
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2. The Git server is automatically created with the address
http://<installationcomputer>:3000 and entered as the main server.

On the installation computer in the installdepot

3. The file.auth is created in the directory git_latest. This file should not be readable,
see Auth-Datei.

On the installation computer in the caddepot
4. The hidden directory .git is created in the operating environment.
5. The file GTS_Update.exe is stored in the directory software.
On the Git server
6. Repositories (Git folders) are created on the Git server for each application.
7. Three users are created for Git:

— A user for GENIUS TOOLS Environment Administrator (“Owner”): Is the user from the
auth file.

— A user for GENIUS TOOLS Project Configurator (“Contributor”): Has write access to all
repositories.

— A user for GENIUS TOOLS Starter App (“Reader”): Has read access to all repositories.
In GENIUS TOOLS Project Configurator

8. The Git checkin button in GENIUS TOOLS Project Configurator replaces the previous
Save button in the user menu. This checkin process commits all changes to the
database sut.db and to files of the operating environment.

9. Under Configuration > Settings: Synchronization > Section: Server, the
synchronization type is changed to Git. The synchronisation type can no longer be
changed in GENIUS TOOLS Project Configurator.

10. GENIUS TOOLS Project Configurator cannot be started in network mode.
In GENIUS TOOLS Environment Administrator

11. During a software update, GENIUS TOOLS Environment Administrator recognizes
whether an operating environment is git-versioned and installs the new version in
the repository of the Git server.
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Encryption of Auth file

Once the operating environment has been created in Git,
the file .auth is created in the directory git latest. This file js  nstalldepot > git latest

required to be able to check in to Git. Name ~
The Auth file contains the user name and password of the custorm

global administrator for GENIUS TOOLS Gitea service and data

is stored in encrypted form if all conditions are met. If git

errors occur during the encryption attempt, they are | auth

written into the log file gtsa.log in the user directory. [ gitea.exe

Warning: Save the Auth file in a safe place so that you
can restore the installation environment if necessary.

Check out from Git

After migrating an operating environment to Git, GENIUS TOOLS Starter must be restarted
on user computers.

For an initial installation of GENIUS TOOLS Starter, start the EXE file GTS.exe on the
application computer.
Path: \\<mainserver>\gtstarter\caddepot\ <operatingenvironment>\software\gts.exe

Check in to Git

With GENIUS TOOLS Environment Administrator the following changes are made on the
installation computer: Adding components, Updating software and Modifying settings.
These are checked in automatically.

Warning: The following applies to git-versioned operating environments: All changes
made on the user computer that have not been commited into Git are discarded when
executing a function in GENIUS TOOLS Environment Administrator.

On the user computer, changes are made in GENIUS TOOLS Project Configurator
(database sut.db) and in configuration and batch files, which must be checked in with
GENIUS TOOLS Git Utility.

All information on check in can be found in the chapter Connecting operating
environments to Git.
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9 GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator is the central application for configuring operating
environments. Use GENIUS TOOLS Project Configurator for managing all project and
operating environment settings.

A Starter project combines specifications that are made in GENIUS TOOLS Project
Configurator, namely

— the program to be started,
— the required licenses,

— the project directory and
— the associated data,

with configuration settings that can be made in the configuration levels using manually
created configuration blocks.

It can be selected by users in GENIUS TOOLS Starter App and starts with locally available
data and the configuration settings defined centrally by the administrator.

Project Configurator manages project information by modifying the central sut.db
database.
.\caddepot\<operatingenvironment>\configuration\database.

The project configuration for each operating environment can be synchronized to the
Creo application computers. The storage location is:
.\cadpool\<operatingenvironment>\configuration\database.

Please note: Make sure that Project Configurator has write access to the central
database in the Caddepot so that it can store configuration settings.

Project Configurator is not synchronized immediately. When you make changes in Project
Configurator, you have to save them to the database before they become available to
GENIUS TOOLS Starter App.

5.1 Starting GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator can be started both from the caddepot, i. e. from the
installation computer, as well as from the cadpool, i. e. from any synchronized application
computer:

— Installation computer: <caddepot>\<operatingenvironment>\software\GTS.exe

— User computer: cadpool>\<operatingenvironment>\software\GTS.exe
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In both cases, Project Configurator accesses and edits the same central database sut.db in
the caddepot. See also the chapter with Important terms.

There are two ways to start Project Configurator:

Starting via GENIUS TOOLS Starter App
— Open GENIUS TOOLS Starter App with the GTS.exe file.

— In the user menu 3, select Project Configurator or press F8.

Reset window size
Entry in the user menu of

L‘t GENIUS TOOLS Starter App

Bxit
{03 /

Project Configurator (F8)

(O Last synchronization: 03.07.2024 09:17:21

User menu in GENIUS TOOLS Starter App

Please note: The menu item Project Configurator in the user menu can be hidden for
users so they cannot access Project Configurator. See Assigning function access rights.

Starting with start parameter -gts:admin
— Start Project Configurator directly in the command line with

<cadpool>\<OperatingEnvironment>\software\GTS.exe -gts:admin OF

<caddepot>\<OperatingEnvironment>\software\GTS.exe -gts:admin

Please note: The start parameter -gts:admin cannot override any access restriction for
the Project Configurator.

— You can call up GENIUS TOOLS Project Configurator directly via the GENIUS TOOLS
Starter desktop shortcut by specifying the start parameter -gts:admin under Properties >
Shortcut in the target entry line.
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. A" GTS.exe - Shortcut Properties

GENIUSTOOLS 5
INMNEC -
" GENIUS TOOLS Starter INNEQ

Tarpettype:  Application
Target locabon: softwane
Target: [RTERmdpudx.|NMEowv¢m~ﬁ73m]

Siatin |c-\GTsTmTER\cadpoct~xnueo-aahw|

Shortout key: | Nane

Fun Mammal window

Comment

Open File Location Change lcon .. Advanced,

Direct call up of GENIUS TOOLS Project
Configurator (from cadpool)

Login

If a system other than Windows is selected for authentication, a window for entering login
information appears, e. g. Windchill. See chapter Authentication.

Operating environments without version control

Lock file

When opening GENIUS TOOLS Project Configurator, a lock file is written to the database
directory, which is deleted again when closing the application.

Path: caddepot\ <operatingenvironment name >\configuration\database

Please note: Make sure to close GENIUS TOOLS Project Configurator with the exit
function to delete the lock file.

Read-only mode

To avoid that several users can make changes to the database of GENIUS TOOLS Project
Configurator the application can only be used by one person. All other users can open the
application in read-only mode and receive a note about the user who has accessed
GENIUS TOOLS Project Configurator.

If you cannot open GENIUS TOOLS Project Configurator in write mode and no other user
is working with it, delete the lock file.
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Operating environments with version control system Git

Changes in the caddepot cannot be checked into Git, so GENIUS TOOLS Project
Configurator cannot be opened on the installation server.

When starting GENIUS TOOLS Project Configurator from an operating environment that is
versioned with Git synchronization is automatically paused.

There is no read-only mode. GENIUS TOOLS Project Configurator does not write a lock file.

Warning: All users who are allowed to start GENIUS TOOLS Project Configurator are
contributors and can check in changes to Git. Therefore, make sure that changes to the
operating environment are not made by several users simultaneously. This can lead to
merge conflicts during check-in.

Detailed information can be found in the Connecting operating environments to Git
chapter.

5.2 User interface and navigation

GENIUS TOOLS Project Configurator opens on the Configuration page of the main menu.
Here, you can manage global settings or settings specific to units.

The main menu (1) is located on the left side of the Project Configurator window and can
be extended to show descriptions by clicking the menu symbol ——. It gives access to the

pages:

3 Organizations
Configuration
Projects

Project collections

Resources

e EE S

Satellites

When entering the settings, you will find a help section (4) on the right side of the
window, which guides you through the individual input steps. This can be opened and
collapsed with the arrow symbol.

The user interface can be displayed in a light and a dark color variant.
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EE NNEQ GENIUS TO URATOR 12.0.0.0 - o
— i - STANDARD
= Settings Units @ ® o
~ AUTHENTICATION
& E
=B HELP A
a Authentication provider Windows-Benutzer (Defaull) ~ ~
&5 GENIUS TOOLS 4 Standard The general settings of GENIUS TOOLS Starter App as well as the
Starter App ~ DESKTOP LINK application which are started wit it, are defined here. Define settings
@ 2 DRI globally in Standard or select the relevant unit. Units are created in
Additional 4 Berlin Create desktop link D - the menu item Organization.
Language ,
0 Consmiction Name GTS INNEO Please note: If an input field inherits values from the higher-level
Theme » ¥ Llight  cturing . configuration levels, you will still only see the global default value
Execution path CAPTCTEMP ) EEED
Dark N
*MLimport - Commandiine arguments gray.
iamburg
@ XML-Export 3 Simulation Unit argumertt ~gtswnits=1 Authentication - Subscriptio
4 Leipzig A GENERAL Authentication provider
oo [— An authentication provider is an executable file that requests or
g8 Hide support Nein = receives user data from an authentication system,
i Development
0 ynchronize now (F6) E e The user who changes the authentication provider is autematically
4 Schweiz v
e EEZ) saved as member of the Administrator role. For this purpose, the new
4 Britisellen Log projects without permission . credentials are requested before saving the database.
The authentication system is set globally, i. e. in the Standard group,
Help 3 Construction Write crash report to caddepot directory > for opening GENIUS TOOLS Starter App and GENIUS TOOLS Project
Manufacturing PN EROIECTS Configuratar
) 4 Unites Kinadom Windows user (defautt): Users open GENIUS TOOLS Starter App
Reset window size 9 P with their Windows user names. There is no separate login process.
4 Edinburgh = Auth_Windchill.exe: Users enter their Windchill username and
Exit [Ee— Display invalid projects R . password. The required authentication provider Auth_Windchillexe
77 2, als Fehler is available
Simulation Project language selectable = . Other providers: All executable files located in the system )
Starter App (F8) 4 Stratford-upon-Avon e DROECT OB directory auth_provider are displayed.
§ 3 O 25062024 10:13:18

User interface of GENIUS TOOLS Project Configurator in light color theme

Please note: Note that GENIUS TOOLS Project Configurator — in contrast to previous
Startup TOOLS versions — does not save changes immediately. All modified settings
only become active after clicking Save. Before saving, changes can be undone by
selecting Revert changes in the user menu.

At the bottom left of the sidebar (2) is the function Save database 2] - or for git-versioned
operating environments the function Git checkin 1 as well as the user menu. The footer
(3) contains information on database and synchronization modes. The various menus are
explained in the following chapters.

9.2.1 Main menu

9.2.1.1 Organization

The menu item Organization &2 is used to manage roles and their access rights to
projects, functions, and units.

Access tab

The Access tab lists restricted projects (1), which determine project access based on their
position in the project permission tree (2), see chapter Restricting project access.

Project access is determined via roles (3). Members are assigned to a role in the Details tab
(4), either as static (GTS) or dynamic (LDAP) entries.

Access rights for GENIUS TOOLS for Creo and GENIUS TOOLS Starter App functions are
defined in the Function access tab (5) based on the role to which they belong.
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GENIUS TOOLS'™"

G NNEO GENIL - o
= Access Organization Details 5 @
Projects ° Permissions @
5!?: — ~ GENERAL
4+ W+ E &
Role name Key User
t%‘ CREOQ PARAMETRIC 4 Standard global settings
a Description
X 42 Administrator free role
I " =
M Model Processor 11.0 ~ USERS (GTS) static user entries
Creo 11.0 - Testprojekt
4 Deutschland unit MEMBERS
. APPS 4 Berlin subunit 1 + .....
() GENIUS TOOLS Material <) EEmhrEim subunit 2 User name GTS alias Email
Browser [@ Creo Parametric 8.0
Q 4 %8 CAD-Testgruppe 9 efoster E. Foster im
Roles o I Creo 11.0 - Testprojekt gmueller G. Miller imj]
I E M GENIUS TOOLS Material Browser wheisenberg W.Heisenberg ]W
Development sholl SHoll [
& GTfC Admin ) REr Jturner JTurner imj
Construction
~ COMPUTERS (GTS) static user entries
20 Simulation - -
Key User ~ USERS (LDAP) dynamic user entries
4 Leipzig
LoAP
. . Development
&
S Manufacturing (3 LDAP query Comment
22 users Berlin Ches
4 Britisellen

04.07.2024 13:11:03

Units tab

Units are created and managed in the Units tab, which you can use to map your
organization in different levels and sub-levels. Read chapter Mapping an organization for
detailed information on working with units.

Organization
~ CROSS REFERENCE
+ i mEE
6_:_& Path Standard / Deutschland / Hamburg / Construction
COUNTRY 4 Standard Standard / Deutschland / Berlin / Construction
@ 4 Deutschland Standard / United_Kingdom / Stratford-upon-Avon / Construction
g Deutschiand Berli ~ UNIT
4 Berlin Unit
‘Construction tree Name Canstruction
“ Schweiz
Development Description
9 4 Hamburg )
L United_Kingdom Unit type Department -
a Construction

Please note: Users with permanent licenses can create unlimited number of units, but
are limited to two layers. If you want to work with more layers, you need a subscription
license.subscription license. There will be a warning when creating a unit for the first time
after a license upgrade.

9.2.1.2 Configuration

Use the Configuration page & to manage global settings as well as settings specific to
units and subunits. The Settings list contains several buttons which open the settings pane
and the corresponding help page.
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EE "ROJECT CONFIGURATCR 12.0.0.0
= Settings Units @ STANDARD & = © CONSTRUCTION (@)
= ~ | | A AUTHENTICATION
| )\
Authentication provider Windows user (default) - Windows user (default)

ah GENIUS TOOLS ) S

Starter App ~ DESKTOP LINK

4 Deutschiand

@ Additional 4 Berlin Create desktop link Yes - -

environment variables
Name GTS Inneo GTS Inneo

Synchronization Manufacturing Execution path o =
Simulation

GENIUS TOOLS s Commandiine arguments

License Manager §
@ Simulation U Berrent gtsunits=-1 ~gtsiunits=12427

Network connections 4 Leipzig ~ GENERAL
% Construction R o . .

Creo Parametric Development N

uppor
4 Schweiz
Creo Elements/Direct ) EREeEn Log projects without permission .
Modeling -
Selecting ion Write crash report to caddepot directory | Configuring | .
(2] ~ PROJECTS

Dialog window Configuration

Select a unit to show the settings applicable to this type of group. The Standard unit is
used for managing global settings and cannot be deleted. In a newly created database,
only this unit will be available.

Units are manged in the Organization page in the Units tab.

For more information on the individual settings, please refer to Configuring global
environments and Configuring heterogeneous environments.

9.2.1.3 Projects

In the Projects page Y you can create and configure projects for the supported CAD-
applications as well as projects of other applications (“Apps projects”).

Projects can either be made accessible to all users or to a defined group of users, see
Restrict project access.

EE’ NNEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.00 X
— Application types Projects Creo tabs fiir settings @
+ O 1T 12 ®
i . Creo Parametric 9.0 ~ GENERAL
Creo Parametric
Creo 8 - INNEQ Project name project_creoOp_de
@ afgef_‘fmemm‘fm . Creo Parametric 10.0 B ag Display name Creo Parametric 8.0
in
o Creo Parametric 10.0 R
i access- Description Creo 9 - INNEQ
SolidWorks . restricted _
. Sreolpjrarnemc 11.0 projact Project image gtspr.creod._sutpng o
e1iaste Version

Projects page for Creo Parametric

For a selected project, the corresponding tabs are displayed for inputting settings, e. g. for
Creo Parametric the tabs Creo, Start, Windchill and Environment. For information on how
to create projects and define their settings, please refer to Creating projects.

Projects without an available license can either be hidden from the user's view in GENIUS
TOOLS Starter App or can be marked with a warning color, see chapter GENIUS TOOLS
Starter App.
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9.2.1.4 Project collections

In the main menu item Project Collections [=. you can
organize individual projects into project collections, which
are displayed to users in GENIUS TOOLS Starter App.

Project collections
+
There are company-specific project collections, which can R
contain any projects, as well as application-specific project
collections, which contain all projects of an application.
Consult the chapter Project collections.

‘B Project Archive

iti i i i, . Creo P i
In addition, the display of auto projects can be modified reo Parametric

here. I &, Creo Elements / Direct

“=s Modeling
Auto projects are Starter projects of an application for

which only one project can be created. This project will be
automatically created by GENIUS TOOLS Starter App with
the latest available software version on the user computer and will be displayed with an

icon of the application.

P Apps

Auto projects are generated from the following applications: Creo Elements/Direct
Drafting, Creo lllustrate, Creo Schematics, Creo View, GeomagicDesignX, Keyshot and
MathCad.

Please note: Auto projects are only available with a subscription license.

5.2.1.5 Resources

In the Resources page (&) different types of resource are created in order to work efficiently
with GENIUS TOOLS Project Configurator. Resources are entries for users and computers,
as well as startkeys and license servers for Creo applications. Please read the chapter
Resources.

5.2.1.6 Satellites

In the Satellites page = you can set up and monitor additional synchronization servers.

A satellite (also: synchronization or mirror server) is a computer or a sector of a computer
onto which the state of one or more operating environments of a central main server is
mirrored by data synchronization.

Please read the chapter Working with satellites.

9.2.2 User menu

To access the user menu, click on the gear symbol {23 in the side bar.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 70



GENIUS TOOLS Project Configurator GENIUS TUULS®;=

Language: user interface language

You can switch the user interface language between English, German and French at any
time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set
to German. For all other locale settings, the software first starts with an English user
interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at
any time. The theme setting is saved and will be used the next time you start the software.

XML Import

You can import users and computers from an XML file. If the users or computers are
assigned to a role that has not yet be configured, the role will also be created during the
XML import. When you click XML Import in the user menu, a dialog for selecting the XML
file is displayed.

XML Export

You can export users and computers into an XML file, for example in order to make batch
changes quickly, then re-import the file.

Revert changes

Project Configurator does not save changes immediately, so you can revert any unsaved
changes. If you do so, Project Configurator reloads the database and re-initializes all input
fields.

To revert changes, select Revert changes. A warning dialog is displayed. Confirm the
warning (Reload database. Changes will be deleted.) with Yes.

To save changes, click Save L2]in the sidebar.

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of
the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting
Pause synchronization is saved for the next start and marked by a yellow bar below the
header. When the user resumes synchronization, they are asked whether they want to
resume and overwrite local changes.
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Pause synchronization if you want to prevent local changes from being overwritten until
they have been added to the Caddepot by your administrator.

Please note: Your administrator defines whether you can pause the synchronization. If
you are not allowed to pause the synchronization, the item Pause synchronization is not
displayed in the menu.

Help

— Help (F1): Software manual for GENIUS TOOLS Starter, which corresponds to this
document.

- Support: Contact details for the technical support of INNEO or a company-specific link
which can be set up in GENIUS TOOLS Project Configurator. Inneo's support can be
reached by email, telephone and with Teamviewer.

- Info (F12): Current GENIUS TOOLS Starter version.
- Reference card: Quick overview of the functions in GENIUS TOOLS Project Configurator.

- Parameter variable: List of start parameters and environment variables.

Reset window size

Restores the default size of the dialog window of GENIUS TOOLS Starter. The window can
be adjusted to all sizes.

Switch user - only visible with an alternative authentication system

Switches to another user of the applied authentication system, e. g. Windchill.

Exit
Closes the software. Clicking on the Close button (X) in the header will minimize the
program window.

Starter App
Switch to the GENIUS TOOLS Starter App.

9.2.3 Save changes

Operating environments without version control

Save changes made in the GENIUS TOOLS Project Configurator using the function Save
Database [2]in the sidebar. The changes are saved in the database sut.db on the
installation computer. Path name:

\caddepot\ < OperatingEnvironment>\configuration\database

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 72



GENIUS TOOLS Project Configurator GENIUS TUULS®;=

Before saving to the database, changes can be discarded in the user menu 3 via Reverse
changes.

Changes to files of an operating environment, e. g. configuration blocks and batch files,
must be made in the caddepot (installation computer). If you want to edit files locally in
the cadpool and copy them manually to the caddepot, do not forget to pause the
synchronization. Synchronization can be paused in the user menu of GENIUS TOOLS
Starter App.

Git-versioned operating environments
Clicking on the Git checkin button £1in GENIUS TOOLS Project Configurator
— saves changes in GENIUS TOOLS Project Configurator to the database sut.db and

— opens GENIUS TOOLS Git Utility, which is used for committing all changes to Git, see
chapter GENIUS TOOLS Git Utility.

In a git-versioned operating environment, all changes — e. g. to the database sut.db and to
files — are made on the user computer, i. e. the computer on which the cadpool is located.
These changes are checked into Git using GENIUS TOOLS Git Utility.

Changes to configuration blocks and batch files can therefore be checked locally before
they are checked into Git.

Synchronization is automatically paused when opening GENIUS TOOLS Project
Configurator. Pausing synchronization must be ended in the GENIUS TOOLS Starter App
user menu.

If GENIUS TOOLS Git Utility is opened, you cannot edit settings in GENIUS TOOLS Project
Configurator, however, GENIUS TOOLS Project Configurator can by opened by multiple
users, as no lock file is written.

Warning: All users who are allowed to start GENIUS TOOLS Project Configurator are
contributors and can check in changes to Git. Therefore, make sure that changes to the
operating environment are not made by several users simultaneously. This can lead to
merge conflicts during check-in.

More information on versioning with Git can be found in chapter Connecting operating
environments to Git.

5.2.4 Footer

The footer in Project Configurator contains the following information.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH 73



GENIUS TOOLS Project Configurator G EN I US TO 0 I.S®;=

26.06.2024 11:10:33

Database mode Synchronization

Subscription ?_ \\devberlin\caddepot\INNEO {35 ms)

[@ chgtstarter\cadpool\INNEOQ  Interval: 360 min

Synchronization method Service

Data base mode
The state of the database is displayed in the footer:

Database requires a subscription license. Projects cannot be started when working with
a permanent license.

(P) Database has been created with a permanent license. It can be accessed by both
permanent and subscription license.

Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is
displayed. For more information, please refer to Procedures and synchronization.

Q Synchronization is active
Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to
the local operating environment as a tooltip.

Synchronization inactive
The synchronization of toolkit applications is paused as long as Creo is running

Local operating environment
There is no synchronization; you work on a local directory

T=! Network mode
There is no synchronization; you are working directly on a network directory.

T Network not connected
The network directory cannot be accessed.

Running applications

If a supported desktop application is running, the application icon will be displayed in the
footer, e. g.

Creo Parametric

l% Creo Elements/Direct Modeling
Messages

— Red = Error message. Please troubleshoot.
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— Yellow = Warning message. Please decide whether you want to keep on working
regardless.

— Green = Last synchronization run was completed without errors.

— Green / Creating shortcuts: This message shows that the desktop link for GENIUS TOOLS
Starter App has been updated.

5.3 Organizational structure

In the Units tab of the menu item Organization iy you can create units and build an
organization tree that maps your organization in various units and sub-units.

Settings for the units created here are made in the menu item Configuration, see Unit
settings.

9.3.1 Working with units

The purpose of a unit is to group users into one configuration layer and apply unit-specific
settings. Units are typically used to reflect an organization's structure such as company
departments or sites.

A unit is part of the role-based authorization system, i. e. users are first assigned to a role
and the role is assigned to one or more units. Thus, a user can belong to more than one
unit. In this case, display and settings of projects depend on the unit selection, see next
chapter Displaying units in GENIUS TOOLS Starter App.

The affiliation of users to a unit can be dynamical. In this way, units always reflect the
current staff list and company organizational structure as configured for Windows user
management. If a user quits a company department, their Windows user account is
configured accordingly, and the user is automatically removed from the corresponding
unit. User assignment does not have to be updated manually. See chapter Accessing
Windows user management.

Please note: To allow a transition phase between managing users and computers
individually and managing them via LDAP queries, users and computers can still be
manually assigned to a unit. However, this is not the recommended procedure for using
units.

9.3.2 Creating units

Units are created in the Organization a5 page in the Units tab. Click the Plus button to
define a new unit.
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Oo WJRIEY (2 E K TN S PROYEE
[]° NMMEO GEMNIUS TOOLS PROY
= Units Organization
I ®E®
Standard
[0 - Create unit new dialog
— MName
e
Norway o
s LInit type
- Country e * type or select
Tag ID
- . @
norway
Roles
Everyone o
Description o

In the following dialog fill in the input fields. Except for the name of the unit, you can enter
all settings later when selecting the unit.

Name (1)
Enter a name for the unit. This is the name displayed to users in GENIUS TOOLS Starter
App.
Unit type (2)
Unit types are free generic terms used for clarity in a complex organizational structure in
GENIUS TOOLS Project Configurator. Type in the field to create a new type or select an
existing unit type. Entering a type is optional.

Last: Places a unit as last subunit in each path, see chapter Mapping an organization.

Tag ID (3)
Define the tag ID for the unit. This is optional, see chapterUsing unit tag IDs.

Role (4)

A unit always has to have a role assigned. A unit is part of the role-based system of
granting access rights. This means that firstly a role has to be defined with a group of
users. (Menu item Organisation & > Access tab > Roles.) A role is then assigned to a unit.

You can edit the role for a unit at a later point in time in the Definition section.
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Description (5)

Entering a description is optional. It is displayed in the tooltip of a unit.

Result:

The newly created unit appears as a new item in the Selection column with the default unit
icon ). You can replace this icon with your own images, such as flags, see Displaying
units in GENIUS TOOLS Starter App..

(S Morway — standard symbol of a unit

images in _Images directory

i’} United Kingdom //

You can now use the unit to map your organization.

Please note: Creating a unit GENIUS TOOLS Project Configurator does not create a unit
directory.

9.3.3 Mapping an organization

Units offer a wide range of options for mapping the structure of a company, since the
settings for a unit can be made at several configuration levels.

Basic structure

If all units are organized in one level, no adjustments are needed in the organization tree.

= Units

Organization -
» CROSS REFERENCE
+ i L MR E®
EIE Path Standard | United_Kingdom &
LI e 4 Standard v UNIT
‘%4 @ . Deutschland ~ DEFINITION
s = Breakpoint
Switzerland ¥ USERS (GTS)
COUNTRY United_Kingdom
— ' Deutschland
P PN

Units tab in menu Organization with three units

Sorting units

Units are ordered alphabetically. Within a configuration level, you can place a unit in the
first position by inserting a space at the beginning of the unit name, e. g. " Switzerland".
This will also be applied to the display in the GENIUS TOOLS Starter App selection field.
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Subunits for complex organization structures

A subordinated unit is called subunit. Units can represent multiple configuration levels,
e. g. they can be arranged by region, country, location, city etc.

Please note: Users with subscription licenses can create infinite layers for units. Users
with permanent licenses are limited to three layers.

Example: You want to define settings for the Construction team, which is located in two
locations. The organizational structure could look like this. The unit Construction was
created with the unit type Department.

GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0
= Units Organization 2
 CROSS REFERENCE
+ I i mEe
EIE Path Standard | United_Kingdom / Stratford-upon-Aven / Censtruetion @&
COUNTRY 4 Standard Standard / United_Kingdom / Edinburgh [ Construction <@
A UNIT
;@4 - b Deutsehland —————
b Switzerland Name Construction
[ — 4 United_Kingdom Description
DEPARTMENT 4 Edinburgh
Unit type Department M
T ﬁ Construction ! . Blocked @ Mo
@ = Stratferd-upon-Avon  DEFINITION
h@ Manufacturing Construction v USERS (GTS)

Development
5 Simulation

Manufacturina
Unit tree with subunits

Designing the organization tree

All units are displayed on the right of the dialog Organization. You can select a unit there
and drag it to the desired position in the organization tree. The following applies:

— Dropping a unit under a unit automatically creates a subunit.
— A unit can be used several times in different levels.

— A unit cannot be subordinate to itself.

= Units Organization & @
A CROSS REFERENCE
+m QUEcs
53?, Path e Standard / Deutschland / Hamburg / Construction @
BREAKPOINT 4 Standard Standard [ Deutschland | Berlin { Construction @
A UNIT
iy 4 Deutschland izati
h i Organization
’é‘ @ Breakpoint 9
28 .
4 Berlin tree Name Eonstiuction
COUNTRY o Copshctoy Description
Manufacturin
» y = ]
Deutschland 4 Hamburg
) Country
; 4 Leipzig Tag ID / unit directory =t
E + United_Kingdom Manufacturing Testunit
P Role Canstruction -
DEPARTMENT o
4 Britisellen 2 USERS (GTS)
I ﬁ Constructiol 75Imulallun MEMBERS
4 United_Kingdom Search
e, ven, : 4 User nam GTSalias | Email
@ Construction
Drag-and-drop unit | i\ﬂm‘ﬁgﬁ%ﬂ
3 g nto position i:the - Stratford-upon-Aven | efoster ERES I
7 or ree ! G. Millle i

Positioning unit "Construction" under unit "Stratford-upon-Avon"
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Unit type (1)

For having a better overview of all units in the left Selection column it is useful to subdived
them into types. In this example: Country, Department and Location. See next chapter Unit
types > Grouping units.

Control icons (2)

Waste bin [1]
Removes the selected unit from the organization tree. The unit is not deleted.

Plus symbol =
Expands the organization tree showing all subunits.

Minus symbol =

Collapses the unit tree to the first layer.
Eye symbol &

Hides units of the type Last in the unit tree.
Search &\

The unit tree opens up to the layer of the unit you are looking for. Enter at least three
letters.

Cross Reference (3)

All parent folders containing the selected unit are listed here.

A unit can be hidden from display in GENIUS TOOLS Starter App by deactivating the eye
symbol @, see Invisible units.

9.3.4 Unit types

By default a new unit is created on the left-hand side of the Unit tab under the term Unit.
You can, however, create your own unit types to improve clarity.

The predefined unit type Last is available for selection to create a unit as the last subunit in
the unit tree.

The special unit Breakpoint can be used for test purposes.

Please note: The conversion of a unit to Last does impact the organizational structure.
Sorting units into self-created generic terms has no influence on the organizational
structure.

Grouping units with self-defined terms

For better clarity in a complex organizational structure, you can generate generic terms
under which units are to be grouped, e. g. Country or Location.

Create a new generic term by typing into the Unit type field when creating a unit (1) or
when selecting an existing unit (2).
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Organization

Create unit e

b Deutschiand
b Schweiz

_ Name
Mame T .
Unit type

United Kingdom
Lnit type

Country typeterm here -~

T: Last
Department
Ry Location

The new term appears in the left-hand column of the unit tab and joins the existing terms
alphabetically.

Pre-defined type "Last"

Settings made in the last unit therefore always apply to the role members of this unit
regardless of which path a user selects in GENIUS TOOLS Starter App.

If you select the predefined unit type Last, the unit is automatically placed at the end of
each path, i. e. it cannot be dragged and dropped into the organization tree. Last unit are
by default set to be invisible to users in GENIUS TOOLS Starter App. Invisible Last units
correspond to the functionality of the user and computer groups which were removed in
version 11.

The following applies to last units:

— Existing units can be changed to last units if they do not contain any subunits or if they
contain last units only.

— If several last units are created, all last units to which a user is assigned to are available
for selection in the GENIUS TOOLS Starter App.

— If a user has access to several invisible last units, GENIUS TOOLS Starter App selects the
first last unit in the unit tree.

— If several last units are created, all Last units to which a user is assigned are available for
selection in GENIUS TOOLS Starter App.

— To increase clarity in the organization tree, last units can be hidden with the eye symbol
.
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g8 NN T o 0 —
= Units Organization © @
A CROSS REFERENCE
4 M EE[@}—] hideaniast
:5‘!?; units in tree Path Standard / Greo on E: ®
BREAKPOINT 4 Standard Standard / Deutschiand / B Constructio E &
@ 4 Deutschiand De Bariin { Creo on E:
@ JESy—— =
4 ki De Berlin / Developme E &
s 4 Construction . ot =
= Creo on E
_ o e ®
2 & ceoonen  ——— 4 Development
=2 o ®
e Lel
F—+  =creconEn =
onE
e COUNTRY —» &®creoonEd =
’ Deutschland 4 Leipzig =
E 4 Coenstruction
“‘ - & Creo on B onEl ®
Switzerland
—  &CreoonE\ &
'§= United_Kingdom I ~ UNIT &
== 4 Switzerland
DEPARTMENT 4 Brotisellen
— & CreconEy Description Drive E units hidden in
ﬁ Construction |—» & Creoon E\ GENIUS TOOLS
Unit type Starter App
4 United_Kingdom
@ Development P —— Blocked
4 Construction ~ DEFINITION
LOCATION
- & Creoon B Tag ID / unit directory
o i 4 Development
w Berlin P Role
—=  ®CreoonEl
= ~ USERS (GTS)
Brittisellen ——*™ ®CreoonE\
—— & CreoonE\ MEMBERS
% Hamburg L ®creoonEn
(Wl c\gtstarter\cadpoolINNEO\configuration\database\sut.db

Creating unit "Creo on E:\" as last unit
Example: Last unit for users with different path settings
Create a unit for users for whom the Cadpool is to be set up on drive E of their computers.

1. Create a role with static user entries in the Organisation g2 > Access tab menu item,
e. g. with the name Drive E users.

2. Create a unit in the Unit tab, e. g. with the name Creo on E:\.

3. Select the unit type Last, either in the Create dialogue or afterwards in the Unit
section.

Result: The unit Creo on E:\.

— is created as a unit of type Last %) in the Unit column on the left,
— is added as last unit of every path in the organization tree and

—is hidden in GENIUS TOOLS Starter App, see eye symbol & in the Cross reference
section.

4. In the Configuration & menu item, go to the settings for Synchronization.
5. In the unit tree select the unit Creo on E:\ of an arbitrary path.
6. Enter the following in the General area under Target directory: e:\gtstarter\cadpool

Result: The path with drive E applies to all members of the role Drive E users, regardless of
which unit they select in GENIUS TOOLS Starter App.

7. Optional: For better clarity in the organization tree, hide all last units with the eye
symbol ©.

8. Save changes.
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Special unit: Breakpoint

Administrators can use the breakpoint unit &4 to test settings from GENIUS TOOLS Project
Configurator and from configuration blocks for a specific path. The breakpoint unit does
not have any settings, so when this unit is added to the unit tree, the settings up to the
unit above the breakpoint apply.

The breakpoint unit cannot be renamed or deleted and it is not displayed for the

configuration settings in the Configuration page.

Usage:

— Administrators can create the Config.pro file that is valid for the selected project at the
breakpoint with the button Create config.pro in the Config tab of GENIUS TOOLS Starter
App.

— Administrators who are members of a Last unit can use it to test settings that do not
apply to the Last Unit.

Hint: We recommend creating a separate role for the breakpoint unit or using the
administrator role.

= Organization

+ i A ]E @ @ i& United_Kingdom
E!E iﬁ Stratford-upaon- — - INN
BREAKPOINT A GErEm fven 2B crea
Breakpol &=, Breakpoint
.%4 @ . b Deutschland
I =g Preakpont b Switzerland pavorites j Construction
EEI: COUNTRY <) W LR DesignPr evelopmen
drag-and-drop 4 Edinburgh ' X @ Oevcorment
‘ Deuts '"::'To unft freg Simulation s
4 Stratford-upon-Aven Breaprint under unit
Ol | A svitzerand | Breapomt | "Stratford-upon-Avon" and
Ci i . .
% Preeen selection in GENIUS TOOLS
E i United_Kingdom Development
Starter App

Warning: When selecting Breakpoint, Starter projects may not work correctly because
necessary settings are missing, e. g. the variable GTS_UNIT_NAME.

9.3.9 Assigning unit directories

A unit can be used with or without a unit directory.

Working with unit directories offers extensive possibilities for configuration, as a unit
directory can contain the following files:
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— configuration blocks
— PSF files (Creo startkeys)
— batch files

Creating a unit directory

A unit directory is created manually as a subdirectory in the system directory units of an
application.

Caddepot\ <operatingenvironment >\ <application >\configuration\units\ < unitdirectoryna
me>

The name of the unit directory does not have to correspond with the name of the unit that
is created in GENIUS TOOLS Project Configurator. Different names for a unit and a unit
directory can be advantageous when working with subunits, i. e. for a better overview of
the call hierarchy of settings.

Selecting a unit directory

You can enter the name of the required unit directory in the Create Unit dialog or select it
in the field Tag ID / unit directory in the Defintion segment in the Organization menu item.

5 . . 4 | | « configurati... > units » v
Units Organization @
~ CROSS REFERENCE Organisieren ~  Neuer Ordner
-+ [ NEE v UNIT ~ -
Na
~ DEFINITION Schnellzugriff
COUNTRY 4 Standard o scheliugr Images
‘ E— neu:smlann Tag-ID / directory Deutschland .__\-#_Dim‘pT_\ berlin
eutschlan Downl
b Bertin - Users DE E & DownlozdE Deutschland
Software
) b Hamburg BUED hamburg
“ Switzerland Schweiz
b Leipzi
i MEMBERS manufacturing
4 Schweiz 5
-55 United_Kingdom > Search product-engineering

Selecting a unit directory in the Organisation menu item

When a directory is selected, its name becomes the unit tag ID.

9.3.6 Deactivating units

Blocking a unit in the Project Configurator is useful if you wish to disregard the
configuration for this unit without deleting the unit, e. g. during tests.

To do this, go to the Name/Members area and activate the radio button Blocked. The
name of the unit will be crossed through.

Organization o

¥ CROSS REFERENCE

+ W ]E |—E @ A ~ UNIT
BREAKPOINT 4 Standard Name Deutschland
counTRY pescrtion SancortDE
‘ D i Unit type Country -
Beutschiand b Hamburg
b Leipzig | Blocked m Yes
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You can also block individual users or computers without locking the entire unit, see the
section Blocking individual users or computers.

9.3.7 Using unit tag IDs

A unit tag ID is an additional textual marking in a configuration block (Config_*.pro file)
that defines a unit and limits the validity of the block to it.

Unlike configuration blocks that are located in a specific Unit folder, configuration blocks
with a unit tag ID can be stored in all folders. They are activated by the selection of the
unit in GENIUS TOOLS Starter App.

This allows settings to be made for a unit even without assigning a unit folder to the unit.
Please note: The name of a unit does not have to correspond to the name of the unit

folder. Naming a unit folder differently from a unit can be useful for a better folder
structure of files.

Creating units without a unit folder

When creating a unit in GENIUS TOOLS Project Configurator, a unit tag ID is suggested.
You can change the name of the unit tag ID thereafter in the Definition area. Do not select
a unit folder.

» UNIT

Mame | Berlin |
Comment

Unit type Standort =

Blocked No

# DEFINITION @

Tag-ID / directory berin [ |
Role Everyone M

Unit tag ID / folder name

Defines the tag ID for the unit. If you select a unit folder, its name will also be the name of

the unit tag ID. Unit folders are created manually in configuration\units.

The tag ID preset in the input field can be:
Retained/ overwritten: Defines the unit tag ID. Tag IDs must not contain characters
that are invalid for file names, suchas ~ " # % & *: < > ? /\ {| }. German umlauts and
the letter B are not accepted.

The unit directory preset in the input field can be:
Retained / replaced: Assigns an existing unit folder to the unit; the name of the folder
becomes the unit tag ID (case-insensitive).
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Please note: The name of the unit which users can choose in GENIUS TOOLS Starter
App can be freely set by the administrator and does not necessarily have to correspond
to the name of the unit folder.

Use case

In a company two sub-departments (Amsterdam, Berlin) of the Europe division are to work
together on five projects. In two projects (C, D) of the five different license extensions
should be used: Amsterdam should work with AAX, Berlin with BMX.

Initial situation: A unit folder with the name Europe is located in the units system folder
and contains the Creo configuration options (configuration blocks) for the unit Europe.

Procedure:
In GENIUS TOOLS Project Configurator

1. In the main page Organization main page go to the Select section and click the Plus
button, see Creating units.

Create a unit with the name "Amsterdam” and the tag ID "amsterdam”.
Create a unit with the name “Berlin” and the tag ID "berlin".

Do not assign any unit folders to these units.

A S A

Add the two units in the organization tree under the unit Europe.
At file level

6. Create a configuration block named config_lic.amsterdam.pro.

7. Enter the license extensions for AAX.

8. Create a configuration block named config_aax.berlin.pro.

9. Enter the license extensions for BMX.

10.Place the two files in the project folder for project C.

11.Place the two files in the project folder for project D.

Result: The license extensions AAX and BMX can be restricted to units for projects C and D
without having to create new projects.

Advantage: Without tag ID four projects would be necessary: Project C with AAX/ with
BMX and Project D with AAX / with BMX.

9.3.1.1 Project options with several unit tag IDs

A configuration block with a unit tag ID can be used as a project option in one or more
projects. A project option can be limited to one unit by adding a single unit tag ID, but it
can also contain multiple tag IDs.
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Validity
When using multiple unit tag IDs, all conditions set by the tag IDs must be met.
Example: Validity of a configuration block

A company has the units Construction and Manchester, but no unit MBD. This means

the configuration block config_lic.manchester.construction.mbd.pro is valid if the unit
Construction and the unit Manchester and the combined project option MBD is selected.

Usage

Using multiple unit tag IDs is useful when you have subunits in different configuration
levels.

Example: Configuration block in multiple 4 Standard
levels. b & Key User
For project A, the team Construction on the 4 Deutschiand
site Edinburgh, but not in Hamburg, is to be b Berlin
given NC as an option on the project.
4 Hamburg

Solution: 1. The units Edinburgh and
Construction are created in GENIUS TOOLS
Project Configurator.

Construction

Simulation
[ Leipzig
2. A configuration block with the name
config_lic_nc.edinburgh.construction.nc.pro is
created in the project folder of project A.

B Switzerland
4  United_Kingdom

i . i . 4 Edinburgh
3. The project option NC is defined

according to requirements (e. g. license
extensions), see Single project options.

Simulation

Result: The construction team in Edinburgh can activate the project option NC on
project A.

Advantage: The project option NC is not available to all members of the unit
Construction, as would be the case if the configuration block were located in the
Construction unit directory.

9.3.8 Call hierarchy for subunits

The call sequence of subunits corresponds to the arrangement in the organization tree, in
this example: Standard - United Kingdom - Stratford-upon-Avon - Development (1).

In this example, the following settings define a Starter project

— the settings for the Development unit,
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— the inherited settings from Standard, United Kingdom and Stratford-Upon-Avon as well
as

— settings of the project, see Call sequence for settings.

If a subunit exists more than once, e. g. Construction (2), inherited settings from the parent
units Switzerland / Brattisellen or United Kingdom / Stratford-upon-Avon may apply,
depending on the selection by the user.

i i @
Organization
~ CROSS REFERENCE
HEE® Q S ,
Path e_,\/ Standard / Schweiz / Britisellen/ Construction
4 Standard ~ UNIT Standard / United_Kingdom / Stratford-upon-Avon / Construction
b Deutschiand Name Construction
4 Schweiz
4 Britisellen Description
Construction o Unit type Department -
Simulation Blocked @ No

4 United_Kingdom ~ DEFINITION

b Edinburgh

4 Stratford-upon-Avon Tag ID / unit directory Deutschland -

Role Everyone =
Development ~ USERS (GTS)

View call sequence

The more subunits you have, the more difficult it becomes to track at which configuration
levels settings are made and possibly overwritten. You can see this in two locations:

1. In the Config tab of GENIUS TOOLS Starter App: The configuration blocks are listed by
directory.

. Creo Pare*metric 11.0 Config

Meuesste

& 2 = standard configuration blocks (.pro) standard
ﬁ é@ % j de ~ Active | Mame

2. For Creo Parametric projects in the project report under the heading "config.pro”: The
config.pro blocks are listed with path information.

Directory structure for files

In the units system directory all directories are located on one level, i. e. it is not visible
whether a directory contains settings for a unit or a subunit. For an easier overview at file
level, it may therefore be useful to adjust the unit directory names to reflect the call
hierarchy. You can do this by giving the unit directory a different name to the unit you
create in GENIUS TOOLS Project Configurator.

Please note: The name of the unit directory becomes the unit tag ID when assigning
the directory to a unit.
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Examples for an easy overview of call hierarchy:

caddepot » INMED » parametric » configuration * units

Mame a
_Images
1_Deutschland
1 _Schweiz
1_UnitedKingdom
2_Berlin
2_Frankfurt
2_Harnburg
2_Manchester
3 Konstruktion

3 Simulation

Unit directories by country and city

caddepot » INMEQ = parametric * configuration * units

o~

Mame

_Images

ch
ch_bruetizellen
de

de_berlin
de_frankfurt
de_hamburg
de_muenchen
team_konstruktion
team_simulation
uk

uk_manchester

Unit directories by country

9.3.9 Displaying units in GENIUS TOOLS Starter App

Once users belongs to multiple units, they have to select a unit in the user interface of

GENIUS TOOLS Starter App.

Standard selection

If there are only units in one organization level, the selection field lists all units available to

the user in alphabetical order.

@ Development LV

i‘ Construction

@ Development

%82 Windchil Projects

[ | Creo Parametric

Hint: If you wish to place a unit at the top of the list, put a space character in front of

the unit name, e. g. " United Kingdom".
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Changes to unit names are adapted after restarting GENIUS TOOLS Starter App.

Selection of subunits

If there are subordinated units (subunits) to choose from, a separate dialog box opens.

- 12000 Select units New dialog opens for
switching to another unit

;} United_Kingdom

Creo Parametric 1
MNew version

& United_Kingdom

B nNEO - Cren wi

5% Stratford-upon- K K . Stratford-upon-Avon
(tl Avon — Right mouse click @ .
) opens unit layer
& Construction “
/ i‘ Construction
Construction
Left mouse click opens i\ -
separate window @ Development
m Fimmime Flemlamde

(G) Development

Invisible units

The display of a unit can be hidden in the GENIUS TOOLS Starter App. This supports the
clarity of the selection and can save users from having to click on subunits.

Change the visibility of a unit in GENIUS TOOLS Project Configurator under Organization
sza > Units > Cross reference by deactivating the eye symbol @ on the selected unit path.
The settings for invisible unit are retained.

m NNEO GENIUS TOOLS PROJEC A
= ' Units Organization @ ®
~ CROSS REFERENCE
+ 1 L ITRE®
533 Path Standard / Switzerland / Britisellen
COUNTRY 4 Standard ~ UNIT
@ ’ b Deutschland v DEFINITION
7 Deutschland
4 Switzerland ¥ USERS (GTS)
m
‘F Switzerland
Simulation
P b United_Kingdom
af United_Kingdom

Setting unit Briitisellen to “invisible” in GENIUS TOOLS Project Configurator
Result in GENIUS TOOLS Starter App:
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INNLCO

# Schweiz v

Q Simulation W

Please note: If a unit has several subunits that are all set to invisible, GENIUS TOOLS
Starter App automatically selects the first subunit to which the user has access. If a
different subunit is to be selected, use the start parameter -gts:units.

Displaying units with icons

You can add a picture to the display of a unit by storing a JPEG, PNG or SVG file in the
_Ilmages subdirectory of the configuration directory in the Caddepot. The name of the file
has to be identical to that of the unit directory, e. g. United Kingdom.png, or — if you are
working without a unit folder — to that of the unit tag ID.

caddepot * IMMEQ » configuration » _images

N
Deutschland.png gtsprj_crec11_de  gtsprj_creoll_de  gtsprj_creoll_se.
v.png v_wt.png png
[ LerPziG |
leipzig.png simulation.png Schweiz.png United
Kingdem.png

Images directory under configuration

9.3.10 User and computer groups

User and computer groups have been abolished in version 11.0.0.0, because the
assignment of access rights is defined via roles and roles can be linked to units only, not to
groups. If you want to simulate the way groups have worked, you can create a unit of the
type Last and leave its visibility in GENIUS TOOLS STARTER switched off, see Unit types >
Last.

Existing groups are automatically converted into units when updating to version 11.0.0.0
and newer:
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— Configuration blocks that were created for user or computer groups
(UG_<nameofusergroup>_config.pro or CG_<nameofcomputergroup >_config.pro), will be
migrated into a new unit directory of the same name.

— After the update, the former groups appear as the last subunit in the organization tree,
i. e. they are inserted under each last unit. This corresponds to the call sequence for
settings.

— Group settings (Menu item Configuration) will be transferred to the new unit(s).

Warning: If the environment variables GTS_USER_GROUP or GTS_COMPUTER_GROUP
were used in a configuration block, these variables must be renamed to GTS_UNIT_DIR
when updating to version 11.0.0.0 and later.

Please note: After the update, users with permanent licenses can work with units and
subunits of a further level. A subscription license is required for unrestricted working
with units.

The advantages of units over computer and user groups are:

1. Units can contain sub-units and therefore better reflect the organizational structure of
a company.

2. A user can be assigned to several units.
3. The affiliation to a unit does not have to be maintained manually.

For more information on migrating groups, see GENIUS TOOLS Environment Administrator
> Update.

9.4 Roles

GENIUS TOOLS Starter is based on a role-based authorization concept. This allows you
to grant different access rights to projects and functions to defined user groups.

Roles are managed in the main menu item Organization &2 in the Access tab (1) under
Roles (2).

Firstly, users are assigned to a role in the Details tab (3). These entries can be static or
dynamic (5). Dynamic user entries change automatically in GENIUS TOOLS Starter when
the entries are changing in the source, e. g. Windows Active Directory. Computer entries
are always static entries.

Secondly, access rights are defined for this role. These rights include access to projects (6)
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as well as to functions in GENIUS TOOLS Starter App (4), see chapter Access rights.

If a role configured in this way is assigned to a unit, it becomes a assigned role. For a unit,
you can apply specific settings for the various CAD applications.

A role can also be used in the permissions tree as a free role &2, A free role is not
assigned to a unit but still restricts the access of a project to the members of this role.

The tree for permissions shows — like the tree for units — all units and subunits. These can
restrict the access of a project. In addition, you can also use free roles &2, for defining
project access in the permissions tree.

EE NMNEC GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0 - m]
=8 Access 1 Organization @ Details 5 ®
Projects Permissions @
53_6 —. _ ~ GENERAL
+1 0EE
Role name CAD-User Stratford
"%‘ EEuE ELie 4 Standard .
Description
X 42 Administrator free role
o Creo Parametric 7.0 Image =
access-restricted projects DSyl bk
Creo Parametric 8.0 b (= it - statlc entrles
b Schweiz e unit o MEMBERS
~ Creo Parametric 11.0 - 4 United Kingdom unit + | Sea
(@] Testoriskt 4 Stratford-upon-Avon subunit 1 User name GTS alias Email
Roles e 4 Construction subunit 2
8 efoster E. Foster |}
5 + E [M Creo Parametric 80 project
4 % CAD-Testgruppe free role jgardener J.Gardener m
[ Creo 11.0 - Testprojekt mweber MWeber imj
22, CAD-User Hamb : i
ser Hamburg Development v COMPUTERS (GTs) static entries
W ~ BENUTZER (LDAP) _dynamic entries
2 g -
2 CAD-User Leipzig LDAE
(31 | LDAP query Comment

I 29 CAD-User Stratford

§ cA\gtstarter\cadpoohINNEG\configuration\database\sut.db

Details tab of the role "CAD user Stratford-upon-Avon"

The members list (4) shows all users (or computers) assigned to the selected role. You can
search for users and delete user with the recycle bin icon to the right of the user name.

A crossed name means that a user is blocked, i. e. for this user neither any role nor any
unit configuration is applied. To change the blocked status, go to Resources > Users > Edit
/ create user.

9.4.1 Usage of roles

Roles are used for grouping users and for assigning rights.

Grouping of users

If the members of a role work with a special configuration setting, a role must be assigned
to a unit, under Organization > Unit tab.
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Assignment of function rights

A role must be created if the members of the role require special functions in GENIUS
TOOLS Starter App and GENIUS TOOLS for Creo, see Organization > Access tab > Roles >
Tab: Function access.

If a role is neither added to the project tree nor assigned to a unit, the role does not
define any project restrictions, but still determines the access rights for the members of
the role.

Example: A company assigns access to the Editors of GENIUS TOOLS for Creo to
administrators without creating an extra unit for this user group. The procedure for this
example is described in Chapter Free roles for function access.

Please note: Function access rights are always cross-unit: If a user has different rights in
different roles, the granted access applies regardless of which unit is selected in GENIUS
TOOLS Starter App. See chapter Granting function access rights.

A description of all access rights for GENIUS TOOLS Starter App and GENIUS TOOLS for
Creo can be found in chapter Granting function access rights.

Assignment of project rights

It is possible to restrict access to a project to certain users. To do this, the users must first
be grouped into a role. The second step is to add the project to the permission tree. If
users are assigned to several roles, the visibility of the allowed projects in GENIUS TOOLS
Starter App can be restricted:

— regardless of the selected unit: cross-unit project access

— depending on the selected unit: unit-specific project access

Please note: Project access rights are always defined for the members of a role. The role
can be assigned to a unit or be used as a free role in the permissions tree.

9.4.1.1 Use case: Usage of roles

The company ABC wants to assign certain functions and projects to the following user
groups and specify configuration settings. Click a role to go to the chapter that describes
how to create that role.

Name of Users Function access Project access Configuration
the role options

Default roles
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Name of Users Function access Project access Configuration

the role options

Administ Main — Can enter Operating — own network

rator administrator GENIUS TOOLS  environment for  drive connection
Project testing, e. g. for

Configurator customizing

object data

Everyone All persons for — Can see project
whom a user info
entry was created
in GENIUS TOOLS
Project
Configurator

— Analyze / borrow
licenses
- etc.

Free roles

CAD test User who test like Everyone plus  Test project for

group projects with the — Can pause new Creo version
newest Creo synchronization
version — Can deactivate
configuration
blocks
KeyUser Users trained for like CAD test group Model Processor
Model Processor project
GTfC Site like CAD test group
Admin administrators plus
— Is GTfC-Admin

— Can use network
mode

Assigned roles

Users DE  All users in DE Can see projects - license server in

in DE Germany

Users UK All users in UK

GENIUS TOOLS Starter

Can see projects
in UK

— license server in
UK
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Name of Users Function access Project access Configuration
the role options
Construc All designers in like Everyone plus  Can see projects - configuration
tion CH, DE, UK - Can deactivate  with older Creo  blocks for Creo
configuration versions settings
blocks

9.4.2 Adjusting default roles

There are two pre-configured roles Everyone and Administrator. Both contain in the
default settings all Windows user names known to the system.

Hence, every user is a member of the role Administrator. When you first use GENIUS
TOOLS Project Configurator, you should adjust the role by removing the user entry
Everyone and by assigning some individual users to it.

The default roles cannot be deleted. The roles Everyone and Administrator cannot be
renamed.

Il =2

Organization

Permissions

Projects

+ I L MEE

~ GENERAL

Role name
Standard

Description

Image ]

=]

Roles

+ I

+ USERS (GTS)

o

MEMBERS

I [A] Administrator Default role "Administrator”

in state of delivery User name GTSalias | Email
(E] Everyone \I Everyone user entry Tl |

[0

oy
]

Standard role "Administrator" with user entry "Everyone"

Hint: The user entry Everyone in the Members is accessible to all roles and can be used
if you do not want to manage each user manually.

If you delete the user entry Everyone from the Administrator role, it will still be available
for selection in the Members area (Plus symbol).

9.4.3 Creating roles

To create a new role 55%, click on the plus button (1) in the Roles area of the Access tab.
Enter the name of the role and an optional comment in the Details tab under General (2).
You can add an image.

The following elements can then be assigned to a role:

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH

95



GENIUS TOOLS Project Configurator G EN I US TO 0 I.S®;=

— static entries (GTS) of Windows users (3) and/or computers (7),

— dynamic (changeable), e. g. from the Windows user administration (8, LDAP) or an
alternative authentication system.

Dynamic entries are created directly in the role. For static entries, user or computer entries
must be created under Resources.

Individual users can be added (4), searched for (5) and deleted (6) in the member list.

If you have changed the authentication to a system other than Windows (e. g. Windchill),
the area User groups (authentication provider) appears instead of the LDAP area, in which
the assignment of user groups to a role is possible. The update function B2 to the right of
the add symbol updates these user groups.

To assign access rights, fill in the Function access tab, see chapter View users rights.

SE NNE ECT CONFIGURATOR 12.0.0.0 = m}
&l Access Organization Details Tabs @)
Projects Permissions @
5:_('.\ — . e ~ GENERAL
+0 &=
Role name CAD-User Stratford
@‘ CREO PARAMETRIC 4 Standard
> Description
22 Administrator
Creo Parametric 7.0
I b 2 Key User image )
. a0 b Deutschiand (5 JEEHEH)
T reo Parametric 8.
b Schweiz MEMBERS
. Creo Parametric 11.0 - [ (i) e °+ SR e
() Testprojekt
(] eelpra User name GTS alias Email e
8 efoster E. Foster |}
Roles Ibeer L.Beer imj
1 BN ) jgardener J.Gardener |m}
dgraeber D.Graeber W
22 CAD-User Berlin sholl S.Hall imj
e ~ COMPUTERS (GTS)
22 CAD-User Hamburg MEMBERS
0 +
2 N Ao
Sy Computer name Comment
I 22 CAD-User Stratford o 2IBENUTZERIEDAT)

Q 26.06.2024 13:54:41

Creating a new role

9.4.3.1 Adding static entries to a role

You can assign users and computers to a role statically.

Static entries do not change automatically as dynamic user entries do. Changes to static
entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

To assign a user or computer to a role, you have to first create an entry as a Resource
under users / computer. A user or computer can be assigned to several roles.

Procedure: Add users to a role i
1. Under the main menu item Organization &z, select the role to which you want to add
one or more users.

2. In the Users section (3), click on the plus button (4).
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3. In the new dialog box that opens, select the users you wish to add to the role.
You can search entries and sort them alphabetically.
Hint: The default entry Everyone contains all users.

Please select users
Search searches through all entries Q
" User t+—— sorts alphabetically nent | Email Ly
Administrator Administrator
abachmann A_Bachmann
| ahelp A Help ahelp@inneo.com
+ | efoster E. Foster efoster@inneo.com
Everyone —— contains all users
gmueller G. Mueller gmueller@inneo.com
v OK Q cancel ) Apply

4. Finish the dialog box by clicking on either:

— Ok: Add selected users and close dialog box,
— Cancel: Close dialog box without adding selected users,
— Apply: Add selected users without closing dialog box.

9.4.3.2 Adding dynamic entries to a role

Dynamic user entries adopt changes from the system in which they have been created.

If GENIUS TOOLS Starter is used by Windows users, this is done automatically for dynamic
entries by means of an LDAP request. If users are to authenticate with a different
authentication system, the entries of this system must be regularly updated manually in
GENIUS TOOLS Project Configurator using the Update function B2

Accessing Windows user management

If you are using a subscription license, you can access the Windows user management.
This means that you can assign permissions to users and user groups that have been
defined by your company's central IT management. GENIUS TOOLS Starter App uses live
queries to make sure that user assignment is up-to-date. Thus, you do not have to create
users locally.

Windows user management is accessed using LDAP queries. LDAP (lightweight directory
access protocol) is a standard network protocol for accessing a distributed directory
service.
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Please note: An LDAP query is only available with a subscriptions license. When using a
permanent license, the LDAP tab is not visible.

Defining an LDAP query

To define an LDAP query, go to the Resources page, select the role that you want to assign
a query to, and go to the LDAP tab.

In GENIUS TOOLS Starter App live queries to Active Directory are executed at the start of
project validation. The LDAP groups are cached for fallback functionality.

The LDAP fields Description, DisplayName, Initials and Enabled are queried and the entries
are transferred to the following fields. The administrator can overwrite the content of a
field, but not the mapping.

Details

@
v GENERAL
~ USERS (GTS)

~ COMPUTERS (GTS)
~ USERS (LDAP)

LDAP

(31 | LDAP Query Comment

MODIFY USERS

R ] Q

User already exists as User name 1 GTSalias GTS alias long GTS alias short Comment Email
entry in the User tab -

A ahelp Help, Anna 2 Help, Anna AHE Leipzig = Technische Redakteurin AHelp@inneo. .com

QO @ @ ntries from LOAP field "DisplayName” (@) @"lniti:ls"l ® @ LDAPiieIrJ"Des:ription"l 1 5]
Blocked user from | 8 e emrr— yre—— : e —
LDAP field "Enabled . = |

< Stange e Sasche— A | Lenge-Sascha— [ [

Defining an LDAP query

» Users (LDAP) - Subscription

In the LDAP section, you can assign users from an LDAP query to a role dynamically.
(LDAP: Lightweight Directory Access Protocol)

Blocked (1)
Use this to block the LDAP query.

LDAP query (2)
Enter the name of the LDAP group you want to use.

Comment (3)
Enter an optional comment for the LDAP query.

Delete (recycle bin icon,4)
Removes the LDAP query from the role.

» Modify users

In the section Modify Users you can edit details from LDAP queries or alternative
authentication systems. Specifications for static user and computer entries are edited
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under Resources.
Any changes only apply to GENIUS TOOLS Starter.

Please note: Information from dynamic user entries is not written to GTS variables.

Search (5)

Camera column (6)

Double-click the upload icon in the camera column to add a user image.

User name (7)

Displays the user name (Windows / alternative authentication systems).

GTS Alias (8)

Alias name of the user. An LDAP query transfers entries from the field DisplayName.
GTS Alias Long (9)

Long user alias. An LDAP query transfers entries from the field DisplayName.

GTS Alias Short (10)

Short user alias. An LDAP query transfers entries from the field Initials.

LDAP query (11)

Displays the LDAP group or the user group of the alternative authentication.
Comment (12)

Displays the staff position. An LDAP query transfers entries from the field Description.
Email (13)

Displays the email address.

Accessing alternative authentication systems

If you have selected an alternative authentication method in the global settings, you can
assign user entries that come from this system to a role. Details of users and their
affiliations to user groups are updated with the update function B2 which appears to the
right of the Add icon. These entries are therefore dynamic, i. e. changes made in the
authentication system are adopted by GENIUS TOOLS Starter and do not have to be
entered manually per entry.

Please note: Integrating an alternative authentication system with GENIUS TOOLS
Starter requires a subscription license.

For Windchill, all user groups and their assigned users are automatically imported from
the specified Windchill server. The following information is adopted:

User group information
"Name" > Group name
"Description” > Description of group

User information
"Name" > User name
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"FullName" > GTS Alias Long
"AlternateUserName1" > GTS Alias Short
"Email" > Email

If you would like to use other authentication systems, you must create an authentication
provider by yourself, see chapter Creating your own authentication provider.

In the section Users (Authentication Provider), the following details can be specified and
modified.

P Users (Authentication provider) - Subscription

In the section User groups (authentication provider) you can dynamically assign these
groups to a role.

Blocked (1)
Blocks the user group.

User group (2)
Enter the user group you want to assign to the role.

Comment (3)
Enter an optional comment or accept the existing one.

Delete (recycle bin icon,4)
Deletes the user group from the role.

» Modify users
Details about individual users can be edited like entries from LDAP queries.

5.9 Granting function access rights

Function access rights are always defined for the members of a role. In the Function Access
tab, select the rights you wish to grant to the members of a role for using functions in
GENIUS TOOLS Starter App and GENIUS TOOLS for Creo.

S OLS PROJECT CONFIGURATOR 12.0.0.0

Access Organization Function access ®

Projects Permissions
Ez‘é + -~ ]E_ ’_. l_E ~ ADMINISTRATION

il )
Can enter Project Configurator @ No
P CREO PARAMETRIC 4 Standard
@ - Is GTFC Admin @D o
Administrator
Creo Parametric 7.0 A~ SYNCHRONIZATION

-

Roles | [M Model Processor 11.0 Can pause synchronization 0 es
%)
' ¥ m— b Deutschland Prevent switch to local installation @ No
E‘I b Schweiz N RO

P United Kingdom
Can analyze project Q Yes

7o) 29 keyu
(1] ey User
= I L Can see project information

26.06.2024 13:54:41

89

Granting function access to the role "Key User"

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH

100



GENIUS TOOLS Project Configurator GENIUS TUULS®;=

Use case: Function access when a user is a member of several roles
The table shows the function access authorizations for user Anna Help, who is a member
of the roles GTFC Admin, Construction and Everyone.

Function access: cross-unit

Example for user A. | 51 enter GTPC ,Can use network ,Can deactivate
Help mode” configuration
blocks”

Membership in:

Role GTFC-Admin - X X

Role Construction - - X

Role Everyone - - -
Uberblick

Authorizations for
GENIUS TOOLS
Starter:

Regardless of the - X X
selected unit

Granting access rights — GENIUS TOOLS for Creo
These two functions concern the work with GENIUS TOOLS for CREO (GTfC):

Is GTFC admin

The variable %GTFC_ADMIN% is set to 1, i. e. users have access to all Editors of GENIUS
TOOLS for Creo (GTFC) whose start switches have this variable. The specifications can be
viewed in gt main.cfg and in GENIUS TOOLS Configuration Utility.

Default for role Administrator: Yes

Default for role Everyone: No
Consult the chapter start settings of the Startup TOOLS software.

Prevent switch to local installation

By default, if the GENIUS TOOLS Starter App is started from the Caddepot directory on the
server, GENIUS TOOLS Starter App will switch automatically to the Cadpool. If set to Yes,
there is no automatic switch and the user works with the data in the Caddepot.

Default for all roles: No
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Warning: If this right is granted to a user before the initial synchronization, GENIUS
TOOLS Starter App will not be installed locally for this user, and the user will not be able
to start locally.

Granting access rights — GENIUS TOOLS Starter App

The other access rights are assigned for GENIUS TOOLS Starter App. If an access right is
not given to a user, the corresponding button does not appear in GENIUS TOOLS Starter
App. Also refer to the chapter GENIUS TOOLS Starter App User Interface.

Please note: Not every function in the GENIUS TOOLS Starter App can be controlled.
Default functionalities cannot be influenced. Calling up GENIUS TOOLS Starter and
starting a project cannot be influenced.

» Administration

Can enter Project Configurator
Determines whether users are allowed to open GENIUS TOOLS Project Configurator. For
users who do not have this right, a message will be displayed, and the Project
Configurator will be closed when the user confirms the message.

Default for role Administrator: Yes

Default for role Everyone: No

Hint: When GENIUS TOOLS Starter is started locally from the Caddepot directory,

Project Configurator is always accessible. In this way, an administrator will always have
access to the configuration.

Please note: If this right is not assigned to any user, GENIUS TOOLS Project
Configurator will revert to the default setting of granting the right to all users.

» Synchronization

Can pause synchronization
The user may pause the automatic data synchronization. Synchronization has to be
paused if you want to make changes to files in the Cadpool locally, otherwise local
changes would be overwritten as soon as the synchronization runs.

Default for role Administrator: Yes

Default for role Everyone: No

Warning: GENIUS TOOLS Starter App will keep the synchronization on pause even after
a restart of the software as long as the user still has this right. If this right is withdrawn
while the synchronization is paused, the synchronization will run automatically when
the software is restarted, which may result in data loss.
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» Project
The following settings are also explained in the chapter Customizing information panes.

Can analyze project
Users are able to analyze and edit all configuration files of a project with GENIUS TOOLS
Config Analyzer. The button Kis displayed.

Default for role Everyone: No

Can see project information
Users can open the Info tab containing the project name, paths to the project, data and
working directory as well as the selected language and the startkey. The button ilis
displayed.

Default for role Everyone: Yes
Can create project report
The user can view all information about the project and user settings in a separate
document. The button Elis displayed under the project name.

Default for role Everyone: No

Can see licenses
Controls the visibility of the license evaluation in GENIUS TOOLS Starter App. (See chapter
Displaying license information.) To use this option, you also have to set Show licenses
under Configuration > Creo settings > Tab: Start to Yes.

Default for role Administrator: No

Default for role Everyone: Yes

Can borrow licenses
Users can start the license borrowing process. The button Liis displayed in GENIUS
TOOLS Starter App in the Licenses tab. See License borrowing for Creo Parametric users.
Default for role Administrator: No
Default for role Everyone: Yes

Warning: To borrow the PTC licenses, the user has to complete the PTC borrowing
process.

Can disable configuration blocks
The user can temporarily disable Config files (configuration blocks) for a project. Disabled
files will not be used by GENIUS TOOLS Starter App when creating the configuration
settings. See Config tab.

Default for role Administrator: No

Default for role Everyone: Yes

Warning: Disabled configuration files will become active again on the next project
validation or synchronization.
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Hint: This right makes it possible to quickly disable configuration files on individual
computers without having to change company-wide configuration settings.

Can open configuration blocks
Users can view and edit Config files (configuration blocks). See Config tab.
Default for role Everyone: No

Can save private configuration blocks
Users can edit their private Config files and write them back to the userdata directory in
the Caddepot of the server. See Config tab. Set the path to the userdata directory in the
configuration settings page under User settings in the Application tab.

Default for role Everyone: No

Sees auto projects
GENIUS TOOLS Starter will search for certain supported applications on the computer, for
example Keyshot or Mathcad , see auto projects., and will display them in the last installed
software version in GENIUS TOOLS Starter App.

Default for role Administrator: No

Default for role Everyone: Yes

Can save customized settings/file
Creo Parametric users can view, edit and make a backup copy of the file
creo_parametric_customization.ui, which contains all user-specific settings for the graphical
user interface of Creo.
SolidWorks users can save their user specific settings, which are stored in the registry.
. The button £l is displayed in GENIUS TOOLS Starter App in the Backup tab.

Default for role Everyone: No

9.9.1 Assigned roles for function access

A role that defines a unit is called an assigned role.

Please note: Function access rights are always cross-unit: If a user has different rights in
different roles, the granted access applies regardless of which unit is selected in GENIUS
TOOLS Starter App. See chapter Granting function access rights.

Use case: Granting rights to members of the Construction unit
Company ABC would like to give all designers the right to analyze a project with GENIUS
TOOLS Config Analyzer and generate a project report as PDF.

1. Create role: Construction
2. Assign user to role: Eric Foster, Gerd Miller etc.
3. Tab Function Access: Can analyze project, Can create project report set to Yes

4. Create unit; Construction
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5. Add unit to the organization tree: Drag and drop Unit Construction under Berlin
6. Assign role to unit: Assigning the role Construction to the unit Construction

The tree for permissions shows — like the tree for units — all units and subunits. These can
restrict the access of a project. In addition, you can also use free roles &2, for defining
project access in the permissions tree.

Bl Access -4 Organization Clicking on a unit epens page for unit ED Function access [G)
L ¥ CROSS REFERENCE @
Projects Permissions ~UNIT
& o ~ ADMINISTRATION
4+ WEE o —
Can enter Project Configurator @ o
[l CREO PARAMETRIC 4 Standard Description
@ e Is GTFC Admin @D
42 Administrator .
Creo Parametric 7.0 URtRS Department  SYNCHRONIZATION
b 2 Key User
Blocked
4 Deutschiand @O Can pause synchronization @ no
Creo Parametric 8.0 - ~ DEFINITION
4 Bl Prevent switch to local installation @ D no
Creo Parametric 11.0 - > Construction Tag ID / unit directory construction [m] ~ PROJECT
(&) Development o
Role
Construction - ,
Roles b Hembug A~ USERS (6TS) -
, g s @ -
b Schweiz CEEES @
[A) Administrator b United_Kingdem Eeay @ -
User nat GTSalias | Email
@ e
. CAD-Testgruppe Soster E. Foster
@D
Select role gmueller Milller
5] & nstruction "
frx} | 2 for function access Ibee Bee @
Wl 01.07.2024 11:28:30
Result:
.

— All designers have access to the newly set rights.
— No projects are assigned.
— If a designer is also a member of other roles, he receives all the rights of these roles.

A unit can also be used to restrict projects, see Unit-specific visibility.

9.9.2 Free roles for function access

A role that does not define a unit is called a free role.

If a role is neither attached to the project tree nor assigned to a unit, the role does not
restrict any projects, but still determines the access rights for the members of the role. For
example, a company can give administrators access to the editors of GENIUS TOOLS for
Creo without creating an extra unit for this user group.

Example: Assigning rights for site administrators

Company ABC has one site administrator in Germany and one in Great Britain. Both need
the same rights to make settings in the editors for GENIUS TOOLS for Creo, but should
not, like the main administrator, have the right to make settings in GENIUS TOOLS Project
Configurator and use the network mode.

Use case: Assigning rights for site administrators

Company ABC has one site administrator in Germany and one in UK. Both need the same
rights to make settings in the editors for GENIUS TOOLS for Creo, but should not, like the
main administrator, have the right to make settings in GENIUS TOOLS Project Configurator
and use the network mode.
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1. Create role: GTfC_Admin
2. Assign user: Eric Foster and Gerd Muller
3. Tab Function access: Function Is GTFC-Admin set to Yes

4. Do not add the role to the authorization tree.

Il 35

Organization Details Function access
Projects Permissions @ @
{!_é . ~ GENERAL ~ ADMINISTRATION
+ mEE
Role name GTfC_Admin Can enter Project Configurator @D o
PoSll  CREO PARAMETRIC 4 Standard
® Description Zugang zu GTiC-Editoren Is GTFC Admin @D v
42 Administrator
Creo Parametric 4.0 ~ SYNCHRONIZATION
[ P 2 Key User Image admin_gtic.png ]
b Deutschland ~ USERS (GTS) Can pause synchronization @D v
Creo Parametric 7.0
b Schweiz IMEMBHLS Prevent switch to local installation [ ™
P United Kingdom Search N
TEST - Creo Parametric 11.0 + PROJECT)
@ User name GTS alias
Can analyze project @ -
g gzt 2R Can see projectinformation @
mueller G. Mller
i @
. ~ COMPUTERS (GTS) .
[A] Administrator R # ee @
@
[E) Everyone - @
nfiguration blocks. @ -
I &2 GTC_Admin
3 A USERS (LDAP) Can save private configuration black to server @ -

& 25.06.2024 10:45:15

Result:
— The two site administrators have access to the GENIUS TOOLS for Creo editors.

— No projects are assigned to the site administrators.

— If a site administrator is also a member of other roles, he receives all the rights of these
roles.

Please note: Function access rights are always cross-unit: If a user has different rights in
different roles, the granted access applies regardless of which unit is selected in GENIUS
TOOLS Starter App. See chapter Granting function access rights.

A free role can also be used to restrict projects, see Cross-unit visibility.

9.6 Creating projects

GENIUS TOOLS Starter enables users to launch any program with the user component
GENIUS TOOLS Starter App.

In the main page Projects [, projects can be created for the CAD applications Creo
Parametric, Creo Elements/Direct, SolidWorks, Inventor and AutoCAD.

Projects for all other applications can be created as Apps projects with simplified setting
options. Most importantly, they cannot be set up for a specific release.

GENIUS TOOLS Starter App can also generate projects from certain applications
automatically, if they are installed on the user computer, e. g. KeyShot. For such Auto
projects no settings can be defined.
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Please note: A project created here only becomes a Starter project after having been
selected in GENIUS TOOLS Starter App (by the user and his unit). That is, only the
selection by users computes the different configuration levels. The corresponding
configuration settings and batch files are then included to make up the project start,
according to the Configuration concept.

Administrators can restrict the access to a project to defined user groups (roles), see
chapter Restricting project access.

9.6.1 Creating a new project

Choose the application (1) for which you want to create a new project.

The Plus symbol (2) creates a new button with the name New Project as well as a number if
a project of the same name already exists. The new project becomes visible to the users as
soon as you save your changes to the database.

Click on a project in the projects list to edit the project details in the right pane. Note that
there are further tabs with project details for the CAD applications.

] S )
=8 Application types [EMENENED Projects Creo Tabs @
o Rt =
& Creo Parametric 11.0 - Testp., go, ~ ZSENERAL
Creo Parametric
Creo-Daten zum Testen Project name o INNEC_c8
@ Creo Flements/Direct Creo Parametric 11.0 Display name o Creo Parametric 8.0
Modeling R
Neueste Version B
Description Alte Version
SolidWorks i .
. Creo Parametric 10.0 R e PP =
E] Version 10.0
ventr INNEQ - C Windchill 10.0 e .
reo Winachi L
LEJ ﬂ\ﬁ Creo Parametric + Windchill in cloud Block project 0 @ b
AutoCAD # CREO PARAMETRIC

Details for the project "Creo Parametric 9.0"

Some input fields are pre-filled with the default settings, for others a drop-down menu
opens for directory search.

There are also optional fields (indicated in brackets in the following chapters). If the
optional input fields are not filled in, the system-wide settings (Standard) or the settings of
the unit(s) are inherited by the project.

9.6.2 General project settings

Settings for project display (display name, project image and info text) are entered in the
segment General.

General details

Project name (6)
A unique name without space characters that identifies a project, e.g. project_vers8_en.
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The default setting New Project can be overwritten. The project name can be changed at
any time.

Display name (7)
A unique name that is displayed for the users in GENIUS TOOLS Starter App. In GENIUS

TOOLS Starter App, the projects will be listed alphabetically according to their display
name.

Description (8, optional)
A short text describing the project can be entered which will be shown below Display
name.

Project image (9, optional)

You can upload an image from the _Images directory, which is displayed next to the
project in GENIUS TOOLS Starter App. Use PNG or JPEG files.

Projects are displayed to users in GENIUS TOOLS Starter App as follow.

I N N E a . Creo Parametr

ic 11.0
Neueste Version o
8 Deutschiand ~
. . Creo Parametri€ 10.0
“&’, Hamburg e Selected project
y Construction A4 e N y 1
A (i ]~ K L B - vetaut- parametricpst
\creo-work
Design Projects o AAX o BMX o Freestyle Design & Manikin Install directory
o Notebook & Simulation Live & Toolkit v GENIUS TOOLS for Creo GPIEETD TIPS
- Creo startkey
GroBe Baugruppen Keyshot 10 plugin MP User
& Windchill Projects R v plug parametric.psf
Project options. Language
System
. Creo Parametric ~
=1 Creo Rules of work \nn[mcmu
— A Best practices

A

Displaymc;f projects in GENIUS TOOLS Starter App

Administrators can restrict the access to the tabs and project details for different user
groups (roles), which is explained in the chapter Presenting projects to users.

Sorting projects

In the GENIUS TOOLS Starter App, you can set the order of the projects for the users by
dragging and dropping the projects. The Change sorting button (5) in the Projects column
sorts the projects in the application alphabetically by display name.

Restrict project access

Projects can be restricted to users who belong to a defined role with specific access rights.
Members of this role can only view in GENIUS TOOLS Starter App the projects they have
access to. See chapter Restricting project access.

All projects that a user has access to are displayed under Resources > Users > Card view >
Project symbol (right).
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9.6.3 Hiding and blocking projects

Projects that shall not be displayed to the user in GENIUS TOOLS Starter App can be
hidden in Projects > Application Type > Projects > First tab > Section: General.

. INMEQ - Creo Parametric 9.0

Creo Version 9.0

Hide project

; Creo Parametric 10.0 «

Version 10.0 gray m Yes

Block project

| . Mew-version crossed out m Yes

Blocked projects are displayed in gray in GENIUS TOOLS Project Configurator. Hidden
projects are crossed out.

When you set Hide project to Yes, the project is not listed in GENIUS TOOLS Starter App,
but can still be started using a start parameter. This can be a useful option for Windchill
projects, for example.

Hide project
No (default): The project is listed in the user interface.
Yes: The project is not displayed on the user interface in GENIUS TOOLS Starter App, but
can be selected using the -gts:p=<project name> start parameter.
A blocked project, by contrast, cannot be started using a start parameter.

Block project

No (default): The project can be accessed.

Yes: The project is not displayed and cannot be accessed on the application computer.
The other specifications differ depending on the CAD application, see CAD-specific project
settings.

9.6.4 Copying a project

You can copy existing projects with the Copy button. Enter a new name and the remaining
settings as in the previous chapter.

If you copy an access-restricted project, the access rights are transferred.
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Application types Projects Creo
N ©
opy
] Copy of Creo Parametric 11.0 22 ~ GENERAL
Creo Parametric -
Mew version Project name Copy of project_crea11p
Creo Elements/Direct Creo Parametric 11.0 20 Display name Capy of Crea Parametric 11.0
Modeling
MNew version \ - -
Degrrintinn Ml Blewsr version
SolidWorks | 2 Creo Parametric 10.0 | access-restricted project |

TTOTETT I F

Copying project Creo Parametric 11.0

Access Organization
Projects Permissions
+ [ L I @EE
CREO PARAMETRIC 4 Standard
4 %5 Administrator
Creo Parametric 11.0
[M Copy of Creo Parametric 11.0
Copy of Creo Parametric [ Creo Parametric 11.0
1.0

B Deutschland

Creo Parametric 11.0 and copy in the permission tree

9.1 Restricting project access

Access permissions for projects are defined in the permissions tree in the menu item
Organization & in the Access tab. To do this, create a role with the desired user group.

Please note: Project access rights are always defined for members of a role. The role can
be assigned to a unit or be used as a free role in the permissions tree.

In the Access tab, select a project in the Projects area using the plus symbol. In a new
window, you can search for the desired projects and add them by ticking them.
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Please select projects

Search ~ —— Searches for a term in project name or comment

Praject name T | Comment L

AutoCAD 2022 \ /

A click on project name or comment sorts
projects alphabetically

AutoCAD 2023

AutoCAD Mechanical

«'| Creo Elements/Direct Modeling
AutoCAD Architecture 2023
Creo Rules of work Best practices

| INNEO - Creo Windchill 10.0 Creo Parametric + Windchill in cloud
- : e 00w . oo F e 00w .

INMEQ - Creo Parametric 9.0  Creo Version 9.0

ROBOTIC - Creo Parametric 9.0 Customer

Firefox Firefox
Testumgebung erstellen Mit FreeFilesync
Creo Parametric 11.0 Meues Version

" OK ® Cancel @ Apply

Selecting projects

After selection, the project - in the example Creo Parametric 7.0 - appears in the
permissions tree under Standard.

Organization Project access
Permissions ~ STANDARD / CREOQ PARAMETRIC 7.0
[l @ 1=

CREO PARAMETRIC 4 Standard

M Creo Parametric 7.0
Creo Parametric 7.0

&2, Administrator

Everyone has access to this project.

b 45 Key User
Creo Parametric 8.0
p  Deutschland

An access-restricted project is first inserted under “Standard”

All projects selected in the Access tab are marked as access-restricted with the symbol for
roles on the projects page.

Creo Parametric 7.0 22

Old version

Display of an access restricted project
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Under Standard, the project is accessible to all users. In the permissions tree, access to a
project can now be restricted to a unit or a free role by dragging the project to the
corresponding position. The following options are available:

— Cross-unit visibility (with free roles)
— Unit-specific visibility (with assigned roles)
— Divided unit-specific visibility (with free roles)
Please note: To verify which projects are accessible for a certain user, go to the card

view under Resources > Users and click on the project symbol ] on the user's card, see
View users rights.

9.1.1 Cross-unit visibility

For cross-unit visibility of projects, free roles have to be created, i. e. roles that are not
assigned to a unit. You can allow project access

(a) across all units for the members of a free role by dragging the project under Standard
> Free role, or

(b) across different subunits if the project is under Unit > Free role.

(a) Cross-unit visibility for all units

If a project is created under a free role under Standard, project access is restricted to all
members of the free role. Members of the free role see the project regardless of the
selected unit in GENIUS TOOLS Starter App.

Use case: Enable all key users to access a project

The company ABC would like to limit access to the data revision program GENIUS TOOLS
Model Processor to a small group of designers who have been trained to use this
software. There should not be an extra unit for this group of key users. The key users, who
are members of several units, should be able to open the program out of all units.

1. Create free role: Key User

2. Assign user to role: Eric Foster, Gerd Miller etc.

w

Tab Function Access: No GTPC access, no GTFC admin, no network mode, all project
functions

No GTPC access, no GTFC admin, no network mode, all project functions
Add role to the permissions tree: Drag and drop Key User under Standard

Create project: Model Processor 11.0

N o s

Select project for access restriction: Model Processor 11.0
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8. Add the project to the permissions tree: Drag Model Processor 11.0 under Key User

Co NNEO. NIU _

Access Organization Project access @Function access
Projects Permissions ~ STANDARD / KEY USER / MODEL PROCESSOR 11.0 @
~ ADMINISTRATION
E E A Users (GTS) @
Can enter Project Configurator No
ALES) 4 Standard MEMBERS
Search Is GTFC Admin (: ) No
GENIUY drag and drop for 42 Administrator R
Browsg) project restriction 4 % Key User Genall Username | GTSallas | Email [~ SYNCHRONIZATION
Model Processor 11.0 efostel Foster
& DR . D0 Prevent switch to local installation @ ) no
4 Berin g W.Heisenberg ~ PROJECT
Roles 4 Construction
| YL I Creo Parametric 8.0 S.Hol Can analyze project Q Yes
g o b 42 CAD Testgruppe e e Can see project information @ v
[E) Everyone Development Can create project report @ -
b Hambur
e Can analyze licenses Q Yes
Leipzig
o CAD Test Grou >
) . ° b Seneiz Gan borrow Bcensas @@
) 52 KeyUser b United Kingdom Slectrolelforfuncuon Can disable configuration blocks @ -
access rights

25.06.2024 15:41:16

Result:
— Members of the Key User role have the rights listed above.

— Key users have access to the project Model Processor 11.0.

— Key users see Model Processor 11.0 project regardless of the selected unit in GENIUS
TOOLS Starter App. (Cross-unit project access)

— If a key user is also a member of other roles, he receives all rights of these roles. (Cross-
unit function access)

(b) Cross-unit visibility for subunits

If a project is created under a free role under a unit, e. g. Germany, project access is
restricted to all members of this free role. The project is visible to these members in
GENIUS TOOLS Starter App if they select the unit Germany and any of its subunits — here:
Berlin, Hamburg, Leipzig.

This variant is useful if the higher-level unit contains more users than the free role, e. g. if
the unit Germany contains all German-speaking users, including Swiss users. (If all users in
Germany are already defined in the unit Germany , the project should be arranged directly
under the Germany unit, as in the example under View users rights).

Example: Making work guidelines visible to users in Germany and Switzerland with
free roles

This variant is useful if the superordinate unit contains more users than the free role, e. g.
if the unit Germany (Deutschland) contains all German-speaking users, including Swiss

users. (If all users in Germany are already defined in the unit Germany, the project should
be subordinated directly to the unit Germany, as in the example in Unit-specific visibility).

The company ABC wants to make work guidelines with German legal requirements visible
to all users in Germany and work guidelines with Swiss legal requirements visible to all
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users in Switzerland. There are no units which separately map the users in Germany and
Switzerland.

1. Create free role: Users-DE

2. Assign user to the role: Gerd Miller, Fabian Havemann etc.
3. Tab Function Access: Optional
4

. Add the role to the permissions tree: Drag and drop Users-DE under the unit
Deutschland

u

Create project: Creo rules of work DE
6. Select project for access restriction: Creo rules of work DE

7. Add project to the permissions tree: Drag Creo rules of work DE under the free role
Users-DE

8. Repeat steps 1-8 with the role “Users-CH" and the corresponding user entries and the
project “Creo rules of work CH".

NNEQ G S
Organization Project access @
Projects Permissions » STANDARD / DEUTSCHLAND / USERS DE / CREO RULES OF WORK DE
5:3 + E ]E ’_El x Users (GTS)
MEMBERS
r@' APPS 4 Standard
| S Creo rules of work DE , : :::len;:ramr User name GTSalias | Email

= ||}

=]

b I

4 Deutschland unit gmuelle G. Millles
Creo rules of work CH
4 # Users DE free role fhavemann F.Havemann
[0 Creo rules of work DE wheisenberg W.Heisenberg

drag and drop under

b I

(@) Roles Users DE for b Berlin shol S.Hol 0
— Projektheschrinkung b Hamburg —
Q + | ~ STANDARD / SCHWEIZ / USERS CH / CREQ RULES OF WORK CH
5 b Leipzig
Z Administrator 4 Schwelz unit Users (GTS)
4 2 Users CH free role MEMBERS
#2  Users DE I Creo rules of work CH
roles are used b Britisellen User name GTSalias | Email
82 ysersch —| asfreeroles  [p United Kingdom dgraeber D.Graeber 1l

ﬁ l:] 24.07.2024 13:01:28

Result:

— Members of the role Users-DE have access to the project Creo roles of work DE if they
select the unit Germany and any of its subunits in GENIUS TOOLS Starter App. (Project
access across subunits)

— Members of the role Users-CH have access to the project Creo roles of work CH if they
select the unit Switzerland and any of its subunits in GENIUS TOOLS Starter App. (Project
access across subunits)
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9.1.2 Unit-specific visibility

As of version 11.0.0.0, it is not only possible to restrict access to a project to certain users
(roles), but also to restrict the visibility of a project to users of a certain unit. This is useful
when users are assigned to multiple units.

Please note: For unit-specific visibility of a project you have to use roles that are
assigned to a unit.

Use case: Enable designers in Berlin to access the project

The company ABC wants Creo Parametric version 8.0 to be used only by designers in
Berlin, as this version is needed for a specific customer project. The designers in Berlin
should not see the project if they select another unit in the GENIUS TOOLS Starter App
that they are also a member of.

1. Create role: Construction

Assign user to role: Eric Foster, Gerd Muller etc.
Tab Function Access: Optional

Create unit: Construction

Assign role to unit: Assign the role Construction to the unit Construction

o v ok~ W

Add unit to the organizational tree: Drag and drop Unit Construction under the unit
Berlin

~

Create project: Creo Parametric 8.0

8. Select project for access restriction: Creo Parametric 8.0

9. Add project to the permissions tree: Drag Creo Parametric 8.0 under the Construction
unit

ONFIGURATOR 12.0.0.0

Il G2

Organization Project access
Projects Permissions ~ STANDARD / DEUTSCHLAND / BERLIN / CONSTRUCTION / CREO PARAMETRIC 8.0
EE}!\ o ]E ) E |—E| \ Users (GTS)
MEMBERS
r%j CREO PARAMETRIC 4 Standard -
‘ W Administrator
Creo Parametric 8.0 O (T User name GTSalias | Emall
o 4 Deutschland m
- 0
g drag-and-drop 4 Berlin m
4 Construction Subunit m
Y o , f i
1 Reill ) efoster E. Foster [
= . Development =
Q - gmuelle G. Miller |
5 amburg
&2 construction b Leipzig
EI b Schweiz
Everyone P United Kingdom

25.06.2024 15:41:16
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Result:
— Members of the Construction unit (role: Construction) have access to the Creo
Parametric 8.0 project

— If a member of this unit is also a member of other roles,
— he receives all rights of these roles. (cross-unit function access)
— he can only see the Creo Parametric 8.0 project in GENIUS TOOLS Starter App if he
selects the Construction subunit from the Berlin unit. (Unit-specific project access)

Use case: Making work guidelines visible in Germany and Switzerland with assigned
roles

The company ABC intends to make work guidelines with German legal requirements
visible to all users in Germany and work guidelines with Swiss legal requirements visible to
all users in Switzerland. The Germany unit includes all users in Germany (role: Users-DE)
and the Switzerland unit includes all users in Switzerland (role: Users-CH).

1. Create project: Creo work guidelines DE
2. Select project for access restriction: Creo work guidelines DE
3. Add project to the permissions tree: Drag Creo work guidelines DE under Users DE

4. Repeat steps 1-8 with the role "User-CH" and the corresponding user entries and the
project "Creo work guidelines CH".

a
o

5 PROJECT CONFIGURATCR 12.0.0.0

=]
O

Organization Project access
Projects Permissions _# STANDARD / DEUTSCHLAND / CREO WORK GUIDELINES - DE

EET E m rEl Users (GTS)
MEMEBERS
.-@4 APPS 4 Standard -
42 Administrator
Creo work guidelines - DE User name GTSalias | Email
[0 I b & Key User

3 drag and drop

Creo work guidelines - CH

]

4 Deutschland gmuelle G. Maller

i

&

[M Creo work guidelines - DE

fhavemann F.Havemann

B Berlin
STANDARD / SCHWEIZ / CREO WORK GUIDELINES - CH

P Hamburg

b Leipzig Users (GTS)
4 Schweiz MEMBERS

B

[M Creo werk guidelines - CH Search

29 ysers DE it
sers B Britisellen User name GTS alias Email

P United_Kingdom

]

dgraebe D.Graeber

29 ysers CH

b1

roles are assigned to units sho S.Hol
Deutschland & Schweiz

[!

)1

=
X
i1
T

22 Users UK

24.07.2024 13:01:28

Result:

— Members of the unit Germany (Users-DE role) have access to the Creo work guidelines
DE project.
The project is visible in GENIUS TOOLS Starter App if the Germany unit and any of its
subunit is selected. (Unit-specific project access)
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— Members of the unit Switzerland (Users-CH role) have access to the Creo work
guidelines CH project.
The project is visible in the GENIUS TOOLS Starter App if the unit Switzerland and any of
its subunits is selected. (Unit-specific project access)

9.1.3 Divided unit-specific visibility

With the 11.0.0.0 option to restrict the visibility of a project to the users of a specific unit, a
project can also be restricted to the members of a free role within a unit. For example, a
specific group of people can be given access to a test project within a specific unit.

Use case: Enable project access for test group within unit designers in Berlin

The company ABC would like to set up a test group of designers to test an update of the
Startup TOOLS data packages for Creo Parametric 11.0. To do this, they also need access
to GENIUS TOOLS Material Browser. The testers should be able to pause the
synchronization and open configuration blocks. The test project should only be available
to the testers from Unit Construction in Berlin.

1. Create free role: CAD-Testgruppe

2. Assign user to role: Anna Help, David Graeber etc.

3. Add role to the permissions tree: Drag CAD-Test group into the Construction unit
4

. Tab Function access: Can pause synchronization, Can open configuration blocks set to
Yes

w

Create project: Creo 11.0 - Test project and GENIUS TOOLS Material Browser

6. Select project for access restriction: Creo 11.0 - Test project and GENIUS TOOLS
Material Browser

7. Add project to the permissions tree: Drag Creo 11.0 - Test project into the CAD-Test
group role, drag GENIUS TOOLS Material Browser into the CAD-Test group role
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Organization Function access 4]
Projects Permissions ®
~ ADMINISTRATION
+Q L IEE 1
CREO PARAMETRIC Can enter Project Configurator @ No
4 Standard
Is GTFC Admin ® ) no
Creo 11.0- Test project 42 Administrator
 SYNCHRONIZATION
b &2 Key User
s 4 Deutschland Unit Can pause synchronization m ‘fes
GEMIUS TOOLS Material 4 Berlin Subunit1  Prevent switch to local installation @ No
Browser
2 \ ¢ e Subunit2 . projecT
(&) Drag and drop for [A Creo Parametric 8.0 . y
Roles access restriction &, CAD-Test group Can analyze project 0 s
E +° o M Creo 11.0 - Test project Can see project information 0 Yes
e | C:n create project report Q Yes
A) ini Development
L) CRITETERT F Can analyze licenses m Yes
P Hamburg
o Can borrow licenses Yes
I. CAD-Test group b Leipzig Q
b Schweiz Can disable configuration blocks m Yes
&2 Construction b United_Kingdom Can open configuration blocks m Yes

02.07.2024 15:28:42

Result:

— Members of the CAD-Test group role have the rights listed above.

— Members of the CAD test group role have access to the Creo 11.0 Test project if they
select the Construction subunit from the Berlin unit in the GENIUS TOOLS Starter App.

— All other members of the Construction subunit in Berlin cannot see the test project.
(Divided unit-specific project access)

9.1.4 Project access - overview

This table shows the display in GENIUS TOOLS Starter App of access-restricted projects
when a user is a member of several roles.

Use case: The user Anna Help is member of the free roles Key User and Test Group
and member of the units (and assigned roles) Germany, Construction and
Development.

The following projects are displayed after selecting:

(a) Unit Construction at the location Germany > Berlin

(b) Unit Development at the location Germany > Berlin
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Project access
User A. Help crossunit unitspecific divided,
(free role) (assigned roles) u"'.t'.
specific
(free role)
Model Creo- Creo Creo 11.0
Processor Work Parametric - Test
11.0 Guidelines 8.0 project
Membership in:
Role Key User' X - - -
free role under Standard
Role Users-DE? - X - -~
assigned to unit Germany
Role Construction? - -~ X -~
assigned to unit Construction
Role Test Group* — -~ — X
free role under unit
Construction
Role Development - - - -
assigned to unit Development

Selection in GENIUS TOOLS Starter::

(a) Unit: Germany > Berlin > X X X X
Construction

(b) Unit: Germany > Berlin > X X - -
Development

' This example is described in Enable all key users to access the project.

2This example is described in Work guidelines DE.

3This example is described in Enable project access for test group within unit Designers
in Berlin.
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4 This example is described in Enable designers in Berlin to access the project.

5.8 View users rights

The role-based authorization concept of GENIUS TOOLS Starter allows different user
groups to be granted or denied different access rights. User groups are defined as roles.

You can assign access rights for individual projects to the members of a role and grant
rights for certain functions in GENIUS TOOLS Starter App and GENIUS TOOLS for Creo -
see chapters Kapitel Restricting project access and Granting function access rights.

Please note: Project access rights are always defined for the members of a role. The role
can be assigned to a unit or be used as a free role in the permissions tree.

In the main menu item Resources (&), you can view the access rights for individual users in
the card view.

E Resources —— Search Crad view E =
sh John Gardener — elix Havemann
Q J.Gardener e o
@ i:;‘“” e Felix Havemann
Computers fha
= ®
Creo startkeys
} Creo license servers o Anna Help O David Graeber
ahelp !Jw Lot |II I
@ Y hrep ) DGraeber
Anna Help David Graeber
ahe ara
2 5 &

User entries in the card view

Clicking on the icons Function access and Project access opens the following windows.

GENIUS TOOLS Starter © 2025 INNEO Solutions GmbH

120



GENIUS TOOLS Project Configurator G EN I US TO 0 I.S®;=

Anna Help Anna Help
The user has following permissions: The following projects can be accessed by the user:
Can enter Project Configurator p 4 No project restriction
SloutEsto X . INNEO - Creo Windchill 10.0
Can analyze project v @ Creo Parametric + Windchill in cloud
Can see project information v AutoCAD Architecture
Can pause synchronization >< A 2023
ARC
Prevent switch to local installation ><
Can analyze licenses o UnitedKingdom\Stratford-upon-Avon
) Creo Parametric 8.0
Can borrow licenses v
Old version
Can disable configuration blocks v
Can open configuration blocks v/ UnitedKingdom\Stratford-upon-Avon\Construction
Can save private configuration block to server v Creo 11.0 - Test Project
Can see auto projects (v SUT data for testing
Can save user-specific settings/customization.ui file v

Role: Key User
™™ Model Processor 11.0

X Close X Close

Access rights for user Anna Help List of projects that the user Anna Help sees.
The Function access rights result from all roles in which the user is a member.

Please note: Function access rights are always cross-unit: If a user has different rights in
different roles, the granted access applies regardless of which unit is selected in GENIUS
TOOLS Starter App. See chapter Granting function access rights.

Project access rights can be cross-unit or unit-specific, i. e. it is possible that a user does
not see an access-restricted project in all units with which she logs into GENIUS TOOLS
Starter App. Please refer to the tabular overview in chapter Restrict project access.

5.9 Resources

The following resources are managed in the main menu item Resources (&)
Static Entries for

1. user and

2. computers

For Creo Parametric projects,

3. Creo startkeys and

4. Creo license servers can be created.

Units and roles are not considered resources and are created in the menu item
Organization.
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9.9.1 Creating users

In the main menu Resources page @ static user entries are created and managed. You can
enter static user entries manually or import existing entries.

Static entries do not change automatically as dynamic user entries do. Changes to static
entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

Hint: We recommend that you decide whether you will work with static or dynamic
user entries before creating users, as mixing both types of entries greatly reduces the
clarity in GENIUS TOOLS Starter.

You can switch between the card view (default) and the list view with the icons to the right
of the search window.

— Resources + Search Card view . :E @

Add / List view E .

Create user.

B

The resource "User" can be displayed in two views

GENIUS TOOLS Project Configurator saves the last used view. User photos can only be
edited in the list view.

Adding static users manually

Static users are identified by their Windows user names. If you are not working with
Windows users as an authentication method, work with dynamic users.

To create a static user entry, click the Add icon (+) in the upper left corner. A new window
will open. Alternatively, you can write entries into a new row in the list view, see Editing
users in the section below.

GENIUS TOOLS Starter © 2025 INNED Solutions GmbH 122



GENIUS TOOLS Project Configurator G EN I US TO 0 I.S®;=

Edit/create user Hekp. Anna
Adding images is only possible in list view. ahEIP User I‘\.EII‘HE
] A Help QTS alias
O N Il.nage Anna Help GTS alias long
G © b3 ahe GTS alias short
Q User name Comment Technical Writer
ahelp Email ahelp@innec.com
GTS alias
A. Help User card in GENIUS TOOLS Starter App
GTS alias long
Anna Help
GTS alias short
ahe
Comment

Technical Writer
Email

ahelp@innea.com

@ Save ® Cancel

Dialog for adding users

Creating users with regular expressions

User as well as computer names can be specified either directly (so that only the
corresponding user is legitimized) or with regular expressions (a group of users is
legitimized by a definition). When using regular expressions in the fields Windows user and
computer name the entries are extended by » and §, i. e. to AINPUT$. Longer user names
can thus be legitimized by shorter and partial spellings, e. g. efoster legitimizes both
efoster and ethanfoster. Find a list of regular expressions in the appendix.

Importing existing users

You can import existing entries of Windows users with an Excel list. If you have switched
authentication to a system other than Windows (e. g. Windchill), the Import function 2,
which allows you to import users via the authentication provider, appears to the right of
the Plus icon. See Importing users with authentication provider.

Searching for users

To find existing users, enter a search term in the search input field with at least three
characters.
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» Editing users

To edit a user, double-click on a visiting card or use the list view if you wish to make
several changes. You need to use the list view for assigning a user image.

—+— Search Use list view
CREATE/EDIT USER

& User name GTS alias GTS alias long GTS alias short  Comment = Email
o e ahelp e S A Help o 2. || Anna Help e ahe e o ahe|@neo.com e
v & gmueller 2. 6. Miller 2 Gerd Miller gmu |
&, efoster O E Foster O Eric Foster efo efoster@inneo.com | [Il]
& [new usel ) 2, |}
List view
Blocked (1)
You can block a user, which means that unit settings or role assignment will not be
applied.

Yes/set: Settings or role assignment for this user will not be considered.
No/not set: Settings and role assignment will be used.

Camera (2)
List view: Double-click on the Upload icon to add a photo in PNG or JPEG format to the
user profile.

User name (3)

Enter the user name. If you are in the list view, you can get the user name for the currently
logged-in user by clicking on the person icon ~=. Instead of entering a user name you can
also use regular expressions. See Section below.

GTS alias (4)

Enter a GTS (GENIUS TOOLS Starter) alias for the user, for use in additional Creo
applications. For example, the GTS alias is used in GENIUS TOOLS Parameter. If you do not
specify an alias, the Windows user name will be set. If you are in the list view, you can get
the Windows user name for the currently logged-in user by clicking on the person icon in
the Windows user column. The GTS alias is available as an environment variable GTS USER
% in Creo.

GTS alias long (5)

Long user alias. The long alias is available in Creo via the environment variable <
GTS_USERLONGS.

GTS alias short (6)

Short user alias. The short alias is available in Creo via the environment variable ¢
GTS_USERSHORT%.

Comment (7)

Enter an optional comment. It is available in Creo via the environment variable ¢

GTS_USER COMMENT%.
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Email (8)
Enter the user e-mail address. It is available in Creo via the environment variable 2
GTS USER EMATLS.

Delete (9)
Clicking the recycle bin icon deletes the user entry.

Viewing user rights

You can view the projects accessible to a user and the functions granted in GENIUS TOOLS
Starter App in the map view, see chapter View users rights.

9.9.1.1 Action: Create user entry with image

Prerequisite:
You have an image in JPEG, PNG, SVG or GIF format. The storage location can be any. The
name of the image file is automatically changed to the user name when it is uploaded.
Procedure for the new user entry “Anna Help - ahelp”:

1. In the menu item Resources @, go to the list view.

ENIUS TOOLS

e
= Resources + [ Searn s ®
CREATE/EDIT USER
| Users @ User name GTS alias GTS alias long GTS alias short  Comment Email
Iy | gmuelier 2| GMiller 2| Gerd Miller gmu gmueller@inrobotd. [Il]
Computers Upload a0 || efoster 2| EFoster 2| Eric Foster efo efoster@inrobotde | [II]
@] Creo startkeys EymE) | | 2 | = | Add data for new user

2. Enter the user name in the bottom free line. If you are not working with an alternative
authentication method, this is the Windows user name: ahelp
The upload icon appears in the second column.

3. Click on the icon and select the existing image.
By uploading the image file, a folder with the user name is automatically created under
userdata and the uploaded image is automatically provided with the user name if a
different file name was available.
<working environment name>\userdata\ % USERNAME%\ % USERNAME%.png

Home Share View

© 4 [« CADDEPOT » Inrobot » userdata > v

Home Share View

v <« CADDEPOT » Inrobot » userdata

~ ~
~ Name

st Quick access ;
|| INNEO_PULS-Liste.xlsx

| INNEO_TODO-List xlsx
5] readmetxt

anyoddname
Py

|£ Documents

< Downloads

s Quick access
[Z Documents
4 Downloads

=] Pictures
D Music

B Videos

Jitems

&= Pictures
D Music

& Videos

Jitems

shelp.png

4. Enter the GTS alias: A. Help
The alias is available as the environment variable sGTs Users.
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5. Enter the GTS alias long if your company has assigned it: Anna Help
The long alias is available as the environment variable $GTs USERLONGS.

6. Enter the GTS alias short: ahe
The short alias is available as the environment variable $GTs USERSHORTS.

Resources + & s Q_i=
List view
CREATE/EDIT USER
I Users User name GTS alias GTS aliaslong GTS alias short Comment Email
& gmueller é G. Miiller ,.3 Gerd Muller gmu ]E
Computers
& efoster _—E, E. Foster ,—3 Eric Foster efo ]E
& ahelp 2 AHelp 2 | AnnaHelp ahe ahelp@inneo.com ]m
Creo startkevs
Ressourcen 9 [ ceq =
+ = Sl Card view s —

Anna Help Eric Foster Gerd Miiller
Users ahelp efoster gmueller
A. Help E. Foster G. Miller

Anna Help Eric Foster Gerd Milller

Computers ahe efo gmu

ahelp@inneo.com

Creo startkeys

7. Save the changes with [l in the sidebar.
The changes are saved in the sut.db database, which is located in the caddepot.

9.9.2 Creating computers

Computers are created and managed as permanent entries in the Resources page (@)
under Computers. Each computer is identified by its Windows computer name.

= Resources a_,_ - ) Q
— 4
CREATE/EDIT COMPUTER
'!'-Z-‘! Users Computer name Comment
CAD40 (o
@ I Computers o o . ) o
CAD41 T et T
I R— 0 s 0
| W | = =
=
Creo license servers

» Adding computers

To add new computers, click on the Add symbol (1) or write in the last input field of the
list.

P Searching computers
To find existing computers, enter a search term in the search input field (2).

» Editing computers

Blocked (3)
You can block a computer, which means that unit settings or role assignment will not be
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used.
Yes/set: Settings or role assignment for this computer will not be considered.
No/not set: Settings and role assignment will be used.

Computer name (4)

Enter the Windows computer name. You can get the Windows user name for the current
computer by clicking on the computer icon in the Computer name column. Instead of
entering a user name you can also use regular expressions. See section in Creating users.
Comment (6)

Enter an optional comment on the computer.

Delete (7)
Click the recycle bin icon to the right of the Comment column to delete a computer.

9.9.3 Importing users and computers from Excel

GENIUS TOOLS Starter comes with an XML interface to import a large number of users
into the GENIUS TOOLS Starter database in one step.

Follow the procedure described below to import users or computers. This will create static
entries.

Static entries do not change automatically as dynamic user entries do. Changes to static
entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

Format of the Excel table for importing users or computer

The directory caddepot\serveronly\tools\XML-Import contains two Excel tables —
computer.xls and user.xls — that serve as templates for creating XML files for import into
the GENIUS TOOLS Starter database.

A B c D
1 |USERNAME ALIAS DESCRIPTION ROLES
2 |meier Meier Bielefeld Entwicklung:Key User
3 |mueller Mueller Ellwangen Administrator
4 |schulze Schultze Leipzig Entwicklung;Key User

K
Excel table for importing users and assigning them to one or more

roles

Please note: A role that does not yet exist will be created on import.

Requirements:
— The first line in the Excel table is the header line. The header line must not be removed
and has to be formatted in all capital letters.

— Enter the name of the computer or user in the first column.

— You can use the following columns:
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For users: For computer:

USERNAME (mandatory) COMPUTERNAME (mandatory)
DESCRIPTION DESCRIPTION

ROLES ROLES

ALIAS

ALIASLONG

ALIASSHORT

EMAIL

— For roles, you can enter multiple entries, separated by semicolons.

Creating an XML file from the Excel table
After filling in the Excel table, export it from Excel as CSV (comma-separated value) file.
Beispiel: Content of a CSV file with a user list:

USERNAME;DESCRIPTION;ROLE
ahelp;Leipzig;"Users DE;Key User"
efoster;Edinburgh;"Users UK;Key User"
jturner;Edinburgh;Users UK

sholl;Berlin;Users DE

mweber;Berlin;"Users DE;Key User;GTFC Admin"

Please note: The separator character used by Excel depends on your locale. GENIUS
TOOLS Starter supports comma or semicolon as the separator character. You cannot
use either commas or semicolons in the contents of the columns! Please also refer to
Changing the separator for XML conversion.

The directory caddepot\serveronly\tools\XML-Import contains two batch scripts for
converting the CSV files into the XML import format. Use computer.bat for converting
computer lists and user.bat for converting user lists. The CSV file has to be called
computer.csv or user.csv and be located in the same directory as the batch script. When
you run the batch script, the XML import file will be written out as computer.xml or
user.xml in the same directory.

The XML files created by the batch scripts can now be imported into GENIUS TOOLS
Project Configurator. Open Project Configurator, go to the user menu {23 and select XML
import. Select an XML import file. You will be asked whether you want to delete existing
users or computers. Make your decision. Confirm the import with Yes.

The imported users and computers are now available on the Resources page under Users
or Computers. If the import has created one or more roles, these will be displayed on the
Organization page in the Access tab under Roles.
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Changing the separator for XML conversion

The separator character used by Excel for CSV export depends on your locale. You can
define the separator character in the batch scripts for CSV-to-XML conversion
(computer.bat or user.bat) as follows. Comma and semicolon are supported as separator
characters (sep) by default.

csv2xml -v -s:computer.csv -t:computer.xml -sep:;,

-m:1 -xsl:./extend/model-stylesheet.xsl

—alias:eRoot=RO0OT, eRecord=RECORD >>result.log

9.9.4 Importing users with authentication provider

For importing users who need to authenticate themselves, e. g. Windchill users, the Import
function & is available. The button appears when switching to another authentication
system than Windows in the unit settings.

Resources + N \mm Q| = . @

BENUTZER EDIT| Import users

Retrieve and import all users by using the authentication provider.
Users @] User name GISahas GIS alas long GTS ali
’LE‘ fQ\
Computers

o
) —

For Windchill, all users are imported from the defined Windchill server and the following
information is taken:

"Name" > Username / GTS Alias
"FullName" > GTS Alias Long
"AlternateUserName1" > GTS Alias Short
"Email" > Email

If you want to use other authentication systems you have to create a customized provider,
see chapter Creating your own authentication provider.

9.9.9 Creo startkeys

A startkey is a configured start command that opens Creo with one or several defined
licenses or license extensions. Startkeys are created in PTC's installation assistant when
setting up or reconfiguring Creo, see Creo startkeys (PSF keys).

An administrator can provide user with a choice of several Creo startkeys per project so
that the quantity of projects can be minimized.
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Warning: Using Creo startkeys as a resource is a new feature in GENIUS TOOLS Starter
from version 6.0.1, which means that you need a subscription license to use it. Once
you have configured startkeys in this section, you cannot go back to using perpetual
licenses. See also License-dependent features.

In the main menu item Resources [& enter a display name and a comment for a Creo
startkey which users view in GENIUS TOOLS Starter App.

INNEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

S Resources Creo Startkey @ @
=+ M  CREO STARTKEY

FE’E Display name o Foundation

| Users AAX
Description e found.psf

@ Computers Default Creo Startkey o found.psf

Blocked (4] ® ) No

I Creo startkeys I Foundation
Creo license servers Plastic Advisor

Managing Creo startkeys in main menu Resources

If several start keys have been created, users can select a key when starting a project in
GENIUS TOOLS Starter App. The order of the start keys in the user selection field is that of
the order in the dialog window and can be changed by using drag-and-drop.

Display name (1)
Enter a name for the license key for display in GENIUS TOOLS Starter App.

Comment (2)
Enter a comment for the license key for display in GENIUS TOOLS Starter App.

Creo startkey (3)
Enter the name of the license key. This is the name of the PSF file in the bin directory of
PTC (e. g. parametric.psf).
Blocked (4)
Yes: The Startkey can neither be used nor selected by users.
No: The Startkey can be either directly used or selected by users in GENIUS TOOLS

Starter App.
Startkeys can now be

— directly assigned to a project (see chapter Assigning Creo licenses to projects),
— assigned to units and subunits which have access rights to particular projects and/or

— entered as a global standard (see Configuring global environments > Creo settings).
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5.9.6 Creo license servers

In the main menu Resources (&) you can group one or several Creo license servers into one
resource and then assign this resource Creo License Server to a project or unit.

P Creo license servers
Display name (1)
Enter the name for display of the Creo license server(s).

Comment (2)
Enter an optional comment for the Creo license server.

Creo license server (3)
Enter one or more license servers in the notation porteservernamne (e.g.
7788@<licenseservername>). Separate a series of license servers with semicolons.

Blocked (4)
Yes: The Creo license server cannot be accessed.

Warning: If you block the Creo license server here, the information from the Creo
startkey (PSF file) will be used. Check whether these information are correct.

No: The Creo license server can be used.
The Creo license server(s) can now be assigned:

— directly to a project in Projects > Tab: Creo > Section: Creo license server (See chapter
Settings for Creo projects)

— to units and subunits, which in turn can be granted access to specific projects (See
chapter Settings for Creo projects)

— to the global settings in Configuration > Creo settings > Tab: Application > Section: Creo
license server (See chapter Application)

5.10 Glohal settings: Standard

The next sections explain the potential of configuration options for Starter projects. The
first step is to create the general, global configuration that is required for each system, the
so-called standard configuration. In the next step, deviations from the basic configuration
are made in units and subunits, see chapter Configuring heterogeneous environments.

The unit Standard is pre-installed for the global configuration of the system.

Please note: The group Standard contains the system-wide configuration settings and
is preinstalled. No members can be assigned to it.

Settings are made in input fields and inherited, see Inheritance of the settings.
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If you do not specify anything in the drop-down menus, the default settings of GENIUS
TOOLS Starter apply. These are "No".

You can make the following settings:
— GENIUS TOOLS Starter App

— Additional Environmental Settings
— Synchronization

— GENIUS TOOLS License Manager
— Network Connections

— Creo Parametric

— Creo Elements/Direct Modeling

— SolidWorks

- Inventor

— Windchill Settings

Since these settings can be configured separately for all units, the input fields are
explained in the chapter unit settings.

5.10.1 Authentication

By default, GENIUS TOOLS Starter uses the Windows user name, i. e. there is no separate
login process.

However, administrators can specify that users log in with other user credentials, e. g. as a
Windchill user or as a user of an ERP system such as SAP. This makes it possible to connect
Starter projects to existing authorization groups of other systems. In this case, a login
dialog appears when opening GENIUS TOOLS Starter App and GENIUS TOOLS Project
Configurator.

Please note: Integrating an alternative authentication system with GENIUS TOOLS
Starter requires a subscription license.
Authentication is always global, i. e. can only be set in the group Standard.

In the menu item Configuration @B, go to the settings for GENIUS TOOLS Starter App to
change the authentication system. For Windchill, the required Authentication providers
are supplied. How to proceed and how to create an authentication provider for other
systems, is explained in the following chapters.

Changing the authentication method restarts GENIUS TOOLS Starter App.
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Switching from Windows user credentials to other authentication
methods

The user who changes the authentication provider is automatically saved as administrator,
i. e. becomes a member of the Administrator role. For this purpose, the new credentials
are requested before it is possible to save the database.

The query of the login credentials fails in the following cases:
1. The user name and / or the password are wrong.
— An error message appears.

2. You are offline / user name and password are correct and were used during the last
login.

— A message appears that you are offline.
3. There is no EXE file in the auth_provider directory or it does not have a valid signature.
— GENIUS TOOLS Project Configurator and GENIUS TOOLS Starter App are closed.

Note that it is possible to save a new authentication method even without successfully
entering the credentials, namely by confirming the error message. If you want to make use
of this possibility, e. g. because you access GENIUS TOOLS Project Configurator externally,
make sure that you enter correct credentials and check the role assignments and function
accesses.

Warning: If incorrect credentials are saved for the new authentication method, you
may not be able to re-enter GENIUS TOOLS Project Configurator.

To avoid being permanently locked out of GENIUS TOOLS Project Configurator, you can
manually add your alternative authentication system user name or assign "Everyone" to
the Administration role.

Restoring authentication with Windows

If you have locked yourself out of GENIUS TOOLS Project Configurator when switching to
an alternative authentication system, you can use the last used database sut_*.db in
Caddepot under <OperatingEnvironment>\configuration\database\BackupDefaultAuth to
restore the operating environment.

9.10.1.1 Authentication provider

An authentication provider is an executable file that requests or receives user data from an
authentication system.

Any executable file in the auth_provider system folder is recognized as an authentication
provider.
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GENIUS TOOLS Starter addresses the authentication provider during the following
operations::

1. To authenticate login credentials when starting GENIUS TOOLS Starter App and
GENIUS TOOLS Project Configurator.

2. When querying static user entries.

3. When querying dynamic user entries from user groups.

In the menu item Configuration @ > GENIUS TOOLS Starter App the authentication
provider is defined. For Windchill, two providers are supplied: Auth_Windchill.exe and
Auth_Windchill_SSO.exe, see chapter Authentication for Windchill users.

NEQ GEMIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0 .
= Settings Units © STANDARD @
~ AUTHENTICATION
=
EE'E GENIUS TOOLS Authentication provider Auth_ Windchill.exe
Standard
@ —~ b Deutschland \Windchill/
Additional b Schwalz
environment variabl...
P United_Kingdom I DESKTOURTING

Setting Windchill as authentication system in the Standard unit

If you use one of the supplied authentication provider for Windchill (Auth_Windchill.exe,
Auth_Windchill_SSO.exe), the Windchill server must be entered in this field in the notation
server=<Windchill-Server-URL>.

GENIUS TOOLS Starter automatically writes a configuration file named
<AuthenticationproviderName>.cfg in the directory auth_provider. The content is the text
of the field Authentication provider config in the Authentication section.

If you create your own authentication provider, you can enter additional information in
this field, see next chapter.

9.10.1.2 Creating your own authentication provider

If users are to authenticate against a system other than Windows or Windchill, a separate
provider must be created. This can be selected in GENIUS TOOLS Project Configurator
under GENIUS TOOLS Starter App > Authentication.

An authentication provider is

— an executable file,

— which is signed and

— stored in the system folder auth_provider.

To create your own authentication provider, you need the following information for
output and input.
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Input

GENIUS TOOLS Starter passes the following information to the authentication provider:
— username (from the login credentials)

— password (from the login credentials)

— path to the config file <AuthenticationproviderName>.cfg (see Authentication provider
config)
— transfer parameter -users (passed only when querying users)

— transfer parameter -groups (passed only when querying user groups)

Output

GENIUS TOOLS Starter expects the following output from the authentication provider:

For login
The output of the login result (point 1) must be done. All other output is optional.

1. Login result

1 — successful
0 — not successful (e. g. password and / or username wrong)
2 — special case: not successful, system is unavailable

2. Current user as JSON object with the following structure:

{"AlternateUserName1":"<GTS Alias Short>","Email":"<Email>","FullName":"<GTS Alias
Long>","lId":"<ld>","Name":"<username>"}

3. Result of the group query for the current user

1 — successful
0 — not successful (e. g. password and / or username wrong)
2 — special case: not successful, system is unavailable

4. List of groups for the current user as a JSON object with the following structure:

[{"Description":"Description of the group","ld":"Group Id","Name":"Group name"},

{"Description":"Description of the group”,"ld":"Group Id
o]

User query
A user query in the GENIUS TOOLS Project Configurator imports users and creates static
entries.

,"Name":"Group name"},

Hint: We recommend that you decide whether you will work with static or dynamic
user entries before creating users, as mixing both types of entries greatly reduces the
clarity in GENIUS TOOLS Starter.
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1. Result of the user query

1 — successful
0 — not successful (e. g. password and / or username wrong
2 — special case: not successful, system is unavailable

2. List of all users as JSON object with the following structure:

[{"AlternateUserName1":"<GTS Alias Short>","Email":"<Email>","FullName":"<GTS Alias
Long>","Id":"<ld>","Name":"<Username>"},
{"AlternateUserName1":"<GTS Alias Short>","Email":"<Email>","FullName":"<GTS Alias
Long>","Id":"<ld>","Name":"<Username>"},

.

User group query
A user group query imports user groups with their associated users and creates dynamic
user entries.

1. Result of the user group query

1 — successful
0 — not successful (e. g. password and / or username wrong
2 — special case: not successful, system is unavailable

2. The user group output must consist of the following two lines per user group:
— Line 1: User group as JSON object with the following structure::
{"Description":"Description of the group","ld":"Group Id","Name":"Group name"}
— Line 2: A list of all users in the user group as JSON object with the following structure:

[{"AlternateUserName1":"<GTS Alias Short>","Email":"<Email>","FullName":"<GTS Alias
Long>","lId":"<ld>","Name":"<User name>"},
{"AlternateUserName1":"<GTS AliasShort>","Email":"<Email>","FullName":"<GTS Alias
Long>","lId":"<ld>","Name":"<User name>"},

o]

In this way, all user groups must be output with their corresponding users.

5.10.1.3 Authentication for Windchill users

If you want to authenticate Windchill user data, this can be done either directly by a
Windchill server or by a Windchill server with SSO (single sign-on) setup. The
authentication providers (EXE files) required for this are supplied:

— Auth_Windchill.exe: Web authentication with BasicAuth (REST API)

— Auth_Windchill SSO.exe: Web authentication is carried out via an SSO server
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Authentication for Windchill users without SSO

To change the standard authentication with Windows to Windchill user data, follow this
sequence of necessary steps.

Procedure:
1. Change global settings in the menu item Configuration & > GENIUS TOOLS Starter App
> Authentication.

— In the drop-down menu, select: Auth_Windchill.exe

- In the field Authentication provider config, enter the Windchill server using the
notation: server=<Windchill-Server-URL>

2. Import users
— Decide whether you are working with static or dynamic user entries.

Static entries do not change automatically as dynamic user entries do. Changes to static
entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

Dynamic user entries adopt changes from the system in which they have been created.
— Import static entries under Resources > Users using the import function 2

— Import dynamic entries under Organization > Access > Roles using the update
function. B8 .

3. Assigning users to a role
— Create a role.

— You assign static entries individually under Organization > Access > Roles > tab:
Details > section: Users (GTS).

— You assign dynamic entries through user group membership under Organization >
Access > Roles > tab: Details > section: Users (Authentication provider).

4. Editing users
— All user entries can be individually edited and commented. A photo can be added.
— Static entries can be deleted or locked under Resources > Users (GTS) > Editing users

— Dynamic users cannot be deleted or locked because they are associated with a user
group. A user group can be deleted or locked under Roles > tab: Details > section:
Users (Authentication provider) > User groups.

5. Save changes with

— The Save function requests the new access data. Please note the points when
switching from Windows to other authentication systems and as well as the recovery
options.
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Result:
— Restarting the GENIUS TOOLS Starter App

— The Auth_Windchill.exe file performs web authentication with BasicAuth

— Input screen for user data appears in GENIUS TOOLS Starter App and GENIUS TOOLS
Project Configurator

Login
Please enter username and password.

ahelp

Authentication for Windchill users with SS0

For the SSO authentication of Windchill users, proceed as follows:

Procedure:
1. Ensure that the Windows setting Named Pipe is activated.

Change global settings in the menu item Configuration @ > GENIUS TOOLS Starter
App > Authentication.

Under Authentication provider, select in the drop-down menu:
Auth_Windchill_SSO.exe

2. In the field Authentication provider config, enter the Windchill server with SSO setup in
the following notation: server=<windchil1-S$SO-Server-URL>

3. Continue with point 2. of the previous procedure without SSO.

Result:
— GENIUS TOOLS Starter App is restarted.

— The file Auth_Windchill_SSO.exe opens the file GT_SSO_Proxy.exe, which transfers the
authentication request to the SSO server.

- GT_SSO_Proxy.exe is also used by other GENIUS TOOLS products (e.g. MPUser) and
may therefore already be present.

- GT_SSO_Proxy.exe requires the Windows setting Named Pipe.
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— If Windchill users are authenticated by the domain when logging in, no input mask
appears.

Please note: SSO authentication cannot be supported for server operating systems that
allow several users to work simultaneously on one machine.

5.11 Configuring heterogeneous environments

IT landscapes very seldom have a homogeneous structure. There are different hardware
setups and different user requirements, so that different configurations for starter projects
arise automatically and heterogeneous environments have to be created. GENIUS TOOLS
Starter has been designed to meet these requirements and makes it possible, to organize
similar configurations into units and subunits. In this way, you may define the following
unit-specific configurations:

— settings for GENIUS TOOLS Starter App

— settings for data synchronization

— use of license servers

— PTC data management software (e.g. PDM Windchill for Creo),

Differences from the standard configuration, that is, from the system-wide settings in the
unit Standard, can be defined for units and subunits =/ in the Configuration i) page.

Unlike the unit Standard, all other units have members that can be entered individually or
dynamically. Use units to assign users dynamically through an LDAP connection. This is
done through a role-based assignment, see chapter Accessing Windows user
management.

A mouse click opens the settings for the selected a unit or subunit as well as for all higher-
level units. These can be hidden with the eye symbol.

Oo

e

© STANDARD © DEUTSCHLAND © BERLIN © CONSTRUCTION
Standard Unit €@ swunitn [ IET

Windows user (default)

GENIUS TOOLS 4 Standard
Starter App
4 Deutschland

Additional 4 Berlin
environment vari

Settings (here: for GENIUS TOOLS Starter App) for
he selected subunit (here: Constr and all
superordinate units (here: Standard, Germany,

3 Construct ion Name GTS Inneo G Berlin)

B3 @& &

Synchronization Manufacturing

GENIUS TOOLS b Hamburg

b Leipzig Unit argument ~gtsunits=-1 ~gtsunits=1 ~gtsunits=1,24 ~gtsunits=1,24,27

You may not make any specification, i. e. the selection field remains empty and values are
inherited. (See next chapter.) Fields that contain inherited information can be overwritten
by writing into the input field which then appear in black font.

Please note: If an input field inherits values from the higher-level configuration levels,
you will still only see the global default value displayed in gray.
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9.11.1 Inheritance of the settings

It is possible to overwrite the global settings (Standard) in the lower configuration levels. If
the input field of a unit or project remains empty, the setting of the higher configuration
level is adopted.

The specifications in units and projects are inherited as follows. (See also Call sequence for
settings.)

Settings in GENIUS TOOLS Project Configurator

global unit settings 1—‘ project settings
Standard Subunit 2
.. former groups.

Hierarchy of settings made in GENIUS TOOLS Project Configurator

Default settings

If settings in a drop-down menus remain empty, the default setting of GENIUS TOOLS
Starter will be inherited. This is "No".

Project language selectable ‘ - |
Mo
Yes
Defautt: No —— [
Empty selection field

Please note: Default settings are inherited to the lower configuration level until
overwritten.

9.11.2 Deviations from the standard configuration

This sections explains how to define the language of Creo Parametric as a user-defined
setting as an example for configuring deviations from the standard setting.

9.11.2.1 Defining Creo language for specific users

Before Creo starts, the Creo Ul language can be set to one of the following: English,
German, Italian, French, Spanish, Japanese, Chinese (Simplified), Chinese (Traditional),
Korean, Russian, Brazilian Portuguese. The languages are provided for Creo by PTC.
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Please note: GENIUS TOOLS Starter does not influence the way different locale settings
interact. For information on supported settings, please refer to the PTC website or the
product documentation.

The Ul language for Creo can be defined on four different levels in GENIUS TOOLS Project
Configurator. The language can be set on four configuration levels. If you make settings
on several levels, the last specification is valid, e. g. specifications in a project overwrite the
specifications of units, see Call sequence for settings.

1. System-wide
Main menu Configuration > Creo Parametric > Standard > tab: Start > Startup settings

2. Unit
Main menu Configuration > Creo Parametric > Select unit > tab: Start > Startup settings

3. Group
Main menu Configuration > Creo Parametric > Select subunit > tab: Start > Startup
settings

4. Project
Main menu Projects > Select project > Creo tab > Startup

The following example procedure refers to unit settings.

5.12 Unit settings

Having configured the standard settings, i. e. the global settings of the system, you can
now realize deviations from this basic configuration by making settings in the menu item
Configuration & for the different units and subunits of the organization tree.

It is also possible to define settings directly on the project, see Project settings.

Be careful to take into account the order in which the settings are inherited in GENIUS
TOOLS Project Configurator, see Inheritance of the settings.

9.12.1 GENIUS TOOLS Starter App

In the GENIUS TOOLS Starter App area you can set up the desktop link, the support and
basic presentations of projects.

For the presentation of individual projects as well as the tabs that contain additional
information and functions, please refer to Presenting projects to users.

5.12.1.1 Authentication

This setting can only be defined globally, i. e. for the Standard group, see chapter Global
settings: Authentication.
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9.12.1.2 Configuring the desktop link

By default, a desktop link for GENIUS TOOLS Starter App is created automatically on the
application computers. You can define the properties of this desktop link in Project
Configurator, including centrally-defined start parameters.

To configure the desktop link, go to the Configuration page &, select a group, then select
the settings item GEN/US TOOLS Starter App. Set Create desktop link to Yes. This setting
determines that the desktop link is created or updated according to the configuration with
each program start or synchronization process.

GENIUS TOOLS Starter App starts with the selection of the unit that was last selected by a
user.

Alternatively, you can specify that a desktop link opens GENIUS TOOLS Starter App with a
specific, pre-selected unit by defining the start parameter -gts:units with the ID string of a
unit. This means the user is given a default setting of a unit. If the user is not assigned to
this unit, the unit selection dialog will be displayed.

The ID string is displayed under Unit argument and can be used for copying.
Further transfer parameters can be used

— to start GENIUS TOOLS Starter in a specific language (-gts:lang)

— to open GENIUS TOOLS Project Configurator directly (-gts:admin)

— to open a specific project (-gts:p)

A list of all start parameters can be found in the GENIUS TOOLS Starter installation manual
in the chapter Customizing the GENIUS TOOLS Starter environment.

INNEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

@ STANDARD @

Oo
Dﬂ

Settings Units
- ¥ AUTHENTICATION
E ‘
Bl |~ DESKTOP LINK
@ 4 Deutschland Vi GTS Inneo
Additional b Berlin
environment variables — Execution path (|
Synchronization b Leipzig Commandline arguments
= P Schweiz Unit argument -gts:units=-1

You can define the following settings for the desktop link.

Name
You can define a name for the desktop link. Without an entry the desktop link will be
named GENIUS TOOLS Starter App - <operating environment name>.

Execution path
Enter the path GENIUS TOOLS Starter App should be run in.

Commandline arguments
Enter any start parameters that should be used by GENIUS TOOLS Starter App.
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Warning: If you used start parameters in version 6.0.0, take care to move them to this
setting in Project Configurator. If the start parameters are not specified here, start
parameters in local links will be deleted!

Unit arguments
Shows the start parameter -gts:units and the ID chain of the unit.

Warning: If the start icon is located in the users\public\desktop directory, it cannot be
changed with user access rights. This means that the central icon definition cannot be
applied!

Custom icon graphic

If you want to use a custom icon graphic, you have to place a file of 265*265 pixel in the
_Images directory of the operating environment using the file name
<operating_environment_name >.ico.

9.12.1.3 Support link and logging

In the GENIUS TOOLS Starter App settings under General you can define whether users
should have access to the online support function of INNEO (TeamViewer) or to a
company-specific link or document. You can also hide the Support menu item altogether.

» General

Hide support

Hides the menu item Support in the user menu item Help of GENIUS TOOLS Starter App.
No selection (Default): Users are referred to the Hotline website of INNEO.
No: The user sees the Support item in the menu.
Yes: The Support item is not visible.

Help 5 » Help (F1)

GENIUS TOOLS Knowledge Base

Open home
Support

Open log file (F2) About (F12)

F 5 WO I ] R s S
Support
Enter the URL of a website or the path to a document. Set the above field Hide support to
No.

Log projects without permission
Projects to which a user has no access rights are by default not displayed in the log file.
Yes: Information about the projects is displayed in the log file.
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No (Default): Projects are not included in the log file.

Write crash report to Caddepot directory
Unexpected errors are written to a log file by GENIUS TOOLS Starter App (gts_error.log).
The file can also be copied to the server and is saved there as
serveronly\_ErrorLog\ < Computer_name>.log.
Yes: The client will copy its log file if an unexpected error occurs.
No (Default): The log file is only available on the client computer.

9.12.1.4 General display of projects

In the Projects area, settings are made for all projects that are available for the selected
group or unit. These settings concern the display of invalid projects and the possibility to
provide the language as a project option. They are described in the chapter Presenting
projects to users.

9.12.1.5 Operating environment clean-up

In the Cleanup of operating environment section of the GENIUS TOOLS Starter App settings
you can define whether an outdated operating environment should be deleted from the
application computers, that is, from the Cadpool directories. The operating environment in
the Caddepot is not affected. The user is asked to confirm before the deletion process is
started.

5.12.2 Additional environment variables

You can define environment variables that are assigned to the client workstation under
Additional Environment Settings. This allows you to define additional, company-specific
variables that are available after starting an application without having to use batch files.
For a list of the environment variables created or modified, please refer to the installation
document (GENIUS TOOLS Starter Installation.pdf). The table in the installation document
also lists the corresponding deprecated environment variables, which are still being
generated for compatibility purposes.

Name
Enter the name of the environment variable here.

Value
Enter the value of the environment variable here.

Delete
Click the recycle bin icon to the right of the value input field to delete the line.
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9.12.3 Synchronization

Synchronization allows for having all important files available locally on the local
workstation. This ensures the fastest possible access to these files.
No toolkit applications will be synchronized while Creo is running.

Please note: Options that cannot be selected in this dialog box can be changed in
GENIUS TOOLS Environment Administrator.

Please note: If an input field inherits values from the higher-level configuration levels,
you will still only see the global default value displayed in gray.

» General

Activate synchronization

Shows whether synchronization from the Caddepot or Git repository to the Cadpool
directory is active. If synchronization is deactivated, all computers will only operate locally.
Synchronization is activated/deactivated with the Modify function of GENIUS TOOLS
Environment Administrator (Step 3 > Client settings).

Target directory
Defines the Cadpool directory on the client workstation.

Please note: Changing this entry leads to an initial installation of GENIUS TOOLS
Starter App on the client.

Synchronization interval (minutes)
Specifies the interval at which synchronization is performed in minutes.

Please note: For modifications of the synchronization interval to take effect, GENIUS
TOOLS Starter App has to be restarted.

Start client with windows
Determines whether GENIUS TOOLS Starter App should be started automatically with
Windows.

Save result to Caddepot directory
Determines whether the result of the synchronization should be transferred to the server.
This includes the end time of the last synchronization, the number of copied files,
warnings and errors. The user needs write access in the Serveronly folder.
Yes: The result of the synchronization is saved as <hostname>.log in
caddepot\serveronly\_SyncResults.
No: The result is not transferred to the server.
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» Server

Checksum validation
Shows whether the checksum of a synchronized file is matched with that of the file on the
server. The settings for validating checksums are entered in GENIUS TOOLS Environment
Administrator with the Modify function (Step 2 > Synchronization server settings).
Yes: A checksum is determined for each transferred file and matched with the checksum
from the server. If these differ, the file will be requested again.
No: Files are only copied.

Warning: Activating Checksum verification can significantly slow data transfer.

Server name
Displays the name of the synchronization server.

Comment
Displays the description for the server.

Synchronization type
File system: Each file is copied when synchronized.
Service: GENIUS TOOLS Starter Service checks all files for changes and updates only
these changes during synchronization.
Git: GENIUS TOOLS Starter Gitea is used for data synchronization. When creating a Git
repository with GENIUS TOOLS Environment Administrator, this option is selected here
automatically.

Server path
Displays the UNC path to the synchronization server for file system and service and the
URL address of the Git server.

9.12.4 GENIUS TOOLS License Manager

In order to use the full version of GENIUS TOOLS Starter, you will need a connection to
GENIUS TOOLS License Manager. You can define the server from which GENIUS TOOLS
Starter App should obtain licenses. Without a valid license server entry or when
deactivating the entry, Creo projects can only be started with an academic or home-use
license.

The specifications for license servers are possible for the system-wide settings as well as
for individual units.

Warning: If you change any of the license server settings below, you need to restart
GENIUS TOOLS Starter App.
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» GENIUS TOOLS License Manager

Active
Activate/deactivate the license server(s).

License server(s)

Enter one or more license servers in the notation porteservernamne (e.g.
7766@<licenseservername>). Separate a series of license servers with semicolons.

For license servers of INNEO Cloud, enter the URL address. Additional input fields are then
displayed:

Tenant ID, Tenant short name

Enter the credentials for accessing the license server. You will receive these from the cloud
operator.

Comment
An optional comment on the license server(s).

Hint: The license server used can be found in GT_LIC_SERVER in Creo. You can use this
variable, for example, in GENIUS TOOLS for Creo.

5.12.5 Network connections

» Network drive
Here you can connect a shared network folder that will not be synchronized.

Connect

Specify whether to map the network drive.
Yes: The network drive is mapped when GENIUS TOOLS Starter App is started. If a
drive with the specified drive letter already exists, this drive will be disconnected and
then re-connected according to the configuration, but only if it is not already the drive
to be mapped. This connection will remain active after you stop Creo.
No: Network drive is not mapped. Use this option if the drive mapping is already
established by other means, such as a Windows login script.

UNC path
Specifies the path to any folder on the server.
Usually given as a UNC path: \\COMPUTER\CreoData.

Drive letter
Assigns a drive letter that the drive is mapped to.

Remap drive

Comparable to the Windows function map network drive.
Yes: After restarting the computer the drive will connect automatically.
No: The drive will not be remapped after a restart.
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» User drive
Here you can map an additional user-defined drive.

9.12.6 CAD applications

The unit settings for the various CAD applications are explained in the corresponding
chapters:

— Creo Parametric
— Creo Elements/Direct Modeling
— SolidWorks

— Inventor

9.12.7 Windchill settings

For filling out this tab, read the chapter Automatic Windchill server registration.

9.13 CAD-specific project settings

For all projects of CAD applications the following can be specified:
— a specific release
— a project directory: This can contain project specific configuration and batch files.

— a data directory: This contains all object data.
For example, for Creo Parametric: <GTS_ROOT_DIR>\parametric\data\sut_creo9. (For
Creo Parametric, object data is provided with the Startup TOOLS product package).

— the startup behavior

— project-specific environment variables

Hint: We recommend to define settings at the highest possible configuration level, i. e.
to make as few settings as possible for individual projects. For example, individual
projects may only contain the version-specific settings.

All other specifications differ according to the CAD application and are described in the
respective chapters under Project settings:

— Creo Parametric
— Creo Elements/Direct Modeling

— SolidWorks
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— Inventor

— AutoCAD

Installation directory

For projects of the CAD applications a specific software version can be defined. The
corresponding installation directory is specified in the application in the Configuration
menu item or searched for automatically.

There are three different ways in GENIUS TOOLS Project Configurator of configuring the
installation directory and its start command:

1. Set a fixed install path on the Configuration page
2. Set a fixed install path in the project
3. Via the local Windows registry on the application computer

Depending on your requirements, each way of defining the installation directory can make
sense. With several entries, the result is determined by the call order of the settings.

Configuration P CAD application

Settings Units Application @
’r_l ’V\ [ @ STANDARD
= —= EEC

P Deutschland Creo install path
| Creo Parametric P Schweiz Data directory data-global (o

P United Kingdom A CREQ PARAMETRIC DIRECTORIES

Configuration > CAD application > Select group or Standard > Tab: Application > Segment:
Application > Install path

Install path

— Specify a directory on the user computer where the CAD application is installed: This
allows the path to be inherited to projects, if "Given Path" is selected on the project
under Release and the entry is left empty. (see screenshot below, 1).

— Do not specify an installation path: This determines the installation directory
automatically from the local Windows registry and usses the software version from the
project details (2).

Please note: It is generally recommended to determine the installation path from the

local Windows registry.

Projects P CAD application

For an individual projects you can now specify a software version (1) or enter a fixed path

(2).
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Application types Projects

GENIUS TOOLS'™"

Creo
A
+ @ Ty 12 @
& crenp " . New Project SAGENERAL
reo Parametric
Neues Projekt # CREO PARAMETRIC
@‘ i : Release o | G i M
4 Creo Elements/Direct Creo Parametric 11.0 &f -
Modeling Given Path
Current version Fixed Path

Creo 2.0

SolidWorks . Creo Parametric 12.0 Project directory Creo 3.0
EI Latest Version Data directory T

Inventor 1=

Creo 110

(&)

AutoCAD
g AutoCAD ~ CREQ PARAMETRIC

Architecture a —— .

Release
AutoCAD Mechanical Fixed Path without specification, path will be inherited ]
Project directory )
AutoCAD LT
Data directory data-global (]

Projecnz:; > CAD Application > Select project > Tab: CAD application > Segment: CAD
application > Release: Select version or "Given path"

These rules apply:

— GENIUS TOOLS Starter finds the installation directory of an application on the user
computer.

— Fixed path specifications are only necessary if the program is not automatically found.

— If you want to work with different releases or versions, e. g. as a construction service
provider, this should be defined in the project.

— If the local installations are vary considerably or are not known in detail, the installation
can be determined with the help of the local Windows registry.

— If no installation directory is specified, it is read from the registry.

5.14 Making use of project options

Administrators can provide users with choices for a project ("Project Options"). These
appear as a drop-down menu or as a checkbox on all projects that are available to a unit.

Project options can be used to significantly reduce the number of projects. The following
project options can be provided.

— application language (drop-down menu)
— Creo startkey (drop-down menu)

— company-specific project options (checkboxes)
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Creo Parametric 11.0 Creo Parametric 11.0.0.0

MNeueste Version

language Creo startkey
ﬁ /,@ ﬂ ’—&'1 = % f en ¥ | Default - parametric.psf =
v & AAX ef BMX ¢f Freestyle Design
@f Manikin @f Notebook @f‘; Simulation Live
& Toolkit v GENIUS TOOLS for Creo Big assemblies
Keyshot 10 plugin |+ MP User company-specific project options

Options of a Creo Parametric project
The following table describes three options and the procedure for their creation.

Function Description Configuration / creation

Language selects the language in which to start ~ configured in GENIUS TOOLS
the application Project Configurator for all

= application, see next chapter
Creo selects the license package (PSF key) configured in GENIUS TOOLS
startkey with which to start a Creo Parametric  Project Configurator, see
I o] (o] -Tai Assigning Creo licenses to

projects

Company-  activates license extensions, created with configuration
specific additional programs or further blocks for each application, see
project configuration settings Making use of project options
option

9.14.1 Language

You can grant user the right to select the language of the projects they have access to. If
the right is not granted, neither selection field nor information about the applied language
appears. If you want to provide users with information about this, you can include this in
the name of the project or in the subititle, e.g. Creo Parametric 11.0. DE.

Language selection field

The right to select a language is granted in Configuration > GENIUS TOOLS Starter App >
Select unit > Projects and applies to all projects.
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Project language in GENIUS TOOLS Starter App selectable
Projects of CAD applications support the use of project options. In this area, you can set

up
— the right to select the project language (drop-down menu in GENIUS TOOLS Starter
App)

— the arrangement of the checkboxes for license extensions, additional programs and
other configuration settings. To create this type of project options, consult the chapter
Making use of project options.

Specify whether users are allowed to change the preset language, in which the programm
is to start. The language of a project can be preset in the Projects main page under CAD
application > Projects > Tab: Start > Startup settings > Language.

Please note: This option requires that the selectable language has to be available in
the programm installation used. This is not checked by GENIUS TOOLS Starter.

Yes: Users have the right to change the language of a project. If this options is
activated, a drop down menu will be displayed in GENIUS TOOLS Starter App.

No (default): Users cannot change the language. There is no information about the
language that the programm will start in.

9.14.2 Company-specific project options
Administrators can create company-specific project options. These become visible as

checkboxes in the project area of GENIUS TOOLS Starter App.

For projects of the CAD applications, the following company-specific project options can,
for example, be created.

Creo Parametric: additional applications GENIUS TOOLS for Creo, Model Processor User,
Keyshot, mapkeys license extension such as Simulation Live, AAX, Manikin

Creo Elements/Direct Modeling: none
SolidWorks: SolidWorks Composer (Add-in), drawing frames
Inventor: Additive Manufacturing (Add-in), drawing frames, read-only mode

A detailed description of the possibilities to use project options for the respective
application is described in the chapter Project Display in GENIUS TOOLS Starter App of
each CAD application.

Types of company-specific project options

A distinction is made between individual and combined project options as well as switch
options (in italics).
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Creo Parametric 11.0 Creo Parametric 11.0.0.0

Neueste Version combined
ﬁ /,_f@) ﬁl |—.5_l,'1 = % f en ~  Default - parametric.psf A mbd project option
v o AAX e BMX &f Freestyle Design
@f Manikin @f Notebook @f Simulation Live
& Toolkit v GENIUS TOOLS for Creo Big Assemblies
Keyshot 10 plugin single project option switch option

Project options of a Starter project

Administrators can create project options by placing a basic or a conditional configuration
block in the required configuration layer. The table provides a general overview, while the
following chapters explain the procedure step-by-step.

Function Description Configuration / creation
Single project is a configuration block settings valid according to the call
option which contains one or hierarchy for files,
GTFC mor.e configuration created with basic configuration blocks,
settings see Create single project options
Single project is a configuration block

option with key  that activates license
symbol extensions for Creo

& Simulation Live Parametric or additional

programs
Combined combines configuration settings valid according to the call
project option settings from different hierarchy for files, if conditions are met

mibd directories and created with conditional configuration

gaiguEie e block, see Creating combined project
after selection further options
single project options

may become available
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Function Description Configuration / creation
Switch option for all projects: switches settings valid according to the call
(italic) between different values  hierarchy for files,

Sofaorks Composer O ON@ OF MoTeE created with basic configuration blocks,

configuration options see Creating switch options
for SolidWorks projects:
activates additional

programs

You can specify the number of columns for individual project options and switch options,
see Arranging project options.

9.14.2.1 Single project options

A single project option can contain multiple configuration options, license extensions
and/or add-on programs.

Creating single project options

For each single project option that appears as a selectable checkbox in GENIUS TOOL
Starter App, a basic configuration block must be created, which must contain certain GTS
config variables. (See table below.)

Procedure:
1. Decide to whom the project options should be available to, using the subdirectories

standard, units, projects or users of the configuration directory, see Directories of the
configuration layers.

2. Consider that all settings are processed according to the Call hierarchy for
configuration files.

3. Go the the desired directory, e. g.
<operatingenvironmentname >\ <application>\configuration\projects\project_creo7p.

4. Create a single configuration block in this directory for each project option. The name
of the text file must comply with the application-specific specifications. (See step 5.)

5. Enter the following necessary GTS config variable as comment:
! gts_is_selectable = true for Creo Parametric configuration blocks,
; gts_is_selectable = true for SolidWorks configuration blocks and
<!I-- gts_is_selectable=true --> for Inventor configuration blocks.
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6. Specify further GTS config variables in the file as required. The table below lists all
variables.
Take care to use the proper comment characters — they differ for each data type.

Application Configuration block Com- Example
required (text file) ment
charac-
ter
Creo Parametric config_*.pro, config_*.sup ! ! gts_display name =
Keyshot plugin
SolidWorks config_*.sldreg ; ; gts_display name =
3DConnexion
Inventor config_*xml, ui_*xml, *.addin <'~ <!-- gts_display name =
-—> Additive Manufacturing -->

Result: A checkbox will be created below the project name in GENIUS TOOLS Starter App.

Example: Creating the project option "Simulation Live" for a Creo Parametric
project
1. Choose the directory which controls the settings for the project (standard, units,

projects, users), e. g.:
<operatingenvironment>\parametric\configuration\projects\project_creo11p.

2. Create a textfile with the name config_1_lic_sim_live.pro.

3. Enter the following specifications in the configuration file:
! gts _is selectable = true
! gts_selection default = true
! gts _creo lic = 379
! gts display name = Simulation Live (Echtzeitsimulation)
! gts_selection name = Simulation Live

! gts_selectable pos = 3

Result: Display in of a checkbox for the "Simulation Live" project option in the project Creo
Parametric 11.0

. Creo Parametric 11.0

Mew version

i L2 0B B XK en - | md

&f Simulation Live

gtpc_settingsApp_example.png
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Example: Creating the project option “"FeedbackAddIn" for an Inventor project

1. Choose the directory which controls the settings for the project (standard, units,
projects, users), e. g.:
<operatingenvironment>\inventor\configuration\projects\inventor_23.

2. Create a text file with the name Feedback.Inventor.addin.

3. Write:
<!-- gts is selectable=true -->
<!-- gts selection default=true -->
<!-- gts display name= FeedbackAddIn -->
<Addin>

<ClassId>{B99DB61B-F61E-4A56-AE2C-3FB608A2547D}</ClassId>
<ClientId>{B99DB61B-F61E-4A56-AE2C-3FB608A2547D}</ClientId>
<LoadOnStartUp>0</LoadOnStartUp>

</Addin>

Representing single project options
The display of individual project options is controlled by GTS config variables.

Config
Creo Parametric 11.0 = Project configuration blocks (.pro) INNEO_ci1
AR Active = Name Toolkit
ﬁ p % f en ~ Foundation - found.psf - AAX o
v GENIUS TOOLS for Creo | MP User Keyshot 10 plugin BMX 0
o Toolkit o AAX o BMX Freestyle Design 0
o—» | & Simulation Live & Freestyle Design & Manikin Maniidn 0
L Simulation Live (Real-time simulation) o 0
. > Toolkit 0
Mame of license Project option v GENIUS TOOLS for Creo 1
Simulation Live Options contains simulation for fluids for Greo 7 and newer -
N Keyshot 10 plugin 1
Il Tool tips (i
~/ Model Processor User 1

Displaying a project option (see table for numbering)

The following table lists the GTS Config variables for the example in the above screenshot.
A full list of variables can be found in the appendix.

1 | Creation of project I gts_is_selectable = true
option
2 | Preselection of project I gts_selection_default = true
option (checked box) v
3 | License extension (key) I gts_creo_lic = 379
o
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4 | Display name in Config
tab

I gts_display_name = Simulation Live(Real-time -
simulation)

5 | Display name under
project

I gts_selection_name = Simulation Live

6 | Position in selection list
(7the checkbox)

I gts_selectable_pos = 7

7 | Text in tool tip of
license symbol (key)

I gts_creo_lic_display_name = Simulation Live

8 | Textin tool tip of
project option (text)

I gts_description = Option contains simulation for
fluids for Creo 7.0 and newer.

Options for Creo Parametric projects

For Creo Parametric projects you can create single project options that select license
extensions such as AAX or Simulation Live.

GTS config Specification / Description

variable Example

gts_creo_lic = <licensenumber>, Creo Parametric: License number(s) of the
e.g.379 extension(s) to be added. Multiple numbers

gts_creo_lic_displ  <text>, e. g.

must be separated with empty space.

— if this entry is set, an icon key appears next to
the checkbox in the project

— license numbers can be read from the
license.dat file in the licensing folder under
PTC/FLEXnet Admin License Server

Creo Parametric: Tooltip text for license symbol

ay_name = Simulation Live (key)

GENIUS TOOLS Starter

— if not specified, the line under License name
is empty
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GTS config Specification / Description

variable Example

gts_requires_base_| <baselicense>, Defines condition: if the base license is not

ic = e.g. available, the project option will be deactivated,

PROE_Foundation i. e. no checkbox is displayed.

— It checks if the base license is specified in the
PSF key.

— Multiple licenses must be separated with
empty space. The project option will be
deactivated, unless all of the listed licenses
are available.

gts_auto_activate_ <baselicense>, Defines condition: If the base license is
base_lic = e.g. available, the project option will be preselected,
PROE_Foundation i. e. the box is checked.

— Multiple licenses must be separated with
empty space. The project option will be
deactivated, unless all of the listed licenses
are available.

— Take care not to simultaneously set the
variable ! gts_selection_default to true.

If the file is to control an auxiliary application, specify the corresponding configuration
option, such as a protkdat entry. (Example: protkdat
$GTS_ROOT_DIR\configuration\application\protk_keyshot.dat). These entries do not
create icons next to the checkbox.

9.14.2.2 Gombined project options

Combined project options can contain configuration options, license extensions and/or
add-on programs. They offer possibilities that single project options cannot and are
particularly useful for companies with complex organization structure-

— With one click, several configuration options can be activated that are located in
different directories and levels. (Use case 1)

— Combined project options can be stored in directories other than the project directories.
(Use case 2)

— After the selection of a combined project option additional single project options can
be made available. (Use case 3 and 4)
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. Creo Parametric 11.0 Creo Parametric 11.0.1.0

New version

ﬁ p % f de + Default - parametnc.psf - mbd SR

project option

4 GEMIUS TOOLS for Creo |+ MP User s Keyshot 10 plugin

& Toolkit f AAX eF BMX

Users must activate the checkbox of the project option in GENIUS TOOLS Starter App. The
underlying configuration block is then read at project start.

1. Basics: Creating a combined project option

A combined project option appears as a selectable checkbox in GENIUS TOOL Starter App
after having created at least one conditional configuration block with a free tag ID.

A free tag ID is an additional textual marking on a configuration block that defines a
combined project option and limits the validity of the block to it. The tag ID must not be
assigned to a unit, otherwise it can be freely choosen.

Example: config_licmbd.pro — "mbd" is the free tag ID, if there is no unit called "mbd".

The functionality of a combined project option only comes into its own when you create
multiple configuration blocks with identical tag IDs. These are read across folders and
levels, i. e. the content of all configuration blocks with identical tag IDs is combined
(added). The following rules apply:

— The configuration options specified in the combined project option are read at project
start if all conditions set by tag IDs are met.

— If configuration options conflict, the option is applied according to the Call hierarchy
for configuration files.

— The first configuration block with the free tag ID creates the needed checkbox of the
same name (here: mbd).

Use case 1: Different contents added across folders
Procedure: For one combined project option, assign one free tag ID to multiple files. The
first free tag ID creates the checkbox to select.

1. Decide on which projects the project options should be available. Settings can apply
to all ("Standard") or to individual units, projects, or users.

2. Go to a folder you selected in (1).

3. Create a text file with a meaningful free tag ID, e. g. mbd. The name must start with
config and end with .freetagid.pro, e. g. config_lic.mbd.pro.

4. Specify the required Creo configuration setting(s) in the file.

5. Repeat this for all configuration blocks in all required folders and settings, for
example:
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— config_abc.mbd.pro in the unit folder
— config_licmbd.pro in the project folder
— config_mapkeys.mbd.pro in the user folder

Result: The combined project option "mbd" has been created, which contains Creo
configuration options from configuration blocks from three different configuration
levels.

2. Further use cases for one combined project option

2.1. Creating a combined project option with restriction to one unit

Combined project options can be restricted to one unit by adding a unit tag ID to a
configuration blocks with a free tag ID.

A unit tag ID is a textual marker that restricts the validity of a configuration block to a
unit. The difference to a config.pro module that is located in a specific unit directory,
project options with a unit tag ID can be located in all directories and can be activated by
selecting the unit — independent of the storage location.

A unit tag ID is assigned when creating a unit in GENIUS TOOLS Project Configurator, see
Using unit tag IDs.

Please note: A configuration block with a unit tag ID but without a free tag ID does not
generate a project option.

Use case 2: A project should have two different project options depending on the
selection of the unit available for selection.
Consult the example in Using unit tag IDs.

2.2. Creating a combined project option with restriction to several unit

A combined project option can be activated by multiple units, see Project options in a
multi-unit environment.

2.3. Creating a combined project option and further project options

You can create a combined project option that generates further single project options
after selection.

Creo Parametric 11.0 Creo Parametric 11.0.1.0 c P tric 11.0 Creo Parametric 11.0.1.0
. New version . N:\:iers‘l”fme e
f 208 RBX & en -[[ ] mo i L20R2B XL en -~
| o AAx | o BMX « o AAX B
«| @ Freestyle Design | @ Manikin | @ Freestyle Design
«| &f MNotebook «| & Simulation Live | & Notebook «| @ Simulation Live
Cabling Piping
Before selecting "mbd After selection of the combined project option
mbd
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Use case 3: When the project option METAL is selected, three additional single
project options (X, Y, Z) are displayed
Procedure: For a combined project option, assign one free tag ID to multiple files and
write GTS Config.pro variables single project options in each of these files.

1. Decide the configuration levels for which the project option should be available, i.e.
system wide ("Standard"), individual units, projects or users.

2. Go to a directory you selected in (1).

3. Create a configuration block with a free tag ID, e. g. Metall. The name of the text file
must start with config and end with .freetagid.pro, e. g. config_lic. metal.pro.

4. Write into this file the GTS config.pro variables

! gts is selectable = true
! gts display name = Cabling — "Cabling” is the display name for the first single
project option that will appear after selecting the project option Metal.

5. Specify further required GTS config.pro variables and/or further Creo configuration
setting(s), see table.

3. Creating multiple combined project options

Each free tag ID creates a combined project option, hence, if two free tag IDs are used in a
file name, there are two combined project options to choose from, e. g.
config.mbd.plastad.pro. If there is no checkbox for selection yet, it will be created.

The order of the free tag IDs does not affect the validity of the Configuration block.

This case is typically used in connection with further project options (use case 4) or with
further configuration options (use case 5).

3.1 Creating two combined project options that allow further project options
only after joint selection

Use case 4: When selecting the project options MBD and PLASTAD together, an
additional project option NC shall be displayed.
Initial situation: The configuration blocks config_lic. mbd.pro and config_lic.plast.pro
already exist.

Procedure: Write GTS config.pro variables to a configuration block to create a single
project option, and add the free tag IDs that already exist to the file name.

1. Decide on which projects the two project option selections should be available
(Standard, unit, project or User).

2. Place a config.pro blokc (text file) in a directory you selected in (1).

3. Name the file config_lic.mbd.plast.pro.
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4. Write in the file the GTS-Config.pro variables

! gts _is selectable = true
! gts display name = NC —"NC" is the display name for the checkbox that will appear after s

5. Specify further required GTS config.pro variables and/or further Creo configuration
setting(s), see table.

3.2 Creating several combined project options that set a configuration option
after common selection without allowing further project options

It may be useful to apply a configuration setting when two combined project options are
selected without allowing users to choose the setting.

Use case 5: When selecting the project options MBD and PLASTAD together, Creo is
to be started with the license extension NC.
Initial situation: The configuration blocks config_lic.mbd.pro and config_lic.plast.pro
already exist.

Procedure: Add the two existing free tag IDs to the configuration block that contains
information for the license extension.

1. Proceed as in use case 4, steps 1-3.

2. In the file config_lic.mbd.plast.pro specify the corresponding license extension in the
GTS config.pro variables, e. g. for NC-SHEETMETAL:

! gts creo lic = 116

9.14.2.3 Switch project options

Switch options are project options that toggle between two values of one or more
configuration settings, such as YES/NO or NORMAL/HIGH.

There are two use cases for switch options:

1. In SolidWorks projects: to start additional programs (AddIns)

Project options

= il
Solidworks 2024 O
Standard | 30EXPERIENCE Markerpiace ()
ABC Zeichnungsrahmen
e .
f 208 & e -
+| DEF Zeichnungsrahmen
'  3DEXPERIENCE Marketplace ABC Zeichnungsrahmen |« DEF Zeichnungsrahmen SolidWorks Composer SolidWorks Composer 9
o switch option e switch option

E!ﬂ Solidworks 2022
Integration of 3DExperience Marketplace as a project option for a Starter project

2. For all projects: to switch between two values of several configuration setting without
having to provide two single project options. This is useful for setting multiple
configuration options, e.g. for display settings in Creo Parametric.
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Creating switch options

Switch options are not created by inserting a GTS config variable into a configuration
block, but by using the expression gts_choose. The code is:

gts choose{ Key || true value || false value }

The value for key is displayed as the name of the project option next to the checkbox in
GENIUS TOOLS Starter App. The value true value is read if the project option is checked,
otherwise false value applies.

The entire expression can be assigned to one or more configuration options.

1. Example for SolidWorks: Option to start the add-on program "3DEXPERIENCE
Marketplace" with a project
Procedure: The gts_choose expression must contain two values for registry entry.

1. Decide which users the project option should be made available to. Settings can
apply to all ("default”) or to individual units, projects or users. Pay attention to the
configuration concept.

2. In the appropriate configuration directory, create a text file that starts with config and
ends with the application-specific extension .sldreg, e.g.
config_addin_experience.sldreg. (See also Configuration blocks fir Solidworks .)

3. Write:

Windows Registry Editor version 5.00
[HKEY CURRENT USER\SOFTWARE\SolidWorks\AddInsStartup\{1A49690A-CC1F-4C81-
9B96-303C52F14AC3}]
@=dword:gts choose{SolidWorks Composer||00000001| 00000000}
Result: The checkbox SolidWorks Composer appears under the projects. When checked,

this AddIn is started with SolidWorks.

Please note: For integrating AddIns in SolidWorks projects write true value =
00000001 (starts the AddIn) and false value = 00000000 (does not start the AddIn).

2. Example for Creo Parametric: Option to minimize display settings for big
assemblies
Procedure: The gts_choose expression is set instead of the value of the configuration
option and must contain two values.

1. Decide which users should have the project option available. Settings can apply to all
(default) or to individual units, projects or users. Pay attention to the configuration
concept.

2. In the appropriate configuration level directory, create a text file that starts with
config and ends with the extension .pro, e.g. config_switch_bigass.pro. (See also
Configuration blocks fiir Solidworks .)
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3. In the file, enter the gts_choose expression instead of the value of a configuration

option, for example:
display points gts choose{big assemblies || NO || YES }

[l corfis_switch bigasaro |

1 autoplace_single_comp yes
2 check interface criteria gts choose({Big Assemblies || no || yes }
3 check interference of matches gts choose{Big Assemblies || no || yes }
4 create_temp_interfaces no
5 comp interface placement gts choose({Big Assemblies || interface to geom || interface to interface }
6 comp assemble with interface default multi
7 comp_assemble_start default
9 Y4444 444444 TURN OFF ALL DISPLAY OPTIONS ####4#
10 gts choose{Big Assemblies || display SHADE || display shadewithreflect }
11 display axes gts choose{Big Assemblies || NO || yes }
12 display coordinate sys gts choose{Big Assemblies || NO || YES }
13 display planes gts choose{Big Assemblies || NO || YES }
14 display points gts choose{Big Assemblies || NO || YES }
15 display annotations gts choose{Big Assemblies || NO || YES }
16 display silhouette edges gts choose{Big Assemblies || NO || YES }
17 edge display quality gts choose{Big Assemblies || NORMAL || very high }
18 shade quality gts choose{Big Assemblies || 3 || 50 }
19 skip small surfaces gts choose{Big Assemblies || YES || NO }
20 fast highlight gts choose{Big Assemblies || YES || NO }
21 prehighlight gts choose{Big Assemblies || NO || YES }
22 save triangles flag gts choose{Big Assemblies || NO || YES }
23 spin center display gts choose{Big Assemblies || NO || YES }
24  spin with notes gts choose{Big Assemblies || NO || YES }
25 spin with part entities gts choose{Big Assemblies || NO || YES }
26 spin with silhouettes gts choose{Big Assemblies || NO || YES }
27 tangent edge display gts choose{Big Assemblies || dimmed || phantom }
28 texture gts choose{Big Assemblies || NO || YES }
29 transparency gts choose{Big Assemblies || NO || YES }

Switching values for the Big assemblies option

Result: The key Big Assemblies creates the checkbox of the same name below the
project. If the option is checked (true value), the gts_choose expression is replaced by
the corresponding value (e. g. NO).

Hint: The switch expression can be written in two ways:

display points gts choose{Grolke Baugruppen || NO || YES }
or
gts_choose{GroBe Baugruppen || display points NO || display points YES}

Deleting switch options in GENIUS TOOLS Starter App

In contrast to single project options, a value will be read from a switch option even if the
option is not checked (disabled state = false value).

For users who have the right to deactivate configuration blocks in the Config tab of
GENIUS TOOLS Starter App, this means:

1. Deactivating the configuration block will ignore the content of the configuration block,
i. e. as with all configuration blocks, it will not be included into the configuration.

2. In contrast to single project options, the checkbox of the switch options then
disappears, because neither the checked (true value) nor the unchecked setting (false
value) is to be used for configuration.
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Creo Parametric 11.0

Neueste Version

i 2A0BZ B Xen -

| Big Assemblies I

GENIUS TOOLS'™"

Config | Project options

= standard configuration blocks ]

Active

v o BMX | @ simulationLive « GENIUS TOOLS for Creo v

Name + BMX

BMIX +  Simulation Live

+ GENIUS TOOLS for Creo

o
| no checkbox | v
\ >

SimutationHve

GENIUS TOOLS for Creo \l Bigassemblios

config_switch_bigass.pro

config_switch_bigass.pro

Only checked configuration blocks (in the Config tab) generate checkboxes for switch options

9.14.2.4 Overview of project options by application

The following table lists examples of popular project options for each CAD application and
the configuration blocks needed to create them.

Additional programs

Creo GENIUS TOOLS for
Parametric  Creo, Model Processor
User, Keyshot

- single project option
— use config_*.pro file

Creo —
Elements/
Direct
Modeling

SolidWorks SolidWorks Composer

— switch option
— use config_*.sldreg
file

GENIUS TOOLS Starter

Optional

Special feature

configuration settings

mapkeys

- single project option
— use config_*.pro file

switch between two

values

— switch option

license extensions such
as Simulation Live,
AAX, Manikin

- single project option
— use config_*.pro file
with license number(s)

— use config_*.pro file

drawing frames

- single project option

— use config_*.sldreg

file
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Additional programs

Additive
Manufacturing

Inventor

—single project option
— use *.addin file

9.14.3 Special cases

Inventor

Optional
configuration settings

drawing frames

—single project option
— use config_*.xml file

Special feature

read-only mode

— Special case: set in
GENIUS TOOLS Project
Configurator, like
language selection

For Inventor projects, it is possible to specify in GENIUS TOOLS Project Configurator
whether users can select to open the project in read-only mode. With this setting, the
checkbox Read-only mode is displayed in the project area. See Read-only mode.

Inventor 2023
Version 2023

i 88 7

-

-

+'| Read-only mode

Option to start read-only mode in GENIUS TOOLS Starter

App

9.14.4 Arranging checkboxes

Single project options and switch options can be selected in checkboxes below the project
name as well as in the Project options tab. The tab can be opened with the arrow symbol,
which becomes visible if some checkboxes cannot be displayed below the project.

Creo Parametric 11.0

Current version
Language

v GENIUS TOOLS for Creo |+ MP User
& Toolkit & AAX
& Freestyle Design & Manikin

Creo Parametric 11.0.1.0

ﬁ P f % €N »  Default - parametric.psf -

Creo startkey |

& Notebook

F BMX

Toolkit
AAX
BMX

>

Keyshot 10 plugin

Project options

For displaying project options, such as display name, tooltip and position, can be defined,

see Single project options.
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The display of the checkboxes can also be affected by specifying the number of columns.
The default setting is four columns.

Procedure for arranging checkboxes for single and switch options
1. Open GENIUS TOOLS Project Configurator.

2. In the menu item Configuration & go to GENIUS TOOLS Starter App in the Settings
column.

3. Select a unit, or choose Standard for global settings.

4. In the the segment Project options specify the number columns, here: 2

3 A STANDARD
Settings Units -
AUTHENTICATION
mE =
| | ~ DESKTOP LINK
GENIUS TOOLS 4 Standard ¥ GENERAL
Starter App ~ PROJECTS
Lol + PROJECT OPTIONS
Additional . b Switzerland
environment variabl... 2
b United_Kingdom Columns

SZttings in GENIUS TOOLS Project Configurator

Result: The checkboxes are arranged in two columns below the project name in GENIUS
TOOLS Starter App.

Creo Parametric 11.0

Neueste Version

ﬁ 4,@ / % en ¥  Default - parametric.psf ~
v & AAX v & BMX
@'f Freestyle Design @'f Manikin
& Notebook v @ Simulation Live
@'fﬂ Toolkit v GENIUS TOOLS for Creo
Big Assemblies Keyshot 10 plugin
v MP User

Display in GENIUS TOOLS Starter App

Please note: The arrangement of project options requires a subscription license.

5.15 Apps-Projects: Creating projects of other applications

In the sub item Apps you can create projects with any other program. For such Apps
projects you can only create one project per application, whereby the latest version is
used.

For Apps projects only simplified settings are available, but specifications from
configuration blocks and batch files can be made, as for all programmes, in the four
configuration layers of the directory application.

GENIUS TOOLS Starter © 2025 INNED Solutions GmbH 167



GENIUS TOOLS Project Configurator G EN I US TO 0 I.S®;=

After filling in the general project settings (2), specify the required project and data
directories (3) and the startup behavior (4).

DDE EO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0
S : : <
=8 Application types Projects @
~ GENERAL
0+ w- 2
Project name Model Processor
o e P Model Processor 11.0 !
t
reo Farametric Modellliberarbeitung Display name Model Processor 11.0
@ GENIUS TOOLS Material Bro.. 29 Description Modelliberarbeitung
E- Freeware Project image gtsprj_model_processor.png -]
Apps Firefox [& Hide project @ No
e Firefox
Block project @ No
—) Creo Rules of work ~ APP e
@ _/ Best practices
Project directary J
% [ﬁ Testumgebung erstellen D =
Mit FreeFileSync -
& Sowiildiag Rod  STARTUP SETTINGS 9
drop
Executable file %GTS_APPS_DIR%\Model Processor 9.0\bin\Mode [
Commandline arguments
Startup directory %GTS_APPS_DIR%\Model Processor 9.0\bin [}

Dialog box for Apps projects

In the GENIUS TOOLS Starter App, you can set the order of the projects for the users by
dragging and dropping the projects. The Change sorting button (5) in the Projects column
sorts the projects in the application alphabetically by display name.

» App

Project directory (optional)
Directory below application\configuration\projects. Batch files are copied from this
directory to the user computer and executed at project start.

Data directory (optional)
Directory below application\data. From this directory data packages are copied to the user
computer and applied at project start.

P Startup settings

Executable file
Enter the file that is to be started. It can either be an executable file (such as *.exe, *.bat) or
a file for which a standard application is available on the user computer (such as *.docx,
* html). A command line (cmd) shell or cmd shell application will be executed visibly by
following commands:

— do not stop cmd after execution: start cmd /K "$1"

— stop cmd after execution: start cmd /C "%1"
If a website is to be called, enter the following command: cmd. exe

Command line arguments
Enter commands that specify how the executable file is started. Set the commands in

quotation marks.
If a website is to be called, enter it with the following scheme: /c start

https://www.inneo.co.uk
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Startup folder

Select the startup directory.

The information about the startup behavior and the required directories are displayed for
each project in GENIUS TOOLS Starter App in the Info tab.

9.16 Auto projects

Auto projects are Starter projects of an application for which only one project can be
created. This project will be automatically created by GENIUS TOOLS Starter App with the
latest available software version on the user computer and will be displayed with an icon
of the application.

Auto projects are generated from the following applications: Creo Elements/Direct
Drafting, Creo lllustrate, Creo Schematics, Creo View, GeomagicDesignX, Keyshot and
MathCad.

Please note: Auto projects are only available with a subscription license.

The applications are automatically searched on the user computer. If several versions are
installed, the latest version will be used. If the application is not installed on the user's
computer, the Auto project will not be displayed.

Auto projects can, like all projects, be configured in the four configuration layers
(standard, units, projects and users). For each Auto Project, a new folder structure is
created for this purpose which includes a project directory. In GENIUS TOOLS Project
Configurator, they are listed in the Project collections page =

~ DETAILS
Display name o MathCad
[3] Desian Projects
d I Description e
N ) : ) Image o |
'24' Windchill Projects
Calor o Select a color X -
—
Apps Hide e @ No
+ PROJECTS
MathCad =
e Search Q
(- Define order hy drag
1)
o llustrate and drop
O
= Schematics
‘e
Auto projects can neither be created nor deleted.
=
1’.4) KeyShot GENIUS TOOLS Starter automatically searches the
s applications on the installation computer and lists
them here.
GeomagicDesignX
SDs

03.07.2024 09:15:40
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Individual Auto projects can be hidden in the user interface of GENIUS TOOLS Starter (5).
You can also hide all Auto projects for specific user groups (roles) in the user rights.

In the main page Project collections you can set the display of the Auto projects in GENIUS
TOOLS Starter App, see next chapter.

5.17 Project collections

In the main menu item Project Collections you can organize individual projects into
collections, which are displayed to users in GENIUS TOOLS Starter App. This is especially
helpful for companies that work with many projects.

Warning: Creating collections for projects requires a subscription license. If you create
a project collection without having a subscription license, you will not be able to
continue using GENIUS TOOLS Starter with a perpetual license.

The order of both collections and individual projects can be defined here by using drag
and drop.

Project collections are displayed to all users, but within a collection only those projects a
user has access to are displayed. If a user has no access to any of the projects, the button
for the collection will not be displayed.

A distinction is made between company-specific and application-specific project
collections. You can create company-specific project collections and assign individual
projects. Application-specific project collections, on the other hand, already contain all
projects that have been assigned to the an applications in the menu item projects, i. e.
Creo Parametric, Creo Elements/Direct Modeling as well as Apps projects

Company- Application-specific project
specific project  collection
collection
Collection can be created and yes, see below no
deleted
Collection can include any project yes no, contains all projects of an
application,

— Creo Parametric

— Creo Elements/Direct
Modeling

— or Apps projects
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Company- Application-specific project
specific project  collection
collection

Individual projects can be added yes no

and deleted

In addition, this area lists all auto projects, which are displayed automatically.

Creating a new project collection
Create a company-specific project collection by clicking the Plus button Add (7).

Application-specific project collections as well as auto project are generated automatically
and cannot be created nor deleted.

A DETAILS
-+ | e
EEE Display name Design Projects
Design Projects )
- Description
~ " .
@ f." Windchill Projects company-specific
W project collections T
#FF96DIEG X~
‘B Project Archive
e © @ wen
. Creo Parametric # PROJECTS
@ . application-specific o _+_ “II Search """i
L C.reo E\emen?sf project collections
~»* Direct Modeling . Creo Parametric 11.0
E %} Neueste Version
Apps e Arrange order
"""":r'::a“d . Creo Parametric 10.0
= Version 10.0
‘s) KeyShot
¥ Creo Elements/Direct Modeling
MathCad auto projects N {
-
o AutoCAD 2023
\Ae [llustrate
' CAD

Displaying project collections to users

In the Details dialog (2) on the right, fill in how the project collection should be displayed
in GENIUS TOOLS Starter App.

For application-specific project collections and auto project display names and comments
cannot be edited.

Display name
Enter a name for the project collection. The name of a project collection must be unique.
Duplicate names for project collections are not permitted
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Description

Enter an optional description for the project collection

Image

A collection can be fitted with an image file in JPG, PNG or SVG format.
Color

A collection can be displayed with an individual color for better visualization.

Hide (3)
No (default): The project collection is displayed in GENIUS TOOLS Starter App.
Yes: An project collection is not displayed.

Define order (5)
Put projects in the order needed by using drag and drop.

Adding projects to a collection

You can add single projects only to company-specific collections.

The visibility of a project in GENIUS TOOLS Starter App is defined by the affiliation of a
user to a unit and the access rights granted.

Add (4)

Add projects that have been created in the Projects menu item.

A window will open where you can select, search and sort projects.
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Please select projects

Search ~—— search for a project

Project name 1 —Comment——  sort|projects alphabetically

AutoCAD 2022

AutoCAD 2023

AutoCAD Architecture 2023
AutoCAD Mechanical

Creo 11.0 - Testprojekt SUT-Daten zum Testen
" Creo Parametric 7.0 Qld version
" Creo Parametric 8.0 Alte Version

- e e aaw ) - . e 0.0 Wi .
Firefox Firefox

INNEQ - Creo Parametric 9.0  Creo Version 9.0

Inventor 2022 Version 2022
Inventor 2024 Produktivversion
Madel Processaor 11.0 Modelllberarbeitung
v 0K ® Cancel @ Apply

Delete
Select a project to delete it.

Search
Search a project by keywords.

User-defined project collection

With version 11.0.0.0, users have the option of marking individual projects as favorites,
which are listed in GENIUS TOOLS Starter App under Favorites, see chapter GENIUS TOOLS
Starter App > Favorites.

5.18 Presenting projects to users

The display of projects in GENIUS TOOLS Starter App can be defined for a unit, subunit or
for individual projects.
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Unit settings

In the menu item Configuration of GENIUS TOOLS Project Configurator, settings are made
for all projects that are available for a unit. These are.

— the display of faulty projects as well as
— the option of providing the language selection as project option.

The menu item Resources lets you control what information about a project or additional
features, such as license analysis, are made available to users, see Providing project
information.

Project settings

In the menu item Projects, individual projects can be provided with an icon and an
additional line of information, see General project settings.

Projects can contain selectable options that are created with configuration blocks, see
Project options.

You can also restrict access to a project to certain units. To do this, assign the permitted
projects to this unit, see Restricting project access

Project collections

The menu item Project collections allows you to group individual projects into collections
and define their order, see Project collections. Project collections can be provided with an
individual colored bar and an icon.

NNEO

Creo Parametric 11.0
Neue Version

Deutschland (V]
P f th
) ) jects of t ject
. B INNEO - Creo Windenil 10.0 collection in the order defined
y| Berlin v @ Creo Parametric + Windchill in cloud in GENIUS TOOLS Project

Configurator
Development ~ 9
@ 3 =| Creo Rules of work
A Best practices
E Design Projects i
Prejext collection m Solidworks 2024
| Standard Information line |

fi" Windchill Projects

ﬁ P f en - Project information (info symbols) |
B creo Parametric | IDEXPERIENCE Marketplace ABC Zeichnungsrahmen «| DEF Zeichnungsrahmen SolidWorks Composer

Project options

— e

Projects from the “Design Projects” collection in GENIUS TOOLS Starter App
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9.18.1 Marking faulty projects

Administrators can control whether and how users see projects that cause warnings or for
which they do not have the required license.

NNEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0 <
. K f © STANDARD
— Settings Units @
- v AUTHENTICATION
=
B | v DESKTOP LINK
v GENERAL
Starter App ~ PROJECTS
@ P Deutschland Yes
Adqmgnal . b Schweiz Display warnings
environment variables _ . Yes, as error
b United Kingdom Display invalid projects
. Yes
Synchronization Project language selectable

Global settings ("standard") for displaying projects in GENIUS TOOLS Starter App

Projects with warnings

Project settings can cause warnings other than missing licenses, e. g. if the project
directory cannot be found.

You can define in GENIUS TOOLS Project Configurator The following actions and warning
colors can be set in the menu item Configuration > Group (select) > Settings: GENIUS
TOOLS Starter App > Segment: Projects. The project bar will then be orange and a warning
triangle /' appears, which opens the Warning tab.

Display warnings

Warnings appear for projects e. g. without a valid license (Creo Parametric, SolidWorks).
No: No warnings are issued.
Yes: Projects are marked with a yellow bar. The Warning tab appears.

Invalid projects

For Creo Parametric and SolidWorks projects, it is possible to check available licenses. You
can control whether and how projects for which the required licenses are not available are
displayed in GENIUS TOOLS Starter App, see Display of invalid projects.

Display invalid projects
Specifies how projects that cannot be started with GENIUS TOOLS Starter, e. g. because no
PSF key is found, are displayed to the user.
No: Projects are hidden.
Yes, as error (default): Projects are marked with a red bar. The Error tab appears.
Yes, deactivated: Projects are greyed out and cannot be clicked on.

Please note: Projects for which no corresponding software version can be found are
never displayed.
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9.18.2 Customizing project information

The info area opens when a project is selected. The info icons open tabs with the
corresponding information.

All projects display the Info tab. The other tabs — Licenses, Config, Project Options and
Backup — differ depending on the application, see the respective chapters in GENIUS
TOOLS Starter App.

The Error and Warning tabs are appear for faulty projects.

I N N EO e
. Creo Parametric 11.0
roject name

Neueste Version

# Deutschiand ~
i s BXE

(5t Info symbols

(;7’ Manikin &

& Toolkit v

Selected project with open Info ta

Most info icons and tabs can be hidden by the administrator in GENIUS TOOLS Project
Configurator under Organization > Access > Role > Tab: Function access. Consult the
chapter Granting function access for detailed instructions.

a" Berlin v

j\ Construction ~

Function Description Configurable with
function access?

Information opens Info tab with info icon and tab can be
i — project name disabled with Can see
— path to project, data and working project information
directories

- language, and more

Licenses opens Licenses tab info icon and tab can be
2 — shows licenses and license servers disabled with Can see
— button for analyzing licenses licenses, see Displaying

license details
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GENIUS TOOLS'™"

Function

Configuration
blocks (Config)
gl

Configuration

blocks (Ul)
ED

Backup

Project report

GENIUS TOOLS
Starter App

Config Analyzer
XK

Borrow licenses
i

L]

==

Warning

GENIUS TOOLS Starter

Description

opens Config tab

— lists all used configuration blocks
(config files) and additional applications
(Toolkit Application) in the selected
project

— configuration blocks can be opened by
double clicking

opens Ul tab in Inventor projects

— lists lists all used configuration blocks
(ui files) and

— behavior like config tab

opens the Backup tab

— users can create a backup of user-
specific settings

— fir Creo Parametric: displays the
customization.ui file, see Backup
mechanism in GENIUS TOOLS Starter

App.

Creo Parametric:
opens PDF file containing all information
about the selected project

Creo Parametric:

opens separate utility to view and edit all
configuration blocks and batch files used
for the project and their location.

Creo Parametric, SolidWorks:
Opens Borrow license dialog

icon appears only if project settings
trigger a warning,
opens Warning tab

Configurable with
function access?

info icon and tab: no
users can be granted
rights:

Can open configuration
blocks

Can deactivate
configuration blocks,

see Editing configuration
blocks

like Config tab

info icon and tab can be
disabled with Can save
user specific settings /
customization.uti file

info icon can be hidden
with Can create project
report

info icon can be hidden
with Can analyze project

info icon can be hidden
with Can borrow licenses

no
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Function Description Configurable with
function access?

Error icon appears only if project cannot be tab can be disabled, see
A\ started, Marking faulty projects
opens Error tab

9.18.3 Displaying license information

The Licenses tab is available for projects of Creo Parametric and SolidWorks. The info icon
and the tab appear when the user is granted the function access right Can see licenses.

Please note: Function access rights are always cross-unit: If a user has different rights in
different roles, the granted access applies regardless of which unit is selected in GENIUS
TOOLS Starter App. See chapter Granting function access rights.

The Licenses tab contains information on the license servers assigned to the selected
project as well as a function to analyze licenses.

Licenses
Creo Parametric 12.0
Latest Version .
= @ Last analyze Never Analyze licenses|
2 B B
il & K CREO LICENSE SERVERS
v GENIUS TOOLS fer Creo 7788@localhost ® (Oms) Display of
& Toolkit 7788@srvlictriad @® (16 ms) license
. - servers
Ef': Freestyle Design 7788@srviictriad2 . (13 ms)
7788@srvlictriad3 ® (15ms)

Licenses tab before analyzing licenses

Display license servers
All Creo license servers are listed for the selected project to which the user has access to.

Analyze licenses
Pressing the button @ shows all available licenses and extensions as well as the time that
has passed since the last analysis.
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Licenses

Licenses: 3 free [ 3 total.
<@» Last analyze Mow E|

CREOQ LICENSE SERVERS

7788@localhost @ (0ms)
7788@srvieipziglic @ (30ms)
7788@srviictriad] @ (68 ms)
7788@srviictriad? @ (71ms)
7788@srvlictriad3 @ (67 ms)

BASE LICENSES

Name Free Used

PROE_DesignPrmP 3 0

EXTENSIONS

MName Free Used

TOOLKIT 4 1
ObjectToolkit 5 Q

Licenses tab after analyzing licenses

The display of the Analyze button is defined in GENIUS TOOLS Project Configurator in
Creo Parametric > Tab: Start or in SolidWorks > Tab: Start in the section Licenses > Analyze
Licenses. This setting only comes into effect, if users have been granted the access right
Can see licenses.

Start
> STANDARD
v STARTUP SETTINGS
v LICENSE BORROWING
v CREO STARTKEY
v CREO LICENSE SERVERS
~ LICENSES

Analyze licenses ez M

Start-Tab fiir Uniteinstellungen ftir Creo Parametric

The Borrow licenses function is started via the info icon <& on the project.
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9.18.4 Editing configuration blocks

In the Config tab, users can view and may edit configuration files which configure a
project, so-called configuration blocks.

1. Open / edit configuration blocks

Double-clicking on a line will open GENIUS TOOLS Config Editor. For this, the user must
be granted the access right Can open configuration files from Starter App, see chapter
Granting function access rights.

Config
=  Standard config.pros standard
Active | Name Toolkit
| b AAX Activate by checking bu){l 0
BMX 0

| Freestyle Design Open with double :Ii:kl 0

2. Disable / enable configuration blocks

Activated configuration blocks are used for the project configuration. For being able to
check the corresponding box, users must be granted the access right Can disable
configuration blocks, see chapter Granting function access rights.

3. Edit personal settings

Users have the ability to edit their local configuration block and write it back to the
administration computer in the userdata directory, see next chapter.

9.18.9 User-driven configuration

Users may overwrite or append the settings established by the administrator, by managing
private configuration blocks on their own. To do so, private configuration blocks must be
saved in the userdata directory to which the user needs to be given write access.

The private configuration blocks in the userdata directory are appended to the
configuration blocks in the users, projects, units and standard directories, i.e. they
overwrite the entries made there. See also the chapter Call sequence for files.

Special characteristic of Creo Parametric configuration blocks

The personal Config_*.pro file is attached to the Config_*.pro files in the users, projects,
units and standard directories as a supplement. The user-defined Customization_*.ui file,
on the other hand, replaces the Customization_*.ui files in the other directories.
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Userdata directory
There are two ways to provide users with a userdata directory.

— The Userdata directory is located in the Caddepot of the administration computer, from
where it is synchronized to the Cadpool on the user computer. Users can use the
directory with their Windows user name in the Userdata directory. For this the userdata
directory must be located under GTS_ROOT_DIR. (See chapter Directory structure.)

— A userdata directory can be set up on any location on the client computer where it does
not undergo data synchronization.

Defining private configuration blocks

Administrators specify the path to the user data directory and the spelling of the file
names of the configuration blocks in GENIUS TOOLS Project Configurator.

Procedure using SolidWorks as an example
1. In the menu item Configuration, go to SolidWorks under Settings.

In the Application tab, go to the User Settings section.

In the field Private configuration folder, enter the path to the userdata directory.

A won

In the field Private configuration block, specify the notation for the configuration
module, here for an SLDREG file: config_%username%.sldreg. (There is an overview of
the file endings in the chapter Configuration blocks.)

L1 {INEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

Settings Units Application ®
(= Q @ STANDARD

v APPLICATION
# USER SETTINGS

GENIUS TOOLS 4 Standard
Starter App

Deutschland —
[ BREMEE . " %GTS_ROOT_DIR%\userdata\%username% [
rEm » Private configuration directory

b Schweiz

P United Kingdom Private configuration block config_%eusermname% sldreg

SolidWorks

Application tab in the configuration settings for SolidWorks

Result: The section in the Config tab is visible when an SLDREG file is in the userdata

directory.
Config
e
= Private configuration block {.sldreg) ahelp H
Active | Name Addin
vy config_ahelp.sidreg 0

Display of a private configuration block in
GENIUS TOOLS Starter App
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Editing private configuration blocks

Users can edit their local, private configuration module in GENIUS TOOLS Starter App. A
double click opens the file.

The Upload button & is used to write the configuration block back to the administration
computer in the userdata directory. The button is visible if the user has the access right
Can save personal configuration blocks to server.

Please note: Data synchronization must be paused during editing.

9.19 AutoCAD

Starter projecte for the applications AutoCAD, AutoCAD Architecture und AutoCAD
Mechanical are created with

— essential specifications

- a defined release

- application-related data packages
— specifications for the start behavior

— settings for additional applications / linkages (batch files)

Please note: No unit settings can be defined yet for projects of the AutoCAD
applications and no configuration blocks can be created.

Creating starter projects for AutoCAD applications is a feature that requires a
subscription license.

For general information consult the chapter Starter projects.

9.19.1 Project settings

Project settings are the specifications you make in the main page Projects Il under
Applications > AutoCAD, AutoCAD Architecture or AutoCAD Mechanical in the tabs
AutoCAD, Start and Umgebung

The applications AutcoCAD Architecure and AutoCAD Mechanical have the same input
fields since all AutoCAD applications are started with the same execution file (EXE file).
GENIUS TOOLS Starter generates the correct start command for the applications in the
background.
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9.19.1.1 Essential specifications

After having created a new project with the general project specifications, fill in the
following input fields.

Release
Define the version to be used. The path can be fixed or determined automatically from the
registry of the application computer.
Fixed path: Select the directory from the newly appearing drop-down menu. If you do
not specify a directory, the settings for the standard unit will be used. (Configuration >
Application > Standard > Tab: Application > Install path)
Versions: Specify a certain version. For example, the selection <2022> will determine
the path to the latest installation of the version from the registry.

Please note: The application has to be installed locally on the application computer in
order to have registry entries available. The user must have read permission in HKLM.

Project folder

Directory in <application>\configuration\projects. From this directory configuration blocks
are copied to the application computer.

Please note: Configuration blocks should be stored separately from the data structure
due to their potential multiple use. They should be managed in the specific
subdirectories of the configuration directories units, projects or users, or in the standard
directory for global settings. See Configuration concept.

Data folder
Main directory of an operating environment in which application-related data is located.

5.19.1.2 Start behavior

In the Start tab you define the startup behavior for a single project.

Starting behaviour

Select the application that will open the project.
AutoCAD(default): The project is started with the selected AutoCAD application.
External: The project is started with another application (e. g. SAP).

If External is selected two additional fields open:

External start command

Enter the path to the executable file that is to start the project.

Command arguments for external start

Enter commands that specify how the executable file is started. Set the commands in
quotation marks.
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Startup directory
Enter the working directory of AutoCAD.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
<application>\configuration directory.

5.19.1.3 Environment variables

The variables set here are added to the variables defined for units. Values set here for an
existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A
list of created and affected environment variables can be found in the appendix.

5.20 Creo Parametric

A configured Creo Parametric project consists of the following components:

— a defined Creo release or version
— the licenses to be used (Creo-Startkeys)
— configuration blocks for settings of
— functions and behavior of Creo Parametric (config_*.pro files)
— user interface ((config.ui)
— additional applications, toolkit applications (GENIUS TOOLS for Creo)
— settings and link-ups for additional applications (batch files)
— Windchill availability in the Creo Parametric session
— start object templates, drawing frames
— project libraries
— plot settings
— ModelCheck configurations
— and many other settings relevant to working with Creo, such as
— data referenced in the configuration files (colors, materials, templates etc. in the
data directory)
— data for other tasks (information documents, additional tools)

Data packages and configuration directories

A project configuration consists of Creo object data — filed in the data directory — and Creo
configuration files, which can be stored in any of the project-relevant directories standard,
units, projects and users. Separating the Creo object data from the Creo configuration data
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and the additional applications ensures that Creo objects in an operating environment can
be used in multiple projects.

Both Creo object data and project-specific configuration files for several Creo versions are
included in the product package Startup TOOLS.

For Creo Parametric the configuration for a Starter projekt is made up by the following
directories:

1. Data directory:
<GTS-OperatingEnvironment >\parametric\data

The data directory is a system directory under which all object data for an application can
be found, the so-called Creo data packages.

The directory configuration contains the directories standard, units, projects and users.
Their behavior applies to all applications, see directories of the configuration layers and
the call sequence.

2. Standard directory
<GTS-OperatingEnvironment >\parametric\configuration\standard

3. Unit directory:
<GTS-OperatingEnvironment\parametric\configuration\units\%GTS_UNIT_DIR_NAME%

4. Project directory:
<GTS-OperatingEnvironment\parametric\configuration\projects\%GTS_PROJECT_DIR%

5. User directory:
<GTS-OperatingEnvironment\parametric\configuration\user\%USERNAME%

Please note: In order to work with data for other CAD systems in the future, the entire
directory structure has been changed in version 9.0.0 of GENIUS TOOLS Starter. Consult
the comparison of the old and new directory structure. The adjustment of the paths is
done automatically during an update.

Installation directories of Creo

There are different ways to specify an installation directory and its start command. These
are described in the chapter CAD-specific project settings.

Consider the following criteria:

1. If you want to make sure that each application computer throughout your company
uses the same Creo version, configure the Creo installation directory for the Standard
group in the Configuration page. In this way, you will not have to specify it for each
project.

2. If a variety of releases and versions is in use, for example because you are providing
services for different customers, configure the Creo version for each project.
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3. If local installations are inconsistent or not known in detail, a fall back on the local
Windows registry can determine the Creo installation directory. You can specify which
Creo release to look for — the highest version will be used.

Please note: It is generally recommended to determine the installation path via the
local Windows registry.

9.20.1 Configuration and batch files

For Creo Parametric projects you can create configuration blocks and place them in the
configuration levels where they will be processed according to the call hierarchy for files,
see chapter Configuration concept.

All batch files can be used, see also chapter Batch files.

9.20.1.1 Creo configuration files
The behavior of Creo Parametric is largely determined by the configuration file config.pro.
This is a text file storing all settings that determine how Creo Parametric runs.

Settings in config files are called configuration options — the calculation accuracy is, for
example, set by the command enable absolute accuracy ves.

The config.pro file of Creo can be located in three different folders:
— in the text directory (<installdir>\Common Files\text),

— in the home directory,

—in the user directory (start directory of the user).

In this order Creo copies the configuration options defined there to a single config.pro
file. If a configuration option is set more than once, the last entry is the valid option value,
i. e. the config.pro file is read from top to bottom.

Configuration options can also be specified in another configuration file, the config.sup
file. The options set there cannot be overridden by the options in the config.pro file.

The following configuration files determine the settings for a Creo application.
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Configuration file  Function

config.pro crucial configuration file of Creo
contains settings for a user, e. g.
— appearance of objects and of the graphics window
— behavior when creating, saving or opening objects
— units, tolerances, search paths and default directories
— printing, import and export settings
— settings for optional modules such as Pro/NC, Pro/Sheetmetal,
Pro/Mold
— layers and mapkeys
If a configuration option is not defined, the default value will apply

to Creo.

config.sup contains settings that the user may not modify, i.e., that cannot be
overwritten by the config.pro file, for example to ensure drawing
standards

config.val contains validation settings for data import

creo_parametric_cus contains Ul customizations for a user
tomization.ui

creo_parametric_ad Created by administrator, contains Ul customizations
min_customization.u
i

9.20.1.2 Configuration blocks

By using GENIUS TOOLS Starter, configuration options are not written to the Config.pro
file of Creo, but to different fragmented configuration files of GENIUS TOOLS Starter,
called configuration blocks.

A configuration block for Creo Parametric:

—is a text file that must start with "config_" and
- end with ".pro", e.g. config_sut_de_c6p_dir_file.pro, config_c8p_mapkeys.pro or
- end with ".sup", e. g. config_de.sup.

— is one of many configuration files that are read by GENIUS TOOLS Starter and converted
into a config.pro file for starting Creo,

— can contain one or more multiple Creo configuration options, i. e. settings for users,
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—is not to be mistaken for the config.pro file of Creo, which exists only once,
— is also called config file.

Configuration blocks are created manually and distributed to the desired configuration
layers: standard, units, projects and user. Thus they provide company-wide settings as well
as settings for specific departments and projects. Take note of the Call sequence for files

There are two types of configuration blocks: simple and conditional, see Types of
configuration blocks.

Create configuration blocks (.pro) for Creo Parametric

1. Create a text file in the desired configuration directory starting with config_ and ending
with .pro.

2. Write the configuration options for Creo Parametric.

Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,
configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks and Config.pro files using
the add-on program GENIUS TOOLS Config Editor, which features color highlighting,
auto-completion as well as error messages and which allows you to compare entries of
two configuration blocks.

Example: Configuration settings for welding

Create a text file with the name config_c9p_welding.pro. Write:
pro weld params dir SGTS DATA\library dir\weld params dir
weld fillet preferences file $GTS_DATA\library dir\weld params_dir\iso.spwx
weld plug slot preferences file $GTS_DATA\library dir\weld params_dir\iso.spwx

add weld mp yes
weld color 100 50 O
weld ui standard IsO
weld ask xsec refs no

weld dec places 3

weld edge prep driven by PART
weld edge prep groove angle 45

weld edge prep groove depth 6

weld edge prep instance YES
weld edge prep root open 1

weld edge prep visibility GENERIC
weld geom type default SOLID
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Example: Create single project option for additional application GENIUS TOOLS for
Creo
Create a text file with the name config_1_lic_sim_live.pro. Write:

! gts _display name = GENIUS TOOLS for Creo

! gts_selection name = GTFC
! gts_selection default = true
! gts _is selectable = true

protkdat $GTS CONFIGURATION DIR\application\protk gtfc.dat

When creating single project options, note that an exclamation mark (!) must be used as a
comment character, e. g. ! gts_is_selectable = true. See chapter Single project options.

As well as the file protk.dat GENIUS TOOLS Starter supports the file creotk.dat.

9.20.1.3 User-driven configuration for Creo Parametric

Users may manage configuration blocks on their own, if granted the appropriate right,
and are thus able to overwrite or append the settings established by the administrator.
This is often done, for example, when working with user-defined mapkeys.

For a user to administer his or her own settings the configuration files have to be saved in
the userdata directory, see chapter Userdata directory.

Define the storage location in GENIUS TOOLS Project Configurator under Configuration >
Settings: Creo Parametric > Select a group > Tab: Application > User settings, as well as the
notation of the private configuration block.

e < INNEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

Settings Units Application ®

= o @ STANDARD
L’\_E?: GENERAL

41 SETEEE CREQ PARAMETRIC DIRECTORIES

b Deutschiand PLOT CONFIGURATION
@ L o P Schweiz 4 USER SETTINGS
. b P United_Kingdom ) . . %GTS_ROOT_DIR%\userdata\%username%% [
I ) Configuration directory
Creo Parametric config_%username’.pro
Private config.pro

config_user.ui

Private customization.ui

Entering path to the userdata directory and file names

» User settings
Configuration folder
The configuration files of each user can be stored in the directory userdata.

Private config.pro
Name of a user-defined config.pro file, e. g. config_%username%.pro. It is appended to the
config_*.pro files in the users, projects, units and/or standard directories.
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Please note: For storing their private config.pro file, users must have write access to
the userdata directory, as well as the access right Can save personal Config.pro file [to
userdata directory] on server. See also Backup tab in GENIUS TOOLS Starter App.

Private customization.ui

Name of a user-defined customization.ui file, e. g. config_user.ui. It replaces any
customization.ui file in the users, projects, units and/or standard directories. See also
Backup tab in GENIUS TOOLS Starter App.

9.20.2 Use in complex organizations

For companies with complex structures GENIUS TOOLS Starter offers advantages through
the following functions.

Company structure GENIUS TOOLS Procedure
Starter Functions
Global distribution Working with satellites See Installation Manual, chapter
of locations GENIUS TOOLS Starter Service.
Working with Units Creating units
Many departments Map organizational Creating subunits
and structure
subdepartments
Complex Optimize Creo license Distribute Creo start keys (PSF key)
configuration for distribution automatically to user computers

license distribution
1. Define license server  Define license server per project

per project

2. Assign multiple base  Provide several Creo startkeys (PSF
licenses or packages to  key) for selection in the project

a project
3. Assign selectable Create project options with
license extensions to configuration blocks

individual projects
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Company structure GENIUS TOOLS Procedure

Starter Functions
Many additional Selectable options per Create project options with
applications project configuration blocks

9.20.3 Allocating Creo licenses with GENIUS TOOLS Starter

Companies that only have a few workstations may be able to maintain license files at each
workstation individually, but as corporate structures grow this will be a tedious task:
different workstations require different licenses, the expiration of licenses must be
monitored, but most importantly an efficient assignment of licenses and license extensions
to projects becomes difficult.

With GENIUS TOOLS Starter you can:

1. Specify license servers
You can assign one or more license servers to a project.

2. Assign licenses and license extensions to a project

Creo licenses can be made available to users in various ways, especially to minimize the
number of projects and provide choices for users. See chapter Optimally assigning
licenses.

3. Distribute Creo startkeys (license keys, PSF keys) automatically

You can distribute Creo startkeys automatically to all user computers. GENIUS TOOLS
Starter copies all PSF files located in the configuration folder (Cadpool) of the user
computer to the bin directory of the Creo installation folder. Alternatively, only those PSF
keys that control a specific project can be copied. See chapter Start.

Automatic copying is greatly beneficial when changes are made to the PSF keys as the
maintenance effort is reduced significantly.

4. Work offline by license borrowing

Borrowing licenses for a certain period of time is especially advantageous for mobile
working. Users who have the right to borrow licenses can see the button Zin the
Licenses tab in GENIUS TOOLS Starter App and can use it to start the license borrowing
process of PTC.

5.20.3.1 Basic information

This chapter introduces Creo licenses and Creo startkeys.
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Creo licenses

When purchasing Creo Parametric software from PTC, you receive a FlexNet license key
(license key for FlexNet). This consists of the name of the base license and — if available —
the numbers of the license extensions (modules), e.g. #116 for NC-SHEETMETAL, #339 for
Mold Analysis.

1. Creo Parametric base license, e. g. Creo Foundation (PROE_Foundation)
— is necessary to start Creo Parametric

— depending on the purchased product, a base license can contain a list of modules and
is then labeled base license package, e. g. Creo Advanced XE

2. Creo Parametric license extensions (also called license key features), e. g. Plastic
Advisor (734)

— extends a basic license (package) with functions
— can be purchased separately
— always requires a base license package

— a license extension package contains several license extensions, e. g. Creo Advanced
Assembly Extension (AAX)

Creo Parametric — together with the previous products Pro/ENGINEER and Wildfire — has
been on the market for over 30 years. During this time many modules have been created
and many products were sold by PTC and resellers. In addition, countless product
packages were created as part of sales initiatives. Thus, it is hardly possible to keep track
of all basic license packages and their diverse functions. As a result, all long-time users of
Creo Parametric have a different license key architecture.

The following table lists some examples of products and their license keys.

Product Description License key
Creo Foundation Base license PROE_Foundation
Creo Advanced SE Basic license package with ~ PROE_AdVSE

the additional modules
Surface, Design Animation,
Modelcheck, Mold Analysis
Lite and others

Creo Advanced XE with AAX Basic license package with ~ PROE_FAPAAX
the additional modules
Assembly/AAX and other
modules
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Product Description License key

Assembly License extension 6

Creo Advanced Assembly License extension package ~ PROBUNDLE_10119
Extension (AAX) with Notebook (0), 0,6,97,108,292,329
Assembly (6), Process for
Assemblies (97), WebLink
(108), Creo Layout 3D
Integration (292), Creo
Options Modeler Basic (329)

Administrators of Creo Parametric have the task of correctly assigning existing as well as
newly purchased licenses to users. In other words, administrator are faced with a license
structure and have to set up the Creo Parametric startup options, i.e. the Creo startkeys,
accordingly.

Creo startkeys (PSF keys)

A startkey is a configured start command that opens Creo with one or more specified
licenses or license extensions.

Creo startkeys are created as PSF files and are located in the directory
<creoinstalldir>\Parametric\bin. Startkeys are generated during setup with the PTC
installation wizard or can be reconfiguared later
(<creoinstalldir>\Parametric\bin\reconfigure). Refer to the Creo manuals from PTC for
more information.

When the program starts, Creo reads the startkey to determine which licenses and
extensions are to be searched for on which license server(s). This is defined in the
environment variables PTC_D_LICENSE_FILE- and CREOPMA_FEATURE_NAME.

GENIUS TOOLS Starter intervenes in this process and

— replaces the PTC environment variables:
when settings are made in GENIUS TOOLS Project Configurator, i. e. for license server
and base license specifications.

or

— adds additional information to the PTC environment variables:
when settings are entered into configuration blocks, i. e. for license extensions and other
project options, such as add-on programs.
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Assigning licenses to a startkey

Each startkey should contain information about the base license package and the license
extensions. One startkey can contain several license extensions, as well as several base
licenses.

Usually, multiple startkeys are created for Creo, since the same license structure is typically
not available for all workstations. The actual number of startkeys required and the license
information they contain depends on the procedure you choose to optimize license usage,
as described in the next chapter.

Examples for license information in start keys:
Feature in der Datei found.psf. ENV=CREOPMA FEATURE NAME=PROE FOUNDATION ()

Feature in der Datei manikin.psf: ENV=CREOPMA FEATURE NAME=PROE FOUNDATION (277 278)

Feature in der Datei AAX.psf. ENV=CREOPMA FEATURE NAME=PROE AdvSE ()

9.20.3.2 Determining license servers
If multiple license servers exist in an organization, you can assign one or more license
servers to a specific project, unit or subunit.

You can also assign multiple license servers to a project and define the order in which the
servers are accessed.

Example: For the unit United Kingdom the license server in the United Kingdom should
be searched first and the license server in Asia last.

1. In the Resources main page create the resource Creo license server with the name
ALLSERVERS, which contains all license servers, e. g.
7788@licserverUK;7788@licserverUS,7788@licserverAS

The order of the servers corresponds to the search query.

2. Go to the unit United Kingdom and select the license server ALLSERVERS in the tab
Start in Creo Settings.

9.20.3.3 Optimally assigning licenses
There are three ways to use GENIUS TOOLS Starter to assign licenses and extensions to
one or more projects.

— Method 1: Fixed assignment of a startkey to a project

— Method 2: Assigning several startkeys to one project

— Method 3: Assigning license extensions to a project

Choose the method according to the license structure.
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The three methods can best be explained using an example.

Methods of license usage by example

The following example describes an optimal creation of Creo startkeys for different typical
situations.

Assumptions: The license server CADLICENSES is used. Creo startkeys (PSF keys) are
created by default with the PTC Setup or edited with "reconfigure". They are located in the
bin folder of PTC, e. g. PTC\Creo 8.0.0.0\Parametric\bin.

Initial scenario: One type of license
A company employs 10 Creo users and has 10 "Creo Foundation" base license packages.

Solution / Method 1: You require one Creo startkey which is assigned to one project.

— Content of the file parametric.psf:
ENV=PTC D LICENSE FILE-=7788@cadlicenses
ENV=CREOPMA FEATURE NAME= PROE_ Foundation ()

— In GENIUS TOOLS Project Configurator, assign the startkey parametric.psf to the project
Creo Parametric. (Consult the chapter Assigning Creo licenses to projects for a step-by-
step guide).

Result: 10 users can start the project without any . Crea Parametric
OptiOﬂS. Base enviranment Creo Parametric
i»2Qa¢

Scenario A: Several types of licenses
Two construction engineers join the team. The base license package "Creo Foundation" no
longer exists, so the base license package "Creo Advanced SE" is purchased.

Situation: There are 10 Creo Foundation base license packages and 2 Creo Advanced SE
base license packages for 12 users.

Solution / Method 1: The existing PSF key is extended.

— In the parametric.psf file the license specification for Creo Advanced SE has to be added:
ENV=PTC D LICENSE FILE-=7788@cadlicenses
ENV=CREOPMA FEATURE NAME= PROE_ Foundation PROE_AdvSE ()

— No editing needed in GENIUS TOOLS Project Configurator for the 12 users to work.

Result: 12 users can start the project without any . Crea Parametric
OptiOﬂS. Base enviranment Creo Parametric
i»2Qa¢
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Result: The project is started without any selections in the GENIUS TOOLS Starter App user
component.

Scenario B: One license type with license extension package

The top-down technology (skeleton models, reference control etc.) is to be used. For this
purpose, two license extension packages "Creo Advanced Assembly Extension” (AAX) are
purchased.

Situation: There are 10 Creo Foundation base license packages and 2 AAX license
extension packages for 10 users. Creo Parametric can be started without AAX and with
AAX (but only 2 times).

Solution: You can use all three methods. For all of them users are given the option to start
a project with or without an AAX license extension.

— Content of parametric.psf (as in initial scenario):
ENV=PTC D LICENSE FILE-=7788@cadlicenses
ENV=CREOPMA FEATURE NAME= PROE_Foundation ()

— For methods 1 and 2, a second startkey is created with the content:
ENV=PTC D LICENSE FILE-=7788@cadlicenses
ENV=CREOPMA FEATURE NAME= PROE AdvSE (0 6 97 108 292 329)

Method 1: Assigning a startkey permanently to a project.

— GENIUS TOOLS Project Configurator a new project is created with the second Creo
startkey aax.psf.

Result: Two projects can be started without any Bl creo Parametric
Options. Base environment Creo Parametric
. Creo Parametric
Base environment with TopDown Creo Parametric
it 2 Q¢

Hint: Project permissions can be used to grant selected users only the right to see the
project with AAX.

Method 2: Assigning multiple startkeys to a project.

— The second startkey aax.psf is assigned to the project. (See Projects with several startkeys
to choose from).

Result: The project has an option for selecting the B creo parametric

CreO startkey Base environment Creo Parametric
ﬁ p y Base lics -

AAX

Method 3: Assigning license extensions to a project
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— The aax.psf startkey is not used.

— Create a configuration block in the project folder which contains information about the
AAX license extension package. (See chapter Single project options for details).

— Contents of the config_aax.pro file:
! gts creo lic = 0 6 97 108 292 329

Result: The project has an option for selecting the . Creo Parametric

AAX license extension (CheCkbOX). Base environment Creo Parametric
i»2dZ
¥ &f MAX

Tabular overview of license usage methods:

Method 1 Method 2 Method 3
Description Fixed assignment of  Assigning several Assigning license
a startkey to a startkeys to one extensions to a
project project project
Project options in No options for Selecting a startkey  Activating one or
GENIUS TOOLS project from a list of more project
Starter App startkeys option(s)
Settings Projects > Projects > Creating a

Application > Project Application > Project configuration block
> Tab: Start > Creo > Tab: Start > Creo  (config_*.pro) in a

startkey startkey configuration
configuration directory
Advantage Quick provision of a  Number of projects Number of projects
simple configuration is minimized is minimized
significantly

9.20.3.4 Automatic distribution of Creo startkeys

You can automatically distribute Creo startkeys (PSF keys) to all user computers. GENIUS
TOOLS Starter copies all PSF files located in the configuration directory (Cadpool) of the
user computer to the bin directory of the Creo installation directory of the user computer.
The files are copied to the bin directory of the Creo version that is assigned to the project.
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Installation computer User computer
_aax psf
Pre
Data synchronisation Creo version\Parametric\bin
from Caddepot to Cadpool _
sim.psf
GTS installation directory GT%;;‘::;:“;““
| |
Caddepot Cadpool
| <operatingenvironment>\ | :l
configuration\standard —_parametrl..psf \..\..\standard parametric. psf
creo4 creo4
| <operatingenvironment>\ L \.\.\proiects
configuration\projects POy
creo8 i creod
|
|  <operatingenvironment>\ . { \.\..\units —— DE-Sim
configuration\units (1300

Automatic copying is useful when PSF keys were edited. The maintenance effort is
significantly reduced.

The function to copy startkeys is activated in GENIUS TOOLS Project Configurator in the
menu item Configuration under Creo Settings > Tab: Start > Dialog: Creo startkey. There
you can choose:

— whether all Creo startkeys are copied to the bin directory or
— whether only project-relevant startkeys are copied to the bin directory oder

— whether the bin directory is cleaned up before, i. e. all startkeys are deleted before
copying. (This is only possible for startkeys in the units and users directories).

The startkey used for the project depends on the call hierarchy for configuration blocks.

9.20.4 Installing Creo on user computers

Concept

The installation of Creo Parametric can be configured by providing a Creo setup that is
synchronized on all user computers. Installing can then be done automatically or
manually.

— Automatic installation: The installation is started when Starter projects are fully
synchronized and validated.

— Manual installation: The installation is started when you double-click on the
corresponding project.
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Warning: If the path to the setup folder is incorrect, users cannot open Creo Parametric
projects in GENIUS TOOLS Starter App.

Prerequisites

All folders required for the installation are located under caddepot/<operating
environment>/parametric/install. This folder structure is supplied and should not be
changed so that Creo can be installed without any problems. In addition, certain files must
be stored in this folder so that they can be executed correctly. There is a separate folder
with installation definitions for each Creo main version.

installdepot » 11.0.0.0 » parametric * install » v |

Eas

~
Name (] gts_crec_install_finalize.bat

definition > standard > [ gts_creo_install_prepare.bat

scripts > gts_creo_install_creo.ps1

gts_crec_install_crec_help.psi
gts_crec_install_crec_uninstall.ps1
gts_creo_install_creoview.psi
gts_crec_install_creoview_express.ps]
gts_creo_install_desktop_integraticn.ps1
gts_crec_install_firewall_entries.ps1
gts_crec_install_mathcad.ps1

gts_creo_install_gualityagent.ps1

EEEEEEEEEE

| gts_creo_install_taskkill.ps1

Predefined folder structure:

Folder Subfolder Contents and meaning
definitions  standard* > add_files** > creoX *The folder standard is a
> XML > creoX complete template with all
folders and subfolders for the
> XML > help_creoX*** installation of Creo version 7-
> setup 11. This folder can be copied

L : and renamed for units.
The following files are located directly under

standard:
gts_creo_install_finalize.bat ** The folder add_files is
gts_creo_install_prepare.bat optional.

*** A setup and an XML file can
also be stored for the help.
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Folder Subfolder Contents and meaning
scripts - The following files are located
here:

Scripts required to execute the
Creo installations. Do not copy
or change any files in the
scripts folder!

Please note: The required batch files — gts_creo_install_finalize.bat and
gts_creo_install_prepare.bat — run before and after the start of the setup under the
logged-in user, i. e. not under admin access rights.

Procedure

1. Under caddepot/<operating environment>/parametric\install\definitions\<standard or
UnitDirectory> are all folders you need for a Creo installation. These must be filled
with the required files.

a. In the event that unit-bound different installations are to be executed, the folder
structure must be copied from the standard folder to unit level.

2. Download the Creo Parametric setups to any computer. Save this setup under
standard > setup > Setup-Name > setup.exe.

standard » setup » MED-100WIN-CD-470_10-0-53-0_Wing4

s

= Mame

install

pirm

ptcshl
export_affirmation.pdf
[85] install_license_server.exe
License_Administration_Guide.pdf
ReadThisFirst.pdf
el setup.exe
@ setup-trial.exe

3. Start the setup.exe from the Creo installation directory and complete the entire Creo
setup including the installation in any directory.

4. Copy the following XML files and paste the files into the caddepot of your operating
environment for the Creo version from which you copied the XML files:
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a. <CreolnstallationTargetDirectory>\Creo<CreoVersionNumber>]|...]

ii. [..J\Parametric\bin\pim\xml > Also copy file pma.p.xml to

5. If you need additional files for the setup, e. g. PSF keys, copy these to the directory

[...]J\Common Files\bin\pim\xml > Copy file creobase.p.xml to
\XML\creo< CreoVersionNumber>

\XML\creo< CreoVersionNumber>

add_files\Creo< CreoVersionNumber>.

6. In menu item Configuration & under Creo Parametric > Tab: Install, select the setup

and target directory for the global settings (default) or a unit. You can only enter

“setup”, in which case the front file path is selected automatically.

a. For a setup from a synchronized resource, enter the path accordingly: e. g. %

GTS ROOT DIRS

Sun INNEQ GENIUS T JECT CONFIGURATOR 12.0.0.0 -
= Settings Units Install
(=] @ STANDARD & & @ CONSTRUCTION
P ~ SOURCE FOLDERS
s SIEN“USATQOLS 4 Standard -
arter - o -
o 4 Deutschiand Setup folder setup ™ inherited setup [=]
& Additional A Beir ~ DEFINITIONS
environment variabl
Target folder [} |}
Synchronization Development
s Execution folder [} [}
4 Hamburg
/Deins Parallel - =
. GENIUS TOOLS Construction Install/Deinstall
License Manager
LEJ Simulation Installation mode Manual ~ -
Network connections b Leipzig @ OPTIONS
g ? setwez o Install help S i No =
| Creo Parametric P United_Kingdom
Activate diagnose tools Yes i No -
afg;:gm SR Install Thumbnail Viewer Ne M No -
Do taskkills Yes - No -
SolidWorks o
CiCerle=TyR Credentials are not inherited. [ o
@. PREDENTIALS Information must be entered in the last unit.
Inventor

Windchill

o

08.07.2024 13:40:35

Username administrator

Password administrator

Valid until

7. Define how Creo is installed in the section Definitions.

Execution folder
Enter the execution path.

Install / deinstall

Upgrade: The old Creo version in the target directory is replaced. Enter the installation

directory of the previous version as the target directory.
Parallel: All versions are kept.
Deinstall: The version configured in the project is deinstalled.

........

Installation mode
Manual: Setup is executed when the user starts a project in GENIUS TOOLS Starter App.
Automatic: Setup is executed when the setup for the defined Creo version is available
on the computer and the project is validated.

Warning: Deinstall can only be executed with the Installation mode Manual.
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8. You can also make further specifications for global settings and units: Select
additional functions to be installed in the section Options, see Installing.

9. A setup and an XML file can also be stored for the help. Also set Install help to Yes.

10. Enter the administrator's access data and optionally a validity date for the access data
for the desired unit in the section Credentials. Please note that the credentials are only
taken from the last subunit, i. e. if setups are to be carried out in several units,
Credentials must be entered in each of these units.

11. Go to the menu item Projects > Creo Parametric:

a. In the tab: Install > Source folders, specify that Creo Parametric is to be installed for
this project. If no entries are made, the information from the menu item
Configuration & is loaded.

EE ‘ NNEQ GENIUS TOOLS PROJECT CONFIGURATOR 11.0.1.0
=8 Application types Projects Install
a mr iz @
& | ‘ Creo Parametric 10.0 * SOURCE FOLDERS
Creo Parametric B
Version 10.0 Install Creo
'3%‘ fﬂre&) FlementsIDirect Additional files
lodeling
||| “ DEFINITIONS
SolidWorks
Execution folde:
EI vestor Install/Deinsta Upgrade
o Installation mede
]
AutoCAD

b. In the tab: Creo, use the information for the lowest and highest version in the section
Creo Parametric to restrict the automated Creo installations to permitted versions
only.

If a Creo version with the same release is already installed and you are installing a
minor update, you must enter the lowest and highest version.

59 NNEQ GENIUS TOOLS PROJECT CONFIGURATCR 12.0.0.0
=8 Application types Projects Creo
a m 2 @
] - +~ GENERAL
Creo Parametric 12.0
&% Creo Parametric . .
4 Latest Version Project name project_creo12p
sy
@.‘-‘ %re; I‘El\ementsiD\rect Display name Creo Parametric 12.0
lodeling
i Description Latest Version
SolidWorks
Project image gtsprj_creol2_sutpng ]
EI ventor Hide project @ No
@ Block project @ No
AutoCAD # CREO PARAMETRIC
g AutoCAD Release Creo 120
Architecture
Lowest version 12000
AutcCAD Mechanical Highest version 12.04.0
Project directory INNEQ c12 (]
AutoCAD LT
Data directory Par=s (]
Apps

Windchill user root/Creo Agent home directory

Windchill cache directory

12. Save the settings in the Project Configurator. GENIUS TOOLS Starter checks whether a
new setup is available and installs it.
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9.20.5 Unit settings

In the main page Configuration B you can define the behavior of Creo Parametric. You
can set the behavior here for the system-wide standard (1) as well as for units (2) and
groups (3).

To switch between tabs click on Application, Start, Cleanup or Write (4).

[=F] NNEG S TOOLS PROJEC ) x
Iu NNEG GENIUS TOOLS PROJEC
= Settings Units Application Tabs o Hidden units @
(=] © STANDARD = = © CONSTRUCTION
A GENERAL
& GENIUS TOOLS 4 Standard ‘a
Starter Al
PG ) D] Greo install path =] =]
- = ©
4 Berlin Data directory data-global ] data-global [
 CREO PARAMETRIC DRECTORIES
Development.
Windchill user root/Creo Agent home directory FAPPDATA\PTC\ProENGINEER\%SUT_PROERELEASE% £a B
b Hamburg
=t GENIUS TOOLS b Leipzig Windchill cache directory %PTC_WF_ROOT?\Cache ] i
License Manager
N s St « PLOT CONFIGURATION
(@ .
b United_Kingdom Tral directory %TEMP3\Proe ] =]
% Plot configuration directory %GTS_CONFIGURATION_DIR%:\plot [ [
Plot file directory ETEMPR. [=] [
~ USER SETTINGS
Configuration directory %GTS_ROOT_DIR%\userdata\Jeusername’ £ ]
Solidworks
Pri
ror Private customizat fig [
Windehill Gray slanted font means that the input field inherits its value.
However, onl ly the standard setting will be displayed, even if this is
not the final inherited value.

The Application tab in the Creo Parametric settings dialog.

Please note: If an input field inherits values from the higher-level configuration levels,
you will still only see the global default value displayed in gray.

You can also specify settings directly for individual projects, which will overwrite the data
specified here for a unit. (Projects > Creo Parametric > Select project > Creo tab.)

For general information on units, see the chapter Configuring heterogeneous
environments: and for the inheritance of settings go to the chapter Call sequence for
settings.

9.20.9.1 Application

P Startup settings

Creo install path

You can specify a directory on the user computer where Creo is installed, or leave the field
empty, which means the installation directory is searched for automatically from the local
Windows registry and the Creo version is used as specified in the project settings. For
more information consult the chapter CAD-specific project settings.

Please note: It is generally recommended to have the installation path be determined
from the local Windows registry.
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Data directory
Enter the data directory to be used. The data directory is the main directory of an
operating environment containing Creo-related data.
The following data is stored in the data directory:
— Libraries: all library parts and their directories with MNU file
— Configuration: bend table, search.pro, hole chart, DTL file for drawing
representation, DMT file for colors in Creo, FMT file for displaying parts lists in the
browser
— Materials: material files for Creo in the MAT format
— ModelCheck: configuration files for ModelCheck
— NC: templates and configurations for NC machining.
— Drawings: files for drawing frames, notes and symbols

Please note: The files config_*pro, config_*sup and customization.ui can be stored
separately from the data structure due to their potential multiple use. If you want to use
project-specific configuration files, set the folder for them as the project folder in
GENIUS TOOLS Project Configurator > Projects > Creo.

» Creo Parametric directories
The input fields are described in the chapter Workspace for Windchill.

» Plot configuration

Trail folder

Creo trail files, recording all production steps, are written to this directory, e.g. %TEMP%
\Proe.

Plot configuration folder

This directory contains the configuration files (PCF and PNT) for the plotters, e.g. %
GTS_ROOT_DIR%\parametric\configuration\plot.

Plot file folder
Directory on the workstation in which Creo stores the plot files. e.g: C:\Temp.

P User settings

Configuration folder
The configuration files of each user can be stored in the directory userdata.

Private config.pro
Name of a user-defined config.pro file, e. g. config_%username%.pro. It is appended to the
config_*.pro files in the users, projects, units and/or standard directories.

Please note: For storing their private config.pro file, users must have write access to
the userdata directory, as well as the access right Can save personal Config.pro file [to
userdata directory] on server. See also Backup tab in GENIUS TOOLS Starter App.
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Private customization.ui

Name of a user-defined customization.ui file, e. g. config_user.ui. It replaces any
customization.ui file in the users, projects, units and/or standard directories. See also
Backup tab in GENIUS TOOLS Starter App.

5.20.5.2 Start

In the Start tab you can define the start behavior of Creo Parametric for a unit.

For managing the behavior of a single project, go to the Start tab in Projects main menu.

P Startup Settings

Startup directory

Enter the working directory of Creo.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.
<not specified / empty>: GENIUS TOOLS Starter does not create a language variable
(Lanc) on the application computer (recommended).
System: The country-specific settings of the operating system are adopted.
<language>: This language is used, and the language variable 1.aNG, if defined on the
application computer.

Show only installed languages
By default only languages of installed versions are displayed in the drop-down menu (see
above setting).

Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.

Enable stop batches
Yes: Additional batch files can be executed after Creo has been stopped.
No: No stop batch files can be executed after Creo has been stopped.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
<application>\configuration directory.

Activate Creo Update Notifier
Specify whether a notification should be displayed in Creo Parametric when new versions
are available, including information about new functions.
Yes: The notifier from Creo appears. The environment variable
CREO_MOR_NOTIFY_DISABLE is set to "false".
No: No notifier. The environment variable CREO_MOR_NOTIFY_DISABLE is set to "true".
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P License borrowing

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo,
the maximum borrow duration is determined by the environment variable

LM BORROW DURATION. Project Configurator does not check whether the value you enter is
valid for Creo.

Default duration
Specify the borrow duration in days that is set as the default when a user borrows licenses.

» Creo startkey

Copy Creo startkeys
GENIUS TOOLS Starter copies all Creo license keys (PSF files), which are located in the
operating environment of the user computer (cadpool), to the BIN directory (up to Creo
10.0.1.0) or TEMP directory (from Creo 10.0.2.0) of the user computer. For each PSF file, a
matching BAT file is created automatically. If you only want to copy startkeys required for
a specific project to the application computers, set Copy project-related startkey only to
Yes.
Yes: Up to Creo 10.0.1.0 all Creo startkeys located in the directory configuration or
userdata are copied to the BIN directory of the Creo installation before project
selection.
From Creo 10.0.2.0 all Creo startkeys that cannot be copied to the BIN directory are
copied to the TEMP directory. The environment variable USES_TEMP_PSF_LOCATION
is set.
Yes, cleanup before: All startkeys in the BIN directory of the specified Creo version or
the TEMP directory are deleted before the copy process, except cocreatesim.psf und
gts.psf. This option can only be set for units, not for projects.

Warning: Setting this option may lead to invalid projects, if no Creo startkey(s) are
copied.

No: Creo startkeys will not be copied. USES_TEMP_PSF_LOCATION is not set.

Copy project-related startkey only
Only the startkey(s) required for the selected project is (are) copied. This option can only
be used if the above option Copy Creo startkey is set to Yes.
Yes: Only the project relevant startkey is copied to the BIN directory or — from Creo
10.0.2.0 — to the TEMP directory, if copying into the BIN directory fails.
No: All startkeys are copied.
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» Creo License Servers

Creo license server
Select the Creo license servers to be used for the selected unit. The list is created in
Resources > Creo license servers.
No selection (default): The license server, which is specified in the Creo startkey, is
used.

» Licenses

Show licenses
Specifies whether the licenses specified in a project are displayed in the licenses tab of
GENIUS TOOLS Starter App.
Yes: Creo licenses are listed. The license status is not obtained; validation is possible
by using the see licenses function.
No: Creo licenses are not displayed. The settings Get extensions, Calculate licenses by
extension and Identify license users can not be utilized.

PTC license reusable per host

State whether your PTC licenses can be used several times.
Yes: Use this option if you have DUP_GROUP in your PTC license file. The license
validation will calculate the free PTC licenses in a way that PTC licenses that are
already in use by another session on the same application computer will show an
amount of at least one, making the project valid.
No: Use this option if you are unsure or cannot find DUP_GROUP in your PTC license
file.

Please note: For this option to produce the correct result, the PTC license must contain
the keyword DUP_GROUP according to CS234779. This information cannot be
determined by GENIUS TOOLS Starter App.

Get extensions
Define whether extensions should be queried. To use this setting, Show licenses has to be
set to Yes.
Yes: In addition to the basic license, extensions are also queried on the license server.
No: Only the basic license is queried.

Calculate licenses by extensions
Define whether a free license is calculated based on the basic license or on extensions. To
use this setting, Get extensions has to be set to Yes.

Yes: Extensions are also used for license calculation.

No: Licenses are calculated on the basic license.

Identify license users
Define whether users of a license are identified.
Yes: User names are displayed on the client as a tooltip of the corresponding license
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name. The GTS alias as defined under Resources > User is used.
No: No user names are obtained or displayed.

Please note: To display the name, the user names must be configured via Resources >
Users. Otherwise, the Windows user name is displayed

Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The license servers are pinged
before the license query is started. If the server does not respond to the ping, the query
will still be executed.
The duration you enter is also used as a maximum time for the license query.
If you expect licenses to be unavailable form time to time, set the timeout to 0, which
means that there is no timeout specified.

Default: 0 (no timeout specified)

P Creo Startkey Configuration

The query for license keys corresponds to the general query sequence: Standard > Unit >
Subunit > Project. See chapter Assigning Creo licenses to projects.

Default Creo startkey

Specify the license key (PSF file) of the respective Creo installation, which is defined in the
Creo tab under Release. If multiple startkeys are permitted for a project in the section Creo
startkeys below, the input field changes to a drop-down menu.

Please note: If the Creo startkey is not in the BIN or TEMP directory on the user
computer, the user cannot use it.

If a startkey cannot be found on the user computer, the project becomes invalid. The
display of invalid projects can be defined, see chapter Marking faulty projects > Invalid
projects.

Empty field: The default Creo startkey is inherited from the higher configuration layer.
Enter a PSF file: You can either enter a file name (e. g. parametric.psf) or a complete
path (e. g. D:\PTC\Creo 9.0.0.0\Parametric\bin\parametric.psf) or you can tick a box in
the section Creo startkey configuration below.
Drop-down menu: - Subscription - Appears if multiple startkeys are checked in the Creo
startkeys section below.

Select Creo startkey: The startkey displayed here is the default startkey in the selection
menu of GENIUS TOOLS Starter App.

Last selected: GENIUS TOOLS Starter App starts Creo with the startkey last used for
this project.
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Please note: If you want a unit or project to inherit multiple Creo startkeys from the
higher configuration layer (empty field), no drop-down menu with the selection Last
selected will appear. However, you can create this option by entering a text that does
not end with “.psf” in the input field, e. g. Last selected or Abcd.

Creo startkeys - Subscription -

The startkeys displayed here are the startkeys created under Resources > Creo Startkeys.

If you select several startkeys, that should be available for a Creo Parametric project, a
drop-down menu (project option) is created in GENIUS TOOLS Starter App that displays as
default value either a specific Creo startkey or the last startkey used for this project —
depending on the setting in the upper section Default Creo startkey. See Using project
options.

9.20.9.3 Cleanup

Configuration files of Creo Parametric are not overwritten by default. If a new file is to be
created, a previous deletion of the old configuration file is necessary. Here, you can
manage the cleanup settings of GENIUS TOOLS Starter App for Creo projects.

» Text directory

Config.pro, Config.sup, Customization.ui and - from Creo version 11.0.0.0 -
Mapkeys.pro
Defines whether these configuration files are deleted or retained in the text directory of a
Creo installation.

Yes: Delete

No: Retain

Please note: Make sure the user has access rights to delete files in the text directory of a
Creo installation. This will be of special importance if Creo is installed in Programs.

» Home directory

Config.pro
Determines whether this configuration file in the user's home directory is deleted or
retained.

Yes: Delete

No: Retain

Customization.ui and - from Creo version 11.0.0.0 - Mapkeys.pro
Determines whether these files in the directory .Settings in PTC_WF_ROOT are deleted or
retained.

Yes: Delete

No: Retain
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» Startup directory

Config.pro, Customization.ui, Config.val
Define whether these configuration files are deleted or retained in the start directory of a
Creo installation.

Yes: Delete

No: Retain

P Alternative path

Config.pro, Config.sup, Creo_parametric_admin_customization.ui and - from Creo
version 11.0.0.0 - Mapkeys.pro
Define whether these configuration files in the alternative target directory are deleted or
retained.

Yes: Delete

No: Retain

9.20.5.4 Write

Configuration files for Creo can be located in three different places, which can affect the
configuration of Creo. Here, you can influence the copy settings of GENIUS TOOLS Starter
and define target directories.

Warning: A new configuration file will only be written if no configuration file is yet
stored at the location. Use the settings in the Cleanup tab to avoid difficulties.

P Target directories

Use alternative path (from 9.0.2.0)
As of Creo version 9.0.2.0, it is possible to write the Creo configuration files config.pro,
config.sup as well as creo_parametric_admin_customization.ui in a directory other than
Text, Home or Start.
Yes: The alternative path below is used and the environment variable
PTC_CREO_ALT_SETTINGS_PATH is set. The target directory for the file config.pro is no
longer used for version 9.0.2.0 and later. For projects of older Creo versions, the
config.pro file is written to the target directory up to 9.0.1.0 and the config.sup file is
written to the text directory.
No: Do not use an alternative path.
Alternative path
Specify a directory for which users have write access. The directory is displayed in the
Info tab of GENIUS TOOLS Starter App.

Config.pro location (up to 9.0.1.0)
Select the directory to which the config.pro file will be copied. If no directory is selected,
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the file will be copied to the home directory.
Text: The config.pro file is copied to the text directory of the Creo installation.
Home (Default): The config.pro file is copied to the home directory of the user.
Start: The config.pro file is copied to the startup directory.

Please note: Make sure the user has access rights to create files in the text directory of a
Creo installation. This will be of special importance if Creo is installed in the Programs
directory.

Ul file location

Select the directory to which the customization.ui file will be copied. If no directory is

selected, the file will be copied to PTC_WF_ROOT.
PTC_WF_ROOT: The file creo_parametric_customization.ui is copied to the Settings
directory in PTC_WF_ROOT. If the file creo_parametric__admin_customization.ui exists
and no alternative path is specified from Creo version 9.0.2.0 and later, it will be copied
to the text directory.
Start: When existent, the creo_parametric__admin_customization.ui file is copied to the
text directory. The creo_parametric_customization.ui file is copied to the Creo startup
directory.

Please note: If Creo is to read the customization.ui file from the startup directory, the

following option must be set in the config.pro file: 10ad ui customization run dir
yes.

» Config Handling

Specify whether the following configuration files should be written.

Please note: To copy current configuration files, the corresponding files in the target
directory have to be deleted first (see Cleanup tab). This makes sure that the config.pro
settings defined by the administrator will always be used.

Config.pro
Yes: A config.pro is compiled and copied to the target directory unless a config.pro file
exists there already.
No: Writing config.pro is skipped.
Transfer mapkeys from config.pro (from 11.0.0.0)
As of Creo version 11.0.0.0 mapkeys must be saved in a separate file. GENIUS TOOLS
Starter can extract existing mapkeys and create the new mapkey file mapkeys.pro. If the
home or start directory is specified as the Config.pro target directory, the mapkeys are
created as user mapkeys, otherwise they are created as administrator mapkeys.
Yes: Mapkeys from the config.pro file are extracted if there are no mapkeys in config.sup.
Yes, transfer all: Mapkeys from the config.pro file are extracted, if mapkeys are found in
config.sup.
No: No support by GENIUS TOOLS Starter. Creo automatically loads user or
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administrator mapkeys into the mapkeys dialog, but does not create a mapkeys file for
administrators. A message window appears.

Config.sup
Yes: If a config.sup is found in the project folder, it will be copied to the target directory
unless a config.sup file exists there already.
No: Writing config.sup is skipped.
Transfer mapkeys from config.sup (from 11.0.0.0)
As of Creo version 11.0.0.0 mapkeys must be saved in a separate file. GENIUS TOOLS
Starter can extract existing mapkeys and create the new mapkey file mapkeys.pro. The
mapkeys are created as administrator mapkeys.
Yes: Mapkeys from the config.sup file are extracted and written to the text directory, or if
defined, to the alternative path.
No: No support by GENIUS TOOLS Starter. Creo automatically loads administrator
mapkeys into the mapkeys dialog, but does not create a mapkeys file. A message
window appears.

Customization.ui
Yes: If a customization.ui is found in the project folder, it will be copied to the target
directory unless a customization.ui file exists there already.
No: Writing customization.ui is skipped.

Config.val
Yes: If a config.val is found in the project folder, it will be copied to the target directory
unless a config.val file exists there already.
No: Writing config.val is skipped.

9.20.5.5 Installing

In the Install tab, you define how Creo Parametric setups are executed on user computers.
First create a template setup. Consult chapter Installing Creo on user computers for step-
by-step instructions.

» Source folders

Setup folder

Enter the directory that contains the Creo Parametric and Help setups: \
\<mainservername>\caddepot\

<operatingenvironmentname >\parametric\install\definitions\standard\setup

» Definitions

Target directory
Specify the directory to install on user computers.

Execution folder
Enter the execution path.
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Install / deinstall
Upgrade: The old Creo version in the target directory is replaced. Enter the installation
directory of the previous version as the target directory.
Parallel: All versions are kept.
Deinstall: The version configured in the project is deinstalled.

Installation mode
Manual: Setup is executed when the user starts a project in GENIUS TOOLS Starter App.
Automatic: Setup is executed when the setup for the defined Creo version is available
on the computer and the project is validated.

Warning: Deinstall can only be executed with the Installation mode Manual.

» Options

Install help
Determines whether the help is installed.

Install diagnostic tools
Determines whether Creo diagnostic tools are installed.

Install Thumbnail Viewer
Determines whether the thumbnail viewer is installed.

Activate taskkill
Defines whether potentially disruptive Creo processes are terminated.

Write firewall entries
Defines whether Creo is allowed to pass through the firewall.

» Credentials

Username and password of the administrator

Enter the Windows access data with admin rights. Domain users must enter the spelling
username@domain. Local users only enter the user name.

Validity

Enter an expiration date for the validity of the access data.

9.20.6 Project settings

Project settings are the specifications you make in the main page Projects '] under
Applications > Creo Parametric in the tabs Creo, Start, Windchill and Environment.

After having created a new project with the general project specifications, fill in the
following input fields. These entries overwrite both the unit-specific entries and the
standard settings for the startup behavior of the application, which are made under
Configuration > Creo Parametric > Tabs: Application / Start. For more information, see the
chapter Configuration concept.

GENIUS TOOLS Starter © 2025 INNED Solutions GmbH 213



GENIUS TOOLS Project Configurator GENIUS TUULS®;=

9.20.6.1 Settings for Creo projects

After having created a new project, specify the following settings in the Creo tab.

» Creo Parametric

Release
Defines the Creo Parametric version to be used. A path can be configured, or determined
automatically from the registry of the application computer. See Installation directories of
a CAD application.
Fixed path: Select the Creo directory from the drop-down menu. This may differ from
the Creo directory for the global standard settings. Without a directory defined here, the
settings for the standard unit will be used. (See Configuration > Creo Parametric > Unit:
Standard > Application > General > Startup settings > Creo install path).
Creo versions: It is possible to preset the Creo version. If you select Creo 9, for example,
the installation directory for the latest Creo 9 release on the application computer will be
determined from the registry.

Please note: Creo has to be installed locally on the application computer in order to
have registry entries available. The user has to have read permission in HKLM.

Lowest version (optional)

Select the lowest usable version. There is a dropdown list for versions up to Creo 4.
Starting with Creo 5, enter the required version manually in a four-digit format such as
710.0.1.0.

Highest version (optional)

Select the highest usable version. There is a dropdown list for versions up to Creo 4.
Starting with Creo 5, enter the required version manually in a four-digit format such as
710.0.8.0.

Project folder (optional)
Folder in configuration\projects. The files config.pro, config.sup, customization.ui and
config.val are copied as templates from this directory to the application computer.

Data folder (optional)
Main directory of an operating environment to which Creo-related data is saved, see Creo
data packages.

Please note: The files config_*.pro, config_*.sup and customization.ui should be stored
separately from the data structure due to their potential multiple use. These
configuration files should be managed in the specific subdirectories of the configuration
directories Units, Projects, or Users, or in the Standard directory for global settings.

The next section Creo directories is explained in the chapter Workspace for Windchill.
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9.20.6.2 Creo data packages

All Creo object data is stored in subdirectories for each operating environment, the data
packages, for example <GTS_ROOT_DIR>\parametric\data\sut_creo?.

The Creo data is stored in the following directory structure within a data directory:

— config: bend table, search.pro, hole chart, DTL file for drawing representation, DMT
file for colors in Creo, FMT file for displaying parts lists in the browser

— library_dir: all library parts and their directories with MNU file.
— material_dir: material files for Creo in the MAT format

— modelcheck_dir: configuration files for ModelCheck

— nc_dir: templates and configurations for NC machining

— Drawings (texture): files for drawing frames, notes and symbols

All references to data in the data directory are defined in project configuration files, i. e. in
configuration blocks (config_*pro files) in the projects directory. If there are no project-
specific references, the general configuration files in the standard directory will be used,

i. e, the config_*.pro files under <GTS-OperatingEnv>\parametric\configuration\standard.

It is recommended to consistently use variables in your references. For example, a
reference to a data directory from a config_*pro uses the variable scTs para.

Example: A reference in the configuration file config_sut_de_c9p_dir file.pro in the
project directory project _creo9p_de reads

pro library dir $GTS DATA\library dir

This reference points to the directory library _dir within the data directory.

Hint: It is recommended to use variables where possible.

Please note: Many configuration options can be set only once in Creo. In this case, the
value of the latest entry is used, that is, the value from the file that is copied last. There
is a defined call hierarchy for the files, see Call hierarchy.

9.20.6.3 Defining start hehavior for a project

In the Start tab specify the start behavior of an individual project. These specifications
overwrite the specifications for the start behavior set for units or the default settings (main
menu item Configuration > Group (select) > Creo Settings > Tab: Application > Area:
Startup behavior). For more information consult Configuration concept.
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P Startup settings

Starting behaviour

Select the application which will open the project.
Creo (default): The project is started with Creo.
External: The project is started with another application (e. g. SAP). For more
information got to chapter Linking projects with SAP.

If External is selected two additional fields open:

External start command
Enter the path to the executable file that is to start the project.

Command arguments for external start
Enter commands that specify how the executable file is started. Set the commands in
quotation marks.

Copy Creo startkey(s)
Specify whether the startkey (PSF file) required for the project is copied to the BIN
directory of Creo (up to Creo 10.0.1.0) or the TEMP directory (from Creo 10.0.2.0).
Yes: All project-relevant startkeys are copied.
No: Project-relevant startkeys are not copied.

Please note: For this option, write permissions are required on the application
computer in the Creo BIN or TEMP directory.

Take care when copying startkeys. A configuration error may lead to an unintended
distribution of startkeys to user computers that should not have certain licenses
available.

Language /Show only installed languages
See chapter Language of a Creo project.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
<application>\configuration directory.

9.20.6.4 Language of a Creo project

The language of the user interface of Creo Parametric can be set in the Projects main page
under Creo Parametric > Select projects > Tab: Start > Startup settings. The following
languages are available: English, German, Italian, French, Spanish, Japanese, Chinese
(simplified), Chinese (traditional), Korean, Russian, Brazilian Portuguese.

Define the following settings:
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Language
The language in which Creo should run can be specified. If no setting is selected, Creo
Parametric will select the operating system language automatically.
<not specified / empty>: GENIUS TOOLS Starter does not create a language variable
(LaNG) on the application computer (recommended).
System: The country-specific settings of the operating system are adopted.
<language>: This language is used, and the language variable (1anG, if defined on
the application computer, will be set to that language.

Show only installed languages
By default only languages of the installed Creo versions are displayed in the drop-down
menu (see above setting). This input overwrites any unit setting.

Yes: Menu contains only installed Creo languages.

No (default): Menu contains all languages supported by Creo.

Creo language as a project option

Administrators can also grant users the possibility to select a language, see Define project
options > language selection field.

9.20.6.5 Default settings for license borrowing

You can define the maximum duration of borrowing PTC and GENIUS TOOLS licences in
Creo Parametric > Projects > Tab: Start. This information overwrites the unit-specific
settings.

P License borrowing

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo,
the maximum borrow duration is determined by the environment variable

LM BORROW DURATION. Project Configurator does not check whether the value you enter is
valid for Creo.

Default duration
Specify the borrow duration in days that is set as the default when a user borrows licenses.

» Creo License Servers

Creo license server
Select the Creo license servers to be used for the selected unit. The list is created in
Resources > Creo license servers.
No selection (default): The license server, which is specified in the Creo startkey, is
used.
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5.20.6.6 Environment variables

In the Environment tab you can set environment variables for a Creo Parametric project.

The variables set here are added to the variables defined for units. Values set here for an
existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A
list of created and affected environment variables can be found in the appendix.

9.20.6.7 Installing Creo

In the Install tab, you define how Creo Parametric setups are executed on user computers
for the selected project. First create a template setup. Consult chapter Installing Creo on
user computers for step-by-step instructions.

9.20.6.8 Assigning Creo licenses to projects

A project can be started with a Creo Parametric license packages by assigning one Creo
startkey to it or by giving several for selection.

A startkey is

— a configured start command that opens Creo with one or several defined licenses or
license extensions,

— a PSF file located in PTC's bin directory.

The Start tab of the group as well as project settings lists all startkeys that have been
created as a resource.(See chapter Creating Creo startkeys.) The checked startkeys will be
those that users can select in GENIUS TOOLS Starter App. (See Making use of project
options.) If users are provided with several keys to choose from, the number of projects
can be greatly minimized.

Administrators can create projects that either have

1. one startkey or

2. several startkeys that users can choose from in GENIUS TOOLS Starter App.
Projects with several startkeys can either

2.1. have a startkey set as default or

2.2. use the startkey last selected by the user.

Please note: All settings described here can be made both in a project and in the
higher-level configuration levels (units, standard). The query of the Creo startkeys
corresponds to the general query sequence: Standard > Unit > Subunit > Project.
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Individual startkeys can be locked independently of the assigned options to select for
users under Resources > Creo startkeys > Block: Yes/No.

1. Projects with one defined startkey

Enter a Creo startkey in the Start tab in the Creo startkey configuration area. You can
either enter the file name (e.g. parametric.psf) or a complete path (e.g. D:\PTC\Creo
11.0.0.0\Parametric\bin\parametric.psf).

With a subscription license, you also have the option of selecting a startkey from the Creo
startkeys section below.

Settings Units

[E| : @ STANDARD
L] GENIUS TOOLS v STARTUP SETTINGS
LT.T.}
B | e B - - oo
@ P Deutschland ~ CREQ STARTKEY
p Schweiz ~ CREO LICENSE SERVERS
T b United_Kingdom v LICENSES
Crao Paramatric “ CREQ STARTKEY CONFIGURATION
Default creo startkey - -
5 etric.psf
Creo Elements/Direct parametricps O
Modelng Creo startkeys Use Display name Description
(&)
SolidWorks AAK aax.psf
Q « Default parametric.psf

Foundation found.psf

Inventor

Global settings (unit Standard) for the startkey parametric.psf

Application types Projects Start @
+ @ [ 2 ®
v STARTUP SETTINGS
. Creo Parametric 10.0 ~ LICENSE BORROWING
eI T S4CTEGILICENSE SERVERS settings entered at project | | inherited settings |
 CREQ STARTKEY CONFIGURATION
Creo Elements/Direct Creo Parametric 11.0
Modeling . .
New Default Creo startkey parametric.psf
SolidWorks . INNEO - Creo Windchill 10.0 Creo startkeys Use | Display name Description Use | Display name Description
o Cr Parametric + Windchill in cloud
= AAX aax.psf AAX aax.psf
Inventor
. Creo 11.0 - Testprojekt 29 v Default parametric.psf Default parametric psf
SUT-Daten zum Testen Foundation found.psf Foundation found. psf
AutoCAD
Plastic Advisor Plastic Advisor

Defined vs inherited project settings for startkey parametric.psf

2. Projects with several startkeys to choose from

If several Creo startkeys are permitted for a project, a selection field (project option) is
created in GENIUS TOOLS Starter App. See chapter Making use of project options.

— In Creo startkeys segment of the Start tab tick the Creo startkeys that should be
available for the project (project settings) or for all projects assigned to a unit (unit
settings).

— Decide which default setting the drop-down menu should contain. There are two
possibilities:

2.1. Projects with several startkeys and a default startkey

In the Default Creo startkey area, select the startkey that is to appear as the default setting
in the drop-down menu. This means that users do not have to make a selection to start a
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project. If users want to use a different Creo startkey, this must be actively selected in the
selection field.

+ CREO STARTKEY CONFIGURATION

Creo Parametric 11.0
Default Creostartkey parametric.psf T New version

Creo startheys e | Display name Description

> i _— ﬁ p % f de ~ Default - parametric.psf m‘
v Default parametric psf AAX - aax.psf
v Foundation found.psf
Plastic Advisor Foundation - found.psf
Several startkeys with parametric.psf as Selecting a startkeys on a project in GENIUS
default value TOOLS Starter App

2.2. Projects with several startkeys without a default startkey

If you select the entry Last used in the Default Creo startkey section, GENIUS TOOLS
Starter App remembers the startkey that a user last used for this project and uses it to
start Creo Parametric.

~ CREQ STARTKEY CONFIGURATION . Creo Parametric 11.0

Default Creo startkey Last used - Mew version

Creo startkeys se | Display name Description

ﬁé@%fdevm-aax.psf -

u

v AAX aax.psf [,
v Default parametric.psf IAAX - aax.psf

v

Foundation found.psf Default - parametric.psf

Plastic Advisar Foundation - found.psf

Several startkeys with the default set on the  Selecting a startkeys on a project in GENIUS
startkey used last TOOLS Starter App

9.20.6.9 Assigning Creo license extensions to projects

In addition to selectable Creo start keys, you can create the option for license extensions
to be selected individually, i.e. independently of the start key for a project. Users see this
as a checkbox in a project.

Project options

- e
Creo Parametric 11.0 ]
Mew version | AAK
| BMX
o B B,
i 208 B K& d ~ v m
| Simulation Live
GENIUS TOOLS for Creo MP User | Freestyle Design
v| & Manikin v &F Anx | Notebook
+| & Simulation Live «| @ Freestyle Design GENIUS TOOLS for Creo
+| &f Motebook v o BMX h MP User
| Manikin

Project options in GENIUS TOOLS Starter App: checkboxes for license extensions
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Advantages:

Assigning selectable license extensions to a project can reduce the number of Creo
startkeys created, and therefore reduce the number of projects available to users in
GENIUS TOOLS Starter App. If the license conditions allow it, you can, for example,
dispense with the selection of a Creo start key altogether by creating all license extensions
as project options

These project options are not created in GENIUS TOOLS Project Configurator, but with
configuration blocks. The procedure is explained in the chapter Using project options.

9.20.6.10 Workspace for Windchill

Set workspace directories for Windchill and Creo in the dialog Creo Parametric directoires
in the Creo tab.

You can also define these entries on a unit-specific basis in the Configuration menu item
under Creo Parametric > Tab: Application.

» Creo Parametric directories

Windchill user root folder / Creo Agent home directory

Specify the PTC_WF_ROOT directory in which the workspace and user-specific settings can
be stored.

The Creo Agent home directory, in which data relevant for Creo Agent, such as server
information, is saved, has to be set to %PTC_WF _ROOT%.

If no path is specified, the two variables are not set and a note about the default path of
Creo Agent home (APPDATA/PTC/Creo/Platform/<CPA_Version> is written to the log file.

Please note: If you want to specify separate Windchill directories for various Creo
versions you can use variables, like %GTS_PROERELEASE%, which will resolve to the
Creo version, e. g. Creo6, or %GTS_PROJECT_NAME% in building your path.

Windchill cache directory

Cache directory for caching of Windchill data. To use automatic server registration, the
Windchill cache directory must be located below the Windchill user root folder, see
chapter Automatic Windchill Server Registration.

Please note: Try not to modify this option. To change the storage location of the
cache, rather change the setting Windchill user root directory.

Use the Windchill tab is to register the servers. Detailed information about the procedure
are in the chapter Automatic Windchill server registration.

GENIUS TOOLS Starter © 2025 INNED Solutions GmbH 221



GENIUS TOOLS Project Configurator GENIUS TUULS®;=

Dynamic server settings for different Creo versions

When you change the Creo version, the local cache directories should be deleted from the
disk and re-created with the current Creo version. This means that when you use different
Creo versions, you also need to create different cache directories. Also, the storage
location for Windchill server registration information should be different.

There are two ways to ensure separate cache and server registration storage for different
projects:

1. Configure independent Windchill user root directories for different projects.
2. Use variables in configuring the Windchill user root directory.

The following variables can typically be used:

Variable Description

$GTS_PROERELEASES Returns the Creo version as Creo3, Creo4 etc.

$GTS_PROJECT_NAMES Returns the project name

Susernames Returns the name of the Windows user

Scomputername’ Returns the computer name

These variables can be used in the setting the path for the Windchill user root directory.

Example: D:\ptc\workspaces\%username %\
9%GTS_PROERELEASE%\%GTS_PROJECT_NAME%

The Creo Agent home directory, where server registration information is saved, schould
also depend on the Windchill user root directory. To set this up, you can define a variable
for the Windchill user root directory under Configuration > Standard > Additional
Environment Settings.

Name Value

Creo Agent Home $PTC_WE_ROOT%

Making the Windchill user root directory dependent on the Creo version by using %
GTS PROERELEASES and making the Creo Agent home directory dependent on that via %
PTC WE ROOT% Will lead to all server information and data being stored separately per
version.

If you also make the Windchill user root directory dependent on the project name using %
GTS PROJECT NAMES, the storage location will be project-dependent and will change with a
new Creo version.
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Do not use %GTS PROJECT NAMES if you use GENIUS TOOLS Starter projects to manage
different Creo license packages, because you cannot use local workspaces for multiple
projects in this way.

9.20.7 Displaying projects in GENIUS TOOLS Starter App

You can define general settings to present projects in GENIUS TOOLS Starter App, as well
as provide the following project details and functions that are specific to Creo Parametric
projects.

B INNCO -
Creo Parametric 11.0 '
Project name
' Deutschiand Neueste Version project_creol1p
~
eutsemian Project directory
° ' \
o tdBRsrsBEX S INNEQ
erlin v -
E Inf Info symbols Data directory
D) b inneo
A Construction v & o
@{—’ Manikin g’ Working directory
. C:\Users\AHelp\creo-work
—_ G Tl v M

Analyse and borrow licenses

The key icon 2 opens the Licenses tab with the functions to analyze and borrow licenses,
if users have the corresponding access rights.

— Setting: Under Organization > Access > Select role > Tab: Function Access > Dialog:
Project > Can see licenses / Can borrow licenses.

GENIUS TOOLS Starter App borrows its license and then starts the borrowing process from
PTC. Thereafter, Creo and, if configured in the project, GENIUS TOOLS for Creo each
borrow their licenses, see License borrowing process.

— The default and maximum borrowing period can be predefined in Projects > Creo
Parametric > Select Project > Tab: Start > Borrow Licenses.

Backup

The creo_parametric_customization.ui (short: customization.ui) file contains the user-
specific settings for the Creo graphical user interface and can be backed up and managed
by the user. (See Backup tab.)

Analysis

The info symbol K opens separate utility GENIUS TOOLS Config Analyzer to view and edit
all configuration blocks and batch files used for the project and their storage location.

— Setting: Button can be deactivated under Can analyze projects under Function access >
Project
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Project report

The project report — created by clicking on the = button (5) — is a separate PDF file
containing all information about the selected project and the current user.

— Setting: The button can be deactivated with Can create project report under Function
access > Project

The information is grouped as follow:

— General project details

— GENIUS TOOLS STARTER Network-settings
— GENIUS TOOLS Starter App

— Additional Environment Settings
— Synchronization

— Licensing

— Creo Settings

— Delete Creo configuration locally
— Write Creo configuration locally
— Windchill Settings

— Used Files

— Batch-files

— Config.sup

— Config.pro

— Customization.ui

— Dynamic Customization.ui

— Config.val

— Assigned rights

— Appendix

— All environment variables

— Generated config.sup

— Generated config.pro

— Generated config.val

9.20.7.1 Defining project options

Administrators can give users the option to select from the following project options.
— Creo language (1)
— Creo startkey (2)
— project options for license extensions, add-on programs and configuration settings:
- single project options (3)
- switch options (4)

- grouped project options (5)
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Creo Parametric 11.0 Creo Parametric 11.0.0.0
Neueste ‘\:‘ersi0|‘° Selection field for language | | Selection field for Creo startkey e

\_\‘
ﬁ /x@ ﬁl @ ItE'1 % / de ~ || Default - parametric.psf v mbd o
- ic. Grouped project option
v @f AAX e v @f BMX Default - parametric.psf

Foundation - found.psf
& Manikin e/ Notebbo P

@/f; Toolkit v GENIUS TOOLS for Creo
Keyshot 10 D'Ug Checkboxes for further options

Selectable project options in GENIUS TOOLS Starter App

Like all Creo Parametric project settings project options can be defined for a specific
project as well as for units, subunits or system-wide.

Language selection field

You can set whether users can select the language of the projects they have access to. The
right Creo language selectable is granted in Configuration > GENIUS TOOLS Starter App >
Select unit > Projects and applies to all projects. (See Language selection.)

Selection field for Creo startkey

A startkey is a configured start command that opens Creo with one or more specified
licenses or license extensions. Startkeys are PSF files in the bin directory. You can assign
multiple startkeys to a project. The procedure is described in chapter Assigning Creo
licenses to projects If users have multiple startkeys to choose from, a selection field
appears in the selected project in GENIUS TOOLS Starter App.

Users can be given start keys to select from:

— per project: select the startkeys in Projects > Creo Parametric > (select) Project > Tab:
Start > Segment: Creo Startkey Configuration. For more information, see the chapter
Assigning Creo licenses to projects.

— for several projects that can be accessed by a unit: Select the startkeys in Configuration
> Settings: Creo Parametric > Select project > Tab: Start > Segment: Creo Startkey
Configuration

The administrator can set in GENIUS TOOLS Project Configurator whether a project should
have a default start command or whether the start command last selected by the user
should be used again. (See chapter Assigning Creo licenses to projects, 2.1. and 2.2..)

If the right to select is not assigned, neither selection field nor information about the used
start key appears. If you want to give users an information about the start key, you can
insert this in the name of the project or in the subtitle, e.g. Creo Parametric 7.0. AAX.
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Checkboxes for project options

Administrators can define further project options that are tailor-made to a company's
requirements, e. g. for starting Creo with:

— additional license extensions, such as Simulation Live or Manikin,
— additional programs such as Keyshot,
— any other configuration setting.

These types of project options are not created in GENIUS TOOLS Project Configurator, but
with configuration blocks. The chapter Making use of project options explains the
procedure.

For presenting the checkboxes in GENIUS TOOLS Starter App you can define the number
of columns, see Arranging checkboxes.

9.20.8 Linking Creo projects with SAP

With GENIUS TOOLS Starter you have the possibility to open a Creo Parametric project
with a user-defined command. You can use this option, for example, to link a project with
SAP-ECTR (SAP Engineering Control Center interface to PTC Creo).

To use other applications that start a Creo Parametric project, proceed as follows.

1. Check Creo versions and information for licenses and license servers (Creo
startkey)

Check that the Creo version defined in the Creo project in GENIUS TOOLS Starter matches
the Creo version that is to be started by the external application. The correct
parametric.exe is available by the environment variable PROE_START.

Check that licenses and license servers defined in the Creo project in GENIUS TOOLS
Starter match the entries in the external application. We recommend using the gts.psf file
as Creo startkey for the external application. This ensures that the correct licenses and
license servers are used.

2. Change startup behavior of the project

In GENIUS TOOLS Project Configurator in the Projects page, go to the corresponding
project and in the Start tab, go to the Startup settings section. Change the startup behavior
of the project from Creo to External. Two further input fields open.

Projects Start @
+ a0 m i @
o5 . Creo Parametric 10.0 * STARTUP SETTINGS
Version 10.0 Starting behavior Exte

am i Value for thi t
] Creo Elements/Direct Creo Parametric 11.0 External start command e

Medeling Netente version Parameter: UseExternalStart
Command Arguments for external start Project: 1

SclidWorks @ Creo Parametric 11.0 - Testp.. 82, Creo startkey
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3. Enter information about the external start behavior
In the field External start command, enter the path to the application (executable file) with
which the project is to be opened.

In the field Command line arguments for external start field, enter the commands with
which the executable file should be opened.

All other information about a project does not change. (See chapter Settings for Creo
projects.)

9.20.9 Customizing Creo user interface

If you want to customize the user interface of Creo, go in Creo to File > Options >
Configuration editor.

Changes made in Creo will by default be saved in the file creo_parametric_customization.ui
in the directory %PTC_WF_ROOT%\.Settings, e. g. %APPDATA%
\PTC\ProEngineer\creo4\.Settings.

Alternatively, you can have this file stored in the startup directory. To do so, select a group
in GENIUS TOOLS Project Configurator and in Creo Settings > Write > Target Directories >
Ui file location select Start.

NMNEO GENIUS TOOLS PROJECT COMFIGURATOR 12.0.0.0 =
= Settings Units Write @
= % STANDARD
EE'&. » TARGET DIRECTORIES
SETJSSATOOLS 4 Standard
rApp b Deutschland Use alternative path (from 9.0.2.0) la
@ Additional _ b Schweiz Alternative path 0
environment variables
||| b United_Kingdom Config.pro location {up to 9.0.1.0) Text
Synehronizatien ) )
Ul file location ‘ PTC_WF_ROOT = |
&) GENIUS TOOLS A CONFIG HANDLING
License Manzager
s Config.pra
(@) = Start
Network connections Extract mapkeys from config.pro (from 11.0.0.0} Ja
E Config.sup Ja
Crea Parametric
Extract mapkeys from config.sup (from 11.0.0.0) Ja
arfgelli_l\:gﬁemSIDifEﬂ Customization.ui Ja
Config.val Ja
SolidWorks

9.20.9.1 creo_parametric_customization.ui

The file creo_parametric_customization.ui (short: customization.ui) contains the settings for
the graphical user interface (Ul) of Creo.

To customize the user interface specific to a user or a group of users, do as follows:

1. Modify the settings for the user interface in Creo in File > Options > Configuration
editor.
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2. Copy the file creo_parametric_customization.ui that is saved in %PTC_WF_ROOT%
\.Settings by default. (The use of the startup directory as alternative storage location is
described in the previous chapter.)

3. Save the copied ui-file to one of these directories: userdata, users, projects, units or
standard. (See also Directory structure.) In a subdirectory of unit, the Ul file would, for
example, determine the Creo user interface for the named unit.

The Customization.ui file is a configuration file of Creo and not a configuration block
(config_*.pro file) of GENIUS TOOLS STARTER. This changes the procedure to read the
settings. A single customization.ui file is read out, meaning that one customization.ui file
cannot add configuration settings to an existing file, it can only substitute another
customization.ui.

The customization.ui file that is found first determines the Creo user interface. The call
hierarchy is as follows:

1. userdata > 2. users > 3. projects > 4. units > 5. standard

Company-wide configuration with
creo_parametric_admin_customization.ui

The administrator can set up a configuration that is valid for the whole company or for
specific users, projects or units. To do so, change the name of the ui-file that is
automatically saved by Creo from creo_parametric_customization.ui to
creo_parametric_admin_customization and save it to one of these directories: userdata,
user, project, unit oder standard.

The settings in the admin file creo_parametric_admin_customization are overwritten or
complemented by those in the individual creo_parametric_customization.ui.

Executing the file creo_parametric_admin_customization.ui follows a hierarchical search in
these directories:

1. users > 2. projects > 3. units > 4. standard
The administrator can thus set up a standardized graphical user interface for specific users,

projects and units, as well as a company-wide Ul configuration.

Please note: A company standard, i. e. a Ul file in the standard directory, can only be
implemented if there are no admin_customization.ui files in the directories users,
projects and units.

Individual customization.ui file

A user can manage his or her own customization.ui file by saving it to a directory userdata
to which the user needs write access. There are two possibilities. One, the user can access
the userdata directory in the caddepot directory of the administration computer — from
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where it will be synchronized to the client computer. Two, a directory can be created in
any location on the client computer. There, it does not undergo data synchronization. (See
also the chapter on User-driven configuration.)

The administrator can determine the storage location of the userdata directory in
Configuration > (select) group > Creo Settings > Application > User Settings >
Configuration folder.

NNEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

= Settings Units Application @
= Q © STANDARD
EE?; GENERAL
4 Seiite CREO PARAMETRIC DIRECTORIES
@ b Deutschland PLOT CONFIGURATION
2 F B P Schweiz 4 USER SETTINGS
b United_Kingdom . . %GTS_ROOT_DIR%\userdata\%usernames% i
Configuration directory
Creo Parametric config_%username%.pro
Private config.pro
B config_user.ui
Private customization.ui

Backup mechanism with GENIUS TOOLS Starter App

You can create a backup file from creo_parametric_customization.ui in GENIUS TOOLS
Starter App. This can be useful for users who manage their own Ul configuration files, as
well as for administrators who modify Creo Ul settings for test purposes. A description of
the procedure can be found in the chapter GENIUS TOOLS Starter App > Creating backup
copies.

9.21 Creo Elements/Direct Modeling

A Creo Elements/Direct Modeling project consists of configuration files, an operating
environment and data packages for standard parts.

Please note: The work with projects for Creo Elements/Direct Modeling is a feature
that requires a subscription license.

A Starter project configuration is generated from settings of the Power Extension
environment and is not from individual configuration blocks.

For Creo Elements/Direct Modeling, batch files can be used that are opened before the
application is started, i.e. starter batch files. See also chapter Batch files.

9.21.1 Project display in GENIUS TOOLS Starter App

For the Creo Elements/Direct Modeling application, project details are displayed in the
tabs Info, Licenses and Backup.

Language selection can be provided as a project option. Project options that appear as
checkboxes cannot be created.
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Also note the general settings for presenting projects to users in GENIUS TOOLS Starter
App.

9.21.2 Unit settings

In the main page Configuration @ you can define the behavior of this program for the
selected unit (5) or for the system-wide standard (4).

Click Application (1), Start (2) and Cleanup (3) to switch between tabs.

Settings Units Application ®
(=] < STANDARD = = © CONSTRUCTION

~ APPLICATION

GENIUS TOOLS 4 Standard (4]
:::::::::

4 Deutschland

@& =

4 Berlin Allow

Construction S Store Ul layt

Development

]

A PLOT CONFIGURATION

b Hamburg

b Leipzig HPGL plotting

b Schweiz ~ USER SETTINGS

b United_Kingdom Configuration directory

o B

~ SOLIDPOWER ENVIRONMENT

Settings for unit and groups for the application Creo Elements/Direct Modeling

Please note: If an input field inherits values from the higher-level configuration levels,
you will still only see the global default value displayed in gray.

Settings that are made directly to for CED-project overwrite the unit settings entered here
and are made under Projects > Creo Elements/Direct Modeling > Select Project > Modeling
tab, see project settings.

For general information on units, see the chapter Configuring heterogeneous
environments: and for the inheritance of settings go to the chapter Call sequence for
settings.

9.21.2.1 Application

» Application

Creo Elements/Direct install path
Enter a directory on the user computer which has Creo Elements/Direct Modeling
installed.

Allow interactive customization

Defines whether interactive customization are allowed.
Yes: Interactive customization are allowed.
No: Interactive customization are not allowed. The variable
SDDISALLOWINTERACTIVECUSTOMIZATION is set.
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Store Ul layout files
Defines whether user specific files (*_fluentui_layout.def) are saved.
Yes: Files are saved.
No: Files are not saved. The variable SDDONTSTOREUILAYOUTFILES is set.

» Plot configuration

HPGL plotting
Specify whether the plot settings from Power Extensions (PowerX_Styles\plotdefs) are used.

» User settings

Configuration directory
You can store customized configuration files of users in the userdata directory.

» Solidpower environment

Set TSPRO environment
If you have a data package for Creo Elements/Direct Modeling, select Yes.

TSPRO directory
Enter the path to the directory that contains the data for Creo Elements/Direct Modeling.

Standard parts directory / Solidpower directory
Enter the path to the directory that contains the data for standard parts.

5.21.2.2 Start

In the Start tab you define the startup behavior of the application.

» Startup settings

Startup directory

Enter the working directory of Creo Elements/Direct Modeling.

Language

The language in which Creo Elements/Direct Modeling starts can be specified. If no setting

is selected, the application will select the operating system language automatically.
<not specified / empty>: GENIUS TOOLS Starter does not create a language variable
(LaNG) on the application computer (recommended).
System: The country-specific settings of the operating system are adopted.
<language>: This language is used, and the language variable 1.aNG, if defined on the
application computer

Synchronize with project start
Defines whether project data is to be synchronized before a project opens. This
guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
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<application>\configuration directory.

» Creo Elements/Direct license server

Creo Elements/Direct license server
Enter the license server that should be used for the selected unit, e. g. localhost, mels
No input (default): The license server that was entered in the setup is used.

» Licenses

The license server is determined automatically from the registry and cannot be specified
here.

Show licenses
Specifies whether the licenses specified in a project are displayed in the licenses tab of
GENIUS TOOLS Starter App.
Yes: Licenses are listed. The license status is not obtained; validation is possible by using
the See Licenses function.
No: Licenses are not displayed. The settings Get extensions, Calculate licenses by
extension and Identify license users can not be utilized.

Identify license users
Specify whether users of a license can be determined.

Yes: In the GENIUS TOOLS Starter App, the users currently using a license feature are
displayed as a tooltip in the license display. The Windows user is replaced by the
GENIUS TOOLS Starter user alias from the workspace Users.

No: No user names are obtained or displayed.

Please note: To display names, the user names must be configured via Resources >
Users. Otherwise, the Windows user name is displayed.

Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The servers are checked for

availability with a ping before a license evaluation. If it is not possible to ping the server,

the query will be performed anyway.

In addition, the value set here is used as the maximum time to query the licenses.
Default: 0 = No maximum query time is set.

9.21.2.3 Cleanup

Here, you can manage the cleanup settings of GENIUS TOOLS Starter App for projects.

» User directory

SolidPower directory
Determines whether the SolidPower settings directory in the user directory is deleted
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before project start.
Yes: Delete
No: Retain

Default settings (LSP files)

Determines whether all LSP-files are deleted from the Default_Settings directory.
Yes: Delete
No: Retain

Further files or directories
Specify additional files or directories with user settings shall be deleted. The specification
is relative to the user directory, e. g. ANNOTATION\am_fluentui_layout.def

9.21.3 Project settings

Project settings are the specifications you make in the main page Projects Il under
Applications > Creo Elements/Direct Modeling in the tabs Modeling, Start and Environment.

After having created a new project with the general project specifications, fill in the
following input fields. These entries overwrite both the group-specific entries and the
standard settings for the startup behavior of the application, which are made under
Configuration > Creo Elements/Direct Modeling > Tabs: Application / Start. For more
information, see the chapter Configuration concept.

9.21.3.1 Essential specifications

In the tab Modeling you specify essential details for a Creo Elements/Direct Modeling
project.

Input fields without settings inherit the settings from unit specifications.

» Modeling

Release
Defines the Creo Direct/Elements Modeling version to be used. A path can be defined or
determined automatically from the registry of the application computer.
Fixed path: Select the directory from the drop-down menu. This can differ from the
Creo directory for the standard unit as defined on the Configuration page. If you do not
specify a Creo directory, the settings for the standard unit will be used.
Direct Modeling versions: Select a version, e. g.<Direct Modeling 20.4>. The
installation directory will be determined from the registry.

Please note: Creo Direct/Elements Modeling has to be installed locally on the
application computer in order to have registry entries available. The user must have read
permission in HKLM.
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Project directory (optional)
Directory under elements_direct\configuration\projects.

Corp directory
Specify the path to the directory that contains company-specific configuration settings.

Site directory
Specify the path to the directory that contains site-specific configuration settings.

User directory
Specify the path to the user directory.

» Solidpower environment

Set TSPRO environment
If you have a data package for Creo Elements/Direct Modeling, select Yes.

TSPRO directory
Enter the path to the directory that contains the data for Creo Elements/Direct Modeling.

Standard parts directory / Solidpower directory
Enter the path to the directory that contains the data for standard parts.

9.21.3.2 Startup behavior

In the Start tab you define the startup behavior for a Creo Elements/Direct Modeling
project. The specifications set here overwrite the settings for units.

Consult the chapter Creo Elements/Direct Modeling > Unit settings > Start for a
description of the input fields.

5.21.3.3 Environment variables

In the tab Environment you can set environment variables for a CED project.

The variables set here are added to the variables defined for units. Values set here for an
existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A
list of created and affected environment variables can be found in the appendix.

9.22 Inventor

A Starter project for the application Inventor requires:
— essential specifications
- a defined Inventor release

- Inventor-related data packages
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— configuration blocks
- for settings of functions and behavior of Inventor (XML files)
- for embedding additional applications (ADDIN files),

— settings for additional applications / linkages (batch files)

— Project file (IPJ-Datei)

- for managing Inventor data

Please note: Creating starter projects for Inventor is a feature that requires a
subscription license.

For general information consult the chapter Starter projects.

9.22.1 Configuration principles

The behavior of Inventor is determined by two configuration files. These are:

UserApplicationOptions.xml
Configuration file for general configuration settings, e. g. for template paths, import and
export settings, settings for colors and materials.

InventorCustomization.xml
Configuration file for user interface settings.

The XML configuration files are created for each version and are located at:

%APPDATA%/Autodesk/Inventor <version>

Embedding additional applications

By default, most additional applications (AddIns) that are installed with Inventor are
started automatically. If the default behavior for an add-on application is to be changed, a
file with the extension .addin must be created for that application. This is a text file that
can have any name, e. g. AdditiveMFG.inventor.addin.

The default settings can be found under %ALLUSERSPROFILE%\Autodesk\Inventor
<version>\Addins.

ADDIN files, version dependent
If the default behavior of the add-on module is to be changed for a specific version, the
ADDIN configuration file is placed here:

%APPDATA%/Autodesk/Inventor < Version>/Addins

ADDIN files, version independent
If the default behavior of the add-on module is to be changed for all versions, the ADDIN
configuration file is stored here:
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%APPDATA%/Autodesk/ApplicationPlugins

9.22.1.1 Project configuration with GENIUS TOOLS Starter

Configuration settings

By using GENIUS TOOLS Starter, configuration options are not written to Inventor
configuration files, but to different configuration subfiles of GENIUS TOOLS Starter, the
configuration blocks.

Configuration blocks that contain configuration settings can be stored in four different
configuration levels. When selecting a project in GENIUS TOOLS Starter App, the blocks
are loaded from the corresponding configuration levels and their contents are written to
the two required Inventor configuration files, UserApplicationOptions.xm! and
InventorCustomization.xml, see next chapter.

The XML configuration files must be deleted from the Inventor directory before they can
be rewritten. This is set by default in GENIUS TOOLS Starter. Changes to this write
behavior can be made in the Delete and Write tabs of the unit settings.

By default, the XML configuration files are saved to the Inventor version directory (%
APPDATA%/Autodesk/Inventor <version>). However, you can specify a different directory,
in the unit settings in the Write tab > Target Directories.

Additional applications (AddIns)

The inclusion of additional applications can also be defined in the four different
configuration levels, by placing ADDIN files. The next chapter explains how to create
ADDIN files.

Decide whether AddIn applications should be started for a specific version or for all
versions. Specify this in the unit settings in the Write tab under Target Directories > Add-
Ins. The possible locations are in the Appdata directory, see previous chapter
Configuration principles.
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Write

Q) STANDARD

» TARGET DIRECTORIES

UserApplicationOptions.xml

InventorCustomization.xml

Add-Ins \ b

Appdata, version dependent
Appdata, version independent
Write tab in the group settings
Project options

For Inventor projects, options can be created so that users can select directly at the project
which Addins, for example, should be started.

A special feature is that for Inventor project options can be created to start the read-only
mode, see Read-only-Mode.

| Inventor 2023
Wersion 2023
ﬁ f - |+*| Read-only mode

Batch files
For Inventor projects all batch files can be used, which are opened before, during or after
the start of the application, see chapter Batch files.

Inventor project files
For a Starter project you can use Inventor project files (IPJ files) which determine the
location of the work data, templates, styles and libraries.

Libraries are defined in the Libraries tab of GENIUS TOOLS Project Configurator and are
thereby written to the Inventor project file (IPJ file). If no IPJ file exists in an operating
environment, GENIUS TOOLS Starter uses the default project file at CC:
\Users\Public\Documents\Autodesk\Inventor <version>.

You can store one or more IPJ files in the configuration layers standard, units, projects,
users of an operating environment. The search sequence is as follows:

1. users > 2. projects > 3. units > 4. standard
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The first IPJ file found is read, i. e. no settings are added to an existing file. See Call
sequence for files.

9.22.1.2 Configuration blocks for Inventor

Configuration blocks must be created manually and stored in the configuration levels
Standard, Unit, Project, User, see chapter Configuration concept.

A configuration block for Inventor:

—is a text file with the extension .xml or .addin.

Type Notation Content Behavior
1 config_*.xml general configuration specifications are
z. B. config_dir_filexml  settings, e. g. for transferred to the
template paths, import  configuration file
and export settings, UserApplicationOptions.x
settings for colorsand ~ ml before startup
materials
2 ui_*xml user interface settings Details are transferred to
z. B. the
ul_customization.xml InventorCustomization.x
ml configuration file
before startup
3 *.addin Includes or exlcudes file is saved version-

AdditiveMFG.inventor.ad additional applications  dependent or

din independent,
starting an additional
application possible as a
project option

— can contain conditions (see chapter Conditional configuration blocks),

— can contain one or more configuration option(s).

If a configuration option is set multiple times, the last entry is — according to the call
hierarchy of configuration blocks — is the valid option value. If a configuration option is
not set, the default value of the software is active.
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Creating configuration blocks for Inventor

1. Create a text file with the file ending .xml or .addin in the required configuration
directory.

2. Write in the first line: <?xml1 version="1.0" encoding="utf-16" standalone="no" 2>

Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,
configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks and Config.pro files using
the add-on program GENIUS TOOLS Config Editor, which features color highlighting,
auto-completion as well as error messages and which allows you to compare entries of
two configuration blocks.

XML file (type 1)
Example: Setting template paths
Create a text file named config_templates.xml with the following content.
<?xml version="1.0" encoding="utf-16" standalone="no" ?>
<ApplicationOptions Platform="Vista" Version="27.1 Production Candidate">
<File TemplatesPath="$GTS DATA%\Templates\%LANGUAGE%\" />
<Save SaveReminder="0"/>

</RpplicationOptions>

ADDIN file (type 3)

Example: Execute add-in module “Additive Manufacturing” at startup

Create a text file named AdditiveMFG.inventor.addin and specify the ClassID and ClientID

of the add-on application, and the LoadOnStartUp command:

<Addin>
<!--Created for Autodesk Inventor Version 20.0-->
<ClassId>{4e2d52fb-8288-4427-b912-20ef97£073c9}</ClassId>
<ClientId>{4e2d52fb-8288-4427-b912-20e£97£073c9}</ClientId>
<LoadOnStartUp>1</LoadOnStartUp>

</Addin>

ADDIN file (type 3) as project option

Example: Make add-in module “Additive Manufacturing” available as a single
project option

Create the text file from the previous example. Insert the following between the first line
and the ClassID and ClientID:

<!-- gts _is selectable=true -->
<!-- gts selection default=true -->
<!-- gts display name= Additive Manufacturing -->
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Other variables can be used, see table in chapter Single project options. Note the
application-specific notation of the GTS variables.

9.22.1.3 User-driven configuration for Inventor

Users can manage Inventor configuration blocks themselves, overriding the settings made
by the administrator, if they have the appropriate access right.

This type of user-defined settings are created by storing a private configuration block in
the userdata directory. Set the path to the userdata directory in GENIUS TOOLS Project
Configurator in Configuration > Settings: Inventor > Select Group > Tab: Application > User
Settings > Private configuration folder, as well as the notation of the private configuration
blocks.

Consult the chapter User-driven configuration for detailed instructions.

9.22.2 Unit settings

In the menu item Configuration B you can define the program behavior of Inventor that
should apply to the selected group. You can make settings globally for the Standard unit
(1), as well as for units (2).

To fill in all fields, switch between the tabs Application, Start, Cleanup and Write (3).

JEOQ GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

o
e

Settings Application Tabs e
[E] @ STANDARD <© UNITED_KINGDOM
~ APPLICATION

B GENIUS TOOLS P o

Starter App

P Deutschland = =

@ P Schweiz O O
2 UG R e Content Center directory =] ]

SolidWorks b Edinburgh ~ USER SETTINGS
il 4 Stratford-upon-Avon
@ Development Private configuration block (config)

Windchill o] Private cont figuration block (ui)

U-nit settings for the application Inventor in GENIUS TOOLS Project Configurator

Settings for a single project are also possible. They overwrite the unit settings made here,
see Project settings.

Please note: If an input field inherits values from the higher-level configuration levels,
you will still only see the global default value displayed in gray.

For general information on units, see the chapter Configuring heterogeneous
environments: chapter and on inheritance of settings, see the chapter Call sequence for
settings.
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9.22.2.1 Application

» Application

Inventor install path

You can specify a directory on the user computer where Inventor is installed or leave this
field empty, which means the installation directory is searched for automatically from the
local Windows registry and the version is used as specified in the project settings. For
more information consult the chapter CAD-specific project settings.

Please note: It is generally recommended to have the installation path be determined
from the local Windows registry.

Data directory

Enter the data directory to be used. The data directory is the main directory of an
operating environment containing Inventor-related data, e. g. %$GTS_ROOT_DIR%
\inventors\data\inv_22.

Content Center directory
Target directory for Content Center libraries. Default: C:\ProgramData\Autodesk\Inventor
<Version>\Content Center\Libraries

» User settings

Private configuration directory
Customized configuration files of users can be stored in the userdata directory.

Private configuration block (Config)

Enter the name of a user-defined config_*xml file for general settings, e. g. config_%
username%.xml. It is appended to the config_*xml files in the users, projects, units and/or
standard directories and copied to the file UserApplicationOptions.xml.

Private configuration block (Ul)

Enter the name of a user-defined ui_*xml file for user interface settings, e. g. ui_%
username%.xml. It is appended to the ui_*xml files in the users, projects, units and/or
standard directories and copied to the file InventorCustomization.xml.

Please note: For storing their private configuration blocks, users must have write
access to the userdata directory, as well as the access right Can save personal
Configuration file [to userdata directory] on server. See also Config tab in GENIUS
TOOLS Starter App.

5.22.2.2 Start

In the Start tab you define the startup behavior of the application.
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» Startup

Read-only mode selectable in GENIUS TOOLS Starter App
In GENIUS TOOLS Starter App a project options appears for selecting the read-only mode,
e. g. models cannot be edited. (See Project options.)

Yes: Users can select the reading mode.

No: There is no checkbox for selecting the read mode.

Startup directory

Enter the working directory of Inventor.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.
<not specified / empty>: GENIUS TOOLS Starter does not create a language variable
(LanG) on the application computer (recommended).
System: The country-specific settings of the operating system are adopted.
<language>: This language is used, and the language variable 1.aNG, if defined on the
application computer.

Show only installed languages
By default only languages of installed versions are displayed in the drop-down menu (see
above setting).

Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.

Enable stop batches
Yes: Additional batch files can be executed after the application has been stopped.
No: No stop batch files can be executed.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
<application>\configuration directory.

9.22.2.3 Cleanup

By using GENIUS TOOLS Starter, you can store configuration subfiles ("blocks") in four
configuration levels. When a project is selected by a user, the corresponding blocks are
read from the configuration levels and the XML configuration files are created afresh. To
do this, any existing XML configuration files must be deleted first. This is set in the default
settings of GENIUS TOOLS Starter, but can be changed here.

» User directory

Define whether the following configuration files are deleted or retained in the target
directory (as defined in the Write tab).
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Yes: Delete
No: Retain

UserApplicationOptions.xml
Configuration file for general configuration settings, e. g. for template paths, import and
export settings or settings for colors and materials.

InventorCustomization.xml
Configuration file for user interface settings.

Add-Ins, version dependent
Configuration file(s) for embedding additional applications (.addin).

Add-Ins, version independent
Configuration file(s) for embedding additional applications (.addin).

P Startup directory

Project file (*ipj)
Define whether the Inventor project file (as defined in the Write tab) is deleted or retained
in the target directory.

» Content Center libraries

Content Center libraries
Define whether the Content Center libraries (as defined in the Libraries tab) are deleted or
retained in the target directory.

9.22.2.4 Write

Here, you can define target directories for Inventor configuration files and change the
write settings of GENIUS TOOLS Starter.

P Target directories

UserApplicationOptions.xml
Select the directory in which the configuration file will be written. If no directory is
selected, the file will be written to the Appdata directory.

Appdata (default): %APPDATA%/Autodesk/Inventor <version>

Custom: The file is written to the directory specified in the upcoming field.

InventorCustomizations.xml
Select the directory in which the configuration file will be written. If no directory is
selected, the file will be written to the Appdata directory.

Appdata (default): %APPDATA%/Autodesk/Inventor <version>

Custom: The file is written to the directory specified in the upcoming field.

Add-Ins

Select the directory to which the configuration files (ADDIN files) will be written. If no

directory is selected, the file will be written to the version dependent directory.
Appdata, version dependent (default): %APPDATA%/Autodesk/Inventor
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<version>/Addins
Appdata, version independent: %APPDATA%/Autodesk/ApplicationPlugins

» Config handling

GENIUS TOOLS Starter reads configuration subfiles ("blocks") and writes their contents to
Inventor configuration files. Specify whether the follwing Inventor configuration files are
created (default) or not: UserApplicationOptions.xml, InventorCustomizations.xml, Add-
Ins, Inventor project file (IPJ file), Content Center Libraries.

Yes (default): Write

No: Do not write

Warning: A new configuration file is only created if there is no configuration file with
the same name in the target directory. Make sure that the default setting Delete is set
in the Delete tab.

3.22.2.5 Libraries

Specify the libraries that should be available for the selected group or unit in the Inventor
projects they have access to. Unlike other settings in GENIUS TOOLS Project Configurator,
multiple entries are possible here. The inheritance behavior is therefore different.

Please note: The library information of a unit overwrites all library information of the
higher order unit(s).

If you want to add a library path to a subordinate unit, do not forget to copy the paths of
the unit above into this unit. Use the copy function for this purpose, because copied
library entries (grayed out) adopt changes made in the original path.

The libraries defined here are written to the self-created Inventor project file (IPJ file) or to
the default IPJ file.

Appearance libraries

Enter one or more ADSKLIB files.
Active: Check the box to activate the library in Inventor.
Path: Library. The folder icon opens the Windows Explorer.
Delete: Deletes the path.
Copy: Copies the path.

Material libraries
Enter one or more ADSKLIB files.

Workspace
Enter the directory of the workspace.
Path name: You can assign a name for the path.

Workgroup search paths
Enter one or more directories for workgroups.
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Libraries
Enter one or more directories for further libraries.

Frequently used subfolders
Enter one or more subdirectories located in one of the above defined paths.

Content Center libraries

Enter one or more IDCL files.
ReadOnly: Activates the read-only mode for this library.
AttachName: You can specify a name for the library. Default: file name
Servername: You can specify a server name. Default: localhost.

Content Center libraries

By default, Inventor installs Content Center libraries (IDCL files) at C:
\ProgramData\Autodesk\Inventor <version>\Content Center\Libraries. Additionally, you
can create your own Content Center libraries. You can use GENIUS TOOLS Starter to
distribute these to the user computers. To do so, store the IDCL files in the data directory
in the Caddepot, i. e. under %GTS_DATA%\Inventor < Version>\Content Center\Libraries.
GENIUS TOOLS Starter then copies these libraries to the target directory at project start,
since all Content Center libraries must be located in the same directory.

The target directory is preset to C:\ProgramData\Autodesk\Inventor <Version>\Content
Center\Libraries. If you want to change the target directory, you have to set two entries:

— In the UserApplicationOptions.xml file, set the following entry:

<ContentCenter DesktopContentDir="%GTS DATA%\Inventor <Version>\Content Center\Libraries"/>
— In the Application tab change the target directory under Content Center directory.

In the Write tab you can activate or deactivate the copying of Content Center libraries.
IDCL files are never overwritten, i. e. they are only copied if they do not yet exist in the
target directory. Hence, standard Inventor Content Center libraries will not be overwritten.

In the Delete tab the cleanup behavior for Content Center libraries can be defined.
Standard Inventor libraries are not deleted,. Only IDCL files are deleted whose file name
does not begin with Al<4-digit version number>_Inventor.

9.22.3 Project settings

Project settings are the specifications you make in the main page Projects '] under
Applications > Inventor.

After having created a new project with the general project specifications, fill in the
following input fields in the tabs Inventor, Start and Environment. These entries overwrite
both the group-specific entries ans well as the standard settings for the startup behavior
of the application, which are made under Configuration > Inventor > Tabs: Application /
Start.
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For more information, see the chapter Configuration concept.

9.22.3.1 Essential specifications

In the tab Inventor you specify essential details for an Inventor project.

» Inventor

Release
Define the Inventor version to be used. The path can be fixed or determined automatically
from the registry of the application computer.
Fixed path: Select the directory from the newly appearing drop-down menu. If you do
not specify a directory, the settings for the unit Standard will be used. (Configuration >
Inventor > Standard > Tab: Application > Inventor install path)
Inventor versions: Specify a certain version. For example, the selection <Inventor_22>
will determine the path to the latest Inventor 22 version from the registry.

Please note: Inventor has to be installed locally on the application computer in order to
have registry entries available. The user must have read permission in HKLM.

Project folder
Directory in <application>\configuration\projects. From this directory configuration blocks
are copied to the application computer.

Please note: Configuration blocks should be stored separately from the data structure
due to their potential multiple use. They should be managed in the specific
subdirectories of the configuration directories units, projects or users, or in the standard
directory for global settings. See Configuration concept.

Data folder
Main directory of an operating environment in which application-related data is located.

5.22.3.2 Start behavior

In the Start tab you define the startup behavior for a single project. The specifications set
here overwrite the settings for units.

Starting behaviour
Select the application that will open the project.
Inventor (default): The project is started with Inventor.
External: The project is started with another application (e. g. SAP).

If External is selected two additional fields open:

External start command
Enter the path to the executable file that is to start the project.
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Command arguments for external start
Enter commands that specify how the executable file is started. Set the commands in
quotation marks.

Use read-only mode

Specify whether the project is to start in read-only mode.
Yes: The project starts in read-only mode. The environment variable
GTS_USE_INVENTOR_READONLY is set to 1. This allows the selected mode to be used as
information in, for example, a batch script to start Inventor externally.
No (Default): The project starts in professional mode. The environment variable
GTS_USE_INVENTOR_READONLY is set to 0.

Please note: The setting Use read-only mode can be overridden if the user is given the
option to select the mode, in

Startup directory
Enter the working directory of Inventor.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
<application>\configuration directory.

9.22.3.3 Libraries

In the Libraries tab, specify the paths to the libraries that should be available at project
level. The entries made here overwrite the settings for units. They are described in the Unit
settings > Libraries chapter.

5.22.3.4 Environment variables

In the tab Environment you can set environment variables for an Inventor project.

The variables set here are added to the variables defined for units. Values set here for an
existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A
list of created and affected environment variables can be found in the appendix.

9.22.4 Read-only mode

Inventor can be started in read-only mode. There are two options are available.
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1. Start project in read-only mode

Go to the Project Settings in the Start tab and turn on the swith Use read-only mode.

On

< INNEO GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

=8 Application types Projects @
T ®
eh Inventor 2022 ~ INVENTOR ‘
IEA Produktivversion Starting behavior l Inventor
® I N | Inventor 2023 | Use read-only mode @ v |
IEA Startup directory -]
Lanauaae

Using read-only mode as project setting

The project starts in read-only mode. The environment variable
GTS_USE_INVENTOR_READONLY is set to 1. This allows the selected mode to be used as
information in, for example, a batch script to start Inventor externally.

This setting can be overridden by the user if his unit or group is given the permission to
select the mode, i.e. a project option is created.

2. Project option for read-only mode

You can grant users the option to select the read-only mode directly on the project in
GENIUS TOOLS Starter App. To do this, set the Read-only mode selectable in GENIUS
TOOLS Starter App to Yes in the Start tab of the unit settings.

Settings Units ®

= A © STANDARD
E:_ﬁ ~ STARTUP SETTINGS
:
- -
4 Deutschiand Read-only mode selectable in GENIUS TOOLS Starter App ‘ & ‘
No
@ Inventor b Berlin Startup directory
[m P Hamburg e

Read-only mode as project option in the group settings

If in the project settings the switch Use read-only mode is set to Yes, as in the example
above, the checkbox is by default already checked.

| Inventor 2023
Version 2023

ﬁ f - |+*| Read-only mode
Checked project option in GENIUS TOOLS Starter App

9.22.5 Project display in GENIUS TOOLS Starter App

To present projects in GENIUS TOOLS Starter App, you can specify the general settings
that apply to all applications. There are also the following application-specific options.
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Project information

For the Inventor application, project details are displayed in the tabs Info, Config, Ul,
Project Options and Backup. For a description of the information and functions contained
therein, see the GENIUS TOOLS Starter App chapter under Inventor.

Info
o .

My Inventor + Addins Project name
Product version Inventor_22

Project directory
Inventor 2022 . Inventor_22

_ language selection _
Version 2022 Data directory
CAGTSTARTER\cadpoolINNEQ\inventoridata
fi & de ~ || Read-only mode Install directory
—— single project option D:\AutodesklInventor 2022\Bin\
I ————

| Additive Manufacturing FeedbackAddin Language

Deutsch

Inventor project display in GENIUS TOOLS Starter App

Project options
The following project options can be made available:

— Language: in the menu item Configuration under Settings > GENIUS TOOLS Starter App
> Projects, see Selection field for language.

— Project options (checkboxes):
- to start in read-only mode (previous chapter)
- for embedding add-in applications (single project option)
- for one or more configuration settings (single project option)
- for combining configuration settings (combined project options)
- for switching between defined configuration settings (switch option)

For creating project options, consult the chapter Configuration blocks for Inventor as well
as the instructions for creating the different types of project options.

9.23 Solidworks

A Starter project for the application SolidWorks requires:

— essential specifications

- a defined SolidWorks release

- SolidWorks-related data packages
— unit and project settings
— configuration blocks (SLDREG files)

- for functions and behavior of SolidWorks
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- for embedding additional applications (AddIns)

— settings for additional applications / linkages (batch files)

Please note: Creating starter projects with SolidWorks is a feature that requires a
subscription license.

For general information consult the chapter Starter projects.

For SolidWorks projects, project options can be created so that users can select directly at
the project which AddIns should, for example, be also started.

For SolidWorks all batch files can be used, which are opened before, during or after the
start of the application, see chapter Batch files.

9.23.1 Configuration blocks fiir Solidworks

The behavior of SolidWorks is determined by entries in the registry. GENIUS TOOLS Starter
copies all project relevant configuration blocks (configuration component files) into a
configuration file (config.sldreg) and writes the settings that it contains into the registry
before starting SolidWorks .

The configuration blocks must be created manually and stored in the configuration layers
Standard, Unit, Project, User, see chapter Configuration concept.

A configuration block for the application SolidWorks:

— is a text file that must start with "config_" and end with ".sldreg", e. g.
config_addin_3dexp.sldreg,

— is one of many configuration sub files which are read by GENIUS TOOLS Starter and
which create the configuration of a SolidWorks Starter project,

— can be defined with conditions (see chapter Conditional configuration blocks),
— can contain one or more configuration options, e. g. for

- user interface and model appearance settings

- template settings

- settings for colors and materials

- import and export settings

If a configuration option is set multiple times, the last entry — according to the call
hierarchy of the configuration blocks — is the valid option value. If a configuration option is
not set, the default value of the software is active.
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Default settings

You can also write fallback options to an extra file named default.sldreg. This file can, for
example, contain specifications for the user interfaces. The default file will be processed
automatically if there is no user configuration in the registry (under Current User) for
SolidWorks. Afterwards, the configuration file config_*.sldreg will be loaded if it is
available.

Creating configuration blocks for SolidWorks

1. Create a text file that starts with config and ends with .sldreg, e.g.
config_addin_3D.sldreg.

2. Write in the first line: windows Registry Editor Version 5.00

Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,
configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks and Config.pro files using
the add-on program GENIUS TOOLS Config Editor, which features color highlighting,
auto-completion as well as error messages and which allows you to compare entries of
two configuration blocks.

Example: Set drawing frame of company ABC
Windows Registry Editor Version 5.00

[HKEY CURRENT USER\SOFTWARE\SolidWorks\SolidWorks 2021\Document Templates]
"Default Part template"="$GTS DATA%\Document templates\\ABC\Part.prtdot"
"Default Assy template"="$GTS DATA%$\Document templates\ABC\Assembly.asmdot"
"Default Draw Template"="$GTS DATA%\Document templates\ABC\Drawing.drwdot"

Example: Create a single project option for loading drawing frames of company
ABC.
When creating single project options, note that a semicolon (;) must be used as comment
character, e.g. ; gts is selectable = true. See chapter Single project options.
Windows Registry Editor Version 5.00
; gts display name = ABC drawing frame
; gts description = ABC drawing frame
; gts _selection name = ABC drawing frame
; gts_selection default = false
; gts _is selectable = true
[HKEY CURRENT USER\SOFTWARE\SolidWorks\SolidWorks 2021\Document Templates]
"Default Part template"="S%GTS DATA%\Document templates\inneo\Part.prtdot"
"Default Assy template"="S%GTS DATA%\Document templates\inneol\assembly.asmdot"
"Default Draw Template"="%GTS DATA%\Document templatelinneo\drawing.drwdot"
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Example: Create switch options for Addins
To provide additional programs (AddIns) as options for SolidWorks projects, use the
gts_choose expression and write 00000001 for true value (ON) and 00000000 for false value
(OFF), see Switch options.
Windows Registry Editor Version 5.00
[HKEY CURRENT USER\SOFTWARE\SolidWorks\AddInsStartup\{1A49690A-CC1F-4C81-9B96-303C52F14AC3} ]
@=dword:gts choose{SolidWorks Composer| |00000001| 00000000}

9.23.2 Unit settings

In the main page Configuration B you can define the behavior of SolidWorks that will
apply to the system-wide standard (1) as well as for units and subunits (2).

Click Application (3), Start (4), Delete (5), and Write (6) to switch between tabs.

INNEQ GENIUS TOOLS PROJECT CONFIGURATOR 12.0.0.0

Il Qg

Settings Units Application @]
S e e @ STANDARD = © BERLIN
& ~ APPLICATION
GENIUS TOOLS 4 Standard 0
4 Deutschiand SolidWorks install path ] B
@ O - - cold wots o s o
0 Constructi tion A USER SETTINGS
| KOS Development T DET e Py 34GTS_ROOT_DIR % userdata\usernamesé ] [}
b Hamburg :
El b Leipzig Private configuration biack config Fusemame%sldreg

Please note: If an input field inherits values from the higher-level configuration levels,
you will still only see the global default value displayed in gray.

Settings made directly on a SolidWorks project overwrite the settings made here, see
Project Settings.

For general information on units, see the chapter Configuring heterogeneous
environments: and for the inheritance of settings go to the chapter Call sequence for
settings.

9.23.2.1 Application

» Application

SolidWorks install path

You can specify a directory on the user computer where SolidWorks is installed or leave
this field empty, which means the installation directory is searched for automatically from
the local Windows registry and the version is used as specified in the project settings. For
more information consult the chapter CAD-specific project settings.

Please note: It is generally recommended to have the installation path be determined
from the local Windows registry.
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Data directory

Enter the data directory to be used. The data directory is the main directory of an
operating environment containing SolidWorks-related data, e. g. %GTS_ROOT_DIR%
\solid_works\data\swx _22.

P User settings

Configuration folder
Customized configuration blocks from users (Config files) can be stored in the userdata
directory.

Private configuration block
Enter the name of user-defined config_*xml files, e. g. config_%username%.sldreg. It is
appended to the Config files in the users, projects, units and/or standard directories.

Please note: For storing their private config_*sldreg files, users must have write access
to the userdata directory, as well as the access right Can save personal Configuration file
[to userdata directory] on server.

See also Config tab in GENIUS TOOLS Starter App.

5.23.2.2 Start

In the Start tab you define the startup behavior of the application.
» Startup behavior

Startup directory

Enter the working directory of SolidWorks.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.
<not specified / empty>: GENIUS TOOLS Starter does not create a language variable
(Lanc) on the application computer (recommended).
System: The country-specific settings of the operating system are adopted.
<language>: This language is used, and the language variable 1.aNG, if defined on the
application computer.

Show only installed languages
By default only languages of installed versions are displayed in the drop-down menu (see
above setting).

Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.

Enable stop batches
Yes: Additional batch files can be executed after the application has been stopped.
No: No stop batch files can be executed.
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Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
<application>\configuration directory.

» Licenses

The license server is determined automatically from the registry and cannot be specified
here.

Show licenses
Specifies whether the licenses specified in a project are displayed in the licenses tab of
GENIUS TOOLS Starter App.
Yes: Licenses are listed. The license status is not obtained; validation is possible by using
the See Licenses function.
No: Licenses are not displayed. The settings Get extensions, Calculate licenses by
extension and Identify license users can not be utilized.

Identify license users
Specify whether users of a license can be determined.

Yes: In the GENIUS TOOLS Starter App, the users currently using a license feature are
displayed as a tooltip in the license display. The Windows user is replaced by the
GENIUS TOOLS Starter user alias from the workspace Users.

No: No user names are obtained or displayed.

Please note: To display names, the user names must be configured via Resources >
Users. Otherwise, the Windows user name is displayed.

Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The servers are checked for

availability with a ping before a license evaluation. If it is not possible to ping the server,

the query will be performed anyway.

In addition, the value set here is used as the maximum time to query the licenses.
Default: 0 = No maximum query time is set.

9.23.2.3 Cleanup

Here, you can manage the cleanup settings of GENIUS TOOLS Starter App for projects.

» HKEYCURRENT_USER

Registry branch
Defines, whether the configuration settings for SolidWworks are deleted in the registry
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before project start.
Yes: Delete
No: Retain

9.23.2.4 Write

P Registry settings

Specify whether the file config.sldreg, generated by GENIUS TOOLS Starter, is executed.
This writes the entries to the registry.

Write registry entries

Yes (default): GENIUS TOOLS Starter writes into the registry.
No: No entries are written into the registry.

9.23.3 Project settings

Project settings are the specifications you make in the main page Projects 1 under
Applications > SolidWorks in the tabs SolidWorks, Start and Environment.

After having created a new project with the general project specifications, fill in the
following input fields. These entries overwrite both the unit-specific entries and the
standard settings for the startup behavior of the application, which are made under
Configuration > SolidWorks > Tabs: Application / Start.

For more information, see the chapter Configuration concept.

9.23.3.1 Essential specifications

In the tab SolidWorks you specify essential details for a SolidWorks project.

» SolidWorks

Release
Define the SolidWorks version to be used. The path can be fixed or determined
automatically from the registry of the application computer.
Fixed path: Select the directory from the newly appearing drop-down menu. If you do
not specify a directory, the settings for the unit Standard will be used. (Configuration >
SolidWorks > Standard > Tab: Application > SolidWorks install path)
SolidWorks versions: Specify a certain version. For example, the selection
<SolidWorks22> will determined the path to the lastest SolidWorks 22 version from the

registry.

Please note: SolidWorks has to be installed locally on the application computer in order
to have registry entries available. The user must have read permission in HKLM.
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Project folder
Directory in <application>\configuration\projects. From this directory configuration blocks
are copied to the application computer.

Please note: Configuration blocks should be stored separately from the data structure
due to their potential multiple use. They should be managed in the specific
subdirectories of the configuration directories units, projects or users, or in the standard
directory for global settings. See Configuration concept.

Data folder
Main directory of an operating environment in which application-related data is located.

5.23.3.2 Start behavior

In the Start tab you define the startup behavior for a single project. The specifications set
here overwrite the settings for units.

Starting behaviour

Select the application that will open the project.
AutoCAD application (default): The project is started with the selected AutoCAD
application.
External: The project is started with another application (e. g. SAP).

If External is selected two additional fields open:

External start command
Enter the path to the executable file that is to start the project.

Command arguments for external start
Enter commands that specify how the executable file is started. Set the commands in
quotation marks.

Startup directory

Enter the working directory of SolidWorks.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.
<not specified / empty>: GENIUS TOOLS Starter does not create a language variable
(LanG) on the application computer (recommended).
System: The country-specific settings of the operating system are adopted.
<language>: This language is used, and the language variable 1.aNG, if defined on the
application computer.

Show only installed languages
By default only languages of installed versions are displayed in the drop-down menu (see
above setting).

Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.
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Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project.
No (default): No data is synchronized before opening a project.
Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the
<application>\configuration directory.

5.23.3.3 Environment variables

In the tab Environment you can set environment variables for a SolidWorks project.

The variables set here are added to the variables defined for units. Values set here for an
existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A
list of created and affected environment variables can be found in the appendix.

9.23.4 Project display in GENIUS TOOLS Starter App

General settings for projects are made in GENIUS TOOLS Project Configurator, see present
projects in GENIUS TOOLS Starter App.

Project information

For the SolidWorks application, project details are displayed in the tabs Info, Licenses,
Config, Project Options and Backup. For a description of the information and functions in
the tabs, see the GENIUS TOOLS Starter App chapter under SolidWorks.

Info
m Solidworks 2024 project name
New version project_sw22
. Project directory
Solidworks 2022 i . solid_works
Productive version / projectcatals Data directory
solid_works
i 2 Ve | &0 = ERGED3 Install directory
C:\Program Files\SOLIDWORKS Corp
| 3DEXPERIENCE Mggketplace ABC Zeichnungsrahme |« DEF Zeichnungsrahmen \SOLIDWORKS\
. . . B ) Language
SolidWorks Composer.g—  switch options single project option English

SolidWorks project display in GENIUS TOOLS Starter App

Project options
Administrators can set up a SolidWorks project with the following options:

— language: in the menu item Configuration under Settings > GENIUS TOOLS Starter App >
Projectste, see also Selection field for language.

— project options (checkboxes)

- for embedding addin applications (switch option, in italic font)
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- for one or more configuration settings (single project option)
- for combining configuration settings (combined project option)

Consult the chapterMaking use of project options for instructions of how to create the
needed options as well as the Configuration blocks chapter for examples.

5.24 Working with satellites

A satellite (also: synchronization or mirror server) is a computer or a sector of a computer
onto which the state of one or more operating environments of a central main server is
mirrored by data synchronization.

Operating satellites is beneficial at locations that have a slow connection to the main
server. User computers can significantly reduce the time required for data synchronization
by accessing a satellite that is easier to reach.

You can operate active and passive satellites.

An active satellite is a server that request data to be synchronized from the main server at
a defined time interval. This requires GENIUS TOOLS Starter Service.

A passive satellite is a shared directory on a computer, to which data from the main server
is copied. It does not require a service.

Active satellit Passive satellite

Server Shared folder on a computer
Requires GENIUS TOOLS Starter Service No service required

Changes in files on the main server will be  Changes in files on the main server will be

synchronized to the target with the next synchronized immediately. The defined

synchronization according to the defined synchronization interval serves as a back

time interval up, meaning that after this period all files
will be synchronized at the latest.

9.24.1 Creating satellites

In the Satellites page = you can create and manage satellites and monitor
synchronization.

A computer is installed as a satellite if you specify this in a configuration file of the GENIUS
TOOLS Starter Service. The configuration files (CFG files) must be located in the
configuration directory in the installation depot.

Path: \\<mainserver>\GTSTARTER\installdepot\gts-service-latest\conf
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NNEO GENIUS T CONFI 0.0.0 - m]
Sync SEVELS + menitoring satellites (¥ Last updated: 07.06.2024 14:20:33
Servername | Configuration file State Last started Last sync time Last shutdown
Main server e
e boston gt_service_boston.cfg @ Running  07.06.2024 11:02:59  07.06.2024 11:38:04 07.06.2024 11:02:42 O O @ M

I Satellites B8 tokyo gt_service_tokyo.cfg @ Stopped 06.06.2024 05:41:37 06.06.2024 05:41:59 06.06.2024 05:42:07 Q G @ M

berlin gt_service_beriin.cfg @ Ruming 07.06.2024 11:02:59 07.06.2024 11:38:04 07.06.2024 11:02:42 O O @M
passive
% nas-leipzig gt_service_share_nas-leipzig.cfg Q c) @ ]E
managing
synchronization and
service
GENERAL
Satellite type
Server name tokyo
File name gt_service_tokyo.cfg
Server path
configuring satellites
CONFIGURATION
Configuration option Value Commented Main server configuration
service.type satellite
service.sync.interval 300
service.sync.source \\maindev\caddepot
service.update.source \\maindeW\GTSTARTER\installdeppo
service.lic.server T766@tokyolic;7T766@srvlictriad1;77
service.rest.baseaddress http://maindev:8092
service.rest.port 8092 8092
service.environment.whitelist all environments
Beta
§ 07.06.2024 13:48:59

Menu item Satellites in GENIUS TOOLS Project Configurator

Procedure: Adding new satellites

In order to operate satellites GENIUS TOOLS Starter Service must be running on the main
synchronization server (“main server”). Active satellites also require this service, passive
satellites do not. The procedure is described in detail in the document GENIUS TOOLS
Starter Installation.pdf in the chapter GENIUS TOOLS Starter Service.

1. Create a new configuration file (CFG file) with the plus symbol. A new dialog opens.
2. Select the type of satellite.

3. Fillin the input fields as described in the program help.

4. Save the settings.

Result: The configuration file is saved in the configuration directory.

Warning: If access to the configuration directory is not possible, you can select a
different storage location in the save dialog. The file must then be moved to the
configuration directory manually.

5. Go to the Main server page.

6. Enter the web URL in the notation http://<mainservername>:<portnumber>. The port
name must correspond to the value for the entry service.rest.port=in the
configuration file gt_service_<mainservername>.cfg. The standard port is 8092.
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7. Switch on the Use satellite radio button.
8. Restart the main server.

Result: GENIUS TOOLS Starter App automatically determines which synchronization server
(satellite or main server) responds fastest based on the ping runtime. This is then used for
synchronization to the user computer.

9.24.2 Monitoring satellite status

The satellite page contains an overview of all satellites known to the main server. The
following information show whether the satellites are available.

Status
If GENIUS TOOLS Starter Service is not running, a red circle is displayed for active satellite.
As the service is not running on passive satellites, their status cannot be displayed.

Last started
Displays time when the GENIUS TOOLS Starter Service was last started.

Last sync time

Displays time when synchronization was last started. As soon as the time of the last
synchronization is longer than the time specified in the synchronization interval, the time
will be displayed in red. For example, if the synchronization interval is set to 60 minutes,
but the last synchronization was more than an hour ago, the time is displayed in red. See
Setting the synchronization interval.

Last shutdown
Shows when the GENIUS TOOLS Starter Service was last stopped.

9.24.3 Managing satellites

Use the following non-automated actions to control the synchronization of satellites and
GENIUS TOOLS Starter Service.

Restore satellite configuration file

Restores the state of the file before the last change.

{ Trigger synchronization

The satellite is synchronized immediately regardless of the configured interval.

© Restart
GENIUS TOOLS Starter Service is terminated on the active satellite and restarted.

(© Stop GENIUS TOOLS Starter Service
GENIUS TOOLS Starter Service is terminated on the active satellite.

Warning: After this action, the service must be restarted on the active satellite.
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Delete
This function includes the following actions:

— Uninstalls the GENIUS TOOLS Starter Service on the satellite.

— Removes the results file on the main server.
\\<mainserver>\gtstarter\installdepot\gts-service-
latest\results\gts_satellite_info_<satellite_name>.json

— Removes the configuration file in the configuration directory.
\\<mainserver>\gtstarter\installdepot\gts-service-
latest\conf\gt_service_<satellite_name>.cfg.

— Deletes the satellite entry in GENIUS TOOLS Project Configurator.

9.24.4 Editing satellite configuration

You can edit the configuration of existing satellites by clicking on the corresponding line
and changing the option values in the Configuration section. They are described in the
inline help.

+

File name

The file name is filled in automatically: g¢_service_<servernames.cfg ~ *

Servername | Configuration file State Last started Last sync time Last shutdown ) . ) )
Configuration of active satellites

boston gt_service_boston.cfg @ Running  07.06.2024 11:02:59  07.06.2024 12:12:40 ~ 07.06.2024 11:02:42 O O Om service.type=satellite
Indicates that this is the configuration file for an active satellite.

&8 tokyo gt_service_tokyo.cfg @ Stopped  06.06.2024 05:41:37 06.06.2024 05:41:59 06.06.2024 05:42:07 O O O m T sye—

Please note: If the configuration files for the main server and satellites contain
different information, the setting of the satellite applies.

An overview of all options can be found in the GENIUS TOOLS Starter installation manual
in the chapter GENIUS TOOLS Starter Service > Working with satellites > Configuration
options for satellite operation.

5.25 Working with Windchill

GENIUS TOOLS Starter can be used in conjunction with Windchill. The following section
describes requirements and considerations for working with Windchill.

If you want GENIUS TOOLS Starter to look for Creo data in Windchill first, and in the
project directories in the second place, you should set your system settings to Using
Windchill. To do so, go to Configuration > Standard > Windchill settings > General > Using
Windchill > Yes.
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Oo
mil NEC 0)
S . f @ STANDARD
= Settings Units @
- A GENERAL
== Q
gh Using Windchill Yes
GENIUS TOOLS e —
Starter App Windchill server name LSURAWICZ-ZB17
4 Deutschland
@ b Berlin Windchill server URL http://Isurawicz-zb17.ratc-de.com/Windchill
4 Hamburg A REGISTER
windeil Server o et No
Simulation
Server auto rename Yes
P Leipzig
@ b Schweiz Set Windchill server online Yes
P United_Kingdom ~ CONTEXT
% Default workspace name Standard
Windchill context type Product
Windchill context Standard

Main menu item Configuration > Settings

9.29.1 Object search hierarchy in Creo

Creo looks for objects in the following order:
1. Creo session

2. Search or call directory in which the parent object has been found, or directory which is
specified in the Open dialog.

Active Windchill workspace.
Active Windchill commonspace

Local working directory

o v ok~ W

Search paths
(See http://www.ptc.com/appserver/cs/view/solution.jsp?n=131190.)

9.25.2 Using a Windchill library

You can define dedicated directories for libraries, drawing frames, start objects and UDF in
Creo. When you are using Windchill, these directories can point to products or libraries in
the Windchill environment. The required syntax of the config.pro entry is as follows, using
the library directory of Windchill PDMLink as an example.

Pro library dir wtpub://<Windchill server>/<Context>/<Directory>

wtpub: refers to the Windchill commonspace

<Windchill server>: name of the Windchill server as registered in Creo

<Context>: context you want to refer to, e.g., SUT libraries

<Directory>: directory within the context
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Each user can define their own name for the Windchill server. This means that the general
config.pro entry cannot point unequivocally to a storage location, as maybe not all users
have used the same name when first registering the server. The following section
describes how GENIUS TOOLS Starter can be used to influence Windchill server naming.

5.25.3 Automatic Windchill server rename

In the general Windchill settings in GENIUS TOOLS Project Configurator, you can define a
Windchill server name that should be used system-wide (Configuration > Standard >
Windchill settings > General > Windchill server name). To link this name with an existing,
manually configured Windchill server, you also have to make two other settings:

1. Windchill server URL: address of the Windchill server
2. Server auto rename: Yes (under Register)

If a server is found under the URL you have specified for the Windchill server, this server
will be renamed to the specified name on the next Creo start.

9.29.4 Automatic Windchill server registration

The Windchill server registration enables the automatic registration of a Windchill server
under a given name in PTC Creo.

The concept of automatic server registration is that previously registered servers are
retained without changing the entire registration and that a newly registered server is set
to active. It is also part of the concept that server registration does not result in the
registered server reverting to active as soon as a project with the corresponding
configuration is selected. Usually the user wants Windchill settings of the previous Creo
session to be set again after restarting Creo.

Users who are to get access to a Windchill server via automatic server registration need to
have a valid Windchill account and have access to the defined workspace in the defined
Windchill context. It can be useful to create a context (product, library or project) that is
not otherwise used and that these users have access to.

Please note: In order to use automatic server registration, the following requirements
must be met:

— Using Windchill must be activated. (Configuration > Select unit > Windchill Settings >
Section: General)

— The Windchill Context must be set and must exist.

— The default workspace must be located in the Windchill Context that is given.

— The Windchill cache directory must be a subdirectory of the Windchill user root folder.

Users who are to be granted access to a Windchill server using automatic server
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registration must have a valid Windchill account and access to the specified workspace in
the registered Windchill context. It may be advisable to create an otherwise unused
product, library or project to which these requirements apply and to which users have
access.

Automatic server registration is configured under configuration > (Select unit) > Windchill
settings. The Windchill settings are expanded once you set Use Windchill to Yes.

» General

Use Windchill
Activate/deactivate the Windchill server. To use Windchill automatic server registration,
this function must be set to Yes.
Yes: Activates Windchill-relevant settings such as automatic server registration.
No: Windchill settings will be disregarded.
No, don't register: The Creo session is started without an active Windchill server.
However, the Windchill server remains in the server registry without being selected.

Windchill server name
Specify the name with which the server will be registered in Creo.

Windchill server URL
Specify the URL under which the server can be reached.

» Register

Server auto register

Select whether the server should be registered automatically.
Yes: The above mentioned Windchill server is automatically registered and is then
available within Creo.
No: The server is not entered automatically.

Server auto rename
If a server already exists at Windchill server URL and has a different name than Windchill
server name, the server will be renamed when starting Creo next.

Set Windchill server online

Select whether the server should be put online.

Yes: A new server that was added by auto-registration will automatically be put online.
No: The server is registered offline.

» Windchill context

Default workspace name
Name of the workspace that is active during registration. The default workspace has to be
present under the context given.

Windchill context type
Type of context: Product, Library, Project.
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Windchill context
Context of the workspace.

Changing server path from HTTP to HTTPS

When changing the Windchill server path from HTTP to HTTPS, Creo Parametric may
encounter errors that interfere with the correct execution of Windchill auto-registration.
To avoid this, it is recommended to create a new cache directory and delete the old server
path — after a transition period, if necessary.

The entry for the Windchill cache directory is located in the main menu item Configuration
under Creo settings > Section: Startup settings.

9.259.9 Project-specific Windchill settings

You can also define a Windchill server to be used for a specific project. To do so, go to the
Projects page, select the desired Creo Parametric project and make the project-specific
Windchill settings in the Windchill tab.

See also Workspace for Windchill.

9.25.6 Integration in Windchill Worker

If you want to open Creo with Windchill, you can use GENIUS TOOLS Starter to apply the
project settings and environment variables. In this case, you will neither get the GENIUS
TOOLS Starter user interface nor will Creo be opened. For this option, you must create an
extra project for access by the Windchill Worker. Proceed as follows.

Steps for integrating GENIUS TOOLS Starter into an existing Windchill Worker
Creating a project in GENIUS TOOLS Project Configurator

1. In the main page Projects "] click the Create button. A new project is created with the
name "New Project".

2. Rename the project. The default name is publish.

3. If you want the project to be invisible to users, hide it in the Creo tab in the section
General with Hide Project. Alternatively, you can create a role which you grant access
to the project.

4. If necessary, assign a separate license to the project in a Creo startkey (PSF file).
Including the call to the GENIUS TOOLS Starter App in the Worker batch file
5. Open the batch file proeworker.bat in the Windchill Worker directory.

6. Enter the following line below the line set PvIEW HOME=D:\ptc\object adapter:
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call <cadpoolpath>\<nameofoperatingenvironment>\software\worker.bat <project
name>

The project name corresponds to the name selected in step 2.
Install Cadpool on user computer

7. Make sure that GENIUS TOOLS Starter is installed on the user computers that are to
access the project. To do so, perform an initial synchronization by opening the file
gts.exe from the operating environment of the Caddepot directory which is located
on the administration computer: <caddepotpath\<working environment
name>\software\gts.exe

This will install the Cadpool directory and synchronize it with the Caddepot directory.

9.23.1 Freely configurable debug mode

GENIUS TOOLS Starter provides a freely configurable debug mode that allows you to use
the Windchill Workgroup Manager to interact with Windchill in debug mode.

The files logger.cfg.debug and logger.cfg.bat are used for this purpose according to the
call hierarchy for configuration files. Place both files in the standard directory <working
environment name>\configuration\standard.

Hint: Information on how to use client log files for debugging with Windchill
Workgroup Manager can be found at PTC in article CS140107.

logger.cfg.debug
If the logger.cfg.debug file exists multiple times within the directory, it is copied together
like a config.pro file. File names are used in the following notation: logger.cfg*.debug

After merging logger.cfg.debug the log output folder is always set to HOME\ANALYSEWF
by adding the line log_dir_path.

logger.cfg.bat

The batch file is used to define environment variables which should be additionally
defined in the Creo session if the debug mode is used. If more than one batch file exists,
all batch files matching the logger.cfg*.bat notation will be executed.

The debug mode is switched on in the user menu of GENIUS TOOLS Starter App with
Debug Creo/WindCchill.
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6 GENIUS TOOLS Starter App

The projects defined in GENIUS TOOLS Project Configurator are provided to users in
GENIUS TOOLS Starter App. By selecting the unit and project options (language, Creo start
key) further configuration settings are added. This turns the project as configured by the
administrator into a Starter project.

Changes in the central configuration are adopted during synchronization in the GENIUS
TOOLS Starter App.

Information on the configuration of the interface and the selection options can be found
in the chapter Settings for GENIUS TOOLS Starter App.

6.1 Starting GENIUS TOOLS Starter App

By default, GENIUS TOOLS Starter App is configured to start automatically with the
operating system. GENIUS TOOLS Starter App is displayed in the Windows task bar and
can be called up from there.

If GENIUS TOOLS Starter App is not started automatically, the app can be started via a
centrally configurable desktop link.

Please note: To close GENIUS TOOLS Starter App, select Exit in the user menu (3,
When you click Close, the window is minimized.

6.2 Login

An input window for login credentials appears if a system other than Windows is required
for authentication, e. g. Windchill.

Login
Please enter username and password.

ahelp

[ceseeareees |

m c ancel

GENIUS TOOLS Starter © 2025 INNED Solutions GmbH 267



GENIUS TOOLS'™"

GENIUS TOOLS Starter App

For more information, consult the chapter Authentication.

6.3 User interface

GENIUS TOOLS Starter App comes with a clearly structured user interface. Select your unit
on the left. In the project list that appears thereafter, single-click the desired project to
expand information and project options such as language, Creo start keys and license
extensions. Double-click to start the application with the configuration defined for the

project.

O
I N N Eo opens nfo tab Info o
.
Creo Parametric 10.0 Project name
Version 10.0 project_creo10p_de
& Deutschiand - -
e . 5 - Project directory
g i 2 V4 X LH - std_sut_creo0p
§ Berln Data directory
o AAX & BMX @F Freestyle Design inneo

A Construction w~

Favorites

Design Projects
3 Windchill Projects

M creo Parametric

& Notebook
GENIUS TOOLS for Creo

& Simulation Live
GroBe Baugruppen

& Manikin
& Toolkit o

Keyshat 10 plugin  |«| MP User

Creo 11.0 - Test project
SUT data for testing

INNEQ - Creo Parametric 9.0

Creo Version 9.0

Working directory
Ci\Users\ahelk\creo-work

Install directory
CHPTC\Crea 10.0.1.0\Parametric

Creo startkey
parametric.psf

Language
System

‘Windchill

jli GENIUS TOOLS Material Browser

P i

=1 Creo Rules of work
W, Project Archive l Best practices

Freeware

Inventor 2023
& Inventor

Produktivversion
B soliaworks Solidworks 2024

Neue Version

BE 6 .

User interface of GENIUS TOOLS Starter App
The user interface of GENIUS TOOLS Starter App is divided into three areas.
Left area for selection of a

1. unit and

2. project collections:
— company-specific (e. g. My Projects, Project Archive) and
— application-specific (e.g. Creo Parametric, Creo Elements/Direct Modeling), as well
as
auto projects:
— applications which cannot be configured and which are automatically listed by
GENIUS TOOLS Starter (e. g. MathCad, KeyShot). .

Central area with project list
3. Configurated Starter project, maybe with project options

The area on the right side opens when clicking on an info icon in a selected project. These
are the corresponding

4. tabs:
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Info: Shows the most important project (name, directories, Creo startkey, language of
the project).

Licences: Displays all license servers and gives access to analyzing and borrowing
licenses if user has access rights.

Config: Shows configuration blocks and their location for the selected project, as well as
additional applications (toolkit applications).

Project options: Shows all selectable configuration settings for license extensions,
additional programs etc. (Single project options).

Backup: Allows users to save user-specific settings, Ul settings for Creo.

Modify: Saves the project with the project options selected by the user as custom
projects.

Warning / Error These tabs are only displayed if a project cannot be started or causes a
warning.

There are two bars for operating the Starter App
5. Sidebar with user menu ¢

6. Footer with information on licenses and synchronization

6.4 Sidebar

The sidebar contains the following functions.

= User

A picture can be displayed here. Store it in JPEG, PNG, SVG or GIF format (100*130 px)
under the name of the user, in the userdata directory, e. g.
<caddepot>\<environment>\userdata\ % USERNAME%\ % USERNAME%.png. See Action:
Create user entry with image.

Click on the icon or image to display the user card. Once the user has been saved as a
dynamic entry (LDAP query), this information is used for the user card. Otherwise, the
details of the static user entries are used.

Site, Administrator |

Help. Anna
. administrator B | Logout
ahEIP User name Site, Administrator ‘ Switch user
A, HE|p GTS alias - Administrator .
Image . weadmin Appears when using
9 Anna Help GTS alias long an alternative
file . authentication system
she GTS alias short . v
Comment  Technical Writer
Email ahelp@inneo.com
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C Refresh Projects (F5)
Refresh Projects reloads all project configurations from the local computer.

BMessage from Administrator (F4)

There are new messages from your administrator when a red number is displayed on the
letter symbol. Messages that have been opened are displayed in gray color and can be
reread. Messages are saved as text files in the _Information directory, see also Sending
messages to the users.

{8} User menu

6.5 User menu

To access the user menu, click on the gear symbol {33 in the sidebar.

Language: user interface language

You can switch the user interface language between English, German and French at any
time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set
to German. For all other locale settings, the software first starts with an English user
interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at
any time. The theme setting is saved and will be used the next time you start the software.

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of
the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting
Pause synchronization is saved for the next start and marked by a yellow bar below the
header. When the user resumes synchronization, they are asked whether they want to
resume and overwrite local changes.

Pause synchronization if you want to prevent local changes from being overwritten until
they have been added to the Caddepot by your administrator.
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Please note: Your administrator defines whether you can pause the synchronization. If
you are not allowed to pause the synchronization, the item Pause synchronization is not
displayed in the menu.

Debug Creo/Windchill

Switches Creo debug mode on. This mode processes the files logger.cfg.debug and
logger.cfg.bat. Settings for this are made by the administrator, see chapter Freely
configurable debug mode.

Help

— Help (F1): Software manual for GENIUS TOOLS Starter, which corresponds to this
document.

- Support: Contact details for the technical support of INNEO or a company-specific link
which can be set up in GENIUS TOOLS Project Configurator. Inneo's support can be
reached by email, telephone and with Teamviewer.

- Info (F12): Current GENIUS TOOLS Starter version.

Open home
Opens the user directory in the file manager.

Open log file (F2)

Opens the log file that is written on each project start. The log file gts-starter-INNEO.log is
saved in the user directory of the client.

Please note: Please always find and check your log file before opening a call with the
support hotline. The log file is required for troubleshooting any issues.

Open sync log file (F3)

Opens the log file that is written by GENIUS TOOLS Starter App and GENIUS TOOLS
Project Configurator at each synchronization. The log file gts-starter-INNEO-sync.log is
saved in the user directory of the client.

Reset window size

Restores the default size of the dialog window of GENIUS TOOLS Starter. The window can
be adjusted to all sizes.

Switch user - only visible with an alternative authentication system

Switches to another user of the applied authentication system, e. g. Windchill.
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Exit
Closes the software. Clicking on the Close button (X) in the header will minimize the
program window.

Project Configurator (F8)
Opens GENIUS TOOLS Project Configurator.

Please note: Your administrator defines whether you can access GENIUS TOOLS Project
Configurator via access rights. If you are denied access, the item GENIUS TOOLS Project
Configurator is not displayed in the menu.

6.6 Footer

The footer contains the following information.
Eﬂ .. a 0 atio 4.06.2024 470

Database mode Synchronization

Subscription ;‘E)_ \\devleipzig\caddepot\INNEO ( 199 ms )

[@ chgtstarter\cadpool\INNEQ  Interval: 360 min

License mode
Synchronization method Service

Full version

Server T766@localhost; 7766@leipziglic

Data base mode
The state of the database is displayed in the footer:

Database requires a subscription license. Projects cannot be started when working with
a permanent license.

(P) Database has been created with a permanent license. It can be accessed by both
permanent and subscription license.

License mode

The GENIUS TOOLS Starter App footer shows the current license mode by displaying an
icon.

B3 Full version

B Full version. No free subscription license available, i. e. projects cannot be started.
2 :
2\ Borrowed license

5 Educational or home use
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Fail-safe mode for GENIUS TOOLS Starter: If the license server is not available, the
fallback license is used.

A fail-safe license is available only after GENIUS TOOLS Starter has found valid licenses
on a license server during project validation. Projects are validated by the command
Refresh Projects Cin the sidebar.

Warning: The fail-safe mode works for GENIUS TOOLS Starter only, not for GENIUS
TOOLS for Creo or other products.

Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is
displayed. For more information, please refer to Procedures and synchronization.

Q Synchronization is active
Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to
the local operating environment as a tooltip.

Synchronization inactive
The synchronization of toolkit applications is paused as long as Creo is running

Local operating environment
There is no synchronization; you work on a local directory

T=! Network mode
There is no synchronization; you are working directly on a network directory.

T Network not connected
The network directory cannot be accessed.

License borrowed until:
This icon appears when licenses have been borrowed.

License borrowed until:
GEMIUS TOOLS Starter  02.07.2025
GEMIUS TOOLS for Creo  02.07.2025

The synchronization status with the date and time of the last synchronization is displayed
in the middle area of the footer.

Running applications

If a supported desktop application is running, the application icon will be displayed in the
footer, e. g.

Creo Parametric
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l% Creo Elements/Direct Modeling

6.7 Selecting a unit

When using a subscription license, units can be defined as an additional configuration
layer to reflect different company branches or divisions. A user can be assigned to multiple
units. (See chapter Configuring heterogeneous environments.)

If units are used in the working environment and the user can choose from at least two
units, a separate dialog opens to select a unit or subunit.

Units are displayed in alphabetical order, unless a unit is defined to be the first on the list.
This can be specified in GENIUS TOOLS Project Configurator by inserting a space character
in front of the unit name. (See Displaying units in GENIUS TOOLS Starter App.)

Select units New dialog opens for

switching to another unit
eeeeeeeee % United_Kingdom
" o

Right mouse click
opens unit layer

A Construction T

onstruction

@ Development

In this dialog box you can select a unit. Note that units can be selected from several levels.
If no selection is made, the first unit in the drop-down menu will be used.

Confirm the selection with the Change button at the bottom right.

6.8 Display of projects

Information about a project is available
— by the color of the bar to the left of the project name,
—in the area below the selected project,

— in the tabs on the right side.
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open tabs | Info
1
Creo Parametric 11.0 Project name
New version project_creol1p
N - - - Project directory
i 2 V4 K L Infoicons INNEO_c11
Data directory
b GENIUS TOOLS for Creo |+ MP User inneo
Keyshot 10 plugin @f’ AAX Working directory
Ef: Sl Ef 5 e Ch\Users\ahelphcrec-work
imulation Live reestyle Design Install directory
& Notebook D:APTC\Creo 11.0.1.0\Parametric
Creo startkey
. parametric.psf
Solidworks 2024 | Language
Standard English

Windchill

. INNEO - Creo Windchill 10.0 | ! Project with warning
Fi

-
| . INNEO - Creo Parametrl’c10.0| ! Project with error /

Version 10.0 invalid project

Creo Parametric + Windchill in cloud

Project list and tabs in GENIUS TOOLS Starter App

6.8.1 Info symbols

When selecting a project the following icons will appear in the area below the project
name. Some icons can be disabled by the administrator. An overview of how to configure
the info icons and tabs can be found in the GENIUS TOOLS Project Configurator chapter
under Customizing information panes.

. Creo Parametric 12.0 m Solidworks 2024

Latest Version Standard

i 207 B XK E i 2 4
| Inventor 2024 AutoCAD 2022
Productive version CAD Version 2022
i 4 i

Clicking on an info icons opens tabs or functions.

Symbol / Function  Available for projects of Can be
dis-
Creo CED Solid- Inventor Auto- jpled?
Works CAD,
Apps
i Opens the X X X X X yes
tab Info
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Symbol / Function  Available for projects of Can be
dis-
Creo CED Solid- Inventor Auto- jpled?
Works CAD,
Apps
e Opens the X X X yes
tab Licenses
a Opens the X X X no
tab Konfig
o Opens the X no
tab Ul
Opens the X X X yes
tab Backup
& Opens the X X X X X no
tab Modify
E Opens X yes
Project
report (PDF
file)
K Opens X yes
GENIUS
TOOLS
Starter App
Config
Analyzer
)
=2 Opens X X yes
Borrow

license dialog
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Symbol / Function  Available for projects of Can be
dis-
Creo CED Solid- Inventor Auto- pled?
Works CAD,

Apps

Occurs if a X X X X X no
project

triggers a

warning.

Opens the

tab Warning

/N Occurs at X X X X X yes
invalid
projects
Opens the
tab Error

= Occurs if X X X no
some
checkboxes
cannot be
displayed in
the dialog
window.
Opens the
tab Project
options

6.8.2 Warnings

Projects with warnings are displayed with an orange project bar. A flag symbol /. appears,
which opens the Warning tab.
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: Warning
. Creo Parametric 10.0 Startkey must be selected
Creo Parametric 10.0 /

ﬁ é@ % f j{—_ *  Select startkey -

«'| GENIUS TOOLS for Creo

Projects with warnings can be started since warnings are not related to the availability of
licenses.

6.8.3 Invalid projects

For Creo Parametric and Solidworks projects, it is possible to check available licenses.
Projects without a valid license or license extension cannot be started.

Invalid projects can be hidden for users or displayed as follows:

— with a red bar and a warning triangle that opens the Error tab,

INNEO - Creo Windchill 10.0| /A Error

Mo free gts_adv_ext license available

o Creo Parametric + Windchill in cloud

i 20088 XZ d -~

— greyed out, with warning triangle, cannot be clicked at.

@ INNEO - Creo Windchill 10.0] /

o Creo Parametric + Windchill in cloud

i L2 0B B KL e -~

The display setting are made in GENIUS TOOLS Project Configurator, see Marking faulty
projects.

Please note: Error messages are only displayed once existing warnings have been
resolved, e. g. by selecting a start key

6.9 Project options

Project options can be made available for CAD applications. They are displayed either in
the form of
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— drop-down menus: for the choice of language and Creo start key, or

— checkboxes: for the choice of license extensions, additional applications and
configuration settings.

The drop-down menus are created in GENIUS TOOLS Project Configurator, while
checkboxes are created by using configuration blocks. Consult the instructions for Making
use of project options.

Project options

. Creo Parametric 11.0 Creo Parametric 11.0.1.0 |:|
Current version Language Creo startkey b
ﬁ p y % €N » Default - parametric.psf vl :
L4 GENIUS TOOLS for Creo |+ MP User |« @/" Motebook Keyshot 10 plugin
& Toolkit o AAX o BMX Toolkit
& Freestyle Design & Manikin 2> AAX

BMX

The selected project options are not saved and are reset after starting the project. You
can, however, customize a project with the selected project options, see custom projects.

The context menu for selecting or deselecting all options opens with a right mouse click.

If some checkboxes cannot be displayed below the project, an arrow symbol appears
which opens the Project options tab listing all available options.

Project options

Creo Parametric 11.0 Creo Parametric 11.0.1.0 ]
Current version L
Language Creo startkey |
: n L
ﬁ P f % €N »  Default - parametric.psf -
v
vy GENIUS TOOLS for Creo |+ MP User |« f Notebook Keyshot 10 plugin

& Toolkit & AAX F BMX Toolkit
& Freestyle Design & Manikin 2> AAK

BMX

Creo-Parametric-Projekt mit Projektoptionen in GENIUS TOOLS Starter App

The following table explains the different types of project options

Type Function Description
1 Language selects the language in which the application starts the
I project
2 Creo startkey selects the license package (PSF key) to start a Creo
Foundation - found.psf . Parametric project with
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Type

3

Function
Single project
option

GTFC

Single project
option

(f Simulation Live
Switch option
(italic)

SolidWarks Composer

Combined
project option

Context menu,
opens with right-
click

Description

activates one or more configuration settings

activates additional programs for Creo Parametric
projects

activates license extensions for Creo Parametric projects

activates additional programs for Inventor projects

switches between two values of one or more
configuration settings

activates add-ins for SolidWorks

activates combined configuration settings, i. e. settings
located in different directories and levels

after selection further single project options (3) may

become available

opens a menu to deselect or select all options

Behavior of switch options

In contrast to single project options, a value will be read from a switch option even if the
option is not checked (disabled state), see Switch options. For users who have the right to
deactivate configuration blocks in the Config tab of GENIUS TOOLS Starter App, this

means:

1. Deactivating the configuration block will ignore the content of the configuration block,
i. e. as with all configuration blocks, it will not be included into the configuration.

2. In contrast to single project options, the checkbox of the switch options then
disappears, because neither the checked (true value) nor the unchecked setting (false
value) is to be used for configuration.

GENIUS TOOLS Starter
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Creo Parametric 11.0 Config | Project options

Neueste Version

= standard configuration blocks ]

| ol
| no checkbox | v GENIUS TOOLS for Creo
\ "4 config_switch_bigass.pro
config_switch_bigass.pro

Only checked configuration blocks (in the Config tab) generate checkboxes for switch options

2 , )
1l P f % en ~ Active | Name +  BMX
v & BMmx v & simulationlive «| GENIUS TOOLS for Creo v BMX «  Simulation Live
| Big Assemblies | Y | GENIUS TOOLS for Creo
SIMUEa o CIveE

‘l Big Assemblies

6.10 Custom projects

Users can save a project with all selected project options as a custom project in the Modify
tab.

8 INNEQ GENIUS TOOLS STARTER APP 12.0.0.0
I N N Eo opens Modify tab Modify
. My Creo + MP, Keyshot custom project CREATE CUSTOM PROJECT
Neueste Version
B Deutschiand “ Name: | My Creo
" g . Creo Parametric 11.0 base project
4 Neueste Version CUSTOMIZATIONS
Construction “ . . ProjectOption: {"Key":"BMX","Value™:true}
A i 2 X & Default - parametric.psf - Language: English
ProjectOption: {"Key":"Freestyle Design","Value":true}
} AKX v BMX v Freestyle Design ProjectOption: {"Key":"Keyshot 10 plugin""Value":true}
Favorites & & & ! = Startkey: Default
& Manikin & Motebook & Simulation Live >
) ) o Toolkit v GENIUS TOOLS for Creo GroBe Baugruppen
Design Projects
v Keyshot 10 plugin |+ MP User
£88 Windchill Projects
INNEO - Creo Windchill 10.0
@ Creo Parametric + Windchill in cloud
M Creo Parametric
Creo Parametric 8.0
5 Apps 0Id version B Save

ExNu] O Last synchronization: 02.06.2025 11:21:39

Modify tab for saving a custom project

Procedure: Creating a custom project (user-defined project)
1. Select the desired project options (language, Creo start key, checkboxes with
configuration settings).

2. Click the Save icon ¢ to open the Modify tab.

3. Enter a name for the custom project.

4. You can check the selected project options in the Customizations area.
5. Click on Save [2],

Result:

— The custom project appears in the project list with the specified name and a purple label
indicating the original project from which it has been created.

— The original project can be reset to its original state using the Reload project function C
in the sidebar.
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6.11 Favorites

Favorites are projects that users mark as by clicking on the star symbol . This creates a
user-defined project collection listed under Favorites.

If the first project is marked as a favorite, the Favorites button appears on the left of
GENIUS TOOLS Starter App. A red balloon appears in the button after a project has been
marked as a favorite.

Creo Parametric 11.0.0.0

& Deutschland v
g| Berlin wr
i
}\ Construction “

Creo Parametric 11.0
New version

INNEQ - Creo Windchill 10.0

Creo Parametric + Windchill in cloud

Creo Rules of work

Creo Parametric 10.0.1.0

A Best practices

\d Favorites i
Solidworks 2024
Standard

Design Projects

SolidWorks 2024

* Fresware

ji GENIUS TOOLS Material Browser

fE} Windchill Projects
Creo Parametric 11.0.0.0

. My Creo + MP, Keyshot
tg . Creo Parametric New version

B O Last synchronization: 04.07.2024 09:31:45

6.12 Creating hackup copies

In GENIUS TOOLS Starter App, a backup file can be created of the configuration files of
CAD applications. This is useful for users who manage their own configuration files, but
also for administrators who want to make test changes, for example to the Creo user
interface.

In the project details area of GENIUS TOOLS Starter App, click the button [ The Backup
tab of the project opens. The files for a backup differ depending on the application and
are described below in the chapter Backup of an application.

6.13 Tabhs for all applications

Different tabs are available for the various applications. The Info, Warning, Error and
Modify tabs are available for all applications. There are additional tabs for various CAD
applications, see the following chapters.
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Info

The Info tab contains
information on the Info
selected project.

Project name [ INMEQ_c11

project_creol1lp

Users may be able to Freigeben  Ansicht

Project directory

open all directories INNEO_c11 s « projects » INNEO_c11
and files — such as b ~
. Inneo Mame
the PSF file (Creo Working directory -
startkey) —in the C:\Users\ahelp\creo-work _| config 1 lic_aax.pro
X Install directory
Info tab of a project DAPTC\Creo 11.0.1.0\Parametric
by double-clicking Creo startkey Open directory or file by double-clicking
. parametric.psf
on a line. To access Language k\
. . System - Y
this funCtlon/ users _ | parametric.psf - Editor - O X
need to be given the Wi!‘ldd‘llll Datei Bearbeiten Format Ansicht Hilfe
access right Can /f PTC - PSF file: parametric ~
. . 1
open Conﬂguratlon PRODUCT=Creo Parametric
DESC=Creo Parametric (default
OCKS.

The information varies from application to application.
— Project name
— Project directory
— Data directory
— Working directory
— Installation directory
— Language of the application
— Creo startkey, Alternative path, Windchill (for Creo Parametric projects)

— Executable file, Commandline arguments (for Apps projects)

Warning

An orange warning triangle /' next to the project name opens the Warning tab. The
following events trigger warnings:

— Project folder not found: Check the project folder specification in GENIUS TOOLS
Project Configurator in the Projects menu item.

— Startkey must be selected: Select a Creo startkey in the drop-down menu for the
project option.
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Error

A red warning triangle /'\ next to the project name opens the Error tab for invalid
projects. These cannot be started. Errors can be:

— Creo cannot be started.
— No licenses are available.

— Creo startkey is incorrect or does not exist.

Modify

The Modify tab opens when clicking the button Customize project & . After entering a
name, the project is saved with all the selected project options as a custom project. The
selected project options are listed in the Customizations area.

6.14 Tahs: Creo Parametric

For projects of the Creo Parametric application, the project icons open the tabs /nfo,
Licenses, Config, Backup and Modify (1).

You can generate a project report and open the analysis program GENIUS TOOLS Starter
App Config Analyzer as well as the dialog for borrowing licenses (2)

You can select the language (3) and a Creo startkey (4), if you have been granted access
rights. The settings required for this are described in the Defining project options chapter.

Creo Parametric projects can contain project options as checkboxes (5) which activate one
or more configuration settings or license extensions.

Im NNEO GENIUS TOOLS STARTER APP 12.0.0.0
= I N N EO these icons open tabs —————————————» Info
. Creo Parametric_10- Project name
ersion project_creollp
@8 Deutschiand ~ . o Project directory
o i 2 Vza x < ‘de ~ | Default - parametricpsf - mbd INNEO_¢11
y Berlin ™ Data directory
& AAX & BMX e & Freestyle Design inneo
Construction e - -
A & Manikin & Notebook & Simulation Live Working directory
Ci\Users\ahelp\creo-work
. & Toolkit ~ GENIUS TOOLS for Creo GroBe Baugruppen R
ERLULES Keyshot 10 plugin | MP User DAPTCICreo 11.0.1.0\Parametric
Creo startkey
) found.pst
| B Greo Parametric . Creo 11.0 - Test project Language
SUT data for testing English
Ol opens more project options —— gt
. INNEO - Creo Parametric 9.0 -

Project details and options of a Creo Parametric project

6.14.1 Borrow licenses

If users have the right to borrow licenses, they can borrow licenses for Creo Parametric
and the add-on applications GENIUS TOOLS for Creo required for the project, see also
chapter Access rights.
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Borrow licenses

1. Click on the Borrow icon <& in the
project area. This opens the Borrow
license dialog.

Creo Parametric 12.0
Latest Version

i»2d87 B X|&

2. Select the number of days for which you

. ) Borrow licenses
want to borrow the licenses and click

“you click Borrow, GEMIUS TOOLS Satrter is restarted and the F

Borrow. GENIUS TOOLS Starter App ith the selected projectl. This is displayed in the Info tab.) Creo
k NIUS TOOLS for Creo does not start, check in the PTC messag
borrows the licenses for GENIUS TOOLS Daye
. . 10
Starter. The PTC license borrowing
dialog for Creo opens. Start date (today) Donnerstag, 26. Juni 2025

End date (expires at 23:59) Sonntag, 6. Juli 2025

3. In PTC Creo license borrowing dialog,
select the correct startkey and the T e
duration of borrowing in days. The edu
correct startkey is the one that starts E’f;”;i::;m T
with the selected project (see Info tab in
GENIUS TOOLS Starter App). Click Start.
Creo is started with the borrowed

@& Creo Parametric Startkonfiguration auswahlen... d

Lizenzleihung

licenses.
Leihzeitraum in Tagen: 10 =
Startdatum (heute): Do, 26 Juni 2025
Enddaturn (lduft urm 23:59 ab): 5o, 06 Juli 2025
Abbrechen

4. Once Creo has been started completely, GENIUS TOOLS for Creo will automatically
borrow its licenses. If GENIUS TOOLS for Creo does not start, check in the PTC message
window whether the full startup of Creo is displayed.

Please note: If you click on Borrow (step 2) and then cancel the PTC borrow dialog
(step 3) you will have borrowed a GENIUS TOOLS license.

Return licenses

To return borrowed Startup TOOLS licenses, select Return all borrowed GT licenses in the
user menu .
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Display of borrowed licenses
Projects with borrowed a Creo license can be recognized quickly by the note on the right,
which informs about the duration of the license borrowing.

. Creo Fl'a rametric 12 D Creo Parametric 12.4.0.0
Latest Version Borrowed until 02.07.2025

i L2 dl 7B KEde-

In the tooltip of the plane button in the footer you can see which GENIUS TOOLS licenses
have been borrowed and until when.

License borrowed until:

GENIUS TOOLS Starter  02.07.2025
GENIUS TQOLS for Creo  02.07.2025

6.14.2 Licenses tab

The Licenses tab contains information on the license servers assigned to a project of a
CAD application as well as the possibility to analyze these server as well as to borrow
licenses, if the users have the corresponding user rights. The administrator defines which
license functions users can use, see chapter Displaying license information.

Licenses
Creo Parametric 12.0
Latest Version .
o @ Last analyze Never Analyze licenses|
L= By B
il & K CREOQ LICENSE SERVERS
v GENIUS TOOLS for Creo 7788@localhost @® (Oms) Display of
& Toolkit 7788@srvlictriadl @ (16 ms) license
i - Servers
&F Fresstyle Design 7788@srvlictriad2 ® (13ms)
7788@srvlictriad3 ® (5ms)

License tab of a Creo Parametric project

1. License server

All license servers specified in the project are listed here without being checked for
availability. The dots turn green or red only after a license analysis (2)
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2. Analyze licenses

After clicking the symbol @Analyze licenses (2) all licenses — and for Creo Parametric: all
lilcense extensions — needed for the project are listed and their availability is displayed in
the column Free.

If you are running a CAD programm on your local computer, using one license, and there
are no other licenses available on the license server, the number of free licenses is given as
1, not 0. Also, the note Multiple usage is displayed. This is meant to show that you can
start additional instances the CAD programm because no additional license is required.

Licenses

Licenses: 4 free [ 4 total.

{&» Last analyze Now

CREQ LICENSE SERVERS

7788@localhost @ (0Oms)
7788@srvieipziglic ® (msg
7788@srvlictriadi @® (13ms)
7788@srviictriad2 ® (17ms)
7788@srvlictriad3 @® (6ms)

BASE LICENSES

Mame Free Used

PROE_DesignPrmP 4 0

FLOATING OPTIONS

Mame Free Used

CREQ SIMULATION_LIVE 3 0

Also, the time passed since the last analysis is shown.

3. Borrow licenses

If a user is permitted to borrow licenses, the Borrow button L@3)is displayed, which
opens the license borrowing dialog.

Please note: If you are working with borrowed licenses and without synchronization,
the Licenses tab is hidden. If you are working with borrowed licenses, empty
information tables are hidden.
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Display of borrowed licenses
Projects with borrowed a Creo license can be recognized quickly in the main window by
the note on the right.

. Creo Fl'a rametric 12 D Creo Parametric 12.4.0.0
Latest Version Borrowed until 02.07.2025

i L2 dl 7B KEde-

In the tooltip of the plane button in the footer you can see which GENIUS TOOLS licenses
have been borrowed and until when.

License borrowed until:

GENIUS TQOLS Starter  02.07.2025
GENIUS TQOLS for Creo  02.07.2025

Borrow licenses

1. In the Licenses tab, click Borrow (2). The . Creo Parametric 12.0

Borrow licenses dialog is displayed. Latest Version
i 2 ¢ B X|E
2. Select the number of days for which you Borrow licenses

want to bOI’I’OW the Iicenses and C|iCk “you click Borrow, GENIUS TOOLS Satrter is restarted and the F
ith the selected projectl. This is displayed in the Info tab.) Creo

Borrow. GENIUS TOOLS Starter App NIUS TOOLS for Creo does not start, check in the PTC messag

borrows the licenses for GENIUS TOOLS ~ Pa¥s -

Starter. The PTC license borrowing

. Start date (today) Donnerstag, 26. Juni 2025
dialog for Creo opens.

End date (expires at 23:59) Sonntag, 6. Juli 2025
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3. In PTC Creo license bOI"I"OWing dialog, @ Creo Parametric Startkonfiguration auswihlen... x
select the correct startkey and the Startkonfigurationen
. . . edu
duration of borrowing in days. The essentials
correct startkey is the one that starts B

with the selected project (see Info tab in
GENIUS TOOLS Starter App). Click Start.

Creo is started with the borrowed Lizenzleihung
licenses. Leihzeitraurn in Tagen: 0 &
Startdatum (heute): Do, 26 Juni 2025
Enddaturn (lduft urm 23:59 ab): 5o, 06 Juli 2025
Abbrechen

4. Once Creo has been started completely, GENIUS TOOLS for Creo will automatically
borrow its licenses. If GENIUS TOOLS for Creo does not start, check in the PTC message
window whether the full startup of Creo is displayed.

Please note: If you click on Borrow (step 2) and then cancel the PTC borrow dialog
(step 3) you will have borrowed a GENIUS TOOLS license.

Return licenses
To return borrowed Startup TOOLS licenses, select Return all borrowed GT licenses in the
user menu .

6.14.3 Config tab

In the Config tab you can save the Creo configuration files (1) and view all files
(configuration blocks) that configure the selected project (2) as well as additional
applications (3).

The tab opens by clicking on the  button.
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» Config

Creo Parametric 11.0 B+8 Create configuration files 4—' Opens Save dialog | o

Meue Version

i L2dB 7B Xen -

[~ Standard configuration blocks (.pro) standard

Active = Name Toolkit
o AAX o I\!ame of
AAY directory 0
4 GEMIUS TOOLS for Creoc |« \
= Project configuration blocks (.pro) INNEO
] INNEO - Creo Windhill 10.0 _
} i o Active = Name Toolkit
@ Creo Parametric + Windchill in cloud
— BMX 0
=!| Creo Rules of work - o
- ) reest
.J Best practices > — Checkhoxes for
Toolkig activating/deactivating 0
m Solidworks 2024 v EriL configuration blocks 1
Standard v Model PTocEssor USar
< config_core.pro 0
Open with double
P click ”'"'Jf' config_sut_c9p_welding.pro 0
USED TOOLKIT APPLICATION (PROJECT) f'
GT Model Processor User .In.fcrmaticn. on o
GENIUS TOOLS for Creo additional applications

1. Create Creo configuration files for a Starter project

The button Create configuration files opens the dialog for saving the Creo configuration
files that are valid for the selected unit and project to a location of your choice. These are:

— config_ Projektname.pro
— config_ Projektname.sup
— mapkeys_ Projektname.pro (from Creo 11.0.0.0)

— mapkeys_admin_ Projektname.pro (from Creo 11.0.0.0)

2. View configuration blocks

All files used for configuring the selected project (configuration blocks) are listed in the
directories they are are stored in. For Creo Parametric, these are files with the syntax
config_*.pro.

Configuration blocks can be
— opened and edited by double clicking on them and
— activated or deactivated for the selected project

if the user has been granted function access to do so. Your administrator defines this, see
chapter Granting function access rights.
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Private configuration block

The area Private configuration block is visible in the section that lists all configuration
blocks (2), if a file is located in the userdata directory, e. g. <username>_config.pro. Path
specifications and notation of the file are defined by administrators in the user settings.

Users have the option to edit their local, private configuration block (config file) and write
it back to the administration computer using the & upload button. The Upload button is
visible if the user has been given the function access right Can save private configuration
block to server.

& private configuration block (jpro)  apeip
Aktiv = MName Toolkit
o Ahelp_config.pro 0

Please note: Pause data synchronization when editing a private configuration block.

Toolkit applications used from alternative directory

Additional applications (toolkit applications), as specified in the files protk.dat, prodev.dat
and creotk.dat, are listed, if they are located in an alternative directory, see Alternative path
specification.

6.14.4 Backup tab

In the Backup tab users can secure and restore the user specific settings for the user
interface of Creo. It opens with the &l button.

Please note: Backup tab and icon will be visible, if users are granted the access right
Can save user-specific settings / customization.ui file.

The file creo_parametric_customization.ui (short: customization.ui) is the Creo
configuration file that contains user-specific settings for the graphical user interface of
Creo Parametric. You can create a backup copy of this file if you have the necessary access
rights.

A click on the folder icon opens the target directory.

Procedure: Create a backup copy for Customization.ui configuration file
1. In the Backup tab click the button L2l Backup user customization.ut.
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Backup

. Creo Parametric 11.0 CUSTW//

Neueste Version — —
Customization.ui directory

n b = Ci\Users\ = N\AppData\Roaming\PTC\ProENGINEER\creo11_DE\.Settings
i A2 ||/ K

File size 4.7 kb
v o AAX v @ Last modification date 04.06.2024 17:03:35
& Manikin ] @ Backup user customization.ui.

& Toolkit v

Keyshot 10 plugin |+ BACKUP CUSTOMIZATION.UI

File size
Last modification date

. Creo Parametric 10.0
Version 10.0

2. If a backup file already exists: Confirm in the following dialog box that the existing
creo_parametric_customization.ui should be deleted.

Result: The file is saved as creo_parametric_customization.ui.old in the target directory.

To restore the user Ul file:
3. Click ¥2) Restore user customization.ui.

4. In the following dialog box, select whether to delete the backup file.

Result: The creo_parametric_customization.ui.old file is changed to
creo_parametric_customization.ui in the %PTC_WF_ROOT%\.Settings directory.

6.15 Tahs: Creo Elements/Direct Modeling

For projects in Creo Elements/Direct Modeling, you can open the tabs Info, Licenses,
Config, Backup and Modify (1) and select the language (2), if you have the appropriate
rights.

Licenses

" .
« # CreoE/D Projekt V20 @  Last analyze Never

-
S
CREOQ ELEMENTS/DIRECT LICENSE SERVER
2 .
il P ‘f Al = localhost ® (oms) =

mels @ (notreachable) [FJ

. 7 CreoE/D Projekt V19

Project details and options of a CED project

The Info tab specifies the corp directory, the site directory and the user directory.

6.15.1 Licenses

The Licenses tab shows the license servers used in the project. The functions to analyze or
borrow licenses analysis is not available.
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6.15.2 Backup

In the Backup tab users can secure and restore the directory for user specific settings. It
opens with the £ button.

Please note: Backup tab and icon will be visible, if users are granted the access right
Can save user-specific settings / customization.ui file.

6.16 Tahs: Solidworks

For SolidWorks application projects, you can open the tabs Info, Licenses, Config,, Backup
and Modify (1-5) and select the language (6) if you have the appropriate rights.

SolidWorks projects can contain project options as checkboxes (7). Project options can be:

— activate additional programs (AddIns): shown in italics

— activate additional configuration settings

NNEQ GENIUS TOOLS STARTER APP 11.0.1.0
INNCO Conflg
m Solidworks 2021 5 Standard configuration blocks (sldreg) standara
Standard Active = Name Addin
2B Deutschiand v
Berli “ - o i 2 & len - v config_addin_3DEx sldreg
3 v ose.

allla[ =

SDEXPERIENCE o ABC Zei ] DEF
A Construction ~ v
SolidWorks Composer

Favorites Solidworks 2022
Used Addins
Neue Version

Design Projects SOLIDWORKS Gomposer

Project details and options of a Solidworks project

6.16.1 Licenses

The functions in the Licenses tab correspond to those of Creo Parametric projects. (See
Licenses.)

For SolidWorks projects, the borrowing process differs in that SolidWorks licenses are
borrowed directly in the SolidNetWork License Manager client.

6.16.2 Config

The Config tab displays all configuration blocks for SolidWorks, i. e. files of the notation
config_*sldreg, sorted by their storage directories. The tab is opened with the button.

The functions for opening and deactivating the configuration blocks correspond to those
in Creo Parametric projects. Likewise, user-defined settings can be saved in a personal
configuration block if the right to do so has been granted.
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6.16.3 Backup

In the Backup tab users can backup (1) and restore (2) user-specific settings from the
registry. It opens with the |£ button.

Please note: Backup tab and icon will be visible, if users are granted the access right
Can save user-specific settings / customization.ui file.

User configuration

Users can back up (1) and restore (2) the entire SolidWorks user configuration from the
registry.

The registry branch is backed up as:
HKEY_CURRENT_USER\SOFTWARE\SolidWorks\SolidWorks <version> Old.

Default user configuration

Default user settings are settings from the configuration file default.sldreg. If GENIUS
TOOLS Starter App finds a default file that applies to the select project, the path to the
directory (3) as well as a button for taking over those settings (4) will be displayed.

Backup

USER CONFIGURATION

@ Backup user configuration o

USER CONFIGURATION BACKUP

@ Restore backup e

DEFAULT USER CONFIGURATION
Default.sldreg directory
= CAGTSTARTER\cadpoolMNNEO\solid_works\configuration\standard e

File size 55 kb
Last modification date 18.07.2024 15:32:113
{83 Set user configuration to default o

6.17 Tabs: Inventor

For projects in the Inventor application, you can open the Info, Licenses, Config, Backup
and Modify tabs and select the language if you have the corresponding access rights.
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Info

Inventor 2024 Project name

ﬁg Produktivversion Inventor_22

Project directory

Inventor 2022 Inventor_22
Wersion 2022 Data directory
CAGTSTARTER\cadpool\INNEQ\Inventor\data
o : .
i ED & en = |¥| Read-only mode Install directory
De\AutodesklInventor 2022\Bin\
+| Additive Manufacturing FeedbackAddin |« INMEO Templates DE Language

English

Display of an Inventor project with open Info tab

Inventor projects can contain project options

— to select Inventor's Read-only mode, see chapter Read-only mode.
— to activate one or more configuration settings

— start additional programs (AddIns)

To create them, consult the chapter Read-only mode as well as the instructions for
creating company-specific project options.

6.17.1 Config

The Config tab displays all configuration blocks containing the general settings for the
selected Inventor project. The tab is opened with the button .

The tab lists files of the notation config_*xml, i. e. configuration blocks for configuration
settings such as template paths, export settings or color effects. All configuration blocks
are copied together into the Inventor configuration file UserApplicationOptions.xml before
the project is started and stored in the target directory specified.

The functions for opening and deactivating the configuration blocks correspond to those
of the Config tab in Creo Parametric projects. Likewise, user-defined settings can be saved
in a private configuration block if the right to do so has been granted.

All additional applications (AddIns) that are available for the project are also listed.
(Whether an Addin is started or not depends on the LoadOnStartup value).

6.17.2 Ul

The Ul tab lists all configuration blocks containing the user interface settings for the
selected Inventor project. The tab is opened with the icon ED,

The tab lists files with the notation ui_*xml notation, grouped by their storage directory.
These configuration blocks are copied together to the Inventor configuration file
InventorCustomizations.xml before the project is started and stored in the specified target
directory.
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The functions for activating and opening the files correspond to those of the Config tab in
Creo Parametric projects.

6.17.3 Backup

In the Backup tab, the user-specific settings of Inventor can be secured. The tab is opened
with the icon [£].

A backup copy of the Inventor configuration files can be created if the access rights to do
so are granted.

— UserApplicationOptions.xml is the configuration file for general configuration settings,
e.g. template paths, import and export settings, settings for colors and materials.

— InventorCustomization.xml is the configuration file for user interface settings.

Please note: Backup tab and icon will be visible, if users are granted the access right
Can save user-specific settings / customization.ui file.

Clicking the folder icon opens the target directory. The XML configuration files are created
for each version and are located at:

%APPDATA%/Autodesk/Inventor < Version>

Clicking the disk icon 2] saves the XML files as UserApplicationOptions.xmlold or
InventorCustomization.xml.old in the destination directory.

If a backup copy exists, the file size and last modified date is displayed and the backup can
be restored with the Restore icon %2,

6.18 Sending messages to the users

GENIUS TOOLS Starter includes a functionality for administrators to send messages in
form of text files to users who can access them in the GENIUS TOOLS Starter App sidebar..

Creating a message

Step 1: Go to the operating environment's _Information directory in the caddepot
directory.

Step 2: Create a TXT or a PDF file with your message. The name of the text file has to start
with the prefix alert_, e. g., alert message.txt.

After synchronization the existence of new messages is displayed to users by coloring the
message symbol red 4. After reading the document can be opened again.
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6.19 GENIUS TOOLS Starter App Config Analyzer

GENIUS TOOLS Starter Config Analyzer is a tool that allows you to view and edit
configuration blocks (in the Project information page) as well as to directly compare
configuration settings of two projects (in the Compare projects page). The batch files used
are listed.

You can access the Config Analyzer by clicking the Analyze button K in the Config tab of
GENIUS TOOLS Starter App.

. Creo Parametric 11.0

Mew version

i L2 J8 s B[X

This button can be hidden by the administrator in GENIUS TOOLS Project Configurator
under User Rights > Function access > Can analyze project.

6.19.1 Project information

In the Project Information section il of the GENIUS TOOLS Starter App Config Analyzer, you
will see a list of all configuration blocks (config files) and batch files used for the project, as
well as their location (column: Location). Configuration files can be located in the
Standard, Unit or Project directories.

You can edit configuration files with GENIUS TOOLS Config Editor by clicking on the Edit
symbol (3).

The analysis of the configuration files refers to the found version of Creo.

INNEO GENIUS TOOLS STARTER APP CONFIG ANALYZER

=8 Creo Parametric 10.0

ﬁ LOCATION NAME 4 LINES UNKNOWN DEFAULT MAPKEYS = TOOLKIT EDIT
(® ConfigPro 35

[:D List of configuration blocks
Standard C\GTSTARTERTCATPOOTNNED|arame STTFATOMSTANaaratonfig_weblink.pro 3 0 0 0 0 VZ
Standard C:\GTSTARTER\cadpool\INNEO\parametric\configuration\standard\config_welding.pro 22 0 0 0 0 /
Unit CAGTSTARTER\cadpool\INNEO\parametric\configuration\units\Deutschland\config_glebal.deutschland.pro 1 [} 0 0 0 /
Unit C:A\GTSTARTER\cadpool\INNEQ\parametric\configuration\units\Deutschland\config_mapkeys.pro 375 0 0 65 0 /
Project C:AGTSTARTER\cadpool\INNEQ\parametric\configuration\projects\std_sut_creo10p\config_sut_cOp_imexport.pro 14 0 0 0 0 /
Project C:\GTSTARTER\cadpool\INNEO\parametric\configurationiprojects\std_sut_creo10p\config_sut_cOp_piping_mapkey.pro 26 0 0 3 0 VZ
Project C:\GTSTARTER\cadpool\INNEQ\parametric\configuration\projects\std_sut_creo10p\config_sut_c10p_cabling.pro 95 0 0 0 o} f
Project CAGTSTARTER\cadpool\INNEO\parametric\configuration\projects\std_sut_creo10p\config_sut_c10p_core.pro 74 [} 0 0 0 /
LOCATION NAME
(® startBatch 3

List of batch files

Standard C:\GTSTARTEK TN COTpaT aTTE T T CONMg UT g Uomms tarnaaras et t_ifx_env.bat

User interface for project information
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Search and sort configuration files

Search (1): Search for a file (at least three letters)

GENIUS TOOLS'™"

Sort (2): Click on the following areas to sort the files by the size of the value (ascending or

descending)

— Lines (number of lines)

— Unknown: Config option not found in the Creo version (i. e. does not exist or is
hidden) or value not found

— Default: Default value of the configuration option in the Creo version

— Mapkeys: Number of mapkey definitions

— Toolkit: Number of Toolkit applications

— Edit: opens GENIUS TOOLS Config Editor

6.19.2 Compare projects

The dialog Compare Projects ] allows you to directly compare the configuration settings

of two projects.

Select the projects from the drop-down menu (3). The projects available for selection are

those that you are allowed to open in GENIUS TOOLS Starter App.

Search (1) for a configuration option (at least three letters) or use the All, Equals and Not
Equals buttons to compare configuration options (2).

[ an ] [=Equal| |1N01Equalsb

n |Cre:| Parametric 10.0 e Creo Parametric 7.0 ~ |
@ KEY VALUE KEY VALUE

ClieCr_iernierence_ui_indawenes no clieur_iner igienue_ui_inaenes

clearance_triangulation nong clearance_triangulation none

combined_state_type mbd combined_state_type mbd

comp_assemble_start move_then_place comp_assemble_start default

comp_assemble_with_interface default_multi comp_assemble_with_interface default_multi

comp_interface_placement comp_interface_placement

create_drawing_dims_only yes create_drawing_dims_only yes

create_temp_interfaces
date_type_parameter_format
default_abs_accuracy
default_gtol_owned_by_model

default_layer_model

no
Hyyyy-%mm-%dd
0.01

yes

$GTS_DATA\config\sut_de_def_layer_mdl|

create_temp_interfaces
date_type_parameter_format
default_abs_accuracy
default_gtol_owned_by_model

default_layer_model

no
Hyyyy-%mm-%dd
0.01

yes

$GTS_DATA\configisut_de_def_layer_mdl|

User interface for comparing projects
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1 GENIUS TOOLS Config Editor

1.1 Introduction

GENIUS TOOLS Config Editor allows you to analyze and edit configuration files for various
CAD applications.

The following functions are available:
— editing of configuration files an blocks for
- Creo Parametric
- SolidWorks
- Inventor
— syntax highlighting
— for configuration options for Creo Parametric
- auto-completion on inputting and display of the possible values

- color coding for duplicate, hidden and unknown configuration options for each
version

- comparing configuration files of different Creo versions

- comparing entries oin two configuration files and transfer of changes (removed,
added, modified options)

— easy editing of GTS config variables for creating company-specific project options in
GENIUS TOOLS Starter App

— batch mode for editing multiple files

GENIUS TOOLS Config Editor is delivered with GENIUS TOOLS Starter and is available with
a subscription license.

GENIUS TOOLS Starter has been an independent module of GENIUS TOOLS Startup
TOOLS since version 6.

1.2 Starting the program

You can open GENIUS TOOLS Config Editor from any user computer where GENIUS
TOOLS Starter is installed. The program can be started as follows:

1. in the Windows context menu,

2. with the EXE file,
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3. in the project display of GENIUS TOOLS Starter App.

GENIUS TOOLS Config Editor behaves like other editing programs in that all open files are
opened the next time the program is started. A file can be dragged into the dialog
window of the editor by clicking on it.

Please note: GENIUS TOOLS Config Analyzer requires a subscriptions license. Without
a subscription license you can open a configuration file with other editing programs.

1. Starting with Windows context menu

The line Open with GT Config Editor is added to the context menu by default during setup
and will be available after the first start via the EXE file or GENIUS TOOLS Starter App.
D config_global.pro Open with PRO File

Open with GT Config Editor

The entry Register in Windows context menu can be disabled in the Config Editor user
menu.

2. Starting the EXE file

The file GTConfigEditor.exe is located in the tools folder, which is located in the caddepot
of the installation computer as well as in the cadpool of the user computer. Path:
cadpool/<working environment name > /tools/config-editor

3. Starting in GENIUS TOOLS Starter App

3.1. For projects of Creo Parametric, Inventor and SolidWorks
Open the Config Tab using the Config files button (in the info area (1) of a project.

Double-clicking on a configuration file in the Config tab (2) opens the file in GENIUS
TOOLS Config Editor.

INNCO sece=- S
. Creo Parametric 11, = standard configuration blocks (.pro) standard

Neue Version nctive | Name oot
2 Deutschiand ~
Info area i ) B - mbd
i o @i OB B K 2 a9 3
E _ figuration block

v| o aax v| o Bwx V| & Freestyle Design v BMX “'“(‘f:;:i":;‘m“ 0
A pereon M v Freestyle Desi ° o

v & Notebook | & Simulation Live v & Tookit th

v GENIUS TOOLS for Creo GroBe Baugruppen ¥ GTFC 4 Manikin o
[B] Konstruxt v P User s ¥ Notebook 0

3.2. For projects of Creo Parametric

Open the tool GENIUS TOOLS Config Analyzer via the Analysis X button (3) in the Info
area of a project. Note that the Analysis button can be hidden by the administrator in
GENIUS TOOLS Project Configurator (User Rights > Function Access > Can Analyze Project).
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® INNEO GENIUS TOOLS STARTER APP CONFIG ANALYZER

Creo Parametric 7.0

1 LOCATION | NAME

(3) ConfigPro

Standard chinnec\cadpool_beta\INNEQ\canfiguration\standard\config_globald 1 0 0 0 0 ﬁ
Unit c\inneo\cadpool_beta\INNEQ\configuration\units\Deutschland\config 6 0 0 0 0 é’
Unit chinnec\cadpool_beta\INNEQ\configuration\units\Deutschland\config 6 0 0 0 0 é’

GENIUS TOOLS'™"

LINES = UMNKNOWN | DEFAULT = MAPKEYS | TOOLKIT

Clicking the Edit button in the last column of a config file opens GENIUS TOOLS Config

Editor.

1.3 User interface

The user interface of GENIUS TOOLS Config Editor is divided into the following sections.

GENIUS TOOLS CONFIG EDITOR 12.0.0.0

° Selection of version for Creo configuration files

4 allow_move_view_with_move yes

5 auto_constr_always_use_offset never
-

6 no

7 check_interference_of matches no

Release: 90 ~ Version: 9.0.100 ~
O B M 2 B F X ° Command bar a0 = Q
* config_sut_de_c8p_core.pro )X config_addin_composesldreg  config_de.mbd.pro config_global deutschland.pro /
y
1 Close all Open context config_de.mb gpen [ist of all
2 accuracy_lower_bound 1.0e-6 menu with config_global files
3 allow_flat_to_screen_nc  Display of configuration files e Close all but rightelick —

config_sut_de_cdp_core.pro

Copy file path to clipboard

config_sut_de_c8p_core.pro

Open directory in Explorer

8 combined_s{ assembly
9 comp_assen|
10 create_draw
11

2 default_abs |

Tooltip for Creo

Values: configuration options

yes,no

Default value: yes

Show only matches that do not interfere with other components,

3 default_gtol _owned_by_moaerl yes
4 dsplay_all_dims yes
5 display_combined_views yes

~

4 User menu
miwwn e venigurations:
Unbekannte Konfig-Option, Zeile: 14

Info area e
Default value:

show_object_type_in_taskbar, Zeile: 58

1 /A\8

1. Sidebar with
()

‘% Batch mode and

Start dialog, Home

Information

Hidden config options:
auto_orient_axis_alignment, Zeile: &
date_type_parameter_format, Zeile: 11

Line: 7 Column: 6 Length: 1606 Lines: 60

- Compare dialog for Creo Parametric versions and Config.pro files

2. User menu @

3. Selection of version (for configuration files for Creo Parametric)

4. Command bar

GENIUS TOOLS Starter
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5. Display of Confi.pro files with context menu
6. Information area

7. Status bar

Select version for Creo Parametric files

Select the Creo Parametric version (3) and open the configuration file (config_*.pro) you
want to edit. The weekly versions start with a letter up to Creo main version 4. After that,
the weekly versions are digits of the main version.

Release: 40 - Version: MI130 - Release: 90 - Version: 9.0.100 -
Versus

You can compare several files by arranging them side by side in the window. (See Display
of files.)

Please note: This area is omitted for configuration files for Inventor and SolidWorks.

Command bar
The command bar (4) contains the following functions
— New file: Creates a new text file.

— Open file: Opens the Windows file manager with a dropdown menu for supported file
types. A file can also be dragged into the dialog window.

— Save: Saves the current file (Strg + S).

— Save all files: Saves all files (Strg + Shift + S).

— Save as: Opens the Windows file manager.

— Reload file and revert changes: Deletes the unsaved changes.
— Copy: Copies the selected text.

— Cut: Deletes the selected text and keeps it on the clipboard.

— Paste: Pastes the text from the clipboard.

— Delete: Deletes the selected text.

— Undo / Redo: Deletes or restores the last action.

— Increase / decrease font size: Decreases or increases the font size.
— Show / hide tabs: Shows or hides spaces, tabs and line breaks.
— Format file: Formats the currently selected file.

— Find and replace: Opens a dialog box with two tabs for Search and for Find/Replace,
see Editing config files. (Strg + F, Strg + H)
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— Replace SUT variables: Replaces the GENIUS TOOLS Startup TOOLS (SUT) variables
with the new GENIUS TOOLS Starter (GTS) variables that came into use as of version 6
of Startup TOOLS. (Since then GENIUS TOOLS Starter is an independent module of
Startup TOOLS.)

Context menu

Open the context menu by right-clicking on the file name to get the following options:
Close all — Close all but this file — Copy file path to the clipboard — Open directory in
Explorer.

Information area

For Inventor configuration files (XML files), the first error is displayed with line
specification.

For configuration files of Creo Parameter there is more information, see Info area for
config files.

Status line
The status line (7) contains the following information:
— Line: Indicates the line in which the cursor is located.
— Column: Indicates the position in the line where the cursor is located.
— Length: Displays the number of all characters.
— Lines: Displays the number of all lines.
And for configuration blocks for Creo Parametric:

— Number of configuration options with a warning. (Click on the red symbol to jump to
the next option.)

— Number of configuration options with a note. (Click on the orange symbol to jump to
the next option.)

1.4 User menu

The user menu opens when clicking the gear button {23 in the side bar.
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Deutsch
Language v | ¥ English
Theme " | v Light
License server Dark
Creo versions
Register in Windows context menu
Help ’ Help (F1)
5end telemetry data GEMIUS TOOLS Knowledge Base
Support
Reset window size
About (F12)
Exit
Language

The language setting of the user interface can be changed between German and English
while the program is running. The setting is saved for the next start.

If the country setting of the operating system is German, GENIUS TOOLS Config Editor will
start in German. All other country settings will start in English.

Theme
The user interface of the software is offered in the color schemes light and dark. The
setting is saved for the next start.

License server

The license server for GENIUS TOOLS Config Editor, as specified in GENIUS TOOLS Starter,
is shown here. The license server can be changed by using the notation 7766@!localhost
and additional license servers can be specified, separated by semicolons.

Creo versions

Opens the input window for selecting the Creo versions for which you want to view
configuration files.

The databases for configuration options are available for all Creo versions, meaning you
can edit configuration files regardless of whether the Creo version is installed on your
computer.
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Please note: The databases of the enabled versions are loaded into the user directory
AppData\Roaming\INNEO\GENIUS_TOOLS\GENIUS TOOLS Config Editor.

During setup, the activated checkboxes show the Creo versions that are installed on
your computer. If no Creo version is found on the computer, all checkboxes are
activated.

Register in Windows context menu
Adds the command Open with GT Config Editor to the Windows context menu. This entry
is activated by default.

Help

— Help (F1): Opens the help for GENIUS TOOLS Config Editor. The help corresponds to this
document.

— Support: Opens the website of the technical support of Inneo Solutions GmbH.

— Info (F12): Displays the license agreement of the current version of GENIUS TOOLS
Config Editor.

Send telemetry data
Sending telemetry data is defined when starting GENIUS TOOLS Config Editor and can be
changed here.

Reset window size
Restores the default size for the GENIUS TOOLS Config Editor dialog window. The dialog
window can be resized to any size.

Exit

1.5 Display of files

You can display multiple files both one below the other and side by side, e. g. to compare
two configuration files.

This is particularly useful for comparing Creo configuration blocks of different versions.
See chapter Comparing versions.
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GENIUS TOOLS CONFIG EDITOR 11.0.0.0 - O
Mainversion: 80 - Subversion: 8030 -
ol @ & D X @ ) A A 2 Q
config_sut_de_c4p_core.pro config_sut_de_c8p_core.pro X
1 accuracy_lower_bound 1.0e-6 1 accuracy_lower_bound 1.0e-6
2 allow_flat_to_screen_note yes 2 allow_flat_to_screen_note yes
3 auto_constr_always_use_offset never 3 auto_constr_always_use_offset never
4 no 4 no
5 comp_assemble_start move_then_place 5 comp_assemble_start move_then_place
& default_abs_accuracy 0.01 6 default_abs_accuracy 0.01
7 d@splay shaa’eu{t'medges Konfigurationsdatei 7 dﬁsplay s.'fma’ew_{medges Konfigurationsdatei
8 dlsplay_lfull_objec‘[__path yes fiir Projekt mit Creo 4 8 d\splay_lfu\l_object__path yes fiir Projekt mit Creo 8
9 edge_display_quality very_high 9 edge_display_quality very_high
10 edge_tess_quality medium 10 edge_tess_quality medium
11 enable_3dmodelspace_browser_tab no 11 enable_3dmodelspace_browser_tab no
12 enable_absolute_accuracy yes 12 enable_fsaa 8
13 enable_fsaa 8 13
14 14
~ Information Fal Information
Incorrect configurations: Hidden config options: Default value: Hidden config options:
Unknown config option, Line: 12 aute_orient_axis_alignment, Line: 4 show_object_type_in_taskbar, Line: 52 auto_orient_axis_alignment, Line: 4
enable_resource_browser_tab, Line: 17 enable_resource_browser_tab, Line: 16
intf_in_use_template_models, Line: 23 intf_in_use_template_models, Line: 22
intf_out_blanked_entities, Line: 24 intf_out_blanked_entities, Line: 23
1 /\8 Line: 7 Column: 6  Length: 1606 Lines: 60 Line: 7 Column: 6  Length: 1606 Lines: 60

Display of two files next to each other

Procedure: Setting up the file display
Change the position of a single file by clicking and dragging the file to the desired
location using the split star.

& tesT-config-editortgro p 4 config_sut_de_cdd.pro config_de.mbd.pro config_sut_de_c8p_mapkeys.pro

o Click on
tab

1 e Pull
s_selection_default out

'tna‘:]i—conﬁg—editor.pm

P L
o
L L
L
i
%]
]
(1]
(n]

* test-config-editor.pro X

l T um

g y_name

7 accuracy_lower_bound 1.0e-6 | 1 1 gts disht
8 2! gts_selection

With the arrow click on the o
option for dividing the display

1.6 Supported files

With GENIUS TOOLS Config Editor you can edit configuration files and blocks for various
CAD applications.
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Configuration files

A configuration file contains all settings of an application without using GENIUS TOOLS
Starter, e. g. the file config.pro for Creo Parametric.

Configuration blocks

A configuration block is one of many configuration files that are read by GENIUS TOOLS
Starter to create the configuration of a Starter project.

The following configuration blocks can be created for the respective CAD applications.

Configuration- Content Example
block

Creo Parametric

1 config_*.pro All settings (configuration config_sut_de_c6p_dir_file.pro
(also: Config- options) for executing the config_c5p_mapkeys.pro
Datei) application

2 config_*.sup Settings that cannot be config_design_en.sup

modified by users

SolidWorks

3 config_*sldreg All settings, config_addin_compose.sldreg
Embedding additional
application (AddIns)

Inventor

4 config_*.xml All settings config_dir_file.xml

5  ui_*xml Settings for user interface ui_customization.xml

6  *.addin Embedding additional AdditiveMFG.inventor.addin

application

1.1 Configuration files for Creo Parametric

Information and color coding are more extensive for configuration files for Creo
Parametric.
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1.1.1 Display of configuration options

Creo configuration option define settings in Creo Parametric and are written into a
configuration block. For better readability GENIUS TOOLS Config Editor displays
configuration options as follows.

Configuration options that are highlighted in color contain notes (orange) or warnings
(red) which are explained in the information area.

Color code Description

accuracy_lower_bound Configuration option

1.0e-6 Numerical value

yes Nonnumerical value (e. g. yes, medium)
$GTS_DATA Variable

— e. g. variable of Startup TOOLS (SUT) and GENIUS
TOOLS Starter (GTS)

I gts_display_name GTS config variable
— contains information to create a company-specific
project option for GENIUS TOOLS Starter App

Configuration option with the default value
—is listed in the info area

spin_center_display Duplicates (multiple entries of a configuration
option)
— are listed in the information bar
— Please note: Duplicate options that can regularly
be entered several times in a config file — such as
mapkey or search_path — are not marked in
orange.

Hidden configuration option

— are not officially supported by the Creo
manufacturer

—is listed in the info area
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Color code Description

disable_all Unknown configuration option
— due to incorrect spelling or because it is not
known in the selected Creo version
—is listed in the info area

mapkey(continued) Mapkey line is too long
— up to Creo version 4: max. 81 characters allowed

— from Creo version 4: max. 260 characters allowed

Comment

1.1.2 Info area

In the lower part of the main window configuration options with a note or a warning, i. e.
those colored in orange or red, are listed. You can thus get a quick overview of the
content of a Config.pro file for Creo Parametric.

config_globalpro )X config_sut_de_c8p_core.pro config_sut_de_c4p_core.pro config_de.mbd.pro

1 accuracy_lower_bound 1.0e-6
2 allow_flat_to_screen_note yes
3 no

4 file_timestamp_format %yyyy-%mm-%dd %hh:%mi:%ss

5

6 smooth_lines yes?

7 mapkey test sn_glb_export @MAPKEY _NAMECreate a GLB and USDZ files\n \
8 mapkey(continued) with INNEO-Neospace\n\

9 mapkey(continued) for WEB and Windows using.;)\
10 mapkey(continued) @MAPKEY_LABELGLB Export)\
11 mapkey(continued) ~ Command "MDLPRCVisitParametersCmd™ ;~ Activate ‘'mdlprcrunner’ ‘'mdlprcCurModFilter 1;
12 pro_library_dir SGTS_DATA\library_dir
13 spin_center _display noe

14 spin_center_display no

A\ —— Open / close info area Information
olnoorrecl configurations: Duplicates: e Default value: Hidden config options:
Unbekannte Konfig-Option, Zeile: 6 spin_center_display, Zeilen: 13, 14 measure_auto_replace_mode, Zeile: 5 auto_orient_axis_alignment, Zeile: 3
L ANE] Line: 14 Column: 31  Length: 685 Lines: 26

Info area of the Config Editor

1. Unknown configuration options
Options will not be recognised as such
— if they do not exist, e. g. in case of incorrect spelling notation, or
— if they are not known in the selected Creo version, e. g. the smooth_lines option exists

only since Creo version 5.
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Mainversion: | 40 ~* Subversion: M150 - Mainversion: 7.0 - Subversion: 7.070 -
0 B v 0 B v

config_example.pro > config_example.pre <

1 smooth_lines yes 1 smooth_lines yes

)

Incomect configurations: A

Unknown config option, Line: 1
2. Duplicates / duplicates
Configuration options that are set two or more times. Here: in line: 13 and 14.

3. Default value
Configuration options in which the default value is set.

4. Hidden configuration options
Options which are not officially supported by makers of Creo Parametric.

1.1.3 Comparing versions

In the menu item Compare versions - you can view the configuration options and the
default values that have changed from one Creo Parametric version to another.

In the first dropdown menu select Version (1) and select the version (Release and Version)
on the left (2) as well as on the right (3).

The following results are displayed:

— Configuration options whose default values have changed (4): The default values are
listed first for the older version and then for the newer version, regardless of how the
versions have been selected in the command bar.

— Added options with default values (5).

— Removed options (6).
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GENIUS ONFIG EDITOR 12.0.0.0 = [m}

Release: 100 ~ \Version: 10010 - e Version ~ Release: 100 ~ \Version: 10070 ~ o

Config.profle ! changed (older version --> newer version) o

ALLOW_PLY_CROSS_SECTION -> (hidden)
FLEX_DFLT_SELECTION SRF_REGIOI —> yes

RELERSE LICENSE ON APP CLOSIN -> (no default value)

Added options o
COMPOSITE_DEF_CORE NAME PREFIK = core
=0: DE

RE_S = sequence
= ply
) ] = seguence
CONVERT_ALL_XCH = visible
YSTEM PARAM FILES = yes
HATCE PATTERN SCALE IN DEW VIEW = fit_tc_view
ENA LD OPER_GOTO_PNT_FIX = yes
MF MPUTE_STK_MCDEL_WARNING = yes
S _HSM PROGRESS DIALOG = no
FORC! R_HASHING = no
. TRAJ_CRVS_LOC_TOQ_NORMSRES  (hidden)
MFG_DISTINCT_MILLTURN_CUTCOM (hidden)
CREATE_GRAPHICS_BODY_ON_SAVE (hidden)
SMI_FIX MERGE FLATTEN SIDE (hidden)
GE (hidden)
(hidden)
(hidden)
(hidden)
INTF3D_OPEN_OUTOFDATE_UNITE (hidden)
LATTICE_FULL_GECM SHOW_EDGES (hidden)
SOLID TOOL_ PARAMETERS VALIDATE (hidden)
INTF3D_IN SKIE DEACT V5_COMP (hidden)

Removed options e

ENRABLE_CRL_CHECK
‘TRATASYS PRINTERS (hidden)
JLE_ROLLINGBALL OFFSET (hidden)

PRINT3D_3DS_SDK (hidden)
PRINT3D_ENABLE 5927742 (hidden)
PRINT3D GC_SDK (hidden)

The information hidden refers to hidden configuration options.

1.1.4 Comparing config.pro files

In the Compare menu item 7, select Config.pro file (1) to compare entries of two Creo
configuration files or configuration blocks.

Select the files to be compared in the upper area. The following results are displayed:

— removed options

— added options

— modified options

— unmodified options

By double-clicking on one or more of the display options (2), you can hide these options.

The direction of the comparison can be reversed using the double arrow symbol s 3).
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CONFIG EDITOR 11.0.1.0

Configprafile = | \\gtsleipzig\Users\Ahelp\config_project_creo10 pro Configprafile =  \\gtsleipzig\Users\Ahelp\config_project_creall.pro =
— olremovedoptions X + 3addedoptions X 3¢ 13 modified options X X 183 unmodified options X o (& |°
Config option Value i‘l +| Config option Value
piping_extend_show_csys yes g‘l
piping_joint_fitting_clearance 1 ?(-l piping_jeint_fitting_clearance 25
piping_joint_fitting_offset 1 é piping_joint_fitting_offset 100
piping_project_data_dir C:\GTSTARTER\cadpool\INNEO\parametric\datalinneo\library_dir\pi rl',(_l piping_project_data_dir CA\GTSTARTER\cadpoolINNEO\parametric\data\inneollibrary_dir\pi
piping_spec_dir_file C:\GTSTARTER\cadpool\INNEO\parametric\datalinneo\library_dir\pi —o piping_spec_dir_file CA\GTSTARTER\cadpoolINNEO\parametric\data\inneollibrary_dir\pi
piping_thumb_wheel_increment 1 — piping_thumb_wheel_increment 10
o piping_wildfire_convert automatic
pro_weld_params_dir CAGTSTARTER\cadpool\INNEO\parametric\datalinneo\library_dirlwe — —>
— protkdat C:\GTSTARTER\cadpool\INNEO\parametric\configuration\applicatio
— protkdat CAGTSTARTER\cadpoolINNEO\parametric\configuration\applicatio
todays_date_note_format Kyyyy-%mm-%dd —D
weld_ask_xsec_refs no —
weld_color 100500 —D

Comparing two config.pro files: Unmodified options are not displayed

Apply changes
Clicking the arrow button — (4) applies changes to individual configuration options or
mapkeys.
In the drop-down menu in the centre (5), you can apply several changes at the same time:
51 all changes
'l apply all removed options or mapkeys
Il delete all added options or mapkeys
L'l apply all changed values

As soon as at least one modification has been made, the Save button [2] (6) of the
corresponding file becomes active.

Revert applied changes
To reverse the changes you have made, click the Reload button C (7).

The Analyze button (8) opens a new dialog window.

1.1.5 Analyzing config.pro files

The Analysis button in the Compare page - opens a dialog that displays duplicates,
options, reusable options and mapkeys for each Config.pro file.
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<~ Duplicates Count: 56
Config option Value Line Config block
accuracy_lower_bound
accuracy_lower_bound 1.0e-8 pd C:\GTSTARTER\cadpoollINNEC\parametric\configuration\standard\config_core.pro
accuracy_lower_bound 1.0e-8 274 C:\GTSTARTER\cadpoclINNEO\parametricicenfiguration|projectsistd_sut_creo10p\config_su

allow_move_view_with_move

allow_move_view_with_move no 2 CA\GTSTARTER\cadpoclINNEC\parametric\cenfiguration\standard\config_core.pro
allow_mave_view_with_move yes 276 C:\GTSTARTER\cadpochINNEQ\parametric\configuration\projectsistd_sut_crec10p\config_su

auto_constr_always_use_offset /

A~ Options For a. (;reu cur!'figurat_inn.uptiun, 1_he value Count: 196

specified last in the file, is the valid value.

Config option o =T o

accuracy_lower_bound 1.0e-6 274 CAGTSTARTER\cadpaolINNEQ\parametric\configuration\projects\std_sut_creo10p\config_sut_
add_weld_mp yes a3 CAGTSTARTER\cadpoolINMEQ\parametric\canfiguration\projectst\std_sut_creo10p\config_sut_
allow_flat_to_screen_note a5 275 CH\GTSTARTER\cadpoalINMEO\parametric\configuration\projects\std_sut_creo10p\config_sut,
allow_move_view_with_move yes 276 CAGTSTARTER\cadpoolINMEO\parametric\canfiguration\projects\std_sut_creo10p\config_sut.
auto_constr_always_use_offset  never 277 CAGTSTARTER\cadpaolINNED\parametric\configuration\projects\std_sut_creo10p\config_sut_
auto_orient_axis_alignment no 278 CAGTSTARTER\cadpoolINMEQ\parametric\canfiguration\projectststd_sut_creo10p\config_sut_
A farmat MARTCTADTE 72 CARTCTADTED A adnaslIMMEN mnaramatrislcanfisiiratiasl etandardl canfis Adie fila nea

<~ Multi usable options Count: 2
Config option Value Line Config block

protkdat CAGTSTARTER\cadpool\INMEQ\parametric\configuration\application\protk_gtfc.dat 120 C:\GTSTARTER\cadpool\INNEO\paran
protkdat CAGTSTARTER\cadpool\INNEQ\parametric\configuration\application\protk_mpuserdat 130 CAGTSTARTER\cadpool\INNEO\paran

Clicking on the heading of a column reverses the

wg/ alphabetical or numerical display order.

A~ Ma 5 Count: 67
KelLT] Name Label Line Config block

$F12 Ansicht unter "gut” speichern 365 CAGTSTARTER\cadpool INNEO\parametric\configuration\projects\std_sut_creo10p\cor,
SF3 Modell oder Zeichnung einpassen 338 AGTSTARTER\cadpool\INNEQ\parametric\configuration\projects\std_sut_crec10plcor
SF4 Modell in Standardansicht 341 C:\GTSTARTER\cadpool\ INNEO\ parametric\configuration\projects\std_sut_creo10p\cor
SF5 Orientierungsdialog &ffnen 344 CA\GTSTARTER\cadpoohINMNEO\ parametricicenfiguration\projectsistd_sut_creo10p\cor
SF6 Speichern tree.cfg 349 CAGTSTARTER\cadpool INNEO\parametric\configuration\projects\std_sut_creo10p\cor
SF7 Darstellungs-Refresh-Neuaufbau 354 AGTSTARTER\cadpool\INNEQ) parametric\configuration\projects\std_sut_crec10plcor
=] Crhattiaran tamnaranr IRT7 M RTCTADTED Aardnanl IMMEN naramatricrleanfimaratinni nraiacteletd ent rraniNnlenr

Analyze dialog of the Compare page

Note the call sequence for configuration blocks. The last specified value of a configuration
option is the valid value. See the chapter Configuration concept in the GENIUS TOOLS
Starter manual.
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Call sequence of configuration files in GENIUS TOOLS Starter

o Y oo Yomd Pern Y mE P e |

1.8 Editing config files

Find and replace
The magnifying glass button opens the Find and Replace dialog. So does Ctrl + F.

G B > A A = Q

config_sn_core.pro » config_sn_mapkeys.pro T

o
= no

L . - — Tabs

26 file open preview default exparn Replace

27 file open preview_delay 0.2 ] )

26 file timestamp format $yyyy-—%mm Find: measure_dialog_expand yes

3 hole diameter override ves Replace with: ‘ measure_dialog_expand no ‘

32 _’:*:.-‘ Replace all

33 initial bend y factor 0.78539%8

_: js_error_ policy suppress c i1 Options Search mode

35 mass_property calculate a 2 1

36 measure auto replace mode jJ I:‘ Match case @ Normal

kWlimceasure dialog expand yes) I:‘ Match whole words only O Wildcards ("' und '7')

38 menu_show instances no I:‘ Backward direction

. . .. . ORegularexpressian
3%maintain limit tol nominal yes

Wrap around

41 parenthesize_ref dim yes
42 pdf use pentable yes

43 prehighlight tree g

44 pro unit lenath unit mm 1

Edited file
Changes to a file are indicated with an asterisk.

Beﬂ-config-editor.pm X config_sut_de_cdp_mapkeys.pro

Functions for Creo configuration files

Files that contain configuration options for Creo Parametric (config_*.pro files) are
supported by additional functions.

Autocomplete
When entering a new configuration option, a list of the possible configuration options
opens. The list includes hidden configuration options.
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28 spin_center_display no
29 dis

su disable_custom_tool_prm_warning
disable_search_path_check

disp_camp_name_in_symb_rep

Auto completion

disp_trimetric_dwg_rmode_view
display

display_all_dims
display_annotations

display_axes

Options when entering "dis".

Suggest function

When entering a value for a the configuration option, a list of all possible values opens.
For hidden configuration options no values are suggested. The GTS config variable
gts_choose is always an option.

check interference of matches ne
combined state type mbd
comp_assemble start move then place
comp assemble with interface

ITe)

default_multi
default_single
from_list

nane

[ Y S TV S R S

1 gts_choose

Possible values for a configuration option

Tooltip
Each configuration option is explained in a tooltip which contains

— the possible input values,
— the default value and

— a description of the option.

1 edge_display_guality very_high
2 Model Disp ay

Values: n::urm.aI,high,\rery_high,Ic};ﬁIL Stay with mouse on
configuration option a

while to open tooltip

Default value: normal

Controls display quality of an edge for wireframe and hidden-line removal.
MNormal - Normal quality of edge display.

High - Increases tessellation by 2.

Very_high - Increases tessellation by 3.

Low - Decreases tessellation from normal, speeds up display.

Functions for Inventor configuration files

Collapse
Program code can be collapsed with the minus symbol.
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config_innec-templates.xml >

1 <?xml wersion="1.0" encoding="utf-16" standalone="no" 2>
2 g «ApplicationOptions Platform="Vista" Version="27.1 Production Candidate">

Collapse code
- == lesPa: ="%GTS_DATA:\Templates\$LANGUAGEZ\" />

5 <Save SaveReminder="0"/>

o

</BpplicationOptions>

1.9 GTS environment variahles

All environment variables that can be set with GENIUS TOOLS Starter are listed when
entering the dollar sign ($).

GENIUS TOOLS'™"

17 pro format dir
18 pro_group dir

19 pro library dir
20 pro material dir 5

L

s

S

e —— S ——

AL

Ts DETE\library dir\group dir

DATA\library dir\format dir

SGTS_DATA\library_dir
type Dollar symbol |
GTS_DATA i
GTS_DATA_LIE

GTS_ENV_MAME
GTS_EXECUTION_DIR
GTS_MAIN_SERVER_DIR

Created environment variables

GTS environment
variable

GT_LIC_SERVER
GT_LIC_TIMEOUT

GT_TELEMETRY

GTFC_ADMIN

GENIUS TOOLS Starter

Old SUT
variable

Description / example

contains the specifications of -gts:licServer

contains the specifications of -
gts:licTimeout (maximum waiting time of a
license query)

1 if Send telemetry data is activated,
otherwise 0

contains the result of the switch Is GTfC
Admin in GENIUS TOOLS Project
Configurator > Organization > Access > Role

TBXADMIN

> Function Access
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GENIUS TOOLS™"

GTS environment
variable

GTS_APPS_DIR

(GTS_CFG_LW)
recommended instead:
GTS_ROOT _DIR

GTS_*_ESCAPED

GTS_CONFIGURATION_
DIR

GTS_CREO_INSTALL_DEF
INITIONS_DIR

GTS_CREO_INSTALL_DIA
GNOSTIC

GTS_CREO_INSTALL_FIRE
WALL

GTS_CREO_INSTALL_HEL
P

GTS_CREO_INSTALL_HEL
P_XML_DIR

GTS_CREO_INSTALL_MAI
N_VERSION

GENIUS TOOLS Starter

Description / example Old suT
variable

Finds the selected, application-specific
directory for add-on applications.
<Caddepot>\<operatingenvironment>\<ap
plication>\apps

GTS:<Cadpool>\<operatingenvironment>  STOOLS_CFG_L
GTS: D:\gtstarter\cadpool\2017_latest W

SUT: <Driveletter>

SUT: P:

Variant of a variable that prevents the
variable from being resolved, e. g. needed
in mapkeys. Is defined automatically, see
explanation in section below.

Finds the selected, application specific
configuration directory.
<Caddepot>\<operatingenvironment>\<ap
plication>\configuration

definitions directory under the install folder

1 if diagnostic tools are activated, otherwise
0

1 if Write firewall entries is activated,
otherwise 0

1 if Install help is activated, otherwise 0

XML directory for the help
(install/definitions/<Unit or
standard>/XML/help_Creo<MainVersion>)

Creo main version to be installed
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GTS environment
variable

GTS_CREO_INSTALL_TAS
KSKILL

GTS_CREO_INSTALL_UNI
T_FOLDERS

GTS_CREO_INSTALL_UP
GRADE

GTS_CREO_INSTALL_VER
SION

GTS_CREO_INSTALL_VIE
WER

GTS_CREO_INSTALL_XM
L_DIR

GTS_DATA

GTS_DATA_LIB
GTS_ENV_NAME
GTS_EXECUTION_DIR

GTS_MAIN_SERVER_DIR
GTS_MC

GTS_NET_LW
GTS_PLOT_CONFIG_DIR

GENIUS TOOLS Starter

Description / example Old suT
variable

1 if Taskkill is activated, otherwise 0

List of the currently selected units (e. g.
“Germany|Leipzig|Construction”)

-upgrade if the installation type was set to

un

upgrade, otherwise

Creo version to be installed (e. g. 11.0.1.0)

1 if Install Thumbnail Viewer is activated,
otherwise 0

XML directory (install/definitions/<Unit or
standard>/XML/Creo<MainVersion>)

Finds the selected data package directory, is SUTDATA
from version 9.0 application specific: i. e. in

Creo Parametric it has been changed from
<Caddepot>\<operatingenvironment>\dat
a\<companydata>

to

<Caddepot>\<operatingenvironment>\<ap
plication>\data\<companydata>

Datalib directory
Name of operating environment.

Points to the directory which contains the
executed file (*.exe, *.bat, *.pdf).

Server path of the main server
SUTMC
Name of the first network drive

Directory for the plot configuration of Creo PLOT_CONFIG_D
Parametric IR
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GTS environment Description / example Old SuUT
variable variable
GTS_PLOT_FILE_DIR File for the plot settings of Creo Parametric PLOT_FILE_DIR
GTS_PROEDATECODE Version of Creo Parametric SUT_PROEDATE

CODE
GTS_PROERELEASE Version of Creo Parametric SUT_PROERELEA

SE
GTS_PROJECT_DIR Finds the selected project directory, from APPL_PROJECT_

version 9.0 application-specific. Path: DIR

<Caddepot>\<operatingenvironment>\<ap
plication>\configuration\projects\<projectn
ame>

GTS_PROJECT_DIR_NAM Name of project directory (until version 9.0

E GTS_PROJECT_DIR.)
GTS_PROJECT_NAME Name of current project SUT _PROJECT_N
AME

GTS_ROOT_DIR Main directory of the operating SUT_ROOT _DIR
environment

GTS_SATELLITEONLY_DI  Directory that only exists on the main server

R and the satellite

GTS_SERVERONLY_DIR  Directory that exists only on the server

GTS_SERVER_DIR Path to the server

GTS_SYNC_LAST Last synchronization date

GTS_SYNC_MODE Synchronization mode

GTS_TEMP Points to the temp directory

GTS_TRAIL_DIR Trail directory of Creo Parametric TRAIL_DIR
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GTS environment Description / example Old SuUT

variable variable

GTS_UNIT_DIR Finds the selected unit directory, from as of version
version 9.0 application-specific. Path: 11.0, use instead

<Caddepot>\<operatingenvironment>\<ap of:

plication>\configuration\units\<unitdirector GTS_USER_GRO

yname> UP,
GTS_COMPUTER
_GROUP

GTS_UNIT_DIR_NAME Name of unit directory
GTS_UNIT_NAME Name of unit that is selected by the user

GTS_USER Contains the alias name of the user entry in  STOOLS_USER
GENIUS TOOLS Starter (,GTS alias”)

GTS_USER_COMMENT Contains the comment of the user entry in
GENIUS TOOLS Starter

GTS_USER_CONFIG_DIR  Directory that contains the personal settings USER_CONFIG_

of users DIR
GTS_USER_EMAIL Contains the email address of the user entry
in GENIUS TOOLS Starter
GTS_USER_LW Letter of user drive STOOLS_USER_L
W
GTS_USERLONG Contains the long alias name of the user STOOLS_USER_L
entry in GENIUS TOOLS Starter (,GTS alias  ONG
long”)
GTS_USERSHORT Contains the short alias name of the user STOOLS_USER_S
entry in GENIUS TOOLS Starter (,GTS alias  HORT
short”)
GTS_VERSION Version of GENIUS TOOLS Starter
GTS_WCSRVNAME Windchill server name STOOLS_WCSRV
NAME
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GTS environment Description / example Old SuUT
variable variable
GTS_WCSRVURL Url of windchill server STOOLS_WCSRV

URL
GTS_WORKING_DIR Points to the start directory (for Creo

Parametric: working directory)

LANG Language LANG

Created environment variables: ESCAPED variant

Since version 6.0.2.0 variables are resolved in configuration files. This means that mapkeys,
in which environment variables with path specifications are used, no longer work. In order
to allow you to continue using variables in mapkeys and other places where a resolution is
undesirable, a new variant of all environment variables was introduced with the extension

_ESCAPED.

The ESCAPED variant of a variable is defined automatically: If an environment variable is
defined without the ESCAPED extension, GENIUS TOOLS Starter automatically writes the
value of this environment variable into the ESCAPED environment variable.

All variables can be extended with _ESCAPED. In particular, the following variables are
required for use in Mapkeys: GTS_PLOT_CONFIG_DIR_ESCAPED,
GTS_SERVERONLY_DIR_ESCAPED, GTS_SERVER_DIR_ESCAPED, GTS_TRAIL_DIR_ESCAPED,
GTS_UNIT_DIR_ESCAPED, GTS_USER_CONFIG_DIR_ESCAPED.

Affected environment variables
PTC_WF_ROOT

Environment variable that overwrites the default location of the Creo directory. (WF
comes from “Wildfire”, name of the predecessor product of Creo.)

PTC_WF_CACHE
Environment variable that refers to additional cache space.
PTC_SESSION_LOG_PATH
PTC_SESSION_TRACEBACK_PATH
PTC_SESSION_TRAIL_PATH
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7.10 GTS config variables

All configuration blocks can also be used for creating a project option. To do this, enter
GTS config variables as a comment in the file (configuration block).

Make sure to use the correct comment characters for the application-specific file type.
These are:

— for Creo Parametric configuration blocks: !
— for SolidWorks configuration blocks:,
— for Inventor configuration blocks: </-- -->

Enter the necessary expression gts_is_selectable = true as a comment, as well as other GTS
config variables if required for the display of the project option. Auto-completion and,
after clicking on a function, an explanation are available for the input.

g variable

gts_auto_activate_base_lic

gts_creo_lic
gts_creo_lic_display_name Teoltip text for name of project option.
SE i - If not specified, the file name is used

gts_display_name

The table lists GTS config variables that can be used for all CAD applications. For detailed
instructions and more variables for license extensions for Creo Parametric projects, refer to
the GENIUS TOOLS Starter manual.

GTS config Specification / Description
variable for all Example
applications

gts_is_selectable = true/false Defines if the project option appears as a
checkbox (in the Options tab as well as below
the project name)

gts_selection_defa true/false Defines whether the project option is selected
ult = by default or not, i. e. whether the box is
checked. Default: false.

gts_display_name  Simulation Live display name in the Config tab
= (Real-time — if not specified, the file name is used
simulation)
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GTS config
variable for all
applications

gts_selection_nam
e =

gts_selectable_pos

gts_description =

Specification / Description

Example

Simulation Live display name in selected project and in the
Options tab

— if not specified, gts_display_name is used

1 specifies the position in the list of project
options. This does not change the order in
which the configuration file is processed.

— if this command is not specified, the project
option will be placed after the options with
position and ordered alphabetically

Simulation for Tooltip text for name of project option
fluids for Creo — if not specified, the file name is used
from version 7.0.

GTS config Specification / Description
variable for Example

switch options

gts_choose

gts_choose{Big The gts_choose expression is set instead of the

Assemblies || value of a configuration option and must contain
display_points  two values.

NO ||

display_points

YES}

71.11 Batch mode

In batch or batch mode &, you can revise any number of config files. You can:

— find files with hidden config options,

— find files that contain fixed paths,

— search and replace words,

— replace SUT variables with GTS variables. (This actions assigns the corresponding GTS
variables automatically.)

GENIUS TOOLS Starter
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Please note: Do not mistake GTS variables (environment variables) for GTS config

< - m}
Actions o Processing list e Settings e

Find files containing hidden options > B selectall B Path: | CAINNEO\cadpoo\ENVIRONMENT\configuration\proj =
Search fixed paths 5 Search recursively

drag and drop D Search fixed paths v
Search and replace

File types.

Replace SUT variables > Find files containing hidden options A

Creo Parametric (%pro, *:sup)

Select Creo Version: o [] sclidWorks (*sidreg, *reg)

Mainversion Subversion: | 8030 -

[] inventor (*xml, *.addin)

Log

Hidden config options (grouped by the files they are contained in):

CAINNEO\cadpool_nightly\nightly ion\proj d_sut_int_de_creo0p\config_sut_de_cOp_cabling pro
ENABLE_OBSOLETE_MODES

C:\INNEO\cadpool_nightly\nightly ion\proj d_sut_int_de_creoOp\config_sut_de cOp_core.pro
INTF_OUT_BLANKED_ENTITIES

AUTO_ORIENT_AXIS_ALIGNMENT
DATE_TYPE_PARAMETER_FORMAT
ENABLE_RESOURCE_BROWSER_TAB

Batchmode dialog: Finding files with hidden options

Procedure
1. Drag the action you want to perform to the processing list.

2. In the processing list click on the action and fill in the details.

3. Under Settings (3) specify the folder where the config files are located. Activate
Recursive search to include files in all contained subfolders in the search.

4. Click the arrow icon (4).

Result: You will see the executed actions and the found options and paths in the log area.

Show preview

For the actions Search and replace and Replace SUT variables, you can get a preview in an
extra window which shows all hits. You can disable individual hits and choose to apply or
cancel the replacement. With the option Next change you can jump to the next hit within a
file.
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Search and replace ~

Search: rnass_property_calculate automatic

Replace: | mass_property_calculate by_request

I:' Ignore Case
Search in comments
Sh:uw Preview

] — Y H I =a A — 5 S==h —— = = H -

m' CANNEO\cadpool nighthAnighthAconfiguration\projects\std_sut int de creo0p... — a
Original text New text

34 js_error_pelicy suppress_continue js_error_palicy suppress_continue

35 mass_property_calculate automatic mass_property_calculate by_request

36 measure_auto_replace_mode yes measure_auto_replace_mode yes

37 measure_dialog_expand yes measure_dialog_expand yes

wentchange | nopy ] concel

Preview for searching and replacing a value of a configuration option
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8 Working with Git

Operating environments can be synchronized with the version control system Git and can
be managed on a Git server both in your company and cloud-based.

8.1 Connecting operating environments to Git

To synchronize an operating environment with the Git version control system, proceed as
follows.

Connecting to Git
1. Ensure that all requirements for connecting an operating environment to Git are
fulfilled, see <%TARGETTITLE%.

Warning: Git environments must be created on the computer on which the caddepot is
located (installation computer).

2. Select the Git function in GENIUS TOOLS Environment Administrator.

3. Select an existing operating environment. Create an new operating environment
beforehand, if needed.

Checking out an operating environment from Git
4. After migrating an operating environment to Git, GENIUS TOOLS Starter must be
restarted on user computers.

For an initial installation of GENIUS TOOLS Starter, start the EXE file GTS.exe on the
application computer.
Path: \\<mainserver>\gtstarter\caddepot\ <operatingenvironment>\software\gts.exe

8.2 Checking in changes to Git

The workflow of a git-versioned operating environment differs from the workflow for non-
versioned operating environments.

In a git-versioned operating environment, all changes — e. g. to the database sut.db and to
files — are made on the user computer, i. e. the computer on which the cadpool is located.
These changes are checked into Git using GENIUS TOOLS Git Utility.

Changes to components or software updates are checked in with GENIUS TOOLS
Environment Administrator on the installation computer and are automatically checked in.
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Git check-in: on any user
computer (Cadpool)

Changes in configuration and with GENIUS TOOLS Git Utility:
batch files — can be opened independently or via GENIUS
TOOLS Project Configurator
— changes must be checked in (Commit).

Changes to settings in GENIUS with GENIUS TOOLS Git Utility:
TOOLS Project Configurator — is opened automatically when saving in GENIUS
TOOLS Project Configurator
— changes must be checked in (Commit).

Git check-in: on installation
computer (Caddepot)

Software update with GENIUS TOOLS Environment Administrator:

Adding components - changes are automatically checked into Git.

— Note: On the installation computer, the check in
can only be made by the user who is the owner of
the Git repositories, i. e. who has created the
operating environment with GENIUS TOOLS
Environment Administrator in Git.

Changing synchronization and
license server settings

Git check-in on the user computer with GENIUS TOOLS Git Utility

In a git-versioned operating environment, changes are made in the Cadpool on a user
computer so that configuration files can be checked locally.

1. Open GENIUS TOOLS Project Configurator.

When starting GENIUS TOOLS Project Configurator synchronization is automatically
paused.

Please note:

Warning: All users who are allowed to start GENIUS TOOLS Project Configurator are
contributors and can check in changes to Git. Therefore, make sure that changes to
the operating environment are not made by several users simultaneously. This can
lead to merge conflicts during check-in.
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— You cannot check in changes with GENIUS TOOLS Project Configurator on the
installation computer, i. e. from the caddepot. The Git check-in button is grayed out.

Change settings for users, units and projects in GENIUS TOOLS Project Configurator.
Edit files locally in the cadpool, e. g. configuration and batch files.

Check the changes to the files locally before checking them into Git.

Click the Git check-in £7 button in GENIUS TOOLS Project Configurator.

Clicking on the Git checkin button £1in GENIUS TOOLS Project Configurator

— saves changes in GENIUS TOOLS Project Configurator to the database sut.db and

ok N

— opens GENIUS TOOLS Git Utility, which is used for committing all changes to Git, see
chapter GENIUS TOOLS Git Utility.

6. Follow the procedure for checking in with GENIUS TOOLS Git Utility, see GENIUS TOOLS
Git Utility.

7. Exit GENIUS TOOLS Git Utility.

8. Reactivate the synchronization in the user menu of GENIUS TOOLS Starter App or
GENIUS TOOLS Project Configurator by removing the checkmark under Pause
synchronization.

Git check-in on the installation computer with GENIUS TOOLS
Environment Administrator

Execute the functions Update, Modify or Add components, see chapter GENIUS TOOLS
Environment Administrator.

GENIUS TOOLS Environment Administrator recognizes whether you want to modify a git-
versioned operating environment.

Changes are automatically checked into Git.

Warning: The following applies to git-versioned operating environments: All changes
made on the user computer that have not been commited into Git are discarded when
executing a function in GENIUS TOOLS Environment Administrator.

8.3 Further information

System directories

The directories required for configuration layers — standard, projects, units, users — must be
created and committed manually on the user computer (Cadpool) in a git-versioned
operating environment, see Configuration layers.

GENIUS TOOLS Starter © 2025 INNED Solutions GmbH 328



Working with Git GENIUS TOOLS®;=

Please note: Empty directories are not synchronized.
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9 GENIUS TOOLS Git Utility

9.1 Introduction

GENIUS TOOLS Git Utility is an add-on application for GENIUS TOOLS Starter that checks
changes made to an operating environment into the version control system Git and
displays the history of these changes.

9.2 Starting the program

You can start GENIUS TOOLS Git Utility from any user computer on which GENIUS TOOLS
Starter is installed.

The program requires a subscription license for GENIUS TOOLS Starter.
It can be opened:

— from GENIUS TOOLS Project Configurator

—as an EXE file.

Starting from GENIUS TOOLS Project Configurator

Click the Git Check-in & % button in the sidebar of GENIUS TOOLS Project Configurator.
This

— saves changes to the database sut.db and

— opens GENIUS TOOLS Git Utility.

Please note: If the floppy disk icon L2l is displayed in the sidebar, this is not a git-
versioned operating environment.

While GENIUS TOOLS Git Utility is open, it is not possible to work with GENIUS TOOLS
Project Configurator.

Starting the EXE file

The file GTGitUtility.exe is located in the tools folder of an operating environment. Path:
cadpool/<operatingenvironment>/tools/git-utility

The file must be started from the cadpool of the user computer, as changes cannot be
made on the installation computer.
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9.3 User interface

The GENIUS TOOLS Git Utility interface is divided into the following areas.

Staged files Wl
configuration/database/sut.db —
+ parametric/fconfiguration/standard/config_core.pro —
+ parametric/configuration/standard/config_dir_file.pro —
+ parametricfconfiguration/standard/config_piping.pro —

+ parametric/configuration/standard/config_sut_de_start_gtfc.pro -

Unstaged files 1: Madified X:‘ I:+ New Xj] 1:— Deleted X:\] e ﬂa +TT 'A
Language U=
Theme menu r
Help 4
Configure compare tool
Forspotile S ration blocks (config.pro files)

1. Sidebar with
(] Commit page (Checking in changes to Git)
sy History of changes
 Reload
£33 User menu

2. Commit page

User menu

The user menu is opened in the sidebar using the cogwheel button {3,

- Language
The language setting of the user interface can be changed between German and English
during operation. The setting is saved for the next start.
GENIUS TOOLS Git Utility starts with German country settings for the operating system
in German. All other country settings result in an English language setting at startup.

— Theme
The software interface is available in light and dark color themes. The setting is saved for
the next start.

- Help
Help (F1): Opens the help for GENIUS TOOLS Git Utility. The help corresponds to this
document.
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Info (F12): Displays the license agreement for the current version of GENIUS TOOLS Git
Utility.

— Specify comparison tool

— Reset window size
Restores the standard size of the GENIUS TOOLS Git Utility dialog window. The window
can be enlarged or reduced as required.

— Exit

9.4 Checking in changes: Git commit

Changes to an operating environment are made in the Cadpool, i. e. on the user
computer. The commit page Il lists all changed files such as:

— Changes to the database sut.db
These are all changes made with GENIUS TOOLS Project Configurator.

— Configuration blocks
These are all text files that contain one or more configuration options for an application

— Batch files
— All files in the resource directory, e. g. files in PRT, DRW, ASM, SYM, TBL format.

If GENIUS TOOLS Git Utility is open, no changes can be made in GENIUS TOOLS Project
Configurator on this computer. However, GENIUS TOOLS Project Configurator can be used
on several computers.

Warning: All users who are allowed to start GENIUS TOOLS Project Configurator are
contributors and can check in changes to Git. Therefore, make sure that changes to the
operating environment are not made by several users simultaneously. This can lead to
merge conflicts during check-in.

Cleaning up and marking files

A distinction is made between marked and unmarked files. Select the files you want to
check in. Click on the button Stage all Jror Stage selected . or select individual files with
the Plus icon .

1. Filter
Unchecked files can be filtered by

modified files

+ new files
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= deleted files

Staged files 7

configuration/database/sut.db —

. ) . Open
+ parametric/configuration/standard/aax.psf —

+ parametric/configuration/standard/found.psf Show in Explorer

+ parametric/configuration/standard/gt_main.cfg Copy path to clipboard —

parametric/configuration/standard/gt_modules.cfg -

+ parametric/cenfiguration/standard/parametric.psf —

Unstaaed files |'/ Modified ><\f| |'/ + Mew X\fu \'/— Deleted X\]
g
b AN AN Iy

— configuration/_Images/gtsprj_creo3_dev_wt.png +
— configuration/_Images/gtsprj_creo3_sut.png 5+
+ parametric/cenfiguration/prejects/INNEQ_c12/config_1_lic_aax.pro Open 9 +
+ parametric/configuration/projects/INNEQ_c12/config_1_lic_bmx.pro . )
Show in Explorer
+ parametric/configuration/projects/INNEQ_c12/config_1_lic_freestyle.pro )
Copy path to clipboard
+ parametric/configuration/projects/INNEO_c12/config_1_lic_manikin.pro 2+
+ parametric/configuration/projects/INNEC_c12/config_1_lic_notebaook.pro Compare file Open 9+
parametric/configuration/gt_resource_folder/jnsnect/oti feature rev refer num context
. Remove menu with
+ gti_feature_rev_refer_num_mdI_wt Keep current version right-
+ gti_feature_rev_refer_num_mdl_wt.sym.3 Remove version extension Piscard mouse
parametric/configuration/gt_resousee Tolder/| Purge i Stop tracking  click
+ gti_feature_rev_refer_num_mdl.sym.2 R
2 Context menu 2JuElis
+ gti_feature_rev_refer_num_mdl.sym.3 for file groups
for deleting versions Resolve conflicts »

Commit message | Global configuration settings and PSF keys |

2. Context menu for marked files
The following actions can be performed from the context menu. The context menu
opens by right-clicking on a file:

— Open
Opens the selected file

— Show in Explorer
Opens the Explorer in the directory of the selected file

— Copy path to clipboard
Copies the path of the selected file to the clipboard

3. Context menu for unchecked files
The following actions can be performed:

- Open
— Show in Explorer

— Copy path to clipboard
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— Compare file
Opens the specified comparison tool to compare the current status of a file with the
status of the file on the Git server, see Comparing file versions.

— Remove
Deletes the selected file

— Discard
Discards the changes to the file. This function can also be executed with the arrow
icon /.

— Stop tracking (for files already checked in)
Stops tracking the file. The file becomes an unknown file and can therefore be
ignored.

— Ignore (for new files)
Adds the file to the file .gitignore so that the file is not tracked by Git.

— Resolve conflicts
This function is activated for files with merge conflicts.

Resclve conflicts 1> Take ours

Take theirs

Merge conflicts can be resolved by deciding whether the changes from the Cadpool
("Take ours") or the changes from the server ("Take theirs") should be kept.

Please note: Files whose conflicts have been resolved with “Take ours” can then be
considered as unmodified. In this case, the file no longer appears as a marked file.

4. Context menu for file groups (unmarked files)
Files with different versions are listed in groups and can be cleaned up individually, see
Cleaning up operating environment.

5. Cleaning up the operating environment

Old versions of a file can be deleted for the entire operating environment using the

broom icon b, see Cleaning up the operating environment.

6. Stage files for commit
Unmarked files can be marked with the icons Stage all Jror Stage selected Ny

7. Unstage files ) )
Staged files can be set back to Unstaged with Unstage all I+ and Unstage selected 1

Checking in staged files

Enter a message for the commit and click the Commit button. This checks in all staged
files with the specified commit message and lists them in the History page.
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Please note: The commit button is only activated after there is at least one marked file
and one commit message.

9.5 History of commits

The History page oI lists all commits to an operating environment with the commit
message and information on the check-in date and author.

Click on the line of a commit to see the changed files in the area Changes.

GENIUS TOOLS GIT UTILITY 12.00.0 — [m]

Commits L D
Graph | Message Date Author Commit o e

uncommitted changes 6/17/2025 11:51:35 AM  * &

(o] master origin/master | Konfi i ine flr 6/17/2025 11:19:34 -DI local> 4137d0ec-833b-4a3a-al23-775a04e83546

Merge branch ‘master’ of http:/JAHELK1:3000/Inrobot Versioned/parametric.git 6/11/2025 11:43:12 5 ARG [-DE\ahelk@gts local>  510013dd-1d92-4a31-a3e1-4e58ca7aff8

Txt-Datei 6/11/2025 11:42:50 AM  RATC-DE\ahelk <RATC-DE\ahelk@gtslocal>  5b2c9832-19e4-4dOf-8586-9a18¢522026

Project Creq 12 created 6/11/2025 10:15:44 AM  RATC-DE\ahelk <RATC-DE\ahelk@gtslocal>  00218b8a-5516-4168-95e9-c4babded3e6

Add component via GTSA 6/11/2025 9:4912 AM  GTSA <RATC-DE\ahelk@gts local> a5Bd9fde-67f5-4485-3296-c73d66eaaegb

Projekt Creo 11 angelegt 6/11/2025 9:11:49 AM  RATC-DE\ahelk <RATC-DE\ahelk@gtslocal>  [9c9bb34-b541-4cf6-ba07-b51d5415¢026
Changes

+ parametric/configuration/standard/cenfig_core.pro

=+ parametric/cenfiguration/standard/config_welding.pro

parametric/configuration/standard/gt_modules.cfg
configuration/database/sut.db Reseticlconnit o

Open current version
Open selected version Open context menu with right click

Compare file

Show in Explorer

Copy path to clipboard

The following functions are available:

1. Pull
Retrieves the current status from the Git server without discarding changes.
Use case: Another user has checked in changes.

2. Push
Pushes changes to the master.

3. Undo commit
Right-click on the commit that is to be undone.
You can choose whether a new commit should be created automatically to undo the
changes to the original commit.
If no new commit is created automatically, the changed files can be checked in on the
commit page.

The following actions can be performed for the changed files of a commit. Open the
context menu by right-clicking.

4. Context menu

GENIUS TOOLS Starter © 2025 INNED Solutions GmbH 335



GENIUS TOOLS Git Utility G EN I US TO OI.S®==

— Reset to commit
Resets the file to the status of the selected commit and lists the file as a marked file
on the commit page.

— Open current version
Opens the current version of the file from the Cadpool

— Open selected version
Opens the version of the file on the Git server.

— Compare file
Opens the specified comparison tool to compare the current status of a file with the
status of the file on the Git server, see Comparing file versions.

— Show in Explorer
Opens the Explorer in the directory of the selected file.

9.6 Comparing file versions

You can compare the current status of a file with a previous status of this file. You can use
a separate application or Notepad++ in ComparePlus mode to do this.

The Compare file function is available in the context menu:

— on the Commit page: compares the current file in the cadpool with the last checked-in
status of the file

— on the History page: compares the current file in the cadpool with the file of the
selected commit

If you compare a Config.pro file or a Config.sup file with an earlier version, they will open
in GENIUS TOOLS Config Editor on the Compare page.

Unstaged files (~ Modiied 3 )( + nNew > )( = Deieted )
hs AN A -

parametric/configuration/standard/config_core.pro  Config.pro files are opened in GENIUS TOOLS Config Editor

parametric/configuration/standard/gt_main.cfg all other files are opened in the compare tool defined Open

Show in Explorer

— Copy path to clipboard

Open context menu with right mouse click

Compare file

Context menu for unstaged files on the Commit page

Specifying comparison tool

To compare files, you can save your own comparison tool in the sidebar in the user menu
{3 or use Notepad++ in ComparePlus mode.
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Compare tool

Application Motepad++

Executable file | notepad++.exe

Arguments -pluginMessage=compare "SLOCAL" "$REMOTE"
Close

Fill in the following fields in the new dialog:

1. Application
Select whether you want to use your own application or Notepad++ in ComparePlus

mode.
Note that the ComparePlus plugin must be installed in Notepad++.

Please note: The required Notepad plugin is called ComparePlus. Do not confuse this
with Compare.

Ig’ Ci\Users\, “AppData\Local\Temph8c120188-ba0a-4df8-b819-c1033f330b79.cfg - Notepad++

Datei Bearbeiten Suchen Ansicht Codierung Sprache Einstellungen Werkzeuge Makros Ausfohren  Plugins  Fenster 7
cHHBRGES| & DD |t | % x| EE|= 1 - E @05\ compare » IEH = » v = EEIEHEE

ComparePlus > | Set as First to Compare
>

aEc'\ED1B?-baDa-4de-bE19-c1D33f330b?9.cfg = t:ll

‘ 1 ;*** gt_main,cfg *** Compare

MIME Tools
Converter > Compare Selections

e i _arme mestETeTIREmT AN TTRE L o s mme mme meen mn wr

2. Executable file
Enter the directory path to your own application.

3. Arguments
Specify transfer arguments for your own application. These may be required to open in

the correct mode.
The arguments "$LOCAL" "$REMOTE" are always needed to compare the local file with

the last checked-in version of the file on the Git server.

9.7 Cleaning up operating environment

Click on the broom icon b on the Commit page in the Unstaged files area to clean up the
entire operating environment (1) or in the context menu on Purge to clean up an
individual, versioned file (2).

Please note: The number after the file extension indicates the version of a file, e. g.
part1.prt.6. is version 6 of part 1.
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Staged files

| Purge operating environment |

1
Unstaged files 1: Modified X:‘ I:+ MNew XT:] 1:— Deleted Xj] \.\‘.,,TT 4_T

parametric..’conhgurauom‘guesource,fo\derﬁnspecugti,example,grp,num,de.tbl& 2+
Keep current version

+ gti_example_grp_num_de.thl.2 Right-click
+ gti_example_grp_num_de.tbl.3 en Remove version extension
. . . file group

parametric/configuration/gt_resource_folder/inspect/gti_example_grp_num_en.tbl Purge 9+

+ gti_example_grp_num_en.tbl.2

+ gti_example_grp_num_en.tbl.3

Commit message

Function Purge operating environment on the Commit page

1. Cleaning up operating environment

The Purge function h opens a new dialog box to delete versioned files from the operating
environment and to keep a defined number of versions.

Purge operating environment

parametric\configuration\gt_resource_folder\inspect\gti_example_grp_num_de.tbl OPTIONS
gti_example_grp_num_de.tbl1

@ Number of versions to keep | 1
gti_example_grp_num_de.thl.2

gti_example_grp_num_de.tbl.3 Number of days to keep 1

parametric\configuration\gt_resource_folder\inspect\gti_example_grp_num_en.tbl

i 1
gti_example_grp_num_en.tbl1 Set version to

gti_example_grp_num_en.tbl.2 Remave version extensicn

gti_example_grp_num_en.tbl.3

parametric\coenfiguration\gt_resource_folder\inspectigti_feature_change.sym
gti_feature_change.sym.l

parametric\configuration\gt_resource_folder\inspectigti_feature_cone.sym

gti_fea ture_cone.sym.l
- R m Cancel

Configure the versions to be kept on the right under Options.

— Number of versions to keep
Deletes all older versions of a file up to the number specified here.

— Number of days to keep
Deletes all versions of a file that are older than the number of days specified here. The
current version of a file is always retained regardless of its age.

— Set version to

Deletes all versions of a file except for the current one and sets the current version to
the specified version number.

— Remove version extension

Deletes all versions of a file except for the current version and removes the version
number of the current file.
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2. Cleaning up individual files before committing

All changed versions of one file are displayed in the list of unstaged files as a group. This
file group can be cleaned up separately using the actions in the context menu. These
actions delete versions of a file before the commit.

— Keep current version
Deletes all versions of a file except for the current version.

— Delete version number
Deletes all versions of a file except for the current version and removes the version
number of the current file.

— Clean-up
Opens the Clean-up dialog. The options correspond to those in the Purge operating
environment dialog.
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10 Appendix

10.1 Start parameters

Start parameter

-gts:admin

gts:appdata=<directorypath>
-gts:debug
-gts:exp= <directorypath>

-gts:home= <directorypath>

gts:lang=<languageacronym
>

-gts:L=<languageacronym>
-gts:CL=<languageacronym>

-gts:licDebug

-gts:licServer=<lizenseserver>

gts:licTimeout=<timespecifica
tion>

gts:networkTimeout=<timesp
ecification>

-gts:noChecksum

GENIUS TOOLS Starter

Description
Starts GENIUS TOOLS Project Configurator.

Redefines the path to the Appdata directory.

Activates debug logging.
Defines the location of the expcfg.bat file of the worker.

Sets the home directory. Example: D:
\gtstarter\cadpool\inneo\software\GTS.exe -gts-home=
%SystemDrive%\home\%USERDOMAIN%.%USERNAME%
\pro.creo3

Starts GENIUS TOOLS Starter App in a defined language
(de/en/fr).

Sets Creo language.
Set language for GENIUS TOOLS Starter.

Activates debug logging for the license server (loud
alarm when license problems occur).

Sets the license server.

Defines the maximum waiting time to receive a license, in
milliseconds. Entries from 1000 to 60000. Default: 10000.
Setting is passed on to Creo by environment variable
GT_LIC_TIMEOUT.

Redefines the network timeout. Entries in milliseconds.

Deactivates checksum tests during synchronization.
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Start parameter Description

-gts:noProjectAutostart Prevents the project (gts:p) from being started
immediately.

-gts:noSync Deactivates synchronization.

-gts:;p=<projectname> Starts a project and filters the project list.

-gts:pui=<projectlist> Filters the project list to a list of projects specified

separated by commas (-
gts:pui=pname1,pname2,pname3).

-gtsitemp=<directorypath>  Redefines path to the Temp directory.

-gts:units=<unitlDstring> Starts GENIUS TOOLS Starter with the defined unit ID
string. (The ID string is displayed in GENIUS TOOLS
Project Configurator under Configuration > GENIUS
TOOLS Starter App > Desktop shortcut for the selected
unit).

-gts:worker Starts in Worker setting.

- Defines the directory where the runtime data (log files) of
gts:workingDir=<directorypat GENIUS TOOLS Starter is stored.
h>

10.2 Environment variables

Created environment variables

GTS environment Description / example Old SuUT
variable variable
GT_LIC_SERVER contains the specifications of -gts:licServer
GT_LIC_TIMEOUT contains the specifications of -

gts:licTimeout (maximum waiting time of a
license query)

GT_TELEMETRY 1 if Send telemetry data is activated,
otherwise 0
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GTS environment
variable

GTFC_ADMIN

GTS_APPS_DIR

(GTS_CFG_LW)
recommended instead:
GTS_ROOT _DIR

GTS_*_ESCAPED

GTS_CONFIGURATION_
DIR

GTS_CREO_INSTALL_DEF
INITIONS_DIR

GTS_CREO_INSTALL_DIA
GNOSTIC

GTS_CREO_INSTALL_FIRE
WALL

GTS_CREO_INSTALL_HEL
P

GTS_CREO_INSTALL_HEL
P_XML_DIR

GENIUS TOOLS Starter

Description / example Old suT
variable

contains the result of the switch Is GTfC TBXADMIN
Admin in GENIUS TOOLS Project

Configurator > Organization > Access > Role

> Function Access

Finds the selected, application-specific
directory for add-on applications.
<Caddepot>\<operatingenvironment>\<ap
plication>\apps

GTS:<Cadpool>\<operatingenvironment>  STOOLS_CFG_L
GTS: D:\gtstarter\cadpool\2017_latest W

SUT: <Driveletter>

SUT: P:

Variant of a variable that prevents the
variable from being resolved, e. g. needed
in mapkeys. Is defined automatically, see
explanation in section below.

Finds the selected, application specific
configuration directory.
<Caddepot>\<operatingenvironment>\<ap
plication>\configuration

definitions directory under the install folder

1 if diagnostic tools are activated, otherwise
0

1 if Write firewall entries is activated,
otherwise 0

1 if Install help is activated, otherwise 0

XML directory for the help
(install/definitions/<Unit or
standard>/XML/help_Creo<MainVersion>)
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GTS environment
variable

GTS_CREO_INSTALL_MAI
N_VERSION

GTS_CREO_INSTALL_TAS
KSKILL

GTS_CREO_INSTALL_UNI
T_FOLDERS

GTS_CREO_INSTALL_UP
GRADE

GTS_CREO_INSTALL_VER
SION

GTS_CREO_INSTALL_VIE
WER

GTS_CREO_INSTALL_XM
L_DIR

GTS_DATA

GTS_DATA_LIB
GTS_ENV_NAME
GTS_EXECUTION_DIR

GTS_MAIN_SERVER_DIR
GTS_MC
GTS_NET_LW

GENIUS TOOLS Starter

Description / example Old suT
variable

Creo main version to be installed

1 if Taskkill is activated, otherwise 0

List of the currently selected units (e. g.
“Germany|Leipzig|Construction”)

-upgrade if the installation type was set to

un

upgrade, otherwise

Creo version to be installed (e. g. 11.0.1.0)

1 if Install Thumbnail Viewer is activated,
otherwise 0

XML directory (install/definitions/<Unit or
standard>/XML/Creo<MainVersion>)

Finds the selected data package directory, is SUTDATA
from version 9.0 application specific: i. e. in

Creo Parametric it has been changed from
<Caddepot>\<operatingenvironment>\dat
a\<companydata>

to

<Caddepot>\<operatingenvironment>\<ap
plication>\data\<companydata>

Datalib directory
Name of operating environment.

Points to the directory which contains the
executed file (*.exe, *.bat, *.pdf).

Server path of the main server
SUTMC

Name of the first network drive
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GTS environment Description / example Old SuUT
variable variable

GTS_PLOT_CONFIG_DIR  Directory for the plot configuration of Creo  PLOT_CONFIG_D

Parametric IR
GTS_PLOT_FILE_DIR File for the plot settings of Creo Parametric PLOT_FILE_DIR
GTS_PROEDATECODE Version of Creo Parametric SUT_PROEDATE
CODE
GTS_PROERELEASE Version of Creo Parametric SUT_PROERELEA
SE
GTS_PROJECT_DIR Finds the selected project directory, from APPL_PROJECT_
version 9.0 application-specific. Path: DIR

<Caddepot>\<operatingenvironment>\<ap
plication>\configuration\projects\<projectn
ame>

GTS_PROJECT_DIR_NAM Name of project directory (until version 9.0

E GTS_PROJECT_DIR.)
GTS_PROJECT_NAME Name of current project SUT _PROJECT_N
AME

GTS_ROOT _DIR Main directory of the operating SUT_ROOT _DIR
environment

GTS_SATELLITEONLY_DI  Directory that only exists on the main server

R and the satellite

GTS_SERVERONLY_DIR  Directory that exists only on the server

GTS_SERVER_DIR Path to the server

GTS_SYNC_LAST Last synchronization date

GTS_SYNC_MODE Synchronization mode

GTS_TEMP Points to the temp directory

GTS_TRAIL_DIR Trail directory of Creo Parametric TRAIL_DIR
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GTS environment Description / example Old SuUT

variable variable

GTS_UNIT_DIR Finds the selected unit directory, from as of version
version 9.0 application-specific. Path: 11.0, use instead

<Caddepot>\<operatingenvironment>\<ap of:

plication>\configuration\units\<unitdirector GTS_USER_GRO

yname> UP,
GTS_COMPUTER
_GROUP

GTS_UNIT_DIR_NAME Name of unit directory
GTS_UNIT_NAME Name of unit that is selected by the user

GTS_USER Contains the alias name of the user entry in  STOOLS_USER
GENIUS TOOLS Starter (,GTS alias”)

GTS_USER_COMMENT Contains the comment of the user entry in
GENIUS TOOLS Starter

GTS_USER_CONFIG_DIR  Directory that contains the personal settings USER_CONFIG_

of users DIR
GTS_USER_EMAIL Contains the email address of the user entry
in GENIUS TOOLS Starter
GTS_USER_LW Letter of user drive STOOLS_USER_L
W
GTS_USERLONG Contains the long alias name of the user STOOLS_USER_L
entry in GENIUS TOOLS Starter (,GTS alias  ONG
long”)
GTS_USERSHORT Contains the short alias name of the user STOOLS_USER_S
entry in GENIUS TOOLS Starter (,GTS alias  HORT
short”)
GTS_VERSION Version of GENIUS TOOLS Starter
GTS_WCSRVNAME Windchill server name STOOLS_WCSRV
NAME
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GTS environment Description / example Old SuUT
variable variable
GTS_WCSRVURL Url of windchill server STOOLS_WCSRV

URL
GTS_WORKING_DIR Points to the start directory (for Creo

Parametric: working directory)

LANG Language LANG

Created environment variables: ESCAPED variant

Since version 6.0.2.0 variables are resolved in configuration files. This means that mapkeys,
in which environment variables with path specifications are used, no longer work. In order
to allow you to continue using variables in mapkeys and other places where a resolution is
undesirable, a new variant of all environment variables was introduced with the extension

_ESCAPED.

The ESCAPED variant of a variable is defined automatically: If an environment variable is
defined without the ESCAPED extension, GENIUS TOOLS Starter automatically writes the
value of this environment variable into the ESCAPED environment variable.

All variables can be extended with _ESCAPED. In particular, the following variables are
required for use in Mapkeys: GTS_PLOT_CONFIG_DIR_ESCAPED,
GTS_SERVERONLY_DIR_ESCAPED, GTS_SERVER_DIR_ESCAPED, GTS_TRAIL_DIR_ESCAPED,
GTS_UNIT_DIR_ESCAPED, GTS_USER_CONFIG_DIR_ESCAPED.

Affected environment variables
PTC_WF_ROOT

Environment variable that overwrites the default location of the Creo directory. (WF
comes from “Wildfire”, name of the predecessor product of Creo.)

PTC_WF_CACHE
Environment variable that refers to additional cache space.
PTC_SESSION_LOG_PATH
PTC_SESSION_TRACEBACK_PATH
PTC_SESSION_TRAIL_PATH

10.3 Regular expressions

Regular expressions can be used for names that create users and computers.
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Character

\

(Pattern)

x|y

{n}

{n}

{n,m}

[xyz]

GENIUS TOOLS Starter

Description

Indicates the following character as a special or verbatim character. For
example "n" is corresponds to the character "n”. “\n"” corresponds to a
line-break character. The sequence “\\" corresponds to “\", “\("
corresponds to “(".

Corresponds to the beginning of the input.
Corresponds to the end of the input.

Corresponds to the proceeding character zero or multiple times. For

u_n

example “zo*" matches either “z" or “zoo”".

Corresponds to the proceeding character one or multiple times. “zo+"
for example matches “zoo”, but does not match “z".

Corresponds to the proceeding character zero or one time. For
example “"a?ve?” matches the “ve” in “never”.

Corresponds to all single characters except for a line-break character.

Matches Pattern and saves the equivalent. The compared substring
can be retrieved from the resulting matches listing using the elements
[0]...[n]. For comparing of characters put in parentheses () use “\(" or
“\)".

Corresponds to either x or y. For example matches “l|red” either “|"
“red”. “(I|r)ed” matches “led” or "red".

or

n is a positive integer. Corresponds to exactly n times. “o{2}" for

example does not match the “0” in “Robert” but the first two “0"s in
“Booooat”.

n is a positive integer. Corresponds to at least n times. “o{2}" for

example does not match the “0" in “"Robert” but all “0"s in “Booooat”.
“of1,}" is equivalent to “o+". "0{0,}" is equivalent to “o*".

m and n are positive integers. Corresponds to at least n and maximum

m times. For example “o{1,3}" matches the first three “0"s in
“Boooooat”. “0{0,1,}" is equivalent to “0?".

A group of characters. Corresponds to any of the included characters.

n_n

“labc]” for example matches the “a” in “falling”.
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Character Description

[Axyz] A group of excluded characters. Corresponds to any character not
included. “[*abc]” for example matches the “f" in “falling”.

[a-Z] A character range. Corresponds to any character in the specified range.
For example, “[a-z]” matches any lowercase alphabetic character in the

u_n u_n

range from “a” to “z".

[Am-Z] An excluded range of characters. Corresponds to any character not
included in the specified range. “[m-z]" for example matches all

u_n

characters not included in the range from “m” to "z".

10.4 GTS config variables

The following GTS config variables are needed for generating single project options to
select license extensions and extensions for Creo Parametric projects.

GTS config Specification / Description
variable for all Example
applications

gts_is_selectable = true/false Defines if the project option appears as a
checkbox (in the Options tab as well as below
the project name)

gts_selection_defa true/false Defines whether the project option is selected
ult = by default or not, i. e. whether the box is
checked. Default: false.

gts_display_name  Simulation Live display name in the Config tab

= (Real-time — if not specified, the file name is used
simulation)

gts_selection_nam Simulation Live display name in selected project and in the

e= Options tab

— if not specified, gts_display_name is used
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GTS config Specification / Description
variable for all Example
applications

gts_selectable_pos 1 specifies the position in the list of project
= options. This does not change the order in
which the configuration file is processed.
— if this command is not specified, the project
option will be placed after the options with

position and ordered alphabetically

gts_description = Simulation for Tooltip text for name of project option

fluids for Creo — if not specified, the file name is used
from version 7.0.

The following GTS Config variables are used to create single project options for selecting
license extensions for Creo Parametric projects.

GTS config Specification / Description

variable Example

gts_creo_lic = <licensenumber>, Creo Parametric: License number(s) of the
e.g.379 extension(s) to be added. Multiple numbers

must be separated with empty space.

— if this entry is set, an icon key appears next to
the checkbox in the project

— license numbers can be read from the
license.dat file in the licensing folder under
PTC/FLEXnet Admin License Server

gts_creo_lic_displ  <text>, e. g. Creo Parametric: Tooltip text for license symbol
ay_name = Simulation Live (key)

— if not specified, the line under License name
is empty
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GTS config Specification / Description

variable Example

gts_requires_base_| <baselicense>, Defines condition: if the base license is not

ic = e.g. available, the project option will be deactivated,

PROE_Foundation i. e. no checkbox is displayed.

— It checks if the base license is specified in the
PSF key.

— Multiple licenses must be separated with
empty space. The project option will be
deactivated, unless all of the listed licenses
are available.

gts_auto_activate_ <baselicense>, Defines condition: If the base license is
base_lic = e.g. available, the project option will be preselected,
PROE_Foundation i. e. the box is checked.

— Multiple licenses must be separated with
empty space. The project option will be
deactivated, unless all of the listed licenses
are available.

— Take care not to simultaneously set the
variable ! gts_selection_default to true.

If the file is to control an auxiliary application, specify the corresponding configuration
option, such as a protkdat entry. (Example: protkdat
$GTS_ROOT_DIR\configuration\application\protk_keyshot.dat). These entries do not
create icons next to the checkbox.

The gts_choose variable can be used to create switch options and to include add-on
applications for Solidworks.
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GTS config Specification / Description
variable for Example
switch options

gts_choose gts_choose{Big The gts_choose expression is set instead of the
Assemblies || value of a configuration option and must contain
display_points  two values.
NO ||
display_points
YES}

GTS config Specification / Description

variable for Example

SolidWorks

gts_choose gts_choose{Soli The gts_choose expression must contain two values
dWorks for registry entry.
Composerl|
00000001||
00000000}

Comment characters for each application

Application Configuration block Com- Example
required (text file) ment
charac-
ter
Creo Parametric  config_*.pro, config_*.sup ! ! gts_display name =

Keyshot plugin

SolidWorks config_*.sldreg ; ; gts_display name =
3DConnexion
Inventor config_*xml, ui_*xml, *.addin <!~ <!-- gts_display name =
-——> Additive Manufacturing -->
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10.5 Start values in Startup TOOLS

Access to the individual extension modules of GENIUS TOOLS for Creo
and editors
The start switches for user modules are set to 1, i. e. they can be opened by users.

The start switches for the editors of these modules are set to 7 or to %GTFC_ADMIN%. The
%GTFC_ADMIN% variable contains the result of the switch Is GTfC Admin in GENIUS
TOOLS Project Configurator > Organization > Access > Roles > Function Access.

The variable %GTFC_ADMIN% is set in the delivery state of the Startup TOOLS in the
following configuration options.

Editor Name and value of configuration option (,,start switch”)

GENIUS TOOLS Library gt_start_library_editor=%GTFC_ADMIN%
Editor

GENIUS TOOLS Material  gt_start_material_editor=%GTFC_ADMIN%
Editor

GENIUS TOOLS Name gt_start_name_generator_editor=%GTFC_ADMIN%
Generator Editor

GENIUS TOOLS Quick gt_start_quick_access_editor=%GTFC_ADMIN%
Access Editor

GENIUS TOOLS UDF gt_start_udf_forms_editor=%GTFC_ADMIN%
Forms Editor

10.6 GENIUS TOOLS Starter: part of Startup TOOLS

GENIUS TOOLS® Starter is a stand-alone application within the product package GENIUS
TOOLS Startup TOOLS.
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Startup TOOLS product and module overview

GENIUS TOOLS Starter

GENIUS TOOLS Starter App —
GENIUS TOOLS Project Configurator
GENIUS TOOLS Environment Administrator

GENIUS TOOLS
Creo Data Packages

-

—] startup TOOLS
GENIUS TOOLS
GENIUS TOOLS for Creo License Manager

GENIUS TOOLS Parameter

- Parametermanagement, Assembly
Report, Quick Access etc.

GENIUS TOOLS Library

- Librarymanagement, UDFs,
Forms, Quick Access etc.

Legend Normal: modules / software components Bold: products, individually available
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11 Glossary

Administration computer
Computer on which the administrative user has full write access to the Caddepot
directory in order to manage all data on the file system level.

Application computer, workstation
Computer on which the (Creo) user works. The application computer houses the
Cadpool directory, which contains the local operating environment.

Authentication provider
An authentication provider is an executable file that requests or receives user data from an
authentication system.

Cadpool
Directory on the application computer that contains the local operating environments.
The Cadpool directory is synchronized from the Caddepot.

Caddepot
Directory on the administration computer that contains the central operating
environment.

Client
Term for application computers for Startup TOOLS versions up to 2018.

Computer group
When updating to version 11.0.0.0 and newer, existing computer groups will be
transformed into units.

Conditional configuration block
Configuration file whose validity is restricted to condition(s) by one or more tag ID(s).
Notation: config_*.TAGID.pro

Config file (also: config_*.pro file)
See configuration block.

Configuration block
Configuration file which is read by GENIUS TOOLS Starter to create the configuration of
a Starter project. Notation: config_*.pro, config_*.sldreg.

Config.pro
Most important Creo Parametric configuration file, defines user settings.

Config.sup file
Creo configuration file which contains settings that cannot be changed by the users, e.g.
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to ensure drawing standards.

Config.val file
Creo Parametric configuration file which contains validation settings for data import.

Creo
Name of CAD software by PTC with the applications Creo Parametric (formerly
Pro/Engineer) ans Creo Elements/Direct (formerly CoCreate).

Creo configuration file
File which determines settings for a Creo session. There are four types of configuration
file: config.pro, customization.ui, config.sup and config.val.

Creo startkey (also: PSF key, start command)
Configured start command that opens Creo Parametric with one or several defined
licenses or license extensions. Stored as PSF file in PTC bin directory.

Customization.ui file
Creo Parametric configuration file which contains user interface customizations for a
user. The precise name of the file is creo_parametric_customization.ui

Data directory
Main directory for all data related to an operating environment at <GTS-
OperatingEnv>\data.

Educational license
License for academic institutions.

Escaped variable
Variant of an environment variable that prevents the variable from being resolved. It is
defined automatically.

Free tag ID
Textual marking in a configuration block which restricts the file to the selection of a
combined project option.

GENIUS TOOLS
Family of software products by INNEO Solutions GmbH, including Startup TOOLS, Model
Processor, and freeware tools such as Purge.

GENIUS TOOLS for Creo
Component of the Startup TOOLS software product which contains functional
enhancements for Creo.

GENIUS TOOLS Environment Administrator
Stand-alone administrative tool. It is used to create and update work environments, edit
work environment properties and migrate from older versions of Startup TOOLS to
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version 6 and later. GENIUS TOOLS Environment Administrator is located at ...
\installdepot\gtsa-latest\gtsa-exe.

GENIUS TOOLS License Manager
Administrative tools for managing Startup TOOLS licenses.

GENIUS TOOLS Project Configurator
Administrative component of GENIUS TOOLS Starter for managing project
configurations and other properties of an operating environment. Open GENIUS TOOLS
Project Configurator from the user menu of GENIUS TOOLS Starter App.

GENIUS TOOLS Starter
Software product consisting of the three components GENIUS TOOLS Project
Configurator, GENIUS TOOLS Starter App and GENIUS TOOLS Environment
Administrator.

GENIUS TOOLS Starter App
Stand-alone component of GENIUS TOOLS Starter which lets users start configured Creo
projects. GENIUS TOOLS Starter app is located in each operating environment under
..\caddepot\lokal\software\GTS.exe.

GENIUS TOOLS Starter App Config Analyzer
Dialog box in GENIUS TOOLS Starter App, in which configuration settings of projects can
be analyzed and edited.

GENIUS TOOLS Starter Service
Method in GENIUS TOOLS Starter for faster data synchronization.

GTS
Abbreviation for GENIUS TOOLS Starter.

GTS.exe
Name of the executable file for GENIUS TOOLS Starter App.

GTSA.exe
Name of the executable file for GENIUS TOOLS Environment Administrator.

GTS Alias
User alias in GENIUS TOOLS Starter, for use in additional applications for Creo. The GTS
alias is available as an environment variable (3GTs USER$) in Creo. If you do not specify
an alias, the user name will be used.

GTS Alias Long
Long user alias. The long alias is available in Creo via the environment variable %
GTS_USERLONGS.
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GTS Alias Short
Short user alias. The short alias is available in Creo via the environment variable 2
GTS USERSHORT%.

GTS-config-variable
Variable that defines settings in a configuration block to create a single project option
for GENIUS TOOLS Starter App, e. g. gts_display_name

GTS variable
Environment variable that creates inforamtion for GENIUS TOOLS Starter, e. g.
GTS_UNIT_DIR.

Home Use license
License for private use.

Initial synchronization, initialization
First synchronization run which creates the Cadpool directory on the application
computer and synchronizes it with the Caddepot.

Installdepot
Subdirectory of the installation directory that contains the release and version setups
without settings and customizations. All setup programs unpack their data to this
directory.

Installation computer
Computer on which the setup programs are run. Typically, this is also the administration
computer.

LDAP (Lightweight Directory Access Protocol)
Network protocol for accessing a distributed directory service, e. g. the Windows user
management.

License extension
License for additional Creo Parametric functionality that is drawn at the start of the
program and blocked during the session.

Mapkey
Macro defining a sequence of commands and functions which can be created in Creo to
simplify often-used procedures.

Mediadepot
Subdirectory of the installation directory. It contains setup files for different releases and
versions. All setup files will install or unpack to the Installdepot directory.

NAS (Network Attached Storage)
File server providing independent storage capacity in a network of computers.
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NC (Numerical Control)
Computer-based applications for controlling machine tools and production lines.

Operating environment
Directory that contains all the data required for working with the desktop application.
This includes configuration data, libraries, templates and additional applications. The
operating environment also contains a database with all configured projects.

Operating environment, local
Operating environment on the application computer.

Organization tree
Structure of all units and subunits that specifies the call hierarchy. Created in GENIUS
TOOLS Project Configurator.

Perpetual license, permanent license
License that allows using a defined version of a software for an unlimited period of time.

PDM directory
Subdirectory of the directory standard, units, projects and users which is included into the
call hierarchy for configuration files and batch files if Windchill is active.

PDMLink
Component of the Windchill software product family that is used for product data
management.

Power Extensions
Application from INNEO for central administration of an operating environment for Creo
Elements/Direct projects.

PTC
The software company that develops Creo.

Project
See Starter project.

Project, blocked
Project that a user can neither access nor see in GENIUS TOOLS Starter App.

Projekt, hidden
Project that a user cannot see in GENIUS TOOLS Starter App, but is able to access it with
a transfer parameter.

Project, invalid
Project, for which a user has no valid license or required license extensions. Access to it
an display in GENIUS TOOLS Starter App can be configured.
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Project directory
Directory for project data at <GTS-OperatingEnv>\configuration\projects\%
GTS_PROJECT_DIR%

Project option
Option to select on one or more projects in GENIUS TOOLS Starter App the Creo
language, Creo startkey as well as license extensions and add-on programs.

Resource directory
Directory gt _resource_folder, which is located in the system directory configuration of
Creo Parametric and contains information for the modules of GENIUS TOOLS for Creo.

Role
Group of users or computers that are assigned access rights to projects and GENIUS
TOOLS Starter App functionality.

Satellite (also: synchronization or mirror server)
Computer or shared folder on a computer to which the state of one or more operating
environments of a central main server is mirrored.

Searchmode directory
Name of the directory PDM until version 9.0.0.

Starter project
Project created in GENIUS TOOLS Project Configurator which contains company-specific
data and additional applications and whose settings, such as license and project
specifications, can be made in different configuration levels.

Startup TOOLS
Software package that comprises the products GENIUS TOOLS Starter, GENIUS TOOLS
Library, GENIUS TOOLS Parameter, as well as Creo data packages and the GENIUS
TOOLS License Manager.

Startup TOOLS Server
Term for the administration computer for Startup TOOLS versions up to 2018.

STOOLS
Root directory name for Startup TOOLS versions up to 2018.

Subscription license
License that allows using a software for a limited period of time.

Subunit
Subordinate unit created by attaching a unit to another unit in the organization tree.

SUT
Abbreviation for Startup TOOLS.
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Synchronization
Functionality that copies the data of an operating environment in the Caddepot
directory to the Cadpool directory on an application computer.

Tag ID
Textual marking in a configuration block that is recognized by GENIUS TOOLS Starter.
There are tag IDs for units (unit tag ID) and for project options (free tag ID).

TeamViewer
Third-party software used by INNEO Solutions GmbH to provide remote support.

UDF (User-defined feature)
Template for repeatedly required Creo features.

Unit
Group of users who belong to a company department defined either geographically or
organizationally. Created in GENIUS TOOLS Project Configurator.

Unit directory
Directory in the units system directory that contains configuration blocks and other files
for a unit.

Unit tag ID
Tag ID that is assigned to a unit in GENIUS TOOLS Project Configurator.

Unit type
Individually defined category for units, for better representation in GENIUS TOOLS
Project Configurator.

User, dynamic
Variable entry in the Resources menu item under Role > LDAP or User group
(authentication provider).

User group
When updating to version 11.0.0.0 and newer, existing user groups will be transformed
into units.

User, permanent
Manually entered entry in the Resources menu item under Users.

Windchill
Software product by PTC for managing product data over the entire product life cycle.
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12 FAQs

GENIUS TOOLS Project Configurator

| created a project in GENIUS TOOLS Project Configurator, but it does not appear in
GENIUS TOOLS Starter App.
— You have selected a unit that does not have project access rights.

— The project is invalid and is not displayed. Make new settings for invalid projects, see
Displaying invalid projects.

— No start key is available. Take a look at the log file.

I cannot open GENIUS TOOLS Project Configurator.
Delete the .lock file under caddepot\ <operating environment>\configuration\database.

I changed the authentication method and can no longer log in to GENIUS TOOLS
Project Configurator.
Incorrect access data has been saved and you are no longer an administrator.

You can restore the old status of the database for GENIUS TOOLS Project Configurator.

To do this, go to the database directory in Caddepot under caddepot\ <operating
environment>\configuration\database and copy the database before the change of
authentication method from the directory Backup to the folder database. Rename the
database to sut.db. This will overwrite the last valid database.

Synchronize GENIUS TOOLS Starter App in the user menu with Synchronize now.
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13 Copyright

Copyright 2025 by:

INNEO Solutions GmbH

IT-Campus 1

73479 Ellwangen

Germany

This documentation is protected by copyright. All rights reserved.

Without prior written consent of an authorized representative of INNEO Solutions GmbH
it must not be copied, photocopied, reproduced, translated, communicated or converted
to electronic or machine readable form in whole or in part.

The unauthorized use of the documentation can lead to a claim for liquidated damages or
legal prosecution. INNEO Solutions GmbH does not accept liability for possible faulty
information in this documentation and the consequences resulting from such.

Note on registered trademarks:
Most of the software, hardware and trade names mentioned in this documentation are
also registered trademarks of the respective software manufacturers.

Registered trademarks and trade names of INNEO Solutions GmbH:
GENIUS TOOLS, Startup TOOLS, INNEO
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